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Constructing the Data Tables

The data tables contain a combination of command rows and data field rows. Each data table must begin with a Level command row that specifies its XML element. Each record must begin with a New Record command that specifies the start of a new record, and the end of a previous record (if any).

The required columns for the data fields vary depending on the Template Type.




Launching the Layout Editor

The layout editor is available in several places.

Launch the layout editor in one of the following ways:

	When Creating a New Report


	When Editing a Report


	When Viewing a Report






When Creating a New Report

You can use the Layout Editor to change the appearance of a report.

To launch the Layout Editor when creating a new report:




	Select the data model for the new report. The Report Editor displays the Add Layout page.



	From the Create Layout region, click a predefined template to launch the Layout Editor.






When Editing a Report

You can alter the layout of a report using the Layout Editor.

To launch the Layout Editor when editing a report:




	In the Report Editor:From the Thumbnail view, click Add New Layout.

or

From the List view, click the Create button on the layouts table toolbar.



	From the Create Layout region, click a predefined template to use to launch the Layout Editor.






When Viewing a Report

You can change the layout of a report while viewing it.

To launch the Layout Editor when viewing a report:




	Click Actions and then click Edit Layout. The layout must have been created in the layout editor.









Selecting a Predefined Layout

When you create a new layout, you are given the option of selecting a predefined layout to help you get started.

The following illustration shows the predefined layouts offered by the Basic and Shared Templates.

[image: Description of GUID-CE23846B-202F-4508-B962-715C358FE81C-default.gif follows]



The Basic and Shared Templates offer common layout structures with specific components already added. Choosing one of the predefined layouts is optional, but can facilitate layout design. If your enterprise utilizes a common design that is not available here, then you can add predefined layouts for your own use, or your Administrator can add more for all users.



Adding Shared Templates for All Users

Follow the steps to add redefined layout files to the shared directory for all users to access.

To add predefined layout files to the shared directory for all users to access:



	Log in with Administrator privileges and navigate to the Catalog.
	In the Shared Folders directory, open the Components folder.
	Locate the Boilerplates report and click Edit.
	Click Add New Layout.
	Design or upload the layout.To design the layout: Click an existing boilerplate (or blank) to launch the layout editor. Insert the components to the layout. When finished, click Save and give the boilerplate a name. This layout is now displayed to all users in the Shared Templates region.

To upload a layout: Click Upload to upload a predefined BI Publisher Template (.xpt file).



	Save the report.


Any BI Publisher Templates (.xpt) added to this report are displayed to all users as a Shared Template.








Adding Personal Predefined Layouts

Adding personal predefined layouts are available to your account user only. You can design the layout by launching the layout editor or you can upload a predefined template.

To add predefined layouts that are available to your account user only:



	Navigate to My Folders.
	Create a new report called "Boilerplates". This report does not have a data model.
	Click Add New Layout.
	Design or upload the layout.To design the layout: Click an existing boilerplate (or blank) to launch the layout editor. Insert the components to the layout. When finished, click Save and give the boilerplate a name.

To upload a layout: Click Upload to upload a predefined BI Publisher Template (.xpt file).





These layouts are presented in the My Templates region when you create a new layout.











Using the Template Builder Translation Tools

Translation is simplified by using Template Builder tools.

The Template Builder provides tools to help you create and test translations for templates.



About Translations

The section describes options for adding translated templates to a report.

There are two options for adding translated templates to a BI Publisher report definition:

	Create a separate RTF template that is translated (a localized template)


	Generate an XLIFF file from the original template (at runtime the original template is applied for the layout and the XLIFF file is applied for the translation)




Use the first option if the translated template requires a different layout from the original template.

If you only require translation of the text strings of the template layout, use the XLIFF option.

For detailed information, see Translation Support Overview and Concepts.

To use the Template Builder translation tools to create templates for translations, see the following topics in this section:

	Extracting Text to an XLIFF File for Translation


	Previewing a Translation


	Localizing a Template




For a demo on BI Publisher's localization capabilities, see the LocalizationDemo.exe demo provided with the Template Builder installation (located in the BI Publisher\BI Publisher Desktop\demos folder where you installed BI Publisher Desktop).





Extracting Text to an XLIFF File for Translation

This menu item allows you to create a standard XLIFF translation file that contains the boilerplate text from the template. XLIFF is a standard file format that is understood by many translation software packages. Since an XLIFF is an XML file, you can translate the text in a regular text editor.

A translatable string is any text in the template that is intended for display in the published report, such as table headers and field labels. Text supplied at runtime from the data is not translatable, nor is any text that you supply in the Microsoft Word form fields.




To extract text to an XLIFF file for translation:


	From the BI Publisher menu, select Tools, then Translate Template, then Extract Text.
	You are prompted to save the extract file as an XML file type. Enter a name for the extract file and save to the desired location.
	If you want to translate the template manually, open the .xlf file using a text editor and enter the translated strings in the file. For a detailed description of working with the BI Publisher generated .xlf files, see Working with Translation Files.
	When done, you can preview the translation. Then upload the file to the BI Publisher report definition.






Previewing the Template and Translation File

You can preview the translation of a template as a PDF file.

To preview the template with the translated XLIFF file applied:




	From the BI Publisher, in the Tools group, click Translation, then Preview Translation.
	You are prompted to select the saved XLIFF file. Locate the file, and click Open.


The Template Builder merges the sample data, the translation file, and the RTF template to generate a PDF for preview.








Localizing a Template

Localizing a template means that you are creating a template to be used for a specific language.

Because BI Publisher enables you to extract the boilerplate text strings from a template into an XLIFF file that can be translated and then applied at runtime, if the reports for additional languages only require the translation of these text strings, then you only need to supply translated XLIFF files to accompany the base template.

However, you would localize a template when the requirements for the report in the specific language go beyond the simple translation of the text in the layout.

To save a template as a localized template:




	From the Oracle BI Publisher menu, in the Tools group, select Translations, then Localize Template. This invokes a warning message that localizing the template overwrites the template. Click OK.
	You are prompted to select the XLIFF translation file. Locate the appropriate file and click Open.The translated XLIFF file is applied to the template that you currently have open in Microsoft Word.



	Save the localized template.
	Upload the template file to the appropriate report definition in the BI Publisher catalog. Select the appropriate locale in the upload dialog.







Limitations

This section describes the limitations of BI Publisher's support for the PDF 1.7 standard.

It includes the following topics:

	Limitations That Apply to All PDF Utilities


	FormProcessor Limitations


	PDFDocMerger and PDFBookBinder Limitations


	PDFSignature Limitations






Limitations That Apply to All PDF Utilities

PDF utilities have limited functionality in BI Publisher.

Limitations that apply to all the BI Publisher PDF utilities are:

	Secured PDF documents cannot be used as input to any BI Publisher PDF utility. 


	PDF documents generated by BI Publisher do not support most accessibility features.


	Unicode passwords are not supported.


	PDF utilities may not work properly with input PDFs that contain 3-D artwork and input PDF documents formatted as a presentation (slideshow).











FormProcessor Limitations

Limitations that apply to the FormProcessor utility are listed in this section.

	XFA Forms (Adobe's XML Forms Architecture) is not supported.


	Portable collection (portfolio) is not supported.


	Tagged PDF documents will lose tags after processing.











PDFDocMerger and PDFBookBinder Limitations

Limitations apply to the PDFDocMerger and PDFBookBinder utilities.

Limitations include:

	The output PDF document version is determined based on the first input PDF document. 


	XFA Forms (Adobe's XML Forms Architecture) is not supported. 


	Portable collection (portfolio) is not supported. 


	Tagged PDF documents will lose tags after merging. 


	The following objects are preserved in the output, but the navigation panel shows only objects contained in the first input PDF document.  

	Bookmark


	Attachment


	Layer


	Print characteristics (such as paper selection, handling, page range, copies, and scaling) 














PDFSignature Limitations

Limitations apply to the PDFSignature utility.

Limitations include:

	Object signature is not supported. 


	Selective encryption of embedded files is not supported. 


	AES (Advanced Encryption Standard) is not supported. 


	PDFSignature may not work correctly with the digital signature constraints and certificate constraints described in Section 1.2.5 of the PDF 1.7 specification. For more information about the PDF 1.7 specification, see the Adobe website at

 http://www.adobe.com/devnet/pdf/pdf_reference.html 












Uploading the Flash Template to the Report Definition

You need to upload the flash template to make it available for report layouts.

To upload the template to the report definition:




	Navigate to the report in the catalog. Click Edit to launch the Report Editor.
	Click Add New Layout.
	Under Upload or Generate New Layout, click Upload.
	In the Upload Template File dialog:	Enter a Layout Name.


	Click Browse and navigate to the Flex project directory. Under this directory open the bin directory and select the EmployeeReport.swf file.


	From the Template Type list, select Flash Template.


	Select the Locale for this template.






	Click Upload to add the Flash template to the available layouts for the report.





Designing Accessible Reports Using RTF Templates

This section describes the following techniques for designing reports using RTF templates. Accessibility support is for HTML output only.

	Avoiding Nested Tables or Separated Tables


	Defining a Document Title


	Defining Alternative Text for an Image


	Defining a Table Summary


	Defining a Table Column Header


	Defining a Table Row Header


	Sample Supported Tables


	Converting Charts to Tables






Avoiding Nested Tables or Separated Tables

Avoid using nested tables in a report. For a complex report, try breaking down complex tables into several simple, straightforward tables.

The following figure shows a simple table.

[image: Description of GUID-0FF44E96-D22E-4E6C-AD14-440F4EEFED5D-default.gif follows]



The following figure shows an example of a nested table: A table is inserted inside a table-cell.

[image: Description of GUID-4670FC9B-4822-45B0-8CE4-4CC29088E0D1-default.gif follows]








Examples

These are examples of table structures that BI Publisher does and does not support for accessibility.



Nested Tables

BI Publisher does not support accessibility when nested tables are used in a report.

In the following illustration, BI Publisher cannot tell to which column data "C1R1data" belongs.

[image: Description of GUID-04D208F4-EE17-418D-8B2D-10D6FBF555BF-default.gif follows]



Remove the nested table as shown in the following illustration.

[image: Description of GUID-2713F4A7-76C0-4706-A797-50DAE3E848B4-default.gif follows]









Table Headers Must Not Be Separated from the Table Body

To ensure accessibility, table headers must be part of the table they belong to.

The example shown in the following illustration is not supported because the header, table body and accessibility fields exist in three different tables.

[image: Description of GUID-B1D9CC0B-BA5D-400B-A238-1D1B1C9B9D52-default.gif follows]



These three tables should be joined into one to support accessibility, as shown in the following illustration.

[image: Description of GUID-05B63C75-46A0-4C1D-BB69-6FE4F2480DA9-default.gif follows]









Defining a Document Title

You can define a document title. The procedure differs slightly depending on the version of Microsoft Word.

To define or change a document title in Microsoft Word 2007:
	Click the Office button, click Prepare, and then click Properties.







To define or change a document title in previous versions of Word:



	On the File menu, click Properties, then click the Summary tab.






Defining Alternative Text for an Image



To define alternative text for an image in the template:



	Right-click the image.
	On the menu, click Format Picture.
	On the Alt Text tab, enter "alt:" followed by the alternative text. For example:alt:flower picture






Note:
In versions of Word prior to 2007, enter the alt:text syntax on the Web tab.










Defining a Table Summary

Add a table summary to a table by inserting this command.

<?table-summary: 'My Table Test '?>


in the first column and first row position of the table.








Defining a Table Column Header

You can define a table column header. The procedure differs slightly depending on the version of Microsoft Word.

To define a table column header in Word 2007:
	Select the heading row or rows. The selection must include the first row of the table.


	On the Design tab, in the Table Style Options group, select Header Row.


	Right-click the table and select Table Properties.


	In the Table Properties dialog, click the Row tab and then select Repeat as Header row at the top of each page.







To define a table column header in previous versions of Word:



	Select the heading row or rows. The selection must include the first row of the table.
	On the Table menu, click Heading Rows Repeat.






Defining a Table Row Header

To define multiple row headers, use the BI Publisher command.

<?acc-row-header:col_index?> 


Example Usage:

<?acc-row-header:'1,2,4'?>  ==> column 1, 2 and 4 will be row-headers. 


<?acc-row-header:'1,4'?>  ==> column 1 and 4 will be row-headers. 


In the following figure, the code behind the ACC field is:

ACC Field=<?table-summary:'My Table Test '?><?acc-row-header:'1,2'?>


which defines the first two columns as row headers.


[image: Description of GUID-13F07BA5-0C89-4F23-B939-ED13C35854CB-default.gif follows]












Sample Supported Tables

The following illustrations display sample tables for which accessibility is supported.

[image: Description of GUID-9B5DA1B7-24EF-482A-96BB-D5586013D3FF-default.gif follows]
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[image: Description of GUID-073C2C57-956E-4ED8-9412-0875BDBE6B88-default.gif follows]
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Converting Charts to Tables

Charts and gauges are not readable by the visually impaired. In order to make report output accessible for visually impaired users, create a table or cross tab that summarizes the data in the table.

The following figure shows the summarized data in the table. Ideally, the data is summarized at the same level as it is in the chart. Avoid providing a large table of detail data that is not summarized appropriately.


[image: Description of GUID-DEB647D5-69BA-4D85-A0BD-7B170C6A5688-default.gif follows]










Translation Support Overview

You can translate reports and catalogs in BI Publisher.

BI Publisher supports translation in two ways, as described in the following sections:

	What Is Catalog Translation?


	What Is Template Translation?


	About Supported Languages






What Is Catalog Translation?

Catalog translation is a feature of BI Publisher that enables you to extract the translatable strings from all objects contained in a selected catalog folder into a separate file.

Note:
If BI Publisher is integrated with Oracle Business Intelligence Enterprise Edition, BI Publisher catalog translation (folder and report, data model, style template and sub template names) is ignored. The Oracle BI Enterprise Edition catalog translation mechanism is applied instead. See "Localizing Oracle Business Intelligence" in System Administrator's Guide for Oracle Business Intelligence Enterprise Edition, for information on components that can be translated in an integrated catalog.

The separate string file can be translated and uploaded back to BI Publisher and assigned the appropriate language code.

Catalog translation extracts not only translatable strings from the report layouts, but also the user interface strings that are displayed to users, such as catalog object descriptions, report parameter names, and data display names.

Users viewing the catalog see the item translations that are appropriate for the user interface language that they selected in their My Account preferences. Users see report translations that are appropriate for the Report Locale that they selected in their My Account preferences.





What Is Template Translation?

Template translation is a feature of BI Publisher that enables you to extract the translatable strings from a single RTF-based template (including sub templates and style templates) or a single BI Publisher layout template (.xpt file).

Use this option when you need only the final report documents translated. For example, you must generate translated invoices to send to German and Japanese customers.





About Supported Languages

BI Publisher supports any language that is supported by Unicode and does not require a special algorithm to render.

Examples of languages that require a special algorithm to render are Hindi and Farsi. It is the user's responsibility to prepare an appropriate font if the language is not supported by Albany fonts.

BI Publisher does support Arabic and Hebrew.  






Getting Started

This chapter describes the concepts of associating XML data to layout elements in a report template. It describes basic techniques as well as advanced techniques for creating complex and highly conditionalized report formats.

If you are using Microsoft Word to create RTF templates, then see Creating RTF Templates Using the Template Builder for Word before reading this chapter. The demos and samples provided in the Template Builder installation can help orient you to the process of creating templates in Microsoft Word.

It is not required to have Microsoft Word or the Template Builder to create RTF templates and this chapter describes how to add components without using the Template Builder. Many of the layout components described in this chapter can also be inserted in a template using the Template Builder.

This section covers the following topics:

	What Are RTF Templates?


	Prerequisites for Designing Templates


	What is XSLT Compatibility?


	Key Concepts


	Designing the Template Layout


	About Adding BI Publisher Code






What Are RTF Templates?

Rich Text Format (RTF) is a specification used by common word processing applications, such as Microsoft Word.

When you save a document, RTF is a file type option.

BI Publisher converts documents saved as the RTF file type to XSL-FO enabling you to create report layouts using many standard word processor features.

During design time, you add data fields and other markup to the template using BI Publisher's simplified tags for XSL expressions. These tags associate the XML report data to the report layout and include other processing instructions.

In addition to the word processor's formatting features, BI Publisher supports other advanced reporting features such as conditional formatting, dynamic data columns, running totals, and charts.

If you are familiar with XSL and prefer not to use the simplified tags, BI Publisher also supports the use of pure XSL elements in the template. If you want to include code directly in the template, then you can include any XSL element, many FO elements, and a set of SQL expressions that BI Publisher extends.





Prerequisites for Designing Templates

You must perform these tasks before designing a template.

Before you design a template, you must:

	Know the business rules that apply to the data from the source report.


	Generate sample data from the report data model.

For information on generating sample data from a data model, see Testing Data Models and Generating Sample Data in Data Modeling Guide for Oracle Business Intelligence Publisher.


	Be familiar with the formatting features of Microsoft Word.











What is XSLT Compatibility?

BI Publisher uses the XSLT processor provided by Oracle XDK 11.1.0.7.0, which supports the W3C XSL Transformations 1.0 recommendation.

The processor also implements the current working drafts of the XSLT and XPath 2.0 standards. For more information about Oracle XDK, see: Oracle XML Developer's Kit Programmer's Guide.

By default, BI Publisher is compatible with XSLT 1.0. If you want to use XSLT and XPath 2.0 features in the template, then you must disable XSLT 1.0 compatibility. This configuration is performed at the template level. The template-level setting overrides the server setting.

XSLT compatibility is set as a Build Option in the Template Builder for Word. See Setting UI Options.





Key Concepts

When you design the template layout, you must understand how to associate the XML input file to the layout.

This chapter presents a sample template layout with its input XML file to illustrate how to make the proper associations to add the markup tags to the template.





Designing the Template Layout

Use the word processor's formatting features to create the design.

For example:

	Select the size, font, and alignment of text


	Insert bullets and numbering


	Draw borders around paragraphs


	Include a watermark


	Include images (jpg, gif, or png)


	Use table auto formatting features


	Insert a header and footer

For additional information on inserting headers and footers, see Defining Headers and Footers.




For a detailed list of supported formatting features in Microsoft Word, see Supported Formatting Features of Microsoft Word.








About Adding BI Publisher Code

When you create an RTF template, you add BI Publisher code to the RTF document. Follow one of these methods that are supported for adding code.

BI Publisher supports the following methods for adding code:

	Basic RTF Method

Use any word processor that supports RTF version 1.6 writer (or later) to design a template using BI Publisher's simplified syntax.


	Form Field Method

Using Microsoft Word's form field feature allows you to place the syntax in hidden form fields, rather than directly into the design of the template.

Note:
If you use XSL or XSL-FO code rather than the simplified syntax, then you must use the form field method.






This chapter describes how to create RTF templates using the preceding methods.

If you are using Microsoft Word, you can use the BI Publisher Template Builder for Word to facilitate inserting BI Publisher code fields. For detailed information, see Creating RTF Templates Using the Template Builder for Word.






Importing the XLIFF File

When the target tags have been translated you are ready to import the XLIFF file back to BI Publisher.

To import an XLIFF file:


	Navigate to the folder from which the XLIFF file was generated.
	From the toolbar, click the Translation button and select Import XLIFF.
	In the Upload dialog click Browse to locate the translated file and then select the appropriate locale from the list.
	Click Upload.





Setting Up Command Tables

A template always begins with a table that specifies the setup commands.

The setup commands define global attributes, such as template type and output character set and program elements, such as sequencing and concatenation.

The setup commands are:

	TEMPLATE TYPE Command


	OUTPUT CHARACTER SET


	Output Length Mode


	NEW RECORD CHARACTER


	INVALID CHARACTERS


	REPLACE CHARACTERS


	NUMBER THOUSANDS SEPARATOR


	NUMBER DECIMAL SEPARATOR


	DEFINE LEVEL


	DEFINE SEQUENCE


	DEFINE CONCATENATION


	CASE CONVERSION




An example setup table is shown in the following figure:

[image: Description of GUID-F8F4CEC1-91BB-4159-AC4F-2ADB37E4D08E-default.gif follows]
Here is another example setup table:

[image: Description of GUID-F9182E29-9E52-49FB-9A16-FEBB96D23B04-default.gif follows]





TEMPLATE TYPE Command

This command specifies the type of template.

There are two types: FIXED_POSITION_BASED and DELIMITER_BASED.

Use the FIXED_POSITION_BASED templates for fixed-length record formats, such as EFTs. In these formats, all fields in a record are a fixed length. If data is shorter than the specified length, then it is padded. If longer, it is truncated. The system specifies the default behavior for data padding and truncation. Examples of fixed position based formats are EFTs in Europe, and NACHA ACH file in the U.S.

In a DELIMITER_BASED template, data is never padded and only truncated when it has reached a maximum field length. Empty fields are allowed (when the data is null). Designated delimiters are used to separate the data fields. If a field is empty, two delimiters are displayed next to each other. Examples of delimited-based templates are EDI formats such as ASC X12 820 and UN EDIFACT formats - PAYMUL, DIRDEB, and CREMUL.

In EDI formats, a record is sometimes referred to as a segment. An EDI segment is treated the same as a record. Start each segment with a new record command and give it a record name. You should have a data field specifying the segment name as part of the output data immediately following the new record command.

For DELIMITER_BASED templates, you insert the appropriate data field delimiters in separate rows between the data fields. After every data field row, you insert a delimiter row. You can insert a placeholder for an empty field by defining two consecutive delimiter rows.

Empty fields are often used for syntax reasons: you must insert placeholders for empty fields so that the fields that follow can be properly identified.

There are different delimiters to signify data fields, composite data fields, and end of record. Some formats allow you to choose the delimiter characters. In all cases you should use the same delimiter consistently for the same purpose to avoid syntax errors.

In DELIMITER_BASED templates, the <POSITION> and <PAD> columns do not apply. They are omitted from the data tables.

Some DELIMITER_BASED templates have minimum and maximum length specifications. In those cases Oracle Payments validates the length.





DEFINE LEVEL Command

Some formats require specific additional data levels that are not in the data extract. For example, some formats require that payments be grouped by payment date. Using the Define Level command, a payment date group can be defined and referenced as a level in the template, even though it is not in the input extract file.

When you use the Define Level command you declare a base level that exists in the extract. The Define Level command inserts a new level, one level higher than the base level of the extract. The new level functions as a grouping of the instances of the base level.

The Define Level command is a setup command, therefore it must be defined in the setup table. It has three subcommands:

	BASE LEVEL command - defines the level (XML element) from the extract that the new level is based on. The Define Level command must always have one and only one base level subcommand.


	GROUPING CRITERIA - defines the XML extract elements that are used to group the instances of the base level to form the instances of the new level. The parameter of the grouping criteria command is a comma-separated list of elements that specify the grouping conditions.

The order of the elements determines the hierarchy of the grouping. The instances of the base level are first divided into groups according to the values of the first criterion, then each of these groups is subdivided into groups according to the second criterion, and so on. Each of the final subgroups is considered as an instance of the new level.


	GROUP SORT ASCENDING or GROUP SORT DESCENDING - defines the sorting of the group. Insert the <GROUP SORT ASCENDING> or <GROUP SORT DESCENDING> command row anywhere between the <DEFINE LEVEL> and <END DEFINE LEVEL> commands. The parameter of the sort command is a comma-separated list of elements by which to sort the group.




For example, the following table shows five payments under a batch.


	Payment Instance	PaymentDate (grouping criterion 1)	PayeeName (grouping criterion 2)
	Payment1

	PaymentDate1

	PayeeName1


	Payment2

	PaymentDate2

	PayeeName1


	Payment3

	PaymentDate1

	PayeeName2


	Payment4

	PaymentDate1

	PayeeName1


	Payment5

	PaymentDate1

	PayeeName3








In the template, construct the setup table as follows to create a level called PaymentsByPayDatePayee from the base level "Payment" grouped according to Payment Date and Payee Name. Add the Group Sort Ascending command to sort each group by PaymentDate and PayeeName:


	Payment Group	Level
	<DEFINE LEVEL>

	PaymentsByPayDatePayee


	<BASE LEVEL>

	Payment


	<GROUPING CRITERIA>

	PaymentDate, PayeeName


	<GROUP SORT ASCENDING>

	PaymentDate, PayeeName


	<END DEFINE LEVEL>

	PaymentsByPayDatePayee








The five payments generate the four groups (instances) shown in the following table for the new level:


	Payment Group Instance	Group Criteria	Payments in Group
	Group1

	PaymentDate1, PayeeName1

	Payment1, Payment4


	Group2

	PaymentDate1, PayeeName2

	Payment3


	Group3

	PaymentDate1, PayeeName3

	Payment5


	Group4

	PaymentDate2, PayeeName1

	Payment2








The order of the new instances is the order in which the records print. When evaluating the multiple grouping criteria to form the instances of the new level, the criteria can be thought of as forming a hierarchy. The first criterion is at the top of the hierarchy, the last criterion is at the bottom of the hierarchy.

Generally there are two kinds of format-specific data grouping scenarios in EFT formats. Some formats print the group records only; others print the groups with the individual element records nested inside groups. The following tables are two examples for these scenarios based on the five payments and grouping conditions previously illustrated and show the generated output:

Scenario 1: Group Records Only

EFT File Structure:

	BatchRec

	PaymentGroupHeaderRec


	PaymentGroupFooterRec








	Record Sequence	Record Type	Description
	1

	BatchRec

	NA


	2

	PaymentGroupHeaderRec

	For group 1 (PaymentDate1, PayeeName1)


	3

	PaymentGroupFooterRec

	For group 1 (PaymentDate1, PayeeName1)


	4

	PaymentGroupHeaderRec

	For group 2 (PaymentDate1, PayeeName2)


	5

	PaymentGroupFooterRec

	For group 2 (PaymentDate1, PayeeName2)


	6

	PaymentGroupHeaderRec

	For group 3 (PaymentDate1, PayeeName3)


	7

	PaymentGroupFooterRec

	For group 3 (PaymentDate1, PayeeName3)


	8

	PaymentGroupHeaderRec

	For group 4 (PaymentDate2, PayeeName1)


	9

	PaymentGroupFooterRec

	For group 4 (PaymentDate2, PayeeName1)








Scenario 2: Group Records and Individual Records

EFT File Structure:

BatchRec

	PaymentGroupHeaderRec

	PaymentRec





	PaymentGroupFooterRec





	Record Sequence	Record Type	Description
	1

	BatchRec

	NA


	2

	PaymentGroupHeaderRec

	For group 1 (PaymentDate1, PayeeName1)


	3

	PaymentRec

	For Payment1


	4

	PaymentRec

	For Payment4


	5

	PaymentGroupFooterRec

	For group 1 (PaymentDate1, PayeeName1)


	6

	PaymentGroupHeaderRec

	For group 2 (PaymentDate1, PayeeName2)


	7

	PaymentRec

	For Payment3


	8

	PaymentGroupFooterRec

	For group 2 (PaymentDate1, PayeeName2)


	9

	PaymentGroupHeaderRec

	For group 3 (PaymentDate1, PayeeName3)


	10

	PaymentRec

	For Payment5


	11

	PaymentGroupFooterRec

	For group 3 (PaymentDate1, PayeeName3)


	12

	PaymentGroupHeaderRec

	For group 4 (PaymentDate2, PayeeName1)


	13

	PaymentRec

	For Payment2


	14

	PaymentGroupFooterRec

	For group 4 (PaymentDate2, PayeeName1)








Once defined with the Define Level command, the new level can be used in the template in the same manner as a level occurring in the extract. However, the records of the new level can only reference the base level fields that are defined in its grouping criteria. They cannot reference other base level fields other than in summary functions.

For example, the PaymentGroupHeaderRec can reference the PaymentDate and PayeeName in its fields. It can also reference thePaymentAmount (a payment level field) in a SUM function. However, it cannot reference other payment level fields, such as PaymentDocName or PaymentDocNum.

The DEFINE LEVEL command must always have one and only one grouping criteria subcommand. The DEFINE LEVEL command has a companion END DEFINE LEVEL command. The subcommands must be specified between the DEFINE LEVEL and END DEFINE LEVEL commands. They can be declared in any order.





DEFINE SEQUENCE Command

The DEFINE SEQUENCE command defines a sequence that can be used in conjunction with the SEQUENCE_NUMBER function to index either the generated EFT records or the extract instances (the database records). The EFT records are the physical records defined in the template. The database records are the records from the extract. To avoid confusion, the term record always refers to the EFT record. The database record is referred to as an extract element instance or level.

The DEFINE SEQUENCE command has four subcommands: RESET AT LEVEL, INCREMENT BASIS, START AT, MINIMUM, and MAXIMUM:



RESET AT LEVEL

The RESET AT LEVEL subcommand defines where the sequence resets its starting number.

RESET AT LEVE is a mandatory subcommand. For example, to number the payments in a batch, define RESET AT LEVEL as Batch. To continue numbering across batches, define RESET AT LEVEL as RequestHeader.

In some cases the sequence is reset outside the template. For example, a periodic sequence may be defined to reset by date. In these cases, the PERIODIC_SEQUENCE keyword is used for the RESET AT LEVEL. The system saves the last sequence number used for a payment file to the database. Outside events control resetting the sequence in the database. For the next payment file run, the sequence number is extracted from the database for the start at number (see start at subcommand).





INCREMENT BASIS

The INCREMENT BASIS subcommand specifies if the sequence should be incremented based on record or extract instances. The allowed parameters for this subcommand are RECORD and LEVEL.

Enter RECORD to increment the sequence for every record.

Enter LEVEL to increment the sequence for every new instance of a level.

Note that for levels with multiple records, if you use the level-based increment, then all the records in the level have the same sequence number. The record-based increment assigns each record in the level a new sequence number.

For level-based increments, the sequence number can be used in the fields of one level only. For example, suppose an extract has a hierarchy of batch > payment > invoice and you define the INCREMENT BASIS by level sequence, with reset at the batch level. You can use the sequence in either the payment or invoice level fields, but not both. You cannot have sequential numbering across hierarchical levels.

However, this rule does not apply to increment basis by record sequences. Records can be sequenced across levels.

For both increment basis by level and by record sequences, the level of the sequence is implicit based on where the sequence is defined.





MINIMUM

Specifies the minimum sequence number.

If MINIMUM is not declared, the minimum sequence number will be set as 1 by default.

Specify this value when you want the minimum sequence number to be a value other than 1.







Define Concatenation Command

Use the define concatenation command to concatenate child-level extract elements for use in parent-level fields.

For example, use this command to concatenate invoice number and due date for all the invoices belonging to a payment for use in a payment-level field.

The define concatenation command has three subcommands: base level, element, and delimiter.





Base Level Subcommand

The base level subcommand specifies the child level for the operation.

For each parent-level instance, the concatenation operation loops through the child-level instances to generate the concatenated string.





Element Subcommand

The element subcommand specifies the operation used to generate each element. An element is a child-level expression that is concatenated to generate the concatenation string.





Delimiter Subcommand

The delimiter subcommand specifies the delimiter to separate the concatenated items in the string.





Using the SUBSTR Function

Use the SUBSTR function to break down concatenated strings into smaller strings that can be placed into different fields.

For example, the following table shows five invoices in a payment.


	Invoice	InvoiceNum
	1

	car_parts_inv0001


	2

	car_parts_inv0002


	3

	car_parts_inv0003


	4

	car_parts_inv0004


	5

	car_parts_inv0005








Using the concatenation definition shown in the following table:


	Level	Definition
	<DEFINE CONCATENATION>

	ConcatenatedInvoiceInfo


	<BASE LEVEL>

	Invoice


	<ELEMENT>

	InvoiceNum


	<DELIMITER>

	','


	<END DEFINE CONCATENATION>

	ConcatenatedInvoiceInfo








You can reference ConcatenatedInvoiceInfo in a payment level field. The string is as follows:

car_parts_inv0001,car_parts_inv0002,car_parts_inv0003,car_parts_inv0004,car_parts_inv0005

If you want to use only the first forty characters of the concatenated invoice information, then use either TRUNCATE function or the SUBSTR function as follows:

TRUNCATE(ConcatenatedInvoiceInfo, 40)

SUBSTR(ConctenatedInvoiceInfo, 1, 40)

Either of these statements result in:

car_parts_inv0001,car_parts_inv0002,car_

To isolate the next forty characters, use the SUBSTR function:

SUBSTR(ConcatenatedInvoiceInfo, 41, 40)

to get the following string:

parts_inv0003,car_parts_inv0004,car_par





Invalid Characters and Replacement Characters Commands

Some formats require a different character set than the one that was used to enter the data in Oracle Applications. For example, some German formats require the output file in ASCII, but the data was entered in German. If there is a mismatch between the original and target character sets you can define an ASCII equivalent to replace the original. For example, you would replace the German umlauted "a" with "ao".

Some formats do not allow certain characters. To ensure that known invalid characters are not transmitted in the output file, use the invalid characters command to flag occurrences of specific characters.

To use the replacement characters command, specify the source characters in the left column and the replacement characters in the right column. You must enter the source characters in the original character set. This is the only case in a format template in which you use a character set not intended for output. Enter the replacement characters in the required output character set.

For DELIMITER_BASED formats, if there are delimiters in the data, you can use the escape character "?" to retain their meaning. For example,

First name?+Last name equates to Fist name+Last name

Which source?? equates to Which source?

Note that the escape character itself must be escaped if it is used in data.

The replacement characters command can be used to support the escape character requirement. Specify the delimiter as the source and the escape character plus the delimiter as the target. For example, the command entry for the preceding examples is as follows:

<REPLACEMENT CHARACTERS>
+   ?+
?   ??
<END REPLACEMENT CHARACTERS>

The invalid character command has a single parameter that is a string of invalid characters that causes the system to error out.

The replacement character process is performed before or during the character set conversion. The character set conversion is performed on the XML extract directly, before the formatting. After the character set conversion, the invalid characters are checked in terms of the output character set. If no invalid characters are found, then the system proceeds to formatting.





Output Character Set and New Record Character Commands

Use the new record character command to specify the character(s) to delimit the explicit and implicit record breaks at runtime.

Each new record command represents an explicit record break. Each end of table represents an implicit record break. The parameter is a list of constant character names separated by commas.

Some formats contain no record breaks. The generated output is a single line of data. In this case, leave the new record character command parameter field empty.

If you do not define a "new record character" field in the template, then the system sets "\n" as default new record character.





Output Length Mode

Output Length Mode can be set to "character" or "byte".

When OUTPUT LENGTH MODE is set to "character", the output record length for each field is based on character length. When OUTPUT LENGTH MODE is set to "byte", the output record length for each field is based on byte length.

If no OUTPUT LENGTH MODE is setting is provided, "character" is used.





Number Thousands Separator and Number Decimal Separator

The default thousands (or group) separator is a comma (",") and the default decimal separator is a period ("."). Use the Number Thousands Separator command and the Number Decimal Separator command to specify separators other than the defaults. For example, to define "." as the group separator and "," as the decimal separator, enter the commands as follows:

<NUMBER THOUSANDS SEPARATOR>	.
<NUMBER DECIMAL SEPARATOR>	  ,

Note that when you set "NUMBER DECIMAL SEPARATOR", you must also set "NUMBER THOUSANDS SEPARATOR". Ensure to set the appropriate format mask for the field to be displayed. For more information on formatting numbers, see Format Column.





CASE CONVERSION

Use CASE CONVERSION to convert strings from lowercase to uppercase for fields with format type ALPHA. This command is used with FIXED_POSITION_BASED templates.

Valid values are "UPPER" and "LOWER". Enter the command as follows:

<CASE CONVERSION> : UPPER






Uploading a Style Template File to the Catalog

You can place a style template in any folder in the catalog to which you have access.

Your organization may have a designated folder for style templates.

To upload a style template file:




	On the global header click New and then click Style Template. This launches an untitled Style Template properties page.
	From the Templates region, click the Upload toolbar button.
	In the Upload Template File dialog, click Browse to select the Template File. Select rtf as the Type, and select the appropriate Locale.[image: Description of GUID-9C7EB713-E62E-4AF8-B285-C91C863C8486-default.gif follows]



[image: Description of GUID-5CEDD465-8927-45E1-B371-5A4009C8FE8C-default.gif follows]



The style template file is displayed in the Templates region as the locale name that you selected (for example: English-United States).



	Click Save.
	In the Save As dialog choose the catalog folder in which to save the style template. Enter the Name and click Save.Note:
You may only upload one RTF file per locale to a Style Template definition. If you upload additional template files to this Style Template, each file is automatically named as the locale regardless of the name that you give the file before upload.



	If you are uploading multiple localized files, then select the file that is to be used as the default. For more information on localization of template files see Adding Translations to a Style Template Definition.





About Style Templates

A style template is an RTF template that contains style information that can be applied to layout templates. The style information in the style template is applied to report layout templates at runtime to achieve a consistent look and feel across your enterprise reports.

For more information, see Creating and Implementing Style Templates.




Overview

To create a PDF template, take an existing PDF document and apply the BI Publisher markup.

Because you can use a PDF from any source, you have multiple design options. For example:

	Design the template using any application that generates documents that can be converted to PDF, such as Microsoft Word


	Scan a paper document to use as a template


	Download a PDF document from a third-party website




Note:
The steps required to create a template from a third-party PDF depend on whether form fields have been added to the document. For more information, see Creating a Layout from a Predefined PDF Form.

If you are designing the template, then when you have converted to PDF, the template is treated like a set background. When you mark up the template, you draw fields on top of this background. To edit the template, you must edit the original document and then convert back to PDF.

For this reason, the PDF template is not recommended for documents that require frequent updates. However, it is appropriate for forms that have a fixed template, such as invoices or purchase orders.




Adding Translations to a Style Template Definition

Style templates offer the same support for translations as RTF template files.

You can upload multiple translated RTF files under a single Style Template definition and assign the appropriate locale.

Or you can generate an XLIFF (.xlf) file of the translatable strings, translate the strings, and upload the translated file. These are displayed in the Translations region, as shown in the following figure:


[image: Description of GUID-0F5412E4-9E9D-4B2D-8172-AB48421F7586-default.gif follows]





At runtime, the appropriate style template is applied based on the user's account Preference setting for Report Locale for reports viewed online; or, for scheduled reports, based on the user's selection for Report Locale for the scheduled report.

The XLIFF files for style templates can be generated individually, then translated, and uploaded individually. Or, if you perform a catalog translation that includes the style template folders, the strings from the style template files are extracted and included in the larger catalog translation file. When the catalog translation file is uploaded to BI Publisher, the appropriate translations from the catalog file are displayed in the Translations region of the Style Template definition.

For more information on translations, see Translation Support Overview and Concepts.




Runtime Behavior

The following sections describe runtime behavior of PDF templates:

	Placement of Repeating Fields


	Setting Fields as Updatable or Read Only


	Overflow Data






Placement of Repeating Fields

As already noted, the placement, spacing, and alignment of fields that you create on the layout are independent of the underlying form layout. 

At runtime, BI Publisher places each repeating row of data according to calculations performed on the placement of the rows of fields that you created, as follows:

First occurrence:

The first row of repeating fields displays exactly where you have placed them on the layout.

Second occurrence, single row:

To place the second occurrence of the group, BI Publisher calculates the distance between the BODY_START tag and the first field of the first occurrence. The first field of the second occurrence of the group is placed this calculated distance below the first occurrence.

Second occurrence, multiple rows:

If the first group contains multiple rows, then the second occurrence of the group is placed the calculated distance below the last row of the first occurrence.

The distance between the rows within the group is maintained as defined in the first occurrence.





Setting Fields as Updatable or Read Only

You can make fields either read only or updatable.

When you define a field in the layout, you have the option of selecting "Read Only" for the field, as shown in the following illustration:

[image: Description of GUID-F5C57DA6-3C53-45CE-8F70-C2559ACD9393-default.gif follows]



Regardless of what you choose at design time for the Read-Only check box, the default behavior of the PDF processing engine is to set all fields to read-only for the output PDF. You can change this behavior using the following report properties, as described in Setting Report Processing and Output Document Properties:




	all-field-readonly


	all-fields-readonly-asis


	remove-pdf-fields




Note that in the first two options, you are setting a state for the field in the PDF output. The setting of individual fields can still be changed in the output using Adobe Acrobat Professional. Also note that because the fields are maintained, the data is still separate and can be extracted. In the third option, "remove-pdf-fields" the structure is flattened and no field/data separation is maintained.

To make all fields updatable:

Set the "all-field-readonly" property to "false". This sets the Read-Only state to false for all fields regardless of the individual field settings at design time.

To make all fields read only:

This is the default behavior. No settings are required.

To maintain the Read-Only check box selection for each field:

To maintain the setting of the Read Only check box on a field-by-field basis in the output PDF, set the property, all-fields-readonly-asis, to true. This property overrides the settings of all-field-readonly.

To remove all fields from the output PDF:

Set the property "remove-pdf-fields" to "true".








Overflow Data

When multiple pages are required to accommodate the occurrences of repeating rows of data, each page displays identically except for the defined repeating area, which displays the continuation of the repeating data.

For example, if the item rows of the purchase order extend past the area defined on the layout, succeeding pages displays all data from the purchase order form with the continuation of the item rows.






Generating PDF/A Output

PDF/A is a variation of PDF file format designed for the long-term archiving of electronic documents. Some governments and standards organizations require PDF/A to ensure preservation of documents. A PDF/A file is a PDF file viewable by PDF viewers such as Adobe Reader, but the PDF/A file must follow additional requirements specified in the ISO standard. These requirements specify both required objects and features not supported for long-term archiving. BI Publisher generates the PDF/A-1b variation of the PDF/A standard.



Requirements and Limitations

PDF/A output has specified requirements and limitations

The following lists limitations of and requirements for generating PDF/A output:

	Supported template types: The following template types support the generation of PDF/A: RTF, FO, XPT, and XSL. There are no additional template requirements to generate PDF/A. 


	Font requirements: By default, all fonts in the template are replaced with Albany fonts in the output. To use a different font in the output, specify the font mappings in the report configuration. If Albany fonts are not available in the JVM font directory and you have not specified a font mapping, the output will not become a valid PDF/A file. In this case, Helvetica font is used.


	PDF features not supported in PDF/A documents:

	All audio and video content, including Flash embedding


	Transparency (transparent colors render as opaque)


	Encryption





	Reprocessing by BI Publisher utilities is not supported: Reprocessing of the PDF/A file using the BI Publisher utilities PDFBookBinder, PDFDocMerger, or PDFSignature (digital signature) is not supported. The reprocessed PDF file may lose conformance to the PDF/A standard.


	Required report configuration properties: The report run-time properties must be set as shown in the following table.


	Property	Required Setting
	pdf-version

	Must be no higher than 1.4


	Enable PDF Security

(pdf-security)

	Must be set to false


	Encryption Level

(pdf-encryption-level)

	Must be set to 0


	pdf-font-embedding

	Must be se to true








Formatting properties specific to PDF/A output can be set in the Report Properties dialog. For more information, see PDF/A Output Properties.











Additional Resources

For more information about the PDF/A standard, refer to the Adobe website. Refer also to the iso.org website for articles 'Use of PDF 1.4 (PDF/A-1)' and 'Addendum Cor 1:2007'.




Understanding Style Templates

A style template is an RTF template that contains style information that can be applied to RTF layouts.

The style information in the style template is applied to RTF layouts at runtime to achieve a consistent look and feel across your enterprise reports. You associate a style template to a report layout in the report definition. Using a style template has the following benefits:

	Enables the same look and feel across your enterprise reports


	Enables same header and footer content, such as company logos, headings, and page numbering


	Simplifies changing the elements and styles across all reports






About Styles Defined in the Style Template

Use style template to define paragraph and heading styles, table styles, and header and footer content.

The styles of the following elements can be defined in the style template:

	Paragraph and Heading Styles

You can create a paragraph style in a style template. When this same named style is used in a report layout, the report layout inherits the following from the style template definition: font family, font size, font weight (normal, bold), font style (normal, italic), font color, and text decoration (underline, overline, or strike through).


	Table Styles

Following are some of the style elements inherited from the table style definition: font style, border style, gridline definition, shading, and text alignment.


	Header and Footer Content

The header and footer regions of the style template are applied to the report layout. This includes images, dates, page numbers, and any other text-based content. If the report layout also includes header and footer content, then it is overwritten.








Style Template Process

Following this process for creating style templates helps ensure consistency across documents.

Design Time

For the Style Template:

	Open Microsoft Word.


	Define named styles for paragraphs, tables, headings, and static header and footer content. This is the style template.


	Save this document as a .rtf file.


	To ensure that you do not lose custom styles in Microsoft Word, also save the document as a Word Template file (.dot) or save the styles to the Normal.dot file. This file can be shared with other report designers.


	Upload the RTF style template file to the catalog.




For the layout template using the style template:




	In the RTF template, use the same named styles for paragraph and table elements that you want to be inherited from the style template.
	Open the report in BI Publisher's Report Editor and select the style template to associate to the report. Then enable the style template for the specific report layout.


Runtime

When you run the report with the selected layout, BI Publisher applies the styles, header, and footer from the style template.









Creating a Placeholder

You can define a placeholder as text, a check box, or a radio button, depending on how you want the data presented.

Note:
The steps for adding a form field depend on the version of Adobe Acrobat Professional that you are using. See the Adobe documentation for the version. If you are using Adobe Acrobat 9 Pro, then from the Forms menu, select Add or Edit Fields.





Naming the Placeholder

The name of the placeholder must match the XML source field name.





Creating a Text Placeholder

Follow these steps to create a text Form Field placeholder using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, then refer to the documentation for details.

To create a text placeholder:



	From the Forms menu, select Add or Edit Fields.
	From the Add New Field list, choose Text Field. The cursor becomes a crosshair.
	Place the crosshair in the form where you want the field to reside and click. The Field Name dialog pops up.
	Enter the name. The name of the text field must match the name of the XML element from the data that is to populate this field at runtime.
	To set more properties, click Show All Properties.Use the Properties dialog box to set other attributes for the placeholder. For example, enforce maximum character size, set field data type, data type validation, visibility, and formatting.



	If the field is not placed exactly where desired, or is not the correct size, drag the field for exact placement and resize the field using the handles.






Supported Field Properties Options

BI Publisher supports the following options available from the Field Properties dialog box.

For more information about these options, see the Adobe Acrobat documentation.

	General

	Read Only

The setting of this check box in combination with a set of configuration properties controls the read-only/updatable state of the field in the output PDF. See Setting Fields as Updatable or Read Only.


	Required


	Visible/Hidden


	Orientation (in degrees)





	Appearance

	Border Settings: color, background, width, and style


	Text Settings: color, font, size


	Border Style





	Options tab

	Multi-line


	Scrolling Text





	Format tab - Number category options only


	Calculate tab - all calculation functions








Creating a Check Box

A check box is used to present options from which more than one can be selected. Each check box represents a different data element. You define the value that causes the check box to display as checked.

For example, a form contains a check box listing of automobile options such as Power Steering, Power Windows, and Sunroof. Each of these represents a different element from the XML file (for example <POWER_STEERING>). If the XML file contains a value of Y for any of these fields, you want the check box to display as checked. All or none of these options may be selected.

The following describes how to create a check box field using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, refer to the documentation for details. 




To create a check box:



	From the Forms menu, select Add or Edit Fields.
	From the Add New Field list, choose Check Box. The cursor becomes a crosshair.
	Place the crosshair in the form where you want the field to reside and click. The Field Name dialog pops up.
	Enter the name. The name of the check box field must match the name of the XML element from the data that is to determine its state (checked or unchecked).
	Click Show All Properties
	Click the Options tab.
	Select the Check Box Style type from the list.
	In the Export Value field enter the value that the XML data field should match to enable the "checked" state.For example, enter "Y" for each check box field.



	Set other Properties as desired.






Creating a Radio Button Group

A radio button group is used to display options from which only one can be selected.

For example, the XML data file contains a field called <SHIPMENT_METHOD>. The possible values for this field are "Standard" or "Overnight". You represent this field in the form with two radio buttons, one labeled "Standard" and one labeled "Overnight". Define both radio button fields as placeholders for the <SHIPMENT_METHOD> data field. For one field, define the on state when the value is Standard. For the other, define the on state when the value is Overnight.

The following describes how to create a radio button group using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, then refer to the documentation for details. 




To create a radio button group:



	From the Forms menu, select Add or Edit Fields.
	From the Add New Field list, choose Radio Button. The cursor becomes a crosshair.
	Place the crosshair in the form where you want the radio button group to reside and click. The Radio Group Name dialog pops up.
	Enter the name. The name of the radio group must match the name of the XML element from the data that is to determine its state (selected or unselected).
	In the Button Value field enter the value that the XML data field should match to enable the on state.For the example, enter Standard for the field labeled Standard.



	To enter another radio button to the group, click Add another button to group. The name of the radio group defaults into the name field.
	In the Button Value field enter the value that the XML data field should match to enable the on state for this button.For example, enter Overnight for the field labeled Overnight.



	If you want to change any of the properties, then click Show All Properties. To change the radio button style, click the Options tab.
	Select Radio Button from the Type drop down list.
	Set other Properties as desired.







Supported XSL-FO Elements

The following table lists the XSL-FO elements supported in this release. 

For each element the supported content elements and attributes are listed. If elements have shared supported attributes, these are noted as a group and are listed in the subsequent table, Property Groups. For example, several elements share the content element "inline." Rather than list the inline properties each time, each entry notes that "inline-properties" are supported. The list of inline-properties can then be found in the Property Groups table.





	Element	Supported Content Elements	Supported Attributes
	basic-link

	external-graphic

inline

leader

page-number

page-number-citation

basic-link

block

block-container

table

list-block

wrapper

marker

retrieve-marker

	inline-properties

external-destination

internal-destination


	bidi-override

	bidi-override

external-graphic

instream-foreign-object

inline

leader

page-number

page-number-citation

basic-link

	inline-properties


	block

	external-graphic

inline

page-number

page-number-citation

basic-link

block

block-container

table

list-block

wrapper

	block-properties


	block-container

	block

block-container

table

list-block

wrapper

	block-properties


	bookmark-tree

	bookmark

	N/A


	bookmark

	bookmark

bookmark-title

	external-destination

internal-destination

starting-state


	bookmark-title

	N/A

	color

font-style

font-weight


	conditional-page-master-reference

	N/A

	master-reference page-position

	first


	last


	rest


	any


	inherit




odd-or-even

	odd


	even


	any


	inherit




blank-or-not-blank

	blank


	not-blank


	any


	inherit





	external-graphic

	N/A

	graphic-properties

src


	flow

	block

block-container

table

list-block

wrapper

	flow-properties


	inline

	external-graphic

inline

leader

page-number

page-number-citation

basic-link

block

block-container

table

wrapper

	inline-properties


	instream-foreign-object

	N/A

	graphic-properties


	layout-master-set

	page-sequence-master

simple-page-master

simple-page-master

page-sequence-master

	N/A


	leader

	N/A

	inline-properties


	list-block

	list-item

	block-properties


	list-item

	list-item-label

list-item-body

	block-properties


	list-item-body

	block

block-container

table

list-block

wrapper

	block-properties


	list-item-label

	block block-container table list-block wrapper

	block-properties


	page-number

	N/A

	empty-inline-properties


	page-number-citation

	N/A

	empty-inline-properties

ref-id


	page-sequence

	static-content

flow

	inheritable-properties

id

master-reference

initial-page-number 

	auto


	<page-number>




force-page-count

	auto


	end-on-even


	end-on-odd


	end-on-even-layout


	end-on-odd-layout


	no-force


	inherit




format


	page-sequence-master

	single-page-master-reference

repeatable-page-master-reference

repeatable-page-master-alternatives

	master-name


	region-after

	N/A

	side-region-properties


	region-before

	N/A

	side-region-properties


	region-body

	N/A

	region-properties

margin-properties-CSS

column-count


	region-end

	N/A

	side-region-properties


	region-start

	N/A

	side-region-properties


	repeatable-page-master-alternatives

	conditional-page-master-reference

	maximum-repeats


	repeatable-page-master-reference

	N/A

	master-reference

maximum-repeats


	root

	bookmark-tree

layout-master-set

page-sequence

	inheritable-properties


	simple-page-master

	region-body

region-before

region-after

region-start

region-end

	margin-properties-CSS

master-name

page-height

page-width

reference-orientation

	0


	90


	180


	270


	-90


	-180


	-270


	0deg


	90deg


	180deg


	270deg


	-90deg


	-180deg


	-270deg


	inherit




writing-mode

	lr-tb





	single-page-master-reference

	N/A

	master-reference


	static-content

	block

block-container

table

wrapper

	flow-properties


	table

	table-column

table-header

table-footer

table-body

	block-properties


	table-body

	table-row

	inheritable-properties

id


	table-cell

	block

block-container

table

list-block

wrapper

	block-properties

number-columns-spanned

number-rows-spanned


	table-column

	N/A

	inheritable-properties

column-number

column-width

number-columns-repeated


	table-footer

	table-row

	inheritable-properties

id


	table-header

	table-row

	inheritable-properties

id


	table-row

	table-cell

	inheritable-properties

id


	wrapper

	inline

page-number

page-number-citation

basic-link

block

block-container

table

wrapper

	inheritable-properties

id










Property Groups Table

These properties support XSL-FO elements.

The following table lists the supported properties belonging to the attribute groups defined in Supported XSL-FO Elements.





	Property Group	Properties
	area-properties

	clip

overflow (visible, hidden)

reference-orientation

	0


	90


	180


	270


	-90


	-180


	-270


	0deg


	90deg


	180deg


	270deg


	-90deg


	-180deg


	-270deg


	inherit




writing-mode (lr-tb, rl-tb, lr, rl)

baseline-shift (baseline, sub, super)

vertical-align


	block-properties

	inheritable-properties

id


	border-padding-background-properties

	background-color

background-image

background-position-vertical

background-position-horizontal

border

border-after-color

border-after-style (none, dotted, dashed, solid, double)

border-after-width

border-before-color

border-before-style (none, solid)

border-before-width

border-bottom

border-bottom-color

border-bottom-style (none, dotted, dashed, solid, double)

border-bottom-width

border-color

border-end-color

border-end-style (none, dotted, dashed, solid, double)

border-end-width

border-left

border-left-color

border-left-style (none, dotted, dashed, solid, double)

border-left-width

border-right

border-right-color

border-right-style (none, dotted, dashed, solid, double)

border-right-width

border-start-color

border-start-style (none, dotted, dashed, solid, double)

border-start-width

border-top

border-top-color

border-top-style (none, dotted, dashed, solid, double)

border-top-width

border-width

padding

padding-after

padding-before

padding-bottom

padding-end

padding-left

padding-right

padding-start

padding-top


	box-size-properties

	height

width


	character-properties

	font-properties

text-decoration


	empty-inline-properties

	character-properties

border-padding-background-properties

id

color


	flow-properties

	inheritable-properties

id

flow-name


	font-properties

	font-family

font-size

font-style (normal, italic, oblique)

font-weight (normal, bold)

table-omit-header-at-break (TRUE, FALSE, inherit)

table-omit-footer-at-break (TRUE, FALSE, inherit)


	graphic-properties

	border-padding-background-properties

margin-properties-inline

box-size-properties

font-properties

keeps-and-breaks-properties-atomic

id


	inheritable-properties

	border-padding-background-properties

box-size-properties

margin-properties-inline

area-properties

character-properties

line-related-properties

leader-properties

keeps-and-breaks-properties-block

color absolute-position

	auto


	absolute


	fixed


	inherit





	inline-properties

	inheritable-properties id


	keeps-and-breaks-properties-atomic

	break-after (auto, column, page)

break-before (auto,column)

keep-with-next

keep-with-next.within-page


	keeps-and-breaks-properties-block

	keeps-and-breaks-properties-inline


	keeps-and-breaks-properties-inline

	keeps-and-breaks-properties-atomic

keep-together

keep-together.within-line

keep-together.within-column

keep-together.within-page


	leader-properties

	leader-pattern (rule, dots)

leader-length

leader-length.optimum (dotted, dashed, solid, double)

rule-thickness


	line-related-properties

	text-align (start, center, end, justify, left, right, inherit)

text-align-last (start, center, end, justify, left, right, inherit)

text-indent

linefeed-treatment (ignore, preserve, treat-as-space, treat-as-zero-width-space, inherit )

white-space-treatment (ignore, preserve, ignore-if-before-linefeed, ignore-if-after-linefeed, ignore-if-surrounding-linefeed, inherit)

white-space-collapse (FALSE, TRUE, inherit)

wrap-option (no-wrap, wrap, inherit)

direction (ltr)


	margin-properties-block

	margin-properties-CSS

space-after

space-after.optimum

space-before

space-before.optimum

start-indent

end-indent


	margin-properties-CSS

	margin

margin-bottom

margin-left

margin-right

margin-top


	margin-properties-inline

	margin-properties-block

space-start

space-start.optimum

space-end

space-end.optimum

position

	static


	relative


	absolute


	fixed


	inherit




top

left


	region-properties

	border-padding-background-properties

area-properties

region-name


	side-region-properties

	region-properties

extent













About the Layout Types

BI Publisher offers several options for designing layouts for reports.

The following formats are supported. Note that the layout type determines the types of output documents supported.

	BI Publisher layout (XPT)

BI Publisher's Layout Editor is a Web-based design tool for creating layouts. Layouts created with the Layout Editor support interactive viewing as well as the full range of output types supported by RTF layouts.


	Rich Text Format (RTF)

BI Publisher provides a plug-in utility for Microsoft Word that automates layout design and enables you to connect to BI Publisher to access data and upload templates directly from a Microsoft Word session. The RTF format also supports advanced formatting commands providing the most flexible and powerful of the layout options. RTF templates support a variety of output types including: Excel (mhtml), Excel (html), Excel (*.xlsx), HTML, MHTML, PDF, PowerPoint, RTF, and Zipped PDF.


	Portable Document Format (PDF)

PDF templates are used primarily when you must use a predefined form as a layout for a report (for example, a form provided by a government agency). Because many PDF forms already contain form fields, using the PDF form as a template simply requires mapping data elements to the fields that exist on the form. You can also design PDF templates using Adobe Acrobat Professional. PDF templates support only PDF output.


	Microsoft Excel (XLS)

Excel templates enable you to map data and define calculations and formatting logic in an Excel workbook. Excel templates support Microsoft Excel (.xls) output only.


	XSL Stylesheet

Layouts can also be defined directly in XSL formatting language. Specify whether the layout is for Data (CSV), Data (XML), FO Formatted XML, HTML, Text, or XML transformation.


	eText

These are specialized RTF templates used for creating text output for Electronic Data Interchange (EDI) or Electronic Funds Transfer (EFT) transactions.


	Flash

BI Publisher's support for Flash layouts enables you to develop Adobe Flex templates that can be applied to BI Publisher reports to generate interactive Flash output documents.




For more information about layout types, see Creating and Editing Reports.




Generating Zipped PDF Output

When generating PDF output, BI Publisher does not limit the size of the output file. However, when the size of the file approaches 2 GB, Adobe Acrobat Reader may no longer be able to open or handle the file. BI Publisher provides a feature to split a large PDF output file into smaller, more manageable files, while still maintaining the integrity of the report as one logical unit.

When PDF output splitting is enabled for a report, the report is split into multiple files generated in one zip file. The output type is PDFZ. For easy access to the component files, BI Publisher also generates an index file that specifies from and to elements contained in each component PDF file.

To enable this feature, the report designer must set up the report using the methods described in this section.



Limitations and Prerequisites

Perform these steps before using this feature, and be aware of its functional limitations.

	This feature is supported only for PDF output that is generated from an RTF template or a PDF template.


	Data set input to the report must be flat XML data (that is, ROWSET/ROW). The data set cannot be hierarchical or concatenated.


	The data set must be sorted by the element designated as the "repeat" element (as described below).











Design Time Considerations

To enable report splitting, the report designer must determine these steps.

	Select a repeat element to serve as the counter.


	Determine how many instances of the repeat element occur per PDF file.


	Select which data elements to include in the generated index file.








Selecting the Output Type

After uploading the template to the report definition, enable Zipped PDFs as an output type.

The output type menu is shown in the following illustration.

[image: Description of GUID-BECA5F14-7F93-4EC5-B966-7ECC035CAD2D-default.gif follows]



When scheduling the report, select PDFZ as the output type, as shown in the following illustration.

[image: Description of GUID-1BB6C5EA-5546-401F-84B6-7363373E8CE8-default.gif follows]











RTF Template Properties

You configure RTF templates with a number of settings.

The properties described in the following table can be set to govern RTF templates.





	Property Name	Description
	Extract attribute sets

	Default: Auto

Description: The RTF processor automatically extracts attribute sets within the generated XSL-FO. The extracted sets are placed in an extra FO block, which can be referenced. This improves processing performance and reduces file size. Valid values are:

	Enable - extract attribute sets for all templates and subtemplates


	Auto - extract attribute sets for templates, but not subtemplates


	Disable - do not extract attribute sets




Internal Name: rtf-extract-attribute-sets


	Enable XPath rewriting

	Default: true

Description: When converting an RTF template to XSL-FO, the RTF processor automatically rewrites the XML tag names to represent the full XPath notations. Set this property to "false" to disable this feature.

Internal Name: rtf-rewrite-path


	Characters used for checkbox

	Default: Albany WT J;9746;9747/A

Description: The BI Publisher default PDF output font does not include a glyph to represent a checkbox. If the template contains a checkbox, use this property to define a Unicode font for the representation of checkboxes in the PDF output. You must define the Unicode font number for the "checked" state and the Unicode font number for the "unchecked" state using the following syntax: fontname;<unicode font number for true value's glyph >;<unicode font number for false value's glyph> 

Example: Albany WT J;9746;9747/A Note that the font that you specify must be made available to BI Publisher at runtime.

Internal Name: rtf-checkbox-glyph











Accessing Reports via a URL

This section describes how to call a BI Publisher report via a URL from another application.

For example, from a portal or from an Application Express application. It contains the following topics: 



Security Considerations

In the BI Publisher security model, reports are placed in folders and those folders are then secured to a role and a role assigned to a user.

For a user to successfully access the report, you must ensure that the user is credentialed within BI Publisher to see it. There are two options for this:

	Use the Guest folder

Reports in the Guest folder are available to all users to see and run. Use this option if the report does not contain sensitive data. Enable the Guest folder on the Security Configuration tab of the Security Center page. For more information, see Enabling a Guest User in the Administrator's Guide for Oracle Business Intelligence Publisher.


	Use SSO

If both the calling application and BI Publisher are configured as partner applications in an SSO server, you can call any report via a URL, and, as long as the user has rights to see or run the report, then BI Publisher will render it without the need for the user to log in. For more information on setting up security options, see Configuring BI Publisher with Single Sign-on (SSO) in Administrator's Guide for Oracle Business Intelligence Publisher.








Building the URL

You can call a BI Publisher report via a URL, for which you can build the URL.

The basic URL for a report is:

http://<server:port>/xmlpserver/<ReportDirectory>/<ReportName>.xdo
where

	server:port - is the name of the server and port number where BI Publisher is running 
	xmlpserver - is a required static string (the name of the application)
	ReportDirectory - is the folder path to the report. When the report is under Shared Folders, do not include "Shared Folders" in the path. If the report is under My Folders, include the ~username as the first node in the path. See the examples following.
	ReportName.xdo - is the name of the report with the .xdo extension. If the name contains spaces, replace the space with a "+" character.


Examples:

The following URL launches the North America Sales report. The report resides in the catalog under Shared Folders/Samples/Sales. Note that Shared Folders is not included in the path. 

http://example.com:7001/xmlpserver/Samples/Sales/North+America+Sales.xdoThe following URL launches the North America Sales report that resides in the catalog under My Folders/Samples/Sales. Note that the user name in this case is weblogic, therefore the first node in the path is ~weblogic.

http://example.com:7001/xmlpserver/~weblogic/Samples/Sales/North+America+Sales.xdo






Specifying Parameters in the URL

The preceding examples render the complete report inside the BI Publisher report viewer with all the report controls.

The default layout, default output format, and default parameters are used to render the report. You can add parameters to the URL to specify how the report renders. 

When constructing the URL, note the following standard URL syntax:? - denotes the first parameter& - denotes each additional parameter

The following table describes more parameters you can add to the URL.





	Parameter	Definition	Example Usage
	_xpt

	Specifies whether to render the report in the BI Publisher report viewer or export the document to a new window appropriate for the output type. For example, if the output type specified is html, the report document (only) will render in a browser window; if the output type is PDF you will be prompted to save or open the PDF document. When this parameter is not specified, the report renders in the BI Publisher report viewer.

Valid values are:

	0 - renders the report in the BI Publisher report viewer


	1- exports the document to appropriate application window 




	_xpt=0


	_xdo

	 (Optional) Provides the path to the report.

	_xdo=%2FSamples%2FSalary+Report.xdo


	_xt

	Specifies the layout to use. Enter the name of the layout as defined in the report definition. If an invalid name is entered, the default layout is used.

	_xt=Manager+Summary


	_xf

	Specifies the output format. If no value is specified, the default output format is used. If an invalid value is specified, or, if a value is specified that is not enabled for the layout, the report does not render. Valid values are:

	analyze - use for Interactive output


	rtf


	docx


	pdf


	html


	pptx - use for PowerPoint 2007


	ppt - use for PowerPoint


	xml - use for Data


	excel - use for Excel


	excel2000 - use for Excel 2000


	xslx - use for Excel 2007


	csv




	_xf=pdf


	Report parameters as named in the data model

	Specify name-value pairs for the parameters specific to the report. You must use the parameter name as defined in the data model.

	dept=10


	_xmode

	Specifies the report viewer mode. If not specified, defaults to view in the full report viewer. Valid values are:

	0 - view in the full report viewer. 


	1 - hide BI Publisher banner, hide parameters, can change layout, other actions: export only. 


	2 - hide BI Publisher banner. (No Header)


	3 - hide BI Publisher banner, hide parameters (No Parameters)


	4 - report document only: hide BI Publisher banner, hide parameters, hide other actions, hide layouts. (Document Only)




	_xmode=1








Example:

http://example.com:7001/xmlpserver/Samples/Salary+Report.xdo?_xpt=0&_xdo=%2FSamples%2FSalary%20Report.xdo&_xmode=4&dept=10&_xt=Simple&_xf=html

This URL runs the report "Salary Report" located under Shared Folders/Samples. Note the following:

_xpt=0 renders the document in the report viewer

_xdo=%2FSamples%2FSalary%20Report.xdo defines the report path

_xmode=4 renders the document only

dept=10 sets the report-specific parameter "dept" to "10"

_xt=Simple uses the layout called "Simple"

_xf=html sets the output format to html









7 Creating PDF Templates

This chapter describes creating PDF templates for BI Publisher.

This chapter includes the following sections: 

	Overview


	Requirements


	Designing the Template


	Adding Markup to the Template


	Creating a Placeholder


	Defining Groups of Repeating Fields


	Adding Page Numbers and Breaks


	Performing Calculations


	Completed PDF Layout Example


	Runtime Behavior


	Creating a Layout from a Predefined PDF Form


	Adding or Designating a Field for a Digital Signature







Flash Template Properties

The properties described in this table can be set to govern Flash templates.


	Property Name	Description
	Page width of wrapper document

	Default: 792

Description: Specify in points the width of the output PDF document. The default is 792, or 11 inches.

Internal Name: flash-page-width


	Page height of wrapper document

	Default: 612

Description: Specify in points the height of the output PDF document. The default is 612, or 8.5 inches.

Internal Name: flash-page-height


	Start x position of Flash area in PDF

	Default: 18

Description: Using the left edge of the document as the 0 axis point, specify in points the beginning horizontal position of the Flash object in the PDF document. The default is 18, or .25 inch.

Internal Name: flash-startx


	Start y position of Flash area in PDF

	Default: 18

Description: Using the upper left corner of the document as the 0 axis point, specify in points the beginning vertical position of the Flash object in the PDF document. The default is 18, or .25 inch.

Internal Name: flash-starty


	Width of Flash area

	Default: Same as flash width in points in swf

Description: Enter in points the width of the area in the document for the Flash object to occupy. The default is the width of the SWF object.

Internal Name: flash-width


	Height of Flash area

	Default: Same as flash height in points in swf

Description: Enter in points the height of the area in the document for the Flash object to occupy. The default is the height of the SWF object.

Internal Name: flash-height
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Understanding RTF Subtemplates

An RTF subtemplate is an RTF file that consists of one or more <?template:?> definitions, each containing a block of formatting or commands.

This RTF file, when uploaded to BI Publisher as a Sub Template object in the Catalog, can be called from other RTF templates.

The following graphic illustrates the composition of an RTF Sub Template.

[image: Description of GUID-5F1D3F4B-C9EC-435B-BE68-D56FAA9A3BDD-default.gif follows]






Creating an XSL Subtemplate File

Enter the instructions in an editor that enables you to save the file as type ".xsl". An XSL subtemplate consists of one or more XSL template definitions. These templates contain rules to apply when a specified node is matched.

The syntax of the subtemplate definition is as follows:

<xsl:template
  name="name" 
  match="pattern" 
  mode="mode" 
  priority="number">
<!--Content:(<xsl:param>*,template) -->
</xsl:template>


The following table describes the components of the template declaration.





	Component	Description
	xsl:template

	The xsl:template element is used to define a template that can be applied to a node to produce a desired output display.


	name="name"

	Optional. Specifies a name for the template.

If this attribute is omitted, a match attribute is required.


	match="pattern"

	Optional. The match pattern for the template.

If this attribute is omitted, a name attribute is required.


	priority="number"

	Optional. A number which indicates the numeric priority of the template. It is possible that more than one template can be applied to a node. The highest priority value template is always chosen. The value ranges from -9.0 to 9.0.








Example:

<xsl:template match="P|p">
  <fo:block white-space-collapse="false" padding-bottom="3pt" linefeed-treatment="preserve">
     <xsl:apply-templates select="text()|*|@*"/>
  </fo:block>
</xsl:template>

<xsl:template match="STRONG|B|b">
   <fo:inline font-weight="bold">
     <xsl:apply-templates/>
   </fo:inline>
</xsl:template>








About Gauge Charts

A gauge chart is a useful way to illustrate progress or goals. The illustration shows a report with gauges.

For example, the following figure shows a report with three gauges to indicate the status of regional sales goals:


[image: Description of GUID-FEDBA3A5-D644-43A5-9483-0431E33D362C-default.gif follows]







Inserting a Gauge Chart

Follow these steps to insert a gauge chart.

To insert a gauge chart in the layout:


	From the Insert menu, select and drag the Gauge component to the layout. This inserts an empty gauge chart.
	Select and drag the data fields from the Data Source pane to the Label, Value, and Series areas of the chart. The chart immediately updates with the preview data.Note the following:

	A separate gauge is created for each occurrence of the Label (that is, each REGION). One set of properties applies to each occurrence.


	By default, the Value field is a sum. You can change the expression applied to the value field. See Changing the Formula Applied to a Chart Measure Field.


	You can apply a sort to the other gauge chart fields.












Applying and Managing Filters

Follow this section to know how to apply and manage filters.

See About Filters for information on how to apply and manage filters.









Process Overview for Creating and Implementing XSL Sub Templates

You must follow this process when working with XSL sub templates.

Creating and implementing an XSL sub template consists of the following steps:




	Create the XSL file that contains the common components or processing instructions to include in other templates.An XSL sub template consists of one or more XSL template definitions. These templates contain rules to apply when a specified node is matched.



	Create the calling or "main" layout that includes a command to "import" the sub template to the main template and a command to apply the XSL sub template to the appropriate data element.
	Upload the main template to the report definition and create the Sub Template object in the catalog.





Overview of BI Publisher Layouts

Release 11g of Oracle BI Publisher introduces a new type of layout template.

The BI Publisher Layout template enables end users to:

	View Dynamic HTML output and perform lightweight interaction with their report data from within a browser


	Generate high fidelity, pixel perfect reports to PDF, RTF, Excel, PowerPoint, and static HTML




BI Publisher Layout Templates are created using the BI Publisher Layout Editor - a design tool that provides a WYSIWIG, drag and drop interface for creating pixel perfect reports in PDF, RTF, Excel, Word, PowerPoint, and HTML. It also provides dynamic HTML output that supports lightweight interaction through a browser. This interactive output is featured in the following illustration.

[image: Description of GUID-B4407BBE-A0AE-4203-A93D-DF4F018C0EA0-default.jpg follows]



Notice the following features:

	Pop-up chart details - Hover cursor over chart items to display details of data.


	Group filtering - Grouped regions can be filtered by the grouping element.


	Scrollable tables - Table data can be scrolled while maintaining display of the headers and totals.


	Table column sorting - Table data can be sorted by different columns from within the viewer.


	Table column filtering - Table data can be filtered by values in different columns from within the viewer.


	Automatic table totaling - Table data totals are automatically added to the layout.


	Propagated filtering - Filter other components by clicking on chart areas or by clicking on pivot table header, column, or elements.


	Collapse and expand areas of the document.






When to Use a BI Publisher Layout

BI Publisher layouts are best suited for reports of simple to medium complexity that do not require custom coding.

Because the dynamic HTML view is only available for BI Publisher layouts, BI Publisher layouts must be used when there is a requirement to enable a report consumer to interact with the report (change sorting, apply filters, and so on).





Prerequisites, Recommendations, and Limitations

These tips will help you use BI Publisher more effectively.

	To use the layout editor, your account must be granted a role that includes the appropriate permissions for accessing report layout tools.


	You must attach sample data to the data model before you create a new layout. For information on adding sample data to the data model, see Testing Data Models and Generating Sample Data in Data Modeling Guide for Oracle Business Intelligence Publisher.


	For optimum viewing, set your display resolution to 1024 x 768 or higher.


	BI Publisher can handle a large amount of data for interactive sorting and filtering and still provide fast response. Still it is a best practice to summarize data in the Data Model to the level of interest for the consumer for optimal performance. BI Publisher layouts can generate static output such as PDF or RTF documents up to 50% faster than comparable RTF layouts depending on the data. 


	The layout editor does not support namespaces or attributes in the XML data.












Using XPath Commands

XPath is an industry standard developed by the World Wide Web Consortium (W3C).

It is the method used to navigate through an XML document. XPath is a set of syntax rules for addressing the individual pieces of an XML document. You might not know it, but you have already used XPath; RTF templates use XPath to navigate through the XML data at runtime.

This section contains a brief introduction to XPath principles. For more information, see the W3C Web site: http://www.w3.org/TR/xpath

XPath follows the Document Object Model (DOM), which interprets an XML document as a tree of nodes. A node can be one of seven types:

	root


	element


	attribute


	text


	namespace


	processing instruction


	comment




Many of these elements are shown in the following sample XML, which contains a catalog of CDs:

<?xml version="1.0" encoding="UTF-8"?>
<! -  My CD Listing  - >
<CATALOG>
 <CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  <ARTIST>Bob Dylan</ARTIST>
  <COUNTRY>USA</COUNTRY>
  <PRICE>10.90</PRICE>
  <YEAR>1985</YEAR>
 </CD>
 <CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  <ARTIST>Bonnie Tylor</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <PRICE>9.90</PRICE>
  <YEAR>1988</YEAR>
  </CD>
</CATALOG>


The root node in this example is CATALOG. CD is an element, and it has an attribute cattype. The sample contains the comment My CD Listing. Text is contained within the XML document elements.



Locating Data

Locate information in an XML document using location-path expressions.

A node is the most common search element that you encounter. Nodes in the example CATALOG XML include CD, TITLE, and ARTIST. Use a path expression to locate nodes within an XML document. For example, the following path returns all CD elements:

//CATALOG/CD


where

the double slash (//) indicates that all elements in the XML document that match the search criteria are to be returned, regardless of the level within the document.

the slash (/) separates the child nodes. All elements matching the pattern are returned.

To retrieve the individual TITLE elements, use the following command:

/CATALOG/CD/TITLE


This example returns the following XML:

<CATALOG>
 <CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  </CD>
 <CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  </CD>
</CATALOG>


Further limit the search by using square brackets. The brackets locate elements with certain child nodes or specified values. For example, the following expression locates all CDs recorded by Bob Dylan:

/CATALOG/CD[ARTIST="Bob Dylan"]


Or, if each CD element did not have an PRICE element, you could use the following expression to return only those CD elements that include a PRICE element:

/CATALOG/CD[PRICE]


Use the bracket notation to leverage the attribute value in the search. Use the @ symbol to indicate an attribute. For example, the following expression locates all Rock CDs (all CDs with the cattype attribute value Rock):

//CD[@cattype="Rock"]


This returns the following data from the sample XML document:

<CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  <ARTIST>Bonnie Tylor</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <PRICE>9.90</PRICE>
  <YEAR>1988</YEAR>
</CD>


You can also use brackets to specify the item number to retrieve. For example, the first CD element is read from the XML document using the following XPath expression:

/CATALOG/CD[1]


The sample returns the first CD element:

<CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  <ARTIST>Bob Dylan</ARTIST>
  <COUNTRY>USA</COUNTRY>
  <PRICE>10.90</PRICE>
  <YEAR>1985</YEAR>
 </CD>


XPath also supports wildcards to retrieve every element contained within the specified node. For example, to retrieve all the CDs from the sample XML, use the following expression:

/CATALOG/*


You can combine statements with Boolean operators for more complex searches. The following expression retrieves all Folk and Rock CDs, thus all the elements from the sample:

//CD[@cattype="Folk"]|//CD[@cattype="Rock"]


The pipe (|) is equal to the logical OR operator. In addition, XPath recognizes the logical OR and AND, as well as the equality operators: <=, <, >, >=, ==, and !=. For example, you can find all CDs released in 1985 or later using the following expression:

/CATALOG/CD[YEAR >=1985]






Starting Reference

The first character in an XPath expression determines the point at which it should start in the XML tree.

Statements beginning with a forward slash (/) are considered absolute. No slash indicates a relative reference. An example of a relative reference is:

CD/*


This statement begins the search at the current reference point. That means if the example occurred within a group of statements the reference point left by the previous statement would be utilized.

As noted earlier, double forward slashes (//) retrieve every matching element regardless of location in the document, therefore the use of double forward slashes (//) should be used only when necessary to improve performance.





Specifying Context and Parents

To select current and parent elements, XPath recognizes the dot notation commonly used to navigate directories.

Use a single period (.) to select the current node and use double periods (..) to return the parent of the current node. For example, to retrieve all child nodes of the parent of the current node, use:

../*


Therefore, to access all CDs from the sample XML, use the following expression:

/CATALOG/CD/..


You could also access all the CD tittles released in 1988 using the following:

/CATALOG/CD/TITLE[../YEAR=1988]


The two periods (..) are used to navigate up the tree of elements to find the YEAR element at the same level as the TITLE, where it is then tested for a match against "1988". You could also use // in this case, but if the element YEAR is used elsewhere in the XML document, then you might get erroneous results.

XPath is an extremely powerful standard when combined with RTF templates allowing you to use conditional formatting and filtering in the template.






Part I Creating Reports and Layouts

This part describes how to create reports and layouts.

It includes the following chapters:

	Introduction to Designing Reports


	Creating and Editing Reports


	Creating BI Publisher Layout Templates


	Creating RTF Templates


	Creating RTF Templates Using the Template Builder for Word


	Creating Excel Templates


	Creating PDF Templates


	Creating eText Templates


	Creating Flash Templates


	Setting Report Processing and Output Document Properties







8 Creating eText Templates

BI Publisher uses eText templates to generate the flat files for EDI and EFT transactions. This chapter describes creating the eText templates in Microsoft Word.

The chapter includes the following sections:

	Overview


	Structure of eText Templates


	Constructing the Data Tables


	Command Rows


	Structure of the Data Rows


	Setting Up Command Tables


	Creating a Filler Block


	Expressions, Control Structures, and Functions


	Identifiers, Operators, and Literals







Overview

An eText template is an RTF-based template that is used to generate text output for Electronic Funds Transfer (EFT) and Electronic Data Interchange (EDI).

At runtime, BI Publisher applies this template to an input XML data file to create an output text file that can be transmitted to a bank or other customer. Because the output is intended for electronic communication, the eText templates must follow very specific format instructions for exact placement of data.

Note:
An EFT is an electronic transmission of financial data and payments to banks in a specific fixed-position format flat file (text).

EDI is similar to EFT except it is not only limited to the transmission of payment information to banks. It is often used as a method of exchanging business documents, such as purchase orders and invoices, between companies. EDI data is delimiter-based, and also transmitted as a flat file (text).

Files in these formats are transmitted as flat files, rather than printed on paper. The length of a record is often several hundred characters and therefore difficult to layout on standard size paper.

To accommodate the record length, the EFT and EDI templates are designed using tables. Each record is represented by a table. Each row in a table corresponds to a field in a record. The columns of the table specify the position, length, and value of the field.

These formats can also require special handling of the data from the input XML file. This special handling can be on a global level (for example, character replacement and sequencing) or on a record level (for example, sorting). Commands to perform these functions are declared in command rows. Global level commands are declared in setup tables.

At runtime, BI Publisher constructs the output file according to the setup commands and layout specifications in the tables.



Prerequisites

This section is intended for users who are familiar with EDI and EFT transactions.

Preparers of eText templates require both functional and technical knowledge; that is, functional expertise to understand bank and country specific payment format requirements and sufficient technical expertise to understand XML data structure and eText specific coding syntax commands, functions, and operations.









Overview

The Formatting tab of the Report Properties dialog enables you to set runtime formatting properties at the report level.

These properties are also set at the system level. If conflicting values are set for a property at each level, the report level takes precedence.

To set a property at the report level:




	Open the report in the Report Editor. and then
	Click Properties to display the Report Properties dialog.
	Click the Formatting tab to display the formatting properties.


For each property, Report Value is updatable and the Server Value is shown for reference.

The Formatting tab of the Report Properties dialog is shown in the following illustration.

[image: Description of GUID-72FAAF4A-9F73-49CB-BA67-2CB54D2B5C6F-default.gif follows]









Page Layout Tab

The Page Layout tab contains commands to set up the layout.

The figure below shows the Page Layout tab.

[image: Description of GUID-E6266CB6-851F-444C-BF85-349F312D24EE-default.gif follows]





Paper Options

Paper options include Orientation and Paper Size.







	Option	Description
	Orientation

	Choose Portrait or Landscape.


	Paper Size

	Select from the following paper size options: Letter, Legal, A4, A3, Executive, B5, Com-10, Monarch DL, or C5. The paper size determines the dimensions of the layout area.












Header/Footer Options

This table describes the header and footer options.


	Option	Description
	Page Header

	Click to insert a page header in the layout. By default, the page header appears on every page of a printed report, but can be configured to skip the first page. To remove the page header, click Page Header again.


	Page Footer

	Click to insert a page footer in the layout. By default, the page footer appears on every page of a printed report, but can be configured to skip the last page. To remove the page footer, click Page Footer again.


	Report Header

	Click to insert a report header to the layout. The report header appears only once at the beginning of the report. To remove the report header, click Report Header again.


	Report Footer

	Click to insert a report footer to the layout. The report footer appears only once at the end of the report. To remove the report footer, click Report Footer again.










Setting Properties for Headers and Footers

The Properties pane enables you to set the following properties for headers and footers.

To access the Properties pane, select the header or footer in the design region, then click Properties from the accordion pane on the left of the page.

For all report and page headers and footers:




	Height - Set the height of the header region in pixels, points, centimeters, or inches




For headers:

	Show in the first page - Select True to show the header in the first page. Select False to suppress the header from the first page.

This figure shows the Properties for a report header.

[image: Description of GUID-6E7D580B-549A-4BBC-BDFC-6D624C48AC0B-default.gif follows]






For footers:

	Show in the last page - Select True to show the footer in the last page. Select False to suppress the footer from the last page.













View Options

The following table describes view options.





	Option	Description
	Grid

	Click to insert gridlines in the layout design area. The grid unit size depends on the Display Unit selected. To remove the gridlines, click Grid again.


	Ruler

	Click to insert a display ruler across the top of the layout design area. The ruler units depend on the Display Unit. To remove the ruler, click Ruler again.












Display Unit

Select the unit of measure to display. This unit is used for the ruler and grid view options, as well as for any other function that displays a measurement, such as setting border widths and sizing grid cells. Options are: inch, px (pixel), cm (centimeter), and point (pt).





Interactivity: Event Configuration

The Configure Events feature enables you to configure how components of the layout respond to events triggered by a user when viewing the report in interactive mode.

The two types of events are:

	Filter - If you click an element in a list, chart, or pivot table, that element is used to dynamically filter other components defined as targets in the report. The component being clicked does not change.


	Show Selection Only - If you click an element of a list, chart, or pivot table, the chart or pivot table (being clicked) shows the results for the selected element only. This action does not affect other components of the report.






Example of Filter Event Configuration

The illustration here shows an example of filter event configuration. The layout contains two charts and a table. The first chart shows salary totals by department in a pie chart. The second chart shows salary totals by manager in a bar chart. The table displays a list of employees and their salaries.

In this report, if a user clicks on a value in the Salary by Department chart, you want the Salary by Manager chart and the Employees table to automatically filter to show only the managers and employees in the selected department.

[image: Description of GUID-283EADF3-0934-4139-9F74-DEA14192CD08-default.gif follows]







Configuring Automatic Filtering

Follow these steps to know how to configure automatic filtering.

To configure automatic filtering:



	On the Page Layout tab, click Event Configuration to display the Configure Events dialog.The following figure shows the Configure Events dialog.

[image: Description of GUID-A7E55306-B340-431D-B01B-C2C7A1EDF89A-default.gif follows]





	In the Components column, click the layout component (lists, charts, and pivot tables are available to configure).
	Select Filter to enable automatic filtering in other report components.
	Select the report components in the Targets column to enable the automatic filtering based on interactive events in the selected component. To disable the automatic filtering for a target component, clear the box.The preceding figure shows that the Filter event is enabled for Chart 1 in the layout. Chart 2 and Table 3 are selected as targets to enable automatic filtering when a selection event occurs in Chart 1.

The Show Selection Only option is not enabled for Chart 1. That means that Chart 1 continues to display all values when one of its elements is selected.









Example: Show Selection Only

The Show Selection Only event displays only the value of the selected element within the chart or pivot table (being acted on).

In the example shown in the following figure, Chart 2 is configured with Show Selection Only enabled and Filter enabled with Table 3 as the Target.

[image: Description of GUID-ED34C22B-2632-40FD-9E74-E1679FEB0817-default.gif follows]



This configuration results in the output shown in the following figure. When the user clicks on Chart 2, only the selected value is shown in Chart 2. Because the Filter event is enabled for Table 3, the selection is applied as a filter to Table 3.

[image: Description of GUID-4BF65FE8-D9C7-487D-AF8D-B476DA7F14E1-default.gif follows]












Setting Page Margins

You can set page margins for reports.

To set the page margins for the report:




	Click anywhere in the design area outside of an inserted component.
	Click the Properties pane in the lower left of the Layout Editor. The following illustration shows the Properties for the page.[image: Description of GUID-39B05472-B704-4096-9326-7C8626DF1BA8-default.gif follows]





	Click the value shown for Margin to launch the Margin dialog.The following illustration shows the Margin dialog.

[image: Description of GUID-A54A28BC-2B6A-4F4E-AD16-708CA8045846-default.gif follows]





	Select the desired size for the margin. Enter the value for the Top, Left, Right, and Bottom margins.To automatically set the same value for all sides, select the box: Use same value for all sides. This action disables all but the Top margin entry. Enter the value in the Top to apply to all sides.









Setting Maximum Connections for an Interactive Report

You can limit the connections from the browser to the server for the interactive viewer.

More connections are faster but increase server load. The default is six connections. Reduce the number to reduce the load on the server for large reports.

To set the maximum connections for this layout:




	Click anywhere in the design area outside of an inserted component.
	Click the Properties pane in the lower left of the Layout Editor. The following illustration shows the Properties for the page.[image: Description of GUID-39B05472-B704-4096-9326-7C8626DF1BA8-default.gif follows]





	Click the value shown for Max. Connections and select the desired value from the list, as shown in the following illustration.[image: Description of GUID-2E0C59A8-BB40-4EEF-8243-D1AEAA39827E-default.gif follows]












Previewing a Template

The Preview menu group enables you to preview the RTF template with sample XML data.

From the Preview group, select the output format. If you have not yet saved the template as an RTF file, then you are prompted to do so.

Note:
If you have not already done so, then you must load sample data to the Template Builder to preview the report. See Accessing Data for Building Templates.




	PDF

You must have Adobe Acrobat Reader version 5.0 or higher installed to preview documents in PDF format.


	HTML

Launches the default browser to display the report.


	EXCEL

To use this option, you must have Microsoft Excel 2003 or later. If you have Excel 2003 this option generates the document in MHTML and opens the document in Excel. If you have Excel 2007, this option generates the document in .xlsx, the default Office Excel 2007 XML-based file format.


	EXCEL 2000

Generates HTML and launches Microsoft Excel to render it. Embedded images such as charts and logos are not supported in this output type. If you do not have Microsoft Excel 2003 or later, use this option.


	RTF

Generates the report in Rich Text Format.


	PowerPoint

Requires Microsoft PowerPoint 2003 or 2007.










Introduction to Excel Templates

An Excel template is a report layout designed in Microsoft Excel for formatting your enterprise reporting data in Excel spreadsheets.

Excel templates provide a set of special features for mapping data to worksheets and for performing additional processing to control how the data is output to Excel workbooks.

This introduction includes the following topics:

	Features of Excel Templates


	Limitations of Excel Templates


	Prerequisites


	Supported Output


	Desktop Tools for Excel Templates


	Sample Excel Templates






Features of Excel Templates

With Excel templates you can format the data in different ways.

	Define the format for the data in Excel output.


	Split hierarchical data across multiple sheets and dynamically name the sheets.


	Create sheets of data that have master-detail relationships.


	Use native XSL functions in the data to manipulate it prior to rendering.


	Use native Excel functionality.








Limitations of Excel Templates

The following are limitations of Excel templates.

	For reports that split the data into multiple sheets, images are not supported. If the template sheet includes images, when the data is split into multiple sheets, the images are displayed only on the first sheet.


	BI Publisher provides an add-in to Microsoft Excel to facilitate the insertion of fields and repeating groups. More complex designs require manual coding. Some features require the use of XSL and XSL Transformation (XSLT) specifications.











Prerequisites

To design Excel templates, you must meet certain prerequisites.

	You must have Microsoft Excel 2003 or later installed. The template file must be saved as Excel 97-2003 Workbook binary format (*.xls).

Note:
If you are using a version later than Excel 2003 to create your template and then save as Excel 97-2003, ensure that you do not use any features of the later version that are not supported in Excel 97-2003. For example, Excel 2003 allows only three conditional formatting rules per cell, but Excel 2007 allows more. If you apply more than three conditional formatting rules to a cell, only three are applied. Excel 2007 also provides color support not provided in Excel 2003. 




	To use some of the advanced features, you must have knowledge of XSL.


	The data model must be created in BI Publisher with sample data available.











Supported Output

Excel templates generate Excel binary (.xls) output only.








Desktop Tools for Excel Templates

BI Publisher provides a downloadable add-in to Excel that provides these features.

	Connects directly to the BI Publisher server to load sample data and upload and download templates


	Inserts data field mappings to the template


	Inserts repeating group mappings to the template


	Provides a field browser to review all inserted code and to edit or delete mappings


	Previews the template using the sample data or live data when in connected mode






Installing the Template Builder for Excel

The Template Builder for Excel is installed automatically when you install the BI Publisher Desktop Tools. 

The tools can be downloaded from the Home page of Oracle Business Intelligence Publisher or Oracle Business
Intelligence Enterprise Edition, as follows:

Under the Get Started region, click Download BI Publisher Tools, then select the BI Publisher Desktop option (32bit Office or 64bit Office) appropriate for your version of Microsoft Office.

Note:
The Excel Template Builder is not compatible with the (deprecated) Analyzer for Excel. If you have the Analyzer for Excel installed from a previous version, the BI Publisher Tools installer detects its presence and halts the installation. You must remove the Analyzer for Excel before installing the BI Publisher Desktop. The Excel Template Builder includes a feature to import Analyzer for Excel templates to the Excel template format. See Importing Excel Analyzer Templates.










Sample Excel Templates

The Template Builder installation includes sample Excel templates.

To access the samples from a Windows desktop:




	Click Start, Programs, Oracle BI Publisher Desktop, Samples, then Excel.

This action launches the folder that contains the Excel sample templates.












HTML Output Properties

The properties described in this table can be set to govern HTML output files.


	Property Name	Description
	Show header

	Default: true

Description: Set to "false" to suppress the template header in HTML output.

Internal Name: html-show-header


	Show footer

	Default: true

Description: Set to false to suppress the template footer in HTML output.

Internal Name: html-show-footer


	Replace smart quotes

	Default: true

Description: Set to false if you do not want curly quotes replaced with straight quotes in the HTML output.

Internal Name: html-replace-smartquotes


	Character set

	Default: UTF-8

Description: Specifies the output HTML character set.

Internal Name: html-output-charset


	Make HTML output accessible

	Default: false

Description: Specify true if you want to make the HTML output accessible.

Internal Name: make-accessible


	Use percentage width for table columns

	Default: true

Description: Set this property to true to render table columns according to a percentage value of the total width of the table rather than as a value in points. This property is especially useful if the browser renders tables with extremely wide columns. Setting this property to true improves the readability of the tables.

Internal Name: html-output-width-in-percentage


	View Paginated

	Default: false

Description: When set to true, HTML output will render in the report viewer with pagination features. These features include:

	Generated table of contents


	Navigation links at the top and bottom of the page


	Ability to skip to a specific page within the HTML document


	Search for strings within the HTML document using the browser's search capability


	Zoom in and out on the HTML document using the browser's zoom capability




Note:
These features are supported for online viewing through the report viewer only.











Setting Options for the Template Builder

Use the Options dialog to specify template settings.

Access the Options dialog as follows: In the Options group, click Options.

The Options dialog contains four tabs: UI, Preview, Build, and Connection, as described in the following sections.






Setting UI Options

Use the Options dialog: UI tab to set options that influence the look and feel of the Template Builder.



The following illustration shows the Options dialog: UI tab.

[image: Description of GUID-B012627D-422F-4DA1-BB76-5232F80CBBB3-default.gif follows]



The tree view that shows the data source can show either the correct XML tag names of the data source or they can show a slightly modified version that is easier to read. Select the option Element Names for Report XML to show the modified labels. These labels contain no <> characters, use "Title case" and use spaces (" ") instead of underscores ("_").





Setting Preview Options

The Options dialog: Preview tab allows you to specify options that influence the Preview functionality of the Template Builder.

The following illustration shows the Options dialog: Preview tab.

[image: Description of GUID-717296A8-14ED-45DB-935D-C1C7D6F2DA5A-default.gif follows]



The following table describes the options available from the Preview tab.


	Option	Description
	Style Template

	If you have a BI Publisher Style Template available locally, then you can specify it here. A style template is an RTF template that contains style information that can be applied to RTF layouts, similar to a style sheet. The style information in the style template is applied to RTF layouts at runtime to achieve a consistent look and feel across your enterprise reports. For more information, Creating and Implementing Style Templates.


	Locale

	You can choose the language and territory used for previewing the template. While this change does not automatically translate any files, it is important to set the correct locale for the preview to use the correct direction of the text (left-to-right or right-to-left), and to correctly set locale-specific date, number, and currency formats.


	Java Home

	The Preview (and export functionality) requires Java code. You can change the path to the JAVA HOME directory. If this option is not specified, the Template Builder assumes that the Java virtual machine (java.exe) is accessible in the PATH specified in the environment variables of Windows.


	Java Option

	Specify the memory to reserve for the Template Builder to process the template. The default value is -Xmx256M.












Setting Build Options

Use the Options dialog: Build tab to specify options that influence how the Template Builder generates tables and forms.

The following illustration shows the Options dialog: Build tab.

[image: Description of GUID-0CE6E8B8-9FFF-4E35-AA7E-16220F0F431F-default.gif follows]



The following table describes the options available from the Build tab.


	Option	Description
	For-each form field

	Select how the Template Builder creates the form fields for processing instructions in the Insert Table/Form dialog. 

The Descriptive option (for example: for-each Invoice) renders a descriptive form field for the processing instructions. This option makes the layout template easier to understand. However, the longer fields may distract from the visual layout of the template. Note that the descriptive option does not apply to fields within table cells. 

The Abbreviated option (for example: F) provides a one letter abbreviation for each instruction. 

Select the Hidden box to generate the processing instruction form fields using Microsoft Word's hidden font effect. Hidden text is hidden in the Print Preview and you may display or hide the hidden text by changing the Hidden Text setting in the Display group of the Microsoft Word Options.


	Form Field Size

	Large - inserts the BI Publisher code to a document variable. The document variable field can accommodate approximately 48 kilobytes of code line. 

It is important to note that this setting affects only fields that are created or edited while this option is set. The form fields created with the Large setting cannot be understood by Oracle BI Publisher 10g. If the template is intended for use with the 10g version of BI Publisher, use the Backward Compatibility setting.

Backward Compatible - in previous versions of the Template Builder the BI Publisher code was inserted to the Microsoft Word Form Field Help Text box. This limited the length of code that could be inserted for a single form field. By default, the Large option is used because it can accommodate much larger code strings. However, the Large option is not compatible with Oracle BI Publisher 10g.


	Table Header Color

	When you insert a table using the Table Wizard or the Insert Table/Form dialog the Template Builder applies the Table Header Color specified here to the table header background. Customize the default color for the templates.


	Generate XSLT 2.0 compliant code

	BI Publisher uses the XSLT processor provided by Oracle XDK 11.1.0.7.0, which supports the W3C XSL Transformations 1.0 recommendation. The processor also implements the current working drafts of the XSLT and XPath 2.0 standards. For more information about Oracle XDK, see: Oracle XML Developer's Kit Programmer's Guide.

By default, BI Publisher is compatible with XSLT 1.0. If you want to use XSLT and XPath 2.0 features in the template, then enable this option. This configuration is performed at the template level. The template-level setting overrides the server setting.












Setting Connection Options

Options on this tab are reserved for a future release.






Overview

The Template Builder is an add-in to Microsoft Word that simplifies the development of RTF templates.

While the Template Builder is not required to create RTF templates, it provides many functions that increase productivity.

The Template Builder is tightly integrated with Microsoft Word and enables you to perform the following functions:

	Insert data fields


	Insert tables


	Insert forms


	Insert charts


	Preview the template with sample XML data


	Browse and update the content of form fields


	Extract boilerplate text into an XLIFF translation file and test translations




The Template Builder automates insertion of the most frequently used components of an RTF template. RTF templates also support much more complex formatting and processing.



Before You Get Started

The Template Builder installation provides samples and demo files to help you get started.

The demos can be accessed from the Windows Start menu as follows:

Select Start, Programs, Oracle BI Publisher Desktop, and Demos.

You can also access the demos from the BI Publisher\BI Publisher Desktop\demos folder where you installed BI Publisher Desktop (for example: C:\Program Files\Oracle\BI Publisher\BI Publisher Desktop\demos).

The following demos are provided:

	TemplateBuilderDemo.exe - Demonstrates building a report layout using many key features of the Template Builder, including: connecting to the BI Publisher server, loading data for a report, inserting tables and charts, and defining conditional formatting.


	TemplateBuilderInvoice.exe - Demonstrates how to take a prepared layout and use the Template Builder to insert the required fields to fill the template with data at runtime.


	LocalizationDemo.exe - Demonstrates the localization capabilities of the Template Builder and shows you how to extract an XLIFF file from the base RTF template. The XLIFF file can then be translated and the translations previewed in the Template Builder.




The sample files are located in the BI Publisher\BI Publisher Desktop\Samples folder. The Samples folder contains the subfolders:

	eText templates


	Excel templates


	PDF templates


	RTF templates




The eText, PDF, and Excel template samples can be used as references to create these types of templates. The Template Builder is only available for the RTF templates. The RTF templates folder contains eight subfolders to provide samples of different types of reports. Refer to the TrainingGuide.html located in the RTF templates folder for additional information on what is contained in each sample.





Prerequisites and Limitations

Certain prerequisites and limitations apply to this feature.

	Prerequisites:

	The report data model has been created and runs successfully.


	Supported versions of Microsoft Word and Microsoft Windows are installed on the client.

Note:
See System Requirements and Certification for the most up-to-date information on supported hardware and software.




	The BI Publisher Template Builder has been downloaded and installed on the client.

The Template Builder can be downloaded from the Get Started region of the Home page.





	Limitations:

	The Template Builder does not support bidirectional display of text in the user interface.















Using the Localized Template Option

If you must design a different layout for the reports that you present for different localizations, then you can create a new RTF file that is designed and translated for the locale and upload this file to the Template Manager.

Note:
The localized template option is not supported for XPT templates.

The following sections describe using the localized template option:

	Designing the Localized Template File


	Uploading the Localized Template to BI Publisher






Designing the Localized Template File

Use the same tools that you used to create the base template file, translating the strings and customizing the layout as desired for the locale.





Uploading the Localized Template to BI Publisher

Several types of templates can be uploaded to BI Publisher.

To upload the localized template:




	Navigate to the report, subtemplate, or style template in the catalog and click Edit to open it for editing.For reports only:

From the thumbnail view of the report layouts, click the Properties link of the layout to open the Template Manager.



	In the Templates region, click the Upload toolbar button.
	In the Upload Template File dialog, locate the file in a local directory, select rtf as the Template Type and select the Locale for this template file.
	Click OK to upload the file and view it in the Templates table.







PDF/X Output Properties

Set properties to configure PDF/X output.

PDF/X output properties are described in the table below. The values that you set for these properties will depend on the printing device. Note the following restrictions on other PDF properties:

	pdf-version - value above 1.4 is not allowed for PDF/X-1a output


	pdf-security - must be set to False 


	pdf-encryption-level - must be set to 0


	pdf-font-embedding - must be set to true




For more information on PDF/X output see Generating PDF/X output.





	Property Name	Description
	PDF/X ICC Profile Data

	Default: None

Description: (Required) The name of the ICC profile data file, for example: CoatedFOGRA27.icc. 

The ICC (International Color Consortium) profile is a binary file describing the color characteristics of the intended output device. (For more information, see the article at http://en.wikipedia.org/wiki/ICC_profile). For production environments, the color profile may be provided by your print vendor or by the printing company that prints the generated PDF/X file. The file must be placed under <bi publisher repository>/Admin/Configuration.

Profile data is also available from Adobe (http://www.adobe.com/support) or colormanagement.org (http://www.colormanagement.org/).

Internal Name: pdfx-dest-output-profile-data 


	PDF/X output condition identifier

	Default: None

Description: (Required)  The name of one of the standard printing conditions registered with ICC (International Color Consortium). The list of standard CMYK printing conditions to use with PDF/X-1a is provided on the following ICC website: http://www.color.org/chardata/drsection1.xalter. The value that you enter for this property is a valid "Reference name," for example: FOGRA43.   

Choose the appropriate value for the intended printing environment. This name is often used to guide automatic processing of the file by the consumer of the PDF/X document, or to inform the default settings in interactive applications. 

Internal Name: pdfx-output-condition-identifier


	PDF/X output condition

	Default: None

Description: 	A string describing the intended printing condition in a form that will be meaningful to a human operator at the site receiving the exchanged file. The value is set in OutputCondition field of OutputIntents dictionary.

Internal Name: pdfx-output-condition


	PDF/X registry name

	Default: http://www.color.org

Description: A registry name. Set this property when the pdfx-output-condition-identifier is set to a characterization name that is registered in a registry other than the ICC registry.

Internal Name: pdfx-registry-name 


	PDF/X version

	Default: PDF/X-1a:2003

Description: The PDF/X version set in GTS_PDFXVersion and GTS_PDFXConformance fields of Info dictionary. PDF/X-1a:2003 is the only value currently supported. 

Internal Name: pdfx-version 











Adding or Designating a Field for a Digital Signature

Oracle BI Publisher supports digital signatures on PDF output documents. Digital signatures enable you to verify the authenticity of the documents you send and receive. Oracle BI Publisher can access the digital ID file from a central, secure location and at runtime sign the PDF output with the digital ID. The digital signature verifies the signer's identity and ensures that the document has not been altered after it was signed.

Implementing digital signature requires several tasks across the BI Publisherproduct. This topic describes how to add a new field or configure an existing field in the PDF template for the digital signature. For more information and a description of the other required tasks and options, see Implementing a Digital Signature in Administrator's Guide for Oracle Business Intelligence Publisher.



About Signature Field Options

For PDF templates you have these options for designating a digital signature field for the output report.

	Add a signature field to the PDF layout.

Use this option if you want the digital signature to appear in a specific field and the PDF template does not already include a signature field. See Adding a Signature Field.


	Use an existing signature field in the PDF template.

Use this option if the PDF template already includes a signature field that you want to use. To designate an existing field for the digital signature, define the field in the Runtime Configuration page. See Configuring the Report to Insert the Digital Signature at Runtime.


	Designate the position of the digital signature on the output report by setting x and y coordinates.

Use this option if you prefer to designate the x and y coordinates for the placement of the digital signature, rather than use a signature field. You set the position using runtime properties. For information on setting these properties, see PDF Digital Signature Properties.




All three options require setting configuration properties for the report in the Report Properties page after you have uploaded the template.








Adding a Signature Field

Follow these steps to add a signature field.

To add a signature field:



	Open the template in Adobe Acrobat Professional.
	From the Form menu, select Add or Edit Fields. Then click Add New Field. Choose Digital Signature from the list of fields.
	Draw the signature field in the desired location on the layout. When you release the mouse button, a dialog prompts you to enter a name for the field.
	Enter a name for the signature field. The following figure shows an inserted digital signature field called "My_Signature."
[image: Description of GUID-584104C5-B253-4924-8D58-F5518DDD2EA1-default.gif follows]







	Save the template.
	Proceed to Configuring the Report to Insert the Digital Signature at Runtime.






Configuring the Report to Insert the Digital Signature at Runtime

After you have uploaded the PDF template to the report definition you must enable digital signature and specify the signature field in the Report Properties.

To configure the report to insert the digital signature:
See Adding a Layout by Uploading a Template File.




	From the edit report page, click Properties and then click the Formatting tab.
	Scroll to the PDF Digital Signature group of properties.
	Set Enable Digital Signature to True.
	For the property Existing signature field name, enter the field name from the PDF template.No other properties are required for this method.

The following figure shows the My_Signature field name entered into the properties field.


[image: Description of GUID-3AA13447-FECD-4C7B-B1B9-DDAB5C758AB1-default.gif follows]







	Click OK.Note:
The runtime properties that you have just set are at the report level and not the layout level. Therefore any layouts associated with the report now include the digital signature as specified in the Report Properties. When an Existing signature field name is specified, the template must contain the field for the signature to be applied.










Defining Headers and Footers

You can define headers and footers as part of the template.

This section covers the following topics:

	Native Support for Headers and Footers


	Inserting Placeholders in the Headers and Footers


	Creating Multiple or Complex Headers and Footers


	Defining Different First Page and Different Odd and Even Pages






Native Support for Headers and Footers

BI Publisher supports the use of the native RTF header and footer feature.

To create a header or footer, use the word processor's header and footer insertion tools. As an alternative, or if you have multiple headers and footers, you can use start:body and end body tags to distinguish the header and footer regions from the body of the report.





Inserting Placeholders in the Headers and Footers

At the time of this writing, Microsoft Word does not support form fields in the header and footer.

You must therefore insert the placeholder syntax directly into the template (basic RTF method), or use the start body/end body syntax described in the next section.





Creating Multiple or Complex Headers and Footers

If the template requires multiple headers and footers, then create them by using BI Publisher tags to define the body area of the report. You may also want to use this method if the header and footer contain complex objects that you want to place in form fields. When you define the body area, the elements occurring before the beginning of the body area compose the header. The elements occurring after the body area compose the footer.

Use the following tags to enclose the body area of the report:

<?start:body?>

<?end body?>

Use the tags either directly in the template, or in form fields.

The Payables Invoice Register contains a simple header and footer and therefore does not require the start body/end body tags. However, if you wanted to add another header to the template, define the body area.




To define the body area:



	Insert <?start:body?> before the Suppliers group tag:<?for-each:G_VENDOR_NAME?>



	Insert <?end body?> after the Suppliers group closing tag:<?end for-each?>





The following figure shows the Payables Invoice Register with the start body/end body tags inserted:


[image: Description of GUID-37A9DA2B-B1C2-44AB-93F3-A0BC60E7E19B-default.gif follows]












Defining Different First Page and Different Odd and Even Pages

If the report requires a different header and footer on the first page of the report; or, if the report requires different headers and footers for odd and even pages, then you can define this behavior using Microsoft Word's Page Setup dialog.

Note:
This feature is supported for PDF and RTF output only.






To define different page setups:



	Select Page Setup from the File menu.
	In the Page Setup dialog, select the Layout tab.
	In the Headers and footers region of the dialog, select the appropriate check box:Different odd and even

Different first page



	Insert the headers and footers into the template as desired.


At runtime the generated report exhibits the defined header and footer behavior.









Configuring Layouts Using the List View

After creating or uploading the layouts for the report, you can configure settings for the layout from the List View.

The following figure shows the List View.

[image: Description of GUID-CC03C662-53AA-4ABA-A859-68DC055DAB51-default.gif follows]





Applying a Style Template to the Layout

A style template contains style definitions that are applied to the paragraphs, headings, tables, and headers and footers of a report. A style template is optional and can only be applied to an RTF template file.

For more information on creating a style template, see Creating and Implementing Style Templates.

To apply a style template to this layout:




	Click Choose to browse for and select the style template.
	To apply the style template to an individual layout in the list, select theApply Style Template box for that layout in the list of properties.






About the Layouts Toolbar

The table explains the actions that you can do with the layout toolbar buttons.

The Layout toolbar buttons are described in the following table.





	Toolbar Button	Description
	Create

	Launches the add layout page to upload or create a new layout.


	Edit

	Launches the Layout Editor for the selected layout. This button is enabled for BI Publisher layouts (.xpt) only.


	Properties

	Launches the Properties page to enable the upload of localized templates and XLIFF files to associate with this layout. This button is enabled for RTF (.rtf) and BI Publisher layouts (.xpt) only. 

For more information on localizing templates, see Translation Support Overview and Concepts.


	Delete

	Deletes the selected layout.












Configuring the Layout Settings Using the List View

Configure these layout settings using List View.

The settings are described in the following table:





	Setting	Description
	Name

	Place the cursor in the text box to enter a new name for the layout.


	Template File

	Displays the name of the file that was saved to the report definition. Click the template file name to download it.


	Type

	Displays the template file type.


	Output Formats

	Select the output types to be enabled for this layout. By default, all valid output types for a layout are enabled. The layout type determines the output types available. See Selecting Output Formats for the complete list.


	Default Format

	Select the default output format for this layout when viewed or scheduled.


	Default Layout

	Select the layout that this report uses by default when viewed online or scheduled. Only one box in this column can be checked.


	Apply Style Template

	Select this box to apply the style template to this layout. Note that a style template can only be applied to RTF template files. For more information, see Applying a Style Template to the Layout.


	Active

	By default a layout is active. Clear this box when you want to keep the layout as part of the report definition, but no longer make it available. When a layout is inactive it does not display in the report viewer or the scheduler.


	View Online

	By default, a layout is available for report consumers who open the report in the Report Viewer. If this layout is for scheduled reports only, clear this box.


	Locale

	Displays the locale selected when the layout was uploaded. This field is not updatable.












Selecting Output Formats

BI Publisher supports a wide range of output formats.

Different layout types support different output types. The first table lists all possible output types. The second table lists valid output formats for each layout type.





	Output Format	Description
	Data (CSV)

	Enable this option to generate comma separated value output.


	Data (XML)

	Enable this option to generate XML output.


	Excel (mhtml)

	Enable this output type to view the report in Excel when report consumers have Microsoft Excel 2003. This option generates an MHTML format file that can be opened in Excel 2003 or later. This option supports embedded images, such as charts and logos; nested tables are not supported.


	Excel (html)

	Enable this output type only when report consumers are running the earlier versions of Microsoft Excel 2000 or 2002. This option generates HTML that can be opened in Excel. It does not support embedded images or nested tables.


	Excel (*.xlsx)

	Enable this option to generate the report in Excel.xlsx (Excel XML format). If your report consumers have Excel 2007 or later installed, this option provides the best preservation of layout and formatting.

Note: For this output format BI Publisher does not apply any formatting for number and date. BI Publisher saves the formatting mask and the actual value (date or number) into the XLSX output file. The formatting is handled by Microsoft Excel. For example:

	If the Microsoft Windows Region and Language of the client computer is set to English (United States), then the numbers and dates are formatted in en-US locale in the Excel 2007 output file.


	If the Microsoft Windows Region and Language of the client computer is set to French (France), then the numbers and dates in the same Excel 2007 output file are formatted in fr-FR locale.





	FO Formatted XML

	This option generates a XSL-FO (Extensible Stylesheet Language Formatting Objects) file. This output type is useful for debugging templates.


	HTML

	Enable HTML output for reports that require browser viewing.


	Interactive

	This output is only available for layouts designed using BI Publisher's Layout Editor. Interactive output enables pop-up chart value displays, scrollable and filterable tables, and other interactive features for a report.


	MHTML

	Enable Mime Hyper Text Markup Language to allow the report consumer to save a Web page and its resources as a single MHTML file (.mht), in which all images and linked files are saved as a single entity. A report consumer would use this option to send or save HTML output and retain the embedded images and stylesheet formatting.


	PDF

	Portable Document Format is commonly required for reports that require printing or sharing.


	PDF/A

	Use for reports that require long-term preservation or archiving. PDF/A is a specialized subset of the PDF standard that prohibits elements that may interfere with the preservation of the file as a self-contained document.

For more information see Generating PDF/A Output.


	PDF/X

	Use for reports that require formatting for prepress graphics exchange. PDF/X is a specialized subset of the PDF standard that streamlines documents for high-quality print production output and restricts content that does not serve the print production, such as signatures, comments, and embedded multimedia.

For more information see Generating PDF/X output.


	PowerPoint (mhtml)

	Enable this output type to generate a PowerPoint file compatible with Microsoft PowerPoint 2003. Note that Microsoft PowerPoint 2010 does not support this output type. Choose PowerPoint (*.pptx) instead.


	PowerPoint (*.pptx)

	Enable this output type to generate a Microsoft PowerPoint file in Microsoft Office Open XML format. This output type is supported for versions of Microsoft PowerPoint 2007 and later.


	RTF

	Rich Text Format. Enable this output for reports that must be opened for editing.


	Text

	This option generates text output for eText templates. Text output is available only for eText templates.


	Word

	Generates Microsoft Word .docx file.


	Zipped PDFs

	BI Publisher can generate a zip file containing the report PDF output and index files. This option is only available for layouts that have been designed to enable zipped PDF output. For information on designing a report to generate zipped PDF, see Generating Zipped PDF Output.








Note:
Data (CSV) and Data (XML) output formats are available for all layout types. However, when you select either of these formats, no layout formatting is applied and only data is included in the output.





	Layout Type	Valid Output Types
	BI Publisher template created using the layout editor (XPT)

	Data (CSV), Data (XML), Excel (mhtml), Excel (html), FO Formatted XML, HTML, Interactive, MHTML, PDF, PDF/A, PDF/X, PowerPoint (mhtml), PowerPoint (*.pptx), RTF, Word, Zipped PDFs


	RTF template (RTF)

	Data (CSV), Data (XML), Excel (mhtml), Excel (html), Excel (*.xlsx), FO Formatted XML, HTML, MHTML, PDF, PDF/A, PDF/X, PowerPoint (mhtml), PowerPoint (*.pptx), RTF, Word, Zipped PDFs


	PDF template (PDF)

	Data (CSV), Data (XML), PDF, Zipped PDFs


	Excel template (XLS)

	Data (CSV), Data (XML), Excel (*.xls), Excel (html)


	Flash template (SWF)

	Data (CSV), Data (XML), Flash, MHTML, PDF


	XSL Stylesheet (FO) (XSL)

	Same outputs as RTF template


	XSL Stylesheet (HTML XML/Text) (XSL)

	Data (CSV), Data (XML), HTML, Text


	eText template (RTF)

	Data (CSV), Data (XML), Text


	Analyzer template (XPA)

	(Supported for backward compatibility only.) Analyzer templates can be uploaded from previous versions of BI Publisher. The Online Analyzer in current versions of BI Publisher exports the online analysis to layout editor templates (.xpt).












Editing a Layout

Follow these steps to edit a BI Publisher layout and other template types.

To edit a BI Publisher layout (.xpt file type):


	Select the report from the list and click Edit.







To edit any other template type:	Click the File name link to download the layout to a local computer for editing.












Prerequisites and Limitations of the Customization Feature

Following are the prerequisites for and limitations of this feature.



Prerequisites

To enable the Customization option for reports, certain requirements must be met.




Catalog Requirements



	BI Publisher must use a shared catalog with Oracle BI Enterprise Edition.


	A folder named "Custom" must exist directly under Shared Folders. If the Custom folder is not seeded by your application, an Administrator can create it. The Administrator must grant the Write permission to the BI Author role for the Custom folder.


	Reports that are to be customized must reside in the folder hierarchy under Shared Folders. Reports under My Folders cannot be customized using this feature.







User Requirements



Following are requirements for a user to customize a report:

	A user must be granted the BI Author role (or a role that includes the permission oracle.bi.publisher.developReport)


	A user must be granted these permissions on the original report in the catalog:

	Read


	Run Publisher Report





	A user must be granted these permissions on the Custom folder in the catalog:

	Read


	Write





	The user must be granted access to the data model and data source of the original report if the same data model is used.




Following are requirements for a user to view a report in the Custom folder:

	A user must be granted the BI Consumer role


	A user must be granted these permissions on the original report in the catalog:

	Read


	Run Publisher Report





	A user must be granted these permissions on the Custom report in the catalog:

	Read


	Run Publisher Report





	The user must be granted access to the data model and data source of the original report if the same data model is used.











Limitations

You can customize reports within the following parameters.

Following are limitations of the Customize report option:

	The Customize option is not available through the /analytics URL used to access Oracle BI Enterprise Edition (for example: http://hostname.com:7001/analytics). 

You must access BI Publisher through the /xmlpserver URL (for example: http://hostname.com:7001/xmlpserver) to see the Customize option.


	The Customize option is available only for reports. The Customize option is not available for data models, style templates, or sub templates.

To customize data models, style templates or sub templates and insulate them from potential changes from patching, follow the second approach described in the preceding section: Make a copy of the data model, style template, or sub-template and either rename it or place it in a custom directory. Ensure that you update any reports to point to the customized data model, style template, or sub-template. 


	The security grants applied to the original report and folder hierarchy are not copied to the report created in the Custom folder. You must manually apply the security settings for the reports and folders that are created by the Customize feature in the Custom folder. See Using the Customize Feature for details on setting permissions.












Process Overview for Creating and Implementing RTF Sub Templates

You must follow this process to work with RTF sub templates.

Using a sub template consists of the following steps (described in the following sections):




	Create the RTF file that contains the common components or processing instructions that you want to include in other templates.
	Create the calling or "main" layout and include the following two commands:	import - to import the sub template file to the main layout template.


	call-template - to execute or render the sub template contents in the main layout.






	Test the template and sub template.Tip:
 You can use the BI Publisher Desktop Template Viewer to test the main layout plus sub template before loading them to the catalog. To do so, you must alter the import template syntax to point to the location of the sub template in the local environment. See Testing Subtemplates from the Desktop.



	Upload the main template to the report definition and create the Sub Template object in the catalog. See Uploading a Sub Template.





Building a Basic Template Using the Template Builder

This section demonstrates the concepts of Excel templates by describing the steps to create a simple Excel template using the Excel Template Builder.

This procedure follows these steps:

	Step 1: Load Sample Data to the Template Builder
	Step 2: Design the Layout in Excel
	Step 3: Use the Template Builder to Insert Fields
	Step 4: Use the Template Builder to Insert Repeating Groups
	Step 5: Insert the Calculated Salary Field
	Step 6: Test the Template




Step 1: Load Sample Data to the Template Builder

Loading sample data provides a properly formatted base from which to build a template.

The method you choose for loading sample data depends on whether you are working in connected or disconnected mode.




	To load data when working in connected mode, see Accessing the BI Publisher Catalog from the Template Builder.


	To load data when working in disconnected mode, see Loading Sample Data in Disconnected Mode.




The sample data for this example is a list of employees by department. Note that employees are grouped and listed under the department.

<?xml version="1.0" encoding="UTF-8"?>
<! - Generated by Oracle BI Publisher 11.1.1.4.0 - >
<DATA>
 <DEPT>
   <DEPARTMENT_ID>20</DEPARTMENT_ID>
   <DEPARTMENT_NAME>Marketing</DEPARTMENT_NAME>
     <EMPS>
       <EMPLOYEE_ID>201</EMPLOYEE_ID>
       <EMP_NAME>Michael Hartstein</EMP_NAME>
       <EMAIL>MHARTSTE</EMAIL>
       <PHONE_NUMBER>515.123.5555</PHONE_NUMBER>
       <HIRE_DATE>1996-02-17T00:00:00.000+00:00</HIRE_DATE>
       <SALARY>13000</SALARY>
     </EMPS>
     <EMPS>
       <EMPLOYEE_ID>202</EMPLOYEE_ID>
       <EMP_NAME>Pat Fay</EMP_NAME>
       <EMAIL>PFAY</EMAIL>
       <PHONE_NUMBER>603.123.6666</PHONE_NUMBER>
       <HIRE_DATE>1997-08-17T00:00:00.000+00:00</HIRE_DATE>
       <SALARY>6000</SALARY>
     </EMPS>
  </DEPT>
<DEPT>
...
...
</DEPT>
</DATA>


To build the template described in this tutorial, use the sample data available in the Samples folder installed with BI Publisher Desktop. A very similar data set can be found in <Install Directory>\BI Publisher Desktop\Template Builder for Word\samples\Excel templates\Employee By Departments\EmpByDept Single Sheets\EmpbyDeptExcelData.xml








Step 2: Design the Layout in Excel

Use Excel to simplify a design layout.

In Excel, determine how you want to render the data and create a sample design, as shown in the following illustration.

[image: Description of GUID-4474625A-A148-41C0-8F8B-7F337BAC00D1-default.gif follows]



The design shows a department name and a row for each employee within the department. You can apply Excel formatting to the design, such as font style, shading, and alignment. Note that this layout includes a total field. The value for this field is not available in the data and requires a calculation.





Step 3: Use the Template Builder to Insert Fields

You can map data to data fields in the template.

In this layout design, the following fields must be mapped to the template from the data:


	Field in Layout	Element in Data
	Department

	DEPARTMENT_NAME


	Employee Name

	EMP_NAME


	Employee ID

	EMPLOYEE_ID


	Email

	EMAIL


	Telephone

	PHONE_NUMBER


	Salary

	SALARY








To insert field mappings using the Template Builder:




	Select the cell in the spreadsheet where the data field is to display. For example, to map the DEPARTMENT_NAME element, select cell B5. 
	On the BI Publisher tab, in the Insert group click Field. (Because this is the first field you are inserting, a message displays stating that the metadata sheet will be created.) The Field dialog displays showing the data structure, shown in the following illustration.[image: Description of GUID-67966513-D744-4CDC-B41F-DCCF36281A24-default.gif follows]





	Select the element in the Field dialog and click Insert. Sample data is inserted to the cell in the template. For more information about the dialog, see Inserting Fields.
	Repeat for the Employee Name, Employee ID, Email, Telephone, and Salary fields in the template.






Step 4: Use the Template Builder to Insert Repeating Groups

A group is a set of data that repeats for each occurrence of a particular element.

In the sample template design, there are two groups:




	For each occurrence of the <EMPS> element, the employee's data (name, e-mail, telephone, salary) is displayed in the worksheet.


	For each occurrence of the <DEPT> element, the department name and the list of employees belonging to that department are displayed.




In other words, the employees are "grouped" by department and each employee's data is "grouped" by the employee element. To achieve this in the final report, insert a repeating group around the cells that are to repeat for each grouping element.

Note that the data must be structured according to the groups that you want to create in the template. The structure of the data for this example

<DATA> 
   <DEPT>
      <EMPS>


establishes the grouping desired for the report.

To insert the repeating group for Employees:

	Select the cells that make up the group. In this example, the first group is the Employee data that makes up a row in the table, the cells are A8 - E8.


	On the BI Publisher tab, in the Insert group, click Repeating Group. 


	In the BI Publisher Properties dialog, select the following:

	From the For Each list, select EMPS.


	From the Group By list, select EMPLOYEE_ID.




The following illustration shows BI Publisher Properties definitions for the Employees group. Notice that just the row of employee data is highlighted. Do not highlight the headers. Notice also that the total cell is not highlighted.

[image: Description of GUID-D488A487-143B-483E-ABF6-0FE27F145660-default.gif follows]






To insert the repeating group for Departments:




	To define the department group, select the Department name cell and all the employee fields beneath it (A5-E9) as shown in the following illustration.[image: Description of GUID-492AF8CE-46B4-4CC4-A3E4-8CDCB7AEB467-default.gif follows]





	On the BI Publisher tab, in the Insert group, click Repeating Group. Notice that the total salary cell is included in the department group to ensure that it repeats at the department level.
	In the BI Publisher Properties dialog, select the following:	From the For Each list, select DEPT.


	From the Group By list, select DEPARTMENT_ID.








The following illustration shows the selections for the BI Publisher Properties dialog.

[image: Description of GUID-6FD090FA-08AF-4904-9D48-FE87970F72BD-default.gif follows]










Step 5: Insert the Calculated Salary Field

Finally, insert the second Salary field that is to be an aggregated sum for each department.

To insert the calculated field:




	Select the cell in the spreadsheet where the calculated salary is to display. In this example, the cell is E9.
	On the BI Publisher tab, in the group, click Field to display the dialog.
	Select the SALARY element and click Insert to insert the mapping in the template. 
	Open the XDO_METADATA sheet. The Template Builder created a hidden XDO_METADATA sheet when you inserted the first field. Unhide the sheet in your workbook by right-clicking Sheet1 and selecting Unhide from the menu.

The following illustration shows the XDO_METADATA sheet for the sample template.

[image: Description of GUID-6736F219-8813-45BB-9527-A5C9A284BC44-default.gif follows]



The total salary field maps to the cell named XDO_?XDOFIELD7?. 



	In Column B enter the calculation as an XPATH function. To calculate the sum of the SALARY element for all employees in the group, enter the following: <?sum(.//SALARY)?>. The entry is shown in the following illustration.


[image: Description of GUID-8390527F-9E90-4C95-AF70-3CD20AF25F04-default.gif follows]










Step 6: Test the Template

You can test a template using Preview.

To preview a template with the loaded sample data:




	On the BI Publisher tab in the group, click Excel.

The sample data is applied to the template and the output document is opened in a new workbook. 




[image: Description of GUID-E9AAB1AC-E9D0-4AC3-BFA9-432BC3B01354-default.gif follows]











About Sub Templates

A Sub Template is a piece of formatting functionality that can be defined once and used multiple times within a single layout template or across multiple layout template files.

This piece of formatting can be in an RTF file format or an XSL file format. RTF subtemplates are easy to design as you can use Microsoft Word native features. XSL subtemplates can be used for complex layout and data requirements.

For more information, see Understanding Subtemplates.




Identifiers, Operators, and Literals

This section lists the reserved key word and phrases and their usage. The supported operators are defined and the rules for referencing XML extract fields and using literals.



Key Words

There are several categories of key words and key word phrases.

The categories are:

	Command and column header key words


	Command parameter and function parameter key words


	Field-level key words


	Expression key words








Command and Column Header Key Words

The command and column header key words must be used in the format shown: enclosed in <>s and in all capital letters with a bold font.

	<LEVEL> - the first entry of a data table. Associates the table with an XML element and specifies the hierarchy of the table.


	<END LEVEL> - declares the end of the current level. Can be used at the end of a table or in a standalone table.


	<POSITION> - column header for the first column of data field rows, which specifies the starting position of the data field in a record.


	<LENGTH> - column header for the second column of data field rows, which specifies the length of the data field.


	<FORMAT> - column header for the third column of data field rows, which specifies the data type and format setting.


	<PAD> - column header for the fourth column of data field rows, which specifies the padding style and padding character.


	<DATA> - column header for the fifth column of data field rows, which specifies the data source.


	<COMMENT> - column header for the sixth column of data field rows, which allows for free form comments.


	<NEW RECORD> - specifies a new record.


	<DISPLAY CONDITION> - specifies the condition when a record should be printed.


	<TEMPLATE TYPE> - specifies the type of the template, either FIXED_POSITION_BASED or DELIMITER_BASED.


	<OUTPUT CHARACTER SET> - specifies the character set to be used when generating the output.


	<NEW RECORD CHARACTER> - specifies the character(s) to use to signify the explicit and implicit new records at runtime.


	<DEFINE LEVEL> - defines a format-specific level in the template.


	<BASE LEVEL> - subcommand for the define level and define concatenation commands.


	<GROUPING CRITERIA> - subcommand for the define level command.


	<END DEFINE LEVEL> - signifies the end of a level.


	<DEFINE SEQUENCE> - defines a record or extract element based sequence for use in the template fields.


	<RESET AT LEVEL> - subcommand for the define sequence command.


	<INCREMENT BASIS> - subcommand for the define sequence command.


	<START AT> - subcommand for the define sequence command.


	<MAXIMUM> - subcommand for the define sequence command.


	<MINIMUM> - subcommand for the define sequence command.


	<MAXIMUM LENGTH> - column header for the first column of data field rows, which specifies the maximum length of the data field. For DELIMITER_BASED templates only.


	<END DEFINE SEQUENCE> - signifies the end of the sequence command.


	<DEFINE CONCATENATION> - defines a concatenation of child level elements that can be referenced as a string in the parent level fields.


	<ELEMENT> - subcommand for the define concatenation command.


	<DELIMITER> - subcommand for the define concatenation command.


	<END DEFINE CONCATENATION> - signifies the end of the define concatenation command.


	<SORT ASCENDING> - format-specific sorting for the instances of a level.


	<SORT DESCENDING> - format-specific sorting for the instances of a level.








Command Parameter and Function Parameter Key Words

The command parameter and function parameter key words must be entered in all capital letters, non-bold fonts.

	PERIODIC_SEQUENCE - used in the reset at level subcommand of the define sequence command. It denotes that the sequence number is to be reset outside the template.


	FIXED_POSITION_BASED, DELIMITER_BASED - used in the template type command, specifies the type of template.


	RECORD, LEVEL - used in the increment basis subcommand of the define sequence command. RECORD increments the sequence each time it is used in a new record. LEVEL increments the sequence only for a new instance of the level.








Field-Level Key Words

This section gives a list of key words and specifies the data type for each.

	Alpha - in the <FORMAT> column, specifies the data type is alphanumeric.


	Number - in the <FORMAT> column, specifies the data type is numeric.


	Integer - in the <FORMAT> column, used with the Number key word. Takes the integer part of the number. This has the same functionality as the INTEGER function, except the INTEGER function is used in expressions, while the Integer key word is used in the <FORMAT> column only.


	Decimal - in the <FORMAT> column, used with the Number key word. Takes the decimal part of the number. This has the same functionality as the DECIMAL function, except the DECIMAL function is used in expressions, while the Decimal key word is used in the <FORMAT> column only.


	Date - in the <FORMAT> column, specifies the data type is date.


	L, R- in the <PAD> column, specifies the side of the padding (Left or Right).








Expression Key Words

Key words and phrases used in expressions must be in capital letters and bold fonts.

	IF THEN ELSE IF THEN ELSE END IF - these key words are always used as a group. They specify the "IF" control structure expressions.


	IS NULL, IS NOT NULL - these phrases are used in the IF control structure. They form part of boolean predicates to test if an expression is NULL or not NULL.








Operators

There are two groups of operators: the boolean test operators and the expression operators.

The boolean test operators include: "=", "<>", "<", ">", ">=", and "<=". They can be used only with the IF control structure. The expression operators include: "()", "||", "+", "-", and "*". They can be used in any expression.

The following table lists the operators and describes their usage.





	Symbol	Usage
	=

	Equal to test. Used in the IF control structure only.


	<>

	Not equal to test. Used in the IF control structure only.


	>

	Greater than test. Used in the IF control structure only.


	<

	Less than test. Used in the IF control structure only.


	>=

	Greater than or equal to test. Used in the IF control structure only.


	<=

	Less than or equal to test. Used in the IF control structure only.


	()

	Function argument and expression group delimiter. The expression group inside "()" is always be evaluated first. "()" can be nested.


	||

	String concatenation operator.


	+

	Addition operator. Implicit type conversion may be performed if any of the operands are not numbers.


	-

	Subtraction operator. Implicit type conversion may be performed if any of the operands are not numbers.


	*

	Multiplication operator. Implicit type conversion may be performed if any of the operands are not numbers.


	DIV

	Division operand. Implicit type conversion may be performed if any of the operands are not numbers. Note that "/" is not used because it is part of the XPATH syntax.


	IN

	Equal-to-any-member-of test.


	NOT IN

	Negates the IN operator. Not-Equal-to-any-member-of test.












Reference to XML Extract Fields and XPATH Syntax

XML elements can be used in any expression.

At runtime XML elements are replaced with the corresponding field values. The field names are case-sensitive.

When the XML extract fields are used in the template, they must follow the XPATH syntax. This is required so that the BI Publisher engine can correctly interpret the XML elements.

There is always an extract element considered as the context element during the BI Publisher formatting process. When BI Publisher processes the data rows in a table, the level element of the table is the context element. For example, when BI Publisher processes the data rows in the Payment table, Payment is the context element. The relative XPATH you use to reference the extract elements are specified in terms of the context element.

For example to refer to the PayeeName element in a Payment data table, specify the following relative path:

Payee/PayeeInfo/PayeeName

Each layer of the XML element hierarchy is separated by a backslash "/". You use this notation for any nested elements. The relative path for the immediate child element of the level is just the element name itself. For example, you can use TransactionID element name as is in the Payment table.

To reference a parent level element in a child level table, you can use the "../" notation. For example, in the Payment table if you must reference the BatchName element, you can specify ../BatchName. The "../" provides Batch as the context; in that context you can use the BatchName element name directly as BatchName is an immediate child of Batch. This notation goes up to any level for the parent elements. For example if you must reference the RequesterParty element (in the RequestHeader) in a Payment data table, you can specify the following:

../../TrxnParties/RequesterParty

You can always use the absolute path to reference any extract element anywhere in the template. The absolute path starts with a backslash "/". For the PayeeName in the Payment table example above, you have the following absolute path: /BatchRequest/Batch/Payment/Payee/PayeeInfo/PayeeName

The absolute path syntax provides better performance.

The identifiers defined by the setup commands such as define level, define sequence and define concatenation are considered to be global. They can be used anywhere in the template. No absolute or relative path is required. The base level and reset at level for the setup commands can also be specified. BI Publisher can find the correct context for them.

If you use relative path syntax, then you should specify it relative to the base levels in the following commands:

	The element subcommand of the define concatenation command


	The grouping criteria subcommand of the define level command




The extract field reference in the start at subcommand of the define sequence command should be specified with an absolute path.

The rule to reference an extract element for the level command is the same as the rule for data fields. For example, if you have a Batch level table and a nested Payment level table, then you can specify the Payment element name as-is for the Payment table. Because the context for evaluating the Level command of the Payment table is the Batch.

However, if you skip the Payment level and you have an Invoice level table directly under the Batch table, then you must specify Payment/Invoice as the level element for the Invoice table.

The XPATH syntax required by the template is very similar to UNIX/LINUX directory syntax. The context element is equivalent to the current directory. You can specify a file relative to the current directory or you can use the absolute path which starts with a "/".

Finally, the extract field reference as the result of the grouping criteria sub-command of the define level command must be specified in single quotes. This tells the BI Publisher engine to use the extract fields as the grouping criteria, not their values.





Notes on Viewing eText Output from a Browser

If the report data contains Simplified Chinese characters and the <OUTPUT CHARACTER SET> is set to GBK, then the Chinese characters do not display properly in Internet Explorer 7 with gbk2312 encoding.

This issue may also occur in other non-English encodings as well, such as native Japanese and Korean. The output renders appropriately with Firefox 3.5, when setting the character set to be GBK in the eText template and setting the browser encoding to be GBK or GB2312. You can work around this issue by setting <OUTPUT CHARACTER SET> to utf-8. Note that this is a browser display issue only. The text file is generated correctly.






Using the Customize Feature

Use the Customize feature to create custom layouts and processes.

Assume your enterprise uses an Oracle prepackaged report called "Customer Orders" that resides under Shared Folders/Applications/Financials. Existing application processes point to this report in its current location in the catalog. Your organization wants to add a custom layout to this report that displays your company logo and color schemes. You then want the application processes to run your custom layout whenever the report is run as part of the business process, run as a separately scheduled job, or run directly from the catalog.

To use the Customize feature:




	Log in to BI Publisher Enterprise through the /xmlpserver URL. Navigate to your report in the catalog. Click the More link for your report to see all options and then click Customize.BI Publisher creates a copy of the report in the Custom folder, under the identical folder hierarchy: Shared Folders/Custom/Applications/Financials and opens the report copy in the report editor.



	Create a custom layout for this report and save it. Use the List View to customize properties of the layout, enable the custom layout as the default for this report, or inactivate the original layouts so your users no longer see them. See Configuring the Layout Settings Using the List View for information on setting the layout properties.
	Apply security to the custom report. Although BI Publisher creates identical folder hierarchy for the custom copy of the report, the catalog permissions present on the original folders and report are not copied to the custom report or the folder hierarchy. You must manually reapply the catalog permissions to secure the custom report identically to the original report.

To apply catalog permissions to reports: 

	Use the Oracle Business Intelligence interface by logging in to Oracle Business Intelligence using the /analytics URL (for example: http:www.example.com:7001/analytics).


	You must be granted the appropriate permissions for setting permissions on the objects in the Custom folder. This typically requires having a role that is granted Full Control on the Custom folder. For more information about setting catalog permissions, see "Managing Objects in the BI Presentation Catalog" in the User's Guide for Oracle Business Intelligence Enterprise Edition.











Supporting Calendars and Time Zones

This section describes support for calendars and time zones.



Calendar Specification

The term calendar refers to the calendar date displayed in the published report.

The following types are supported:

	GREGORIAN


	ARABIC_HIJRAH


	ENGLISH_HIJRAH


	JAPANESE_IMPERIAL


	THAI_BUDDHA


	ROC_OFFICIAL (Taiwan)




Use one of the following methods to set the calendar type:

	Call the format-date-and-calendar function and declare the calendar type.

For example:<?format-date-and-calendar:hiredate;'LONG_TIME_TZ';'ROC_OFFICIAL';?>

The following figure shows the output generated using this definition with locale set to zh-TW and time zone set to Asia/Taipei:

[image: Description of GUID-640B0774-DB39-4BA9-85FB-2CC0C581949E-default.gif follows]




	Set the calendar type using the profile option XDO: Calendar Type (XDO_CALENDAR_TYPE).




Note:
The calendar type that is specified in the template overrides the calendar type set in the profile option.







Specify Time Zone

You can specify a time zone using a Java time zone string.

There are two ways to specify time zone information:

	Call the format-date or format-date-and-calendar function with the Oracle format.


	Set the user profile option Client Timezone (CLIENT_TIMEZONE_ID) in Oracle Applications.




If no time zone is specified, then the report time zone is used.

In the template, the time zone must be specified as a Java time zone string, for example, America/Los Angeles. The following example shows the syntax to enter in the help text field of the template:

<?format-date:hiredate;'LONG_TIME_TZ';'Asia/Shanghai'?>





Specify No Time Zone Conversion

You can prevent a time zone from being converted to the user’s local time zone.

To stop timezone conversion truncate the timezone component in the date-time XSD string. In reports that do not need timezone conversion, <?format-date-nt: ...?> is a convenient function to achieve no timezone conversion.

Use this RTF template command to prevent any time zone conversion on the date-time provided.

Syntax: <?format-date-nt:<date_string>;'ABSTRACT_FORMAT_MASK'?>

Examples:

<?format-date-nt:Hire_Date;'SHORT'?>
<?format-date-nt:xdoxslt:sysdate_as_xsdformat();'MEDIUM'?>
<?format-date-nt:Hire_Date;'MEDIUM_TIME'?> 






4 Creating RTF Templates

This chapter describes the concepts of associating XML data to layout elements in an RTF report template. It describes basic and advanced techniques for creating complex and highly conditionalized report formats.

This chapter includes the following topics:

	Getting Started


	Associating the XML Data to the Template Layout


	Adding Markup to the Template Layout


	Defining Groups


	Defining Headers and Footers


	Inserting Images and Charts


	Adding Drawings, Shapes, and Clip Art


	Supported Formatting Features of Microsoft Word


	Template Features


	Using Conditional Formatting


	Inserting Page-Level Calculations


	Handling Data


	Setting Variables, Parameters, and Properties


	Using Advanced Report Layouts


	Formatting Numbers, Dates, and Currencies


	Supporting Calendars and Time Zones


	Using External Fonts


	Controlling the Placement of Instructions Using the Context Commands


	Using XPath Commands


	Declaring Namespaces


	Using FO Elements and XSL Elements


	Guidelines for Designing RTF Templates for Microsoft PowerPoint Output


	Guidelines for Designing RTF Templates for Microsoft Excel 2007 Output


	Rendering HTML Formatted Data in a Report


	Embedding PCL Commands for Check Printing







Handling Data

These sections describe methods for handling data in templates.

	Sorting Data


	Checking for Null Values


	Regrouping the XML Data






Sorting Data

You can sort a group by any element within the group. Insert the following syntax within the group tags:

<?sort:element name; order; data-type?>

where

element name is the name of the element you want the group sorted by

order is 'ascending' or 'descending'

data-type is the element data type. Valid values are: 'text' and 'number'.

If the order is not specified, by default, the sort order is ascending. If the data type is not specified, the type is assumed to be text.

For example, to sort a data set by an element named SALARY so that the highest salaries appear first, enter the following:

<?sort:SALARY;'descending';'number'?>


When you are sorting within a for-each group, enter the sort statement after the for-each statement. For example, to sort the Payables Invoice Register (shown at the beginning of this chapter) by Supplier (VENDOR_NAME), enter the following:

<?for-each:G_VENDOR_NAME?><?sort:VENDOR_NAME?>

To sort a group by multiple fields, just enter additional sort statements in the appropriate order. For example, to sort by Supplier and then by Invoice Number, enter the following

<?sort:VENDOR_NAME?> <?sort:INVOICE_NUM;'ascending';'number'?>





Checking for Null Values

Within the XML data there are three possible scenarios for the value of an element.

They are as follows:

	The element is present in the XML data, and it has a value.


	The element is present in the XML data, but it does not have a value.


	The element is not present in the XML data, and therefore there is no value.




In the report layout, you may want to specify a different behavior depending on the presence of the element and its value. The following examples show how to check for each of these conditions using an "if" statement. The syntax can also be used in other conditional formatting constructs.

	To define behavior when the element is present and the value is not null, use the following:

<?if:element_name!=' '?> desired behavior <?end if?>


	To define behavior when the element is present, but is null, use the following:

<?if:element_name and element_name="?> desired behavior <?end if?>


	To define behavior when the element is not present, use the following:

<?if:not(element_name)?> desired behavior <?end if?>








Regrouping the XML Data

The RTF template supports the XSL 2.0 for-each-group standard that allows you to regroup XML data into hierarchies that are not present in the original data.

With this feature, the template does not have to follow the hierarchy of the source XML file. You are therefore no longer limited by the structure of the data source.



XML Sample

This XML sample shows a set of data that uses the for-each-group standard.

To demonstrate the for-each-group standard, the following XML data sample of a CD catalog listing is regrouped in a template:

<CATALOG>
   <CD>
      <TITLE>Empire Burlesque</TITLE>
      <ARTIST>Bob Dylan</ARTIST>
      <COUNTRY>USA</COUNTRY>
      <COMPANY>Columbia</COMPANY>
      <PRICE>10.90</PRICE>
      <YEAR>1985</YEAR>
   </CD>
   <CD>
      <TITLE>Hide Your Heart</TITLE>
      <ARTIST>Bonnie Tylor</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>CBS Records</COMPANY>
      <PRICE>9.90</PRICE>
      <YEAR>1988</YEAR>
   </CD>
   <CD>
      <TITLE>Still got the blues</TITLE>
      <ARTIST>Gary More</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>Virgin Records</COMPANY>
      <PRICE>10.20</PRICE>
      <YEAR>1990</YEAR>
   </CD>
   <CD>
      <TITLE>This is US</TITLE>
      <ARTIST>Gary Lee</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>Virgin Records</COMPANY>
      <PRICE>12.20</PRICE>
      <YEAR>1990</YEAR>
   </CD>


Using the regrouping syntax, you can create a report of this data that groups the CDs by country and then by year. You are not limited by the data structure presented.





Regrouping Syntax

You can regroup data using the proper syntax

To regroup the data, use the following syntax:

<?for-each-group: BASE-GROUP;GROUPING-ELEMENT?>


For example, to regroup the CD listing by COUNTRY, enter the following in the template:

<?for-each-group:CD;COUNTRY?>


The elements that were at the same hierarchy level as COUNTRY are now children of COUNTRY. You can then refer to the elements of the group to display the values desired.

To establish nested groupings within the already defined group, use the following syntax:

<?for-each:current-group(); GROUPING-ELEMENT?>


For example, after declaring the CD grouping by COUNTRY, you can then further group by YEAR within COUNTRY as follows:

<?for-each:current-group();YEAR?> 


At runtime, BI Publisher loops through the occurrences of the new groupings, displaying the fields that you defined in the template.

Note:
This syntax is a simplification of the XSL for-each-group syntax. If you choose not to use the simplified syntax above, you can use the XSL syntax as shown below. The XSL syntax can only be used within a form field of the template.

<xsl:for-each-group
  select=expression
  group-by="string expression"
  group-adjacent="string expression"
  group-starting-with=pattern>
  <!--Content: (xsl:sort*, content-constructor) -->
</xsl:for-each-group>






Template Example

You can see some features that can be used to enhance templates in this example.

The following illustration shows a template that displays the CDs by Country, then Year, and lists the details for each CD.

[image: Description of GUID-122311D4-B8BE-4A00-84E6-88B1D3DB82CA-default.gif follows]



The following table shows the BI Publisher syntax entries made in the form fields of the template that is shown in the previous illustration.





	Default Text Entry	Form Field Help Text Entry	Description
	Group by Country

	<?for-each-group:CD;COUNTRY?>

	The <?for-each-group:CD;COUNTRY?> tag declares the new group. It regroups the existing CD group by the COUNTRY element.


	USA

	<?COUNTRY?>

	Placeholder to display the data value of the COUNTRY tag.


	Group by Year

	<?for-each-group:current-group();YEAR?>

	The <?for-each-group:current-group();YEAR?> tag regroups the current group (that is, COUNTRY), by the YEAR element.


	2000

	<?YEAR?>

	Placeholder to display the data value of the YEAR tag.


	Group: Details

	<?for-each:current-group()?>

	Once the data is grouped by COUNTRY and then by YEAR, the <?for-each:current-group()?> command is used to loop through the elements of the current group (that is, YEAR) and render the data values (TITLE, ARTIST, and PRICE) in the table.


	My CD

	<?TITLE?>

	Placeholder to display the data value of the TITLE tag.


	John Doe

	<?ARTIST?>

	Placeholder to display the data value of the ARTIST tag.


	1.00

	<?PRICE?>

	Placeholder to display the data value of the PRICE tag.


	End Group

	<?end for-each?>

	Closes out the <?for-each:current-group()?> tag.


	End Group by Year

	<?end for-each-group?>

	Closes out the <?for-each-group:current-group();YEAR?> tag.


	End Group by Country

	<?end for-each-group?>

	Closes out the <?for-each-group:CD;COUNTRY?> tag.








This template produces the report that is shown in the next illustration when merged with the XML file.

[image: Description of GUID-2AFAA7EE-AD6E-42A4-899B-0D473CCBCCF9-default.gif follows]










Regrouping by an Expression

Regrouping by an expression allows you to apply a function or command to a data element, and then group the data by the returned result.

To use this feature, state the expression within the regrouping syntax as follows:

<?for-each:BASE-GROUP;GROUPING-EXPRESSION?>


To demonstrate this feature, an XML data sample that simply contains average temperatures per month is used as input to a template that calculates the number of months having an average temperature within a certain range.

The following XML code is composed of <temp> groups. Each <temp> group contains a <month> element and a <degree> element, which contains the average temperature for that month:

<temps>
  <temp>
    <month>Jan</month>
    <degree>11</degree>
  </temp> 
  <temp>
    <month>Feb</month>
    <degree>14</degree>
  </temp>  
  <temp>
    <month>Mar</month>
    <degree>16</degree>
  </temp> 
  <temp>
    <month>Apr</month>
    <degree>20</degree>
  </temp> 
  <temp>
    <month>May</month>
    <degree>31</degree>
  </temp>
  <temp>
    <month>Jun</month>
    <degree>34</degree>
  </temp> 
  <temp>
    <month>Jul</month>
    <degree>39</degree>
  </temp> 
  <temp>
    <month>Aug</month>
    <degree>38</degree>
  </temp>
  <temp>
    <month>Sep</month>
    <degree>24</degree>
  </temp>  
  <temp>
    <month>Oct</month>
    <degree>28</degree>
  </temp> 
  <temp>
    <month>Nov</month>
    <degree>18</degree>
  </temp> 
  <temp>
    <month>Dec</month>
    <degree>8</degree>
  </temp> 
</temps>         


You want to display this data in a format showing temperature ranges and a count of the months that have an average temperature to satisfy those ranges, as shown in the following illustration.

[image: Description of GUID-5936C8DD-AB98-4AB2-AADF-63447F0FE38E-default.gif follows]



Using the for-each-group command you can apply an expression to the <degree> element that enables you to group the temperatures by increments of 10 degrees. You can then display a count of the members of each grouping, which is the number of months having an average temperature that falls within each range.

The next illustration shows the template to create the report that is shown in the previous illustration.

[image: Description of GUID-8CCFDC41-7682-4160-9AB4-A0A5322B59E7-default.gif follows]



The next table shows the form field entries made in the template that is shown in the previous illustration.





	Default Text Entry	Form Field Help Text Entry
	Group by TmpRng

	<?for-each-group:temp;floor(degree div 10)?> <?sort:floor(degree div 10)?>


	Range

	<?concat(floor(degree div 10)*10,' F to ',floor(degree div 10)*10+10, 'F')?>


	Months

	<?count(current-group())?>


	End TmpRng

	<?end for-each-group?>








Note the following about the form field tags:

	The <?for-each-group:temp;floor(degree div 10)?> is the regrouping tag. It specifies that for the existing <temp> group, the elements are to be regrouped by the expression, floor(degree div 10). The floor function is an XSL function that returns the highest integer that is not greater than the argument (for example, 1.2 returns 1, 0.8 returns 0).

In this case, it returns the value of the <degree> element, which is then divided by 10. This generates the following values from the XML data: 1, 1, 1, 2, 3, 3, 3, 3, 2, 2, 1, and 0.

These are sorted, so that when processed, the following four groups are created: 0, 1, 2, and 3.


	The <?concat(floor(degree div 10)*10,'F to ', floor(degree div 10)*10+10,'F'?> displays the temperature ranges in the row header in increments of 10. The expression concatenates the value of the current group times 10 with the value of the current group times 10 plus 10.

Therefore, for the first group, 0, the row heading displays 0 to (0 +10), or "0 F to 10 F".


	The <?count(current-group())?> uses the count function to count the members of the current group (the number of temperatures that satisfy the range).


	The <?end for-each-group?> tag closes out the grouping.














New Features for Report Designers

This preface describes changes to the Oracle BI Publisher report designer.

	New Features and Changes for Release 12c (12.2.1.1.0)






New Features and Changes for Release 12c (12.2.1.1.0)

This section includes new features and changes for Oracle BI Publisher 12c (12.2.1.1.0).

Add XSLT Profiling to Template Viewer
XSL time logging commands are added to the XSL template to enable time measurements, which acts as a profiling tool. When the template is run, a log.csv file is generated which measures the time across the XSL code. See Using XSLT Profiling in Template Viewer.









Using Advanced Report Layouts

Learn more about Advanced Report Layouts.

This section describes the following tasks for advanced report layouts:

	Creating Batch Reports


	Handling No Data Found Conditions


	Inserting Pivot Tables


	Constructing Dynamic Data Columns






Creating Batch Reports

It is a common requirement to print a batch of documents, such as invoices or purchase orders in a single PDF file. Because these documents are intended for different customers, each document requires that the page numbering be reset and that page totals are specific to the document. If the header and footer display fields from the data (such as customer name), then these must be reset as well.

BI Publisher supports this requirement through the use of a context command. This command allows you to define elements of the report to a specific section. When the section changes, these elements are reset.

The following example demonstrates how to reset the header and footer and page numbering within an output file:

The following XML code is a report that contains multiple invoices:

...
<LIST_G_INVOICE>
   <G_INVOICE>
      <BILL_CUST_NAME>Vision, Inc. </BILL_CUST_NAME>
      <TRX_NUMBER>2345678</TRX_NUMBER>
      ...
   </G_INVOICE>
   <G_INVOICE>
      <BILL_CUST_NAME>Oracle, Inc. </BILL_CUST_NAME>
      <TRX_NUMBER>2345685</TRX_NUMBER>
      ...
   </G_INVOICE>
   ...
</LIST_G_INVOICE>
...


Each G_INVOICE element contains an invoice for a potentially different customer. To instruct BI Publisher to start a new section for each occurrence of the G_INVOICE element, add the @section command to the opening for-each statement for the group, using the following syntax:

<?for-each@section:group name?>

where group_name is the name of the element for which you want to begin a new section.

For example, the for-each grouping statement for this example is as follows:

<?for-each@section:G_INVOICE?>

The closing <?end for-each?> tag is not changed.

The following figure shows a sample template for batch reports:

Note:
The G_INVOICE group for-each declaration is still within the body of the report, even though the headers are reset by the command.


[image: Description of GUID-4782470C-48F5-4F97-B5F6-98F94D1F05F4-default.gif follows]





The following table describes the values of the form fields from the template in the previous figure (that shows a sample template for batch reports):


	Default Text Entry	Form Field Help Text	Description
	for-each G_INVOICE

	<?for-each@section:G_INVOICE?>

	Begins the G_INVOICE group, and defines the element as a Section. For each occurrence of G_INVOICE, a new section is started.


	<?TRX_NUMBER?>

	N/A

	Microsoft Word does not support form fields in the header, therefore the placeholder syntax for the TRX_NUMBER element is placed directly in the template.


	end G_INVOICE

	<?end for-each?>

	Closes the G_INVOICE group.








Now for each new occurrence of the G_INVOICE element, a new section begins. The page numbers restart, and if header or footer information is derived from the data, it is reset as well.





Handling No Data Found Conditions

When you use @section with the BI Publisher commands for-each or for-each-group (for example: <?for-each@section:ELEMENT_NAME?>), and the input data file has no data, then an empty or invalid PDF output document may be generated for that for-each loop. To prevent this from happening, edit the RTF template.

To handle no data found conditions:


	At the end of the RTF template, add a section break.
	On the last page (the new section page), add the command <?if@section:not(ELEMENT_NAME)?>No Data Found<?end if?>where ELEMENT_NAME is the same data element that you are using in the for-each@section loop.

Now if no data exists for ELEMENT_NAME, a valid PDF is generated with the text "No Data Found".









Inserting Pivot Tables

The columns of a pivot table are data dependent.

Note:
For more information, see Inserting a Pivot Table.

At design time you do not know how many columns are reported, or what the appropriate column headings are. Moreover, if the columns should break onto a second page, you must be able to define the row label columns to repeat onto subsequent pages. The following example shows how to design a simple pivot tale report that supports these features.

This example uses the following XML sample:

<ROWSET>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2005</YEAR>
    <QUARTER>Q1</QUARTER>
    <SALES>1000</SALES>
 </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2005</YEAR>
    <QUARTER>Q2</QUARTER>
    <SALES>2000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2004</YEAR>
    <QUARTER>Q1</QUARTER>
    <SALES>3000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2004</YEAR>
    <QUARTER>Q2</QUARTER>
    <SALES>3000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2003</YEAR>
     ...
  </RRESULTS>
  <RESULTS>
    <INDUSTRY>Home Furnishings</INDUSTRY>
     ...
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Electronics</INDUSTRY>
     ...
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Food and Beverage</INDUSTRY>
     ...
  </RESULTS>
            
</ROWSET>


From this XML code, a report is generated that shows each industry and totals the sales by year as shown in the following illustration.

[image: Description of GUID-08356E62-44BB-45D8-8A42-9460E9575DC3-default.gif follows]



The following illustration shows the template to generate the report that is shown in the previous illustration.

[image: Description of GUID-1BDECF6C-15CC-40FD-AA47-EFBB73C4632C-default.gif follows]



The form fields in the template that is shown in the previous illustration have the values that are described in the following table.


	Default Text Entry	Form Field Help Text	Description
	header column

	<?horizontal-break-table:1?>

	Defines the first column as a header that should repeat if the table breaks across pages. For more information about this syntax, see Defining Columns to Repeat Across Pages.


	for:

	<?for-each-group@column:RESULTS;YEAR?>

	Uses the regrouping syntax (see Regrouping the XML Data) to group the data by YEAR; and the @column context command to create a table column for each group (YEAR). For more information about context commands, see Controlling the Placement of Instructions Using the Context Commands.


	YEAR

	<?YEAR?>

	Placeholder for the YEAR element.


	end

	<?end for-each-group?>

	Closes the for-each-group loop.


	for:

	<?for-each-group:RESULTS;INDUSTRY?>

	Begins the group to create a table row for each INDUSTRY.


	INDUSTRY

	<?INDUSTRY?>

	Placeholder for the INDUSTRY element.


	for:

	<?for-each-group@cell:current-group();YEAR?>

	Uses the regrouping syntax (see Regrouping the XML Data) to group the data by YEAR; and the @cell context command to create a table cell for each group (YEAR).


	sum(Sales)

	<?sum(current-group()//SALES)?>

	Sums the sales for the current group (YEAR).


	end

	<?end for-each-group?>

	Closes the for-each-group statement.


	end

	<?end for-each-group?>

	Closes the for-each-group statement.








Note that only the first row uses the @column context to determine the number of columns for the table. All remaining rows must use the @cell context to create the table cells for the column. (For more information about context commands, see Controlling the Placement of Instructions Using the Context Commands.)





Constructing Dynamic Data Columns

The ability to construct dynamic data columns is a very powerful feature of the RTF template. Using this feature you can design a template that correctly renders a table when the number of columns that is required by the data is variable.

For example, you are designing a template to display columns of test scores within specific ranges. However, you do not how many ranges have data to report. You can define a dynamic data column to split into the correct number of columns at runtime.

Use the following tags to accommodate the dynamic formatting required to render the data correctly:

	Dynamic Column Header

<?split-column-header:group element name?>

Use this tag to define which group to split for the column headers of a table.


	Dynamic Column <?split-column-data:group element name?>

Use this tag to define which group to split for the column data of a table.


	Dynamic Column Width

<?split-column-width:name?> or

<?split-column-width:@width?>

Use one of these tags to define the width of the column when the width is described in the XML data. The width can be described in two ways:

	An XML element stores the value of the width. In this case, use the syntax <?split-column-width:name?>, where name is the XML element tag name that contains the value for the width.


	If the element defined in the split-column-header tag, contains a width attribute, use the syntax <?split-column-width:@width?> to use the value of that attribute.





	Dynamic Column Width's unit value (in points) <?split-column-width-unit:value?>

Use this tag to define a multiplier for the column width. If the column widths are defined in character cells, then you must use the appropriate multiplier value to render the columns to the correct width in points. For example, if you are using 10 point courier font in the table, you would use a multiplier of 6, which is the approximate width of a character displayed in 10 point courier font. If the multiplier is not defined, then the widths of the columns are calculated as a percentage of the total width of the table. The column width calculations are illustrated in the following table:


	Width Definition	Column 1 (Width = 10)	Column 2 (Width = 12)	Column 3 (Width = 14)
	Multiplier not present -% width

	10/10+12+14*100 28%

	%Width = 33%

	%Width =39%


	Multiplier = 6 - width

	60 pts

	72 pts

	84 pts













Defining Columns to Repeat Across Pages

If the table columns expand horizontally across more than one page, you can define how many row heading columns you want to repeat on every page.

Use the following syntax to specify the number of columns to repeat:

<?horizontal-break-table:number?>

where number is the number of columns (starting from the left) to repeat.

Note:
This functionality is supported for PDF output only.





Example of Dynamic Data Columns

A template is required to display test score ranges for school exams. Logically, you want the report to be arranged as shown in the table here.


	Test Score	Test Score Range 1	Test Score Range 2	Test Score Range 3	...Test Score Range n
	Test Category

	# students in Range 1

	# students in Range 2

	# students in Range 3

	# of students in Range n








However, you do not know how many Test Score Ranges are reported. The number of Test Score Range columns is dynamic, depending on the data.

The following XML data describes these test scores. The number of occurrences of the element <TestScoreRange> determine how many columns are required. In this case there are five columns: 0-20, 21-40, 41-60, 61-80, and 81-100. For each column there is an amount element (<NumOfStudents>) and a column width attribute (<TestScore width="15">).

<?xml version="1.0" encoding="utf-8"?>
 <TestScoreTable>
  <TestScores>
    <TestCategory>Mathematics</TestCategory>
    <TestScore width ="15">
    <TestScoreRange>0-20</TestScoreRange>
    <NumofStudents>30</NumofStudents>
 </TestScore>
    <TestScore width ="20">
    <TestScoreRange>21-40</TestScoreRange>
    <NumofStudents>45</NumofStudents>
 </TestScore>
   <TestScore width ="15">
    <TestScoreRange>41-60</TestScoreRange>
    <NumofStudents>50</NumofStudents>
 </TestScore>
    <TestScore width ="20">
    <TestScoreRange>61-80</TestScoreRange>
    <NumofStudents>102</NumofStudents>
 </TestScore> 
    <TestScore width ="15"> 
    <TestScoreRange>81-100</TestScoreRange>
   <NumofStudents>22</NumofStudents>
 </TestScore>
 </TestScores> 
  <TestScoreTable> 


Using the dynamic column tags in form fields, set up the table in two columns as shown in the following figure. The first column, Test Score is static. The second column, Column Header and Splittingis the dynamic column. At runtime this column is split according to the data, and the header for each column is appropriately populated. The Default Text entry and Form Field Help entry for each field are listed in the following table. (See Using the Form Field Method for more information on using form fields).


[image: Description of GUID-7A10AA37-5BEA-4E85-9627-1610344F5A05-default.gif follows]









	Default Text Entry	Form Field Help Text Entry
	Group:TestScores

	<?for-each:TestScores?>


	Test Category

	<?TestCategory?>


	Column Header and Splitting

	<?split-column-header:TestScore?> <?split-column-width:@width?> <?TestScoreRange?>%


	Content and Splitting

	<?split-column-data:TestScore?> <?NumofStudents?>


	end:TestScores

	<?end for-each?>








	Test Score is the boilerplate column heading.


	Test Category is the placeholder for the <TestCategory> data element, that is, Mathematics, which is also the row heading.


	The second column is the one to be split dynamically. The width you specify is divided by the number of columns of data. In this case, there are 5 data columns.


	The second column contains the dynamic range data. The width of the column is divided according to the split column width. Because this example does not contain the unit value tag (<?split-column-width-unit:value?>), the column is split on a percentage basis. Wrapping of the data occurs if required.

If the tag (<?split-column-width-unit:value?>) were present, then the columns have a specific width in points. If the total column widths were wider than the allotted space on the page, then the table breaks onto another page.

The horizontal-break-table tag could then be used to specify how many columns to repeat on the subsequent page. For example, a value of 1 would repeat the column Test Score on the subsequent page, with the continuation of the columns that did not fit on the first page.




The template renders the output that is shown in the following figure:


[image: Description of GUID-12E92F1C-F88A-4550-A1FF-1E3AE0C7BCD8-default.gif follows]















Creating Reports

Launch the Create Report guide in one of these ways.

	From the global header, click New and then click Report.


	From the Home page, under the Create region, click Report.


	On the catalog toolbar, click New and then click Report.


	From the Data Model editor page, click Create Report.




Note:
If your user interface preference is set to a bidirectional language, the Create Report guide does not display all components in right-to-left orientation.








Selecting a Data Source

Building a report begins with selecting a data source.

Choose one of the following options to begin building your report:




	Use Data Model

Select an existing data model from the catalog.

Click Next to proceed to Choosing Guide Me or Use Report Editor.


	Upload Spreadsheet

Upload a Microsoft Excel file (file type.xls or .xlsx). If the uploaded spreadsheet contains multiple sheets, select the sheet to use as the data source. You can include data from only one sheet.

To use multiple sheets in a workbook, you first create a data model that includes each spreadsheet as a data set, and then use that data model as the data source for the report. For more information, see Creating a Data Set Using a Microsoft Excel Filein Data Modeling Guide for Oracle Business Intelligence Publisher.

Click Next to proceed to Choosing Guide Me or Use Report Editor.


	Use Subject Area

Select a subject area from the Oracle BI repository. This option enables you to directly query the Oracle BI server and eliminates the need to create a data model in BI Publisher. The Create Report guide limits you to one subject area, however, you can create a report against multiple subject areas using the report editor. For more information, see Creating a Report Against Multiple Subject Areas.

Click Next to proceed to Choosing Guide Me or Use Report Editor.











Choosing Guide Me or Use Report Editor

You have the option either to choose guide or to use the report editor on the Create Report page.

The following table describes the options on the Create Report page.





	Option	Description
	Guide Me

	This option guides you through defining the layout of your data in common predefined report styles. Choose this option to:

	Create a report with simple components


	Select a common report style with basic options


	Quickly view the data in preview mode




Proceed to select the report layout. For more information, see Selecting the Report Layout.


	Use Report Editor

	This option prompts you to save the report and then opens the report editor. Choose this option to proceed to configure the report or to create a more complex layout. For more information, see Editing Reports.












Selecting the Report Layout

When you choose Guide Me, you are prompted to select the report page options.

After you select the data source for the report, select the report page options and report layout to define how data is displayed in the report.

To select report layout:




	Select report page options as follows:	Select the Portrait or Landscape page option to define the report page orientation.


	Select the Page Header option to include the date in the report page header.


	Select the Page Footer option to include the page number in the report page footer.






	Select one of the following report layouts:	Table (default)


	Chart


	Pivot Table


	Chart and Table


	Chart and Pivot Table


	Two Charts and Table






	Click Next to proceed.






Choosing Columns for Report Layouts

The layout that you select on the Select Layout page drives the remaining pages that you must complete to create the report.

For example, if you select the Table layout, Create Table is the next page displayed.

After you select a layout, select the data source columns to include in the report. As you select columns, sample data for the columns displays on the page. The selected columns display in the order selected.

Keep the following points in mind about sample data:

	For data models: The Create Report process uses the sample data that is saved to the data model. If sample data is not attached to the data model, the selected column headings display without data.


	For uploaded spreadsheets: Sample data is displayed from the selected spreadsheet.


	For subject areas: Sample data is displayed directly from the columns in the subject area.






Table Layout

On the Create Table page you add columns to the layout by dragging and dropping them from the Data Source pane to the table area.

The columns are displayed in a simple tabular format and the column widths are automatically adjusted based on the number of selected columns as shown in the following illustration.

To remove a column from the table, hover your mouse over the upper-right hand corner of the column header and click Delete.

[image: Description of GUID-A346A09E-078F-47E0-A4AA-70A386F15B35-default.gif follows]



The Show Grand Totals Row option is selected by default to automatically display an aggregated summary row for all columns. Deselect this option to remove the row from the table.

Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.








Chart Layout

The Chart Layout page supports three types of charts. Choose the chart type by clicking its icon: Bar, Line, or Pie. Add columns to the chart by dragging and dropping them from the Data Source pane to the chart area.

The following figure shows the create chart layout. You can specify two values each to display for the chart Value, Series, and Label.

The layout editor supports a variety of more complex charts. To add more values to this chart or create another chart type, edit this layout in the layout editor after saving the report. For more information on creating layout templates, see Creating BI Publisher Layout Templates.

[image: Description of GUID-F60E0976-C0F0-46C1-89D4-D638B18C76D6-default.gif follows]



To remove a value from the chart, hover your mouse over the upper-right hand corner of the item label and click Delete.

Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.








Chart and Table Layout

When you select the chart and table layout, you add columns to the Create Chart page first, click Next, and then the Create Table page displays with the columns that you previously selected for the chart.

You can also add additional columns and remove columns on this page.

Click Next to proceed to Saving the Report.








Pivot Table Layout

When you select columns for the pivot table layout, the columns display on the Create Table page.

The figure below shows the columns displayed.

[image: Description of GUID-A8E10EE4-AE91-4BB3-9BD8-516A893B86F2-default.gif follows]



The Show Row Grand Totals option is selected by default. Deselect this option to hide the row in the table that includes the grand total for each column.

The Show Column Grand Totals option is selected by default. Deselect this option to hide the column in the table that includes the grand total for each row.

Click Switch Rows and Columns to flip the rows and columns axes.

Click Preview Report to display the report in the report viewer.

Click Next to proceed to Saving the Report.








Chart and Pivot Table Layout

When you select the chart and pivot table layout, you add columns to the Create Chart page first, click Next, and then the Create Table page displays with the columns that you previously selected for the chart. You can also add additional columns and remove columns on this page.

Click Next to proceed to Saving the Report.








Two Charts and Table Layout

When you select the two charts and table layout, you add columns to the Create Chart page first, click Next, and then Create 2nd Chart.

Once you add columns to the Create 2nd Chart page, click Next to display the Create Table page. The Create Table page displays with the columns that you already selected for the first chart. You can also add additional columns and remove columns on this page.

Click Next to proceed to Saving the Report.










Saving the Report

You can save the report layout and the columns you added.

Use the Save Report page as shown in the following illustration.

[image: Description of GUID-54369E68-E9E0-47C7-9424-E29DFCE1C068-default.gif follows]



Select one of the following options:




	To run the report you just created, click View Report and then click Finish. The final page prompts you to save the report. After saving, BI Publisher runs and displays the report in the report viewer.


	To customize the report layout, click Customize Report Layout and then click Finish. The final page prompts you to save the report. After saving, the report opens in the layout editor.




For more information about additional report options and layouts, see Editing Reports.









About PDF Version Support

In versions of BI Publisher earlier than 11.1.1.7, the PDF utilities required that all PDF input documents be PDF version 1.4. Starting with the 11.1.1.7 release, users can pass PDF documents of later versions to the BI Publisher PDF utilities.

BI Publisher generates the output PDF version based on the input PDF version as follows: 

	PDF version 1.4 and earlier generates PDF 1.4


	PDF version 1.5 and later generates the same output version as the input version




Note:
The version specification here is referred to as "PDF 1.7," however, there are very few differences between PDF 1.7 and ISO 32000-1. Therefore BI Publisher's support for PDF 1.7 can also be considered as support for ISO 32000-1.

For more information about these standards, see the Adobe website at

 http://www.adobe.com/devnet/pdf/pdf_reference.html 

and the International Organization for Standardization website at

 http://www.iso.org/iso/home.html.






About the Layout Editor Interface

The illustrated figure shows the layout editor interface.

[image: Description of GUID-8B1C1FA7-81E1-4845-B2B7-C0CCF57D122C-default.gif follows]



The Layout Editor interface comprises the following:

	The top of the Layout Editor contains two toolbars:

	The Static toolbar is always available and contains common commands such as save and preview.


	The Tabbed toolbar includes the Insert tab, the Page Layout tab, and a dynamic tab that shows the most commonly used actions and commands for the selected layout component. You can collapse this toolbar to make more room to view the design area. See About the Tabbed Toolbar.





	The accordion pane on the left contains the following:

	Use the Data Source pane to select the data fields to drag to the layout components.


	Use the Components pane to select layout components and drag them to the design area. You can also use the Insert tab to insert components when this pane is collapsed.


	Use the Properties pane to modify properties for the selected layout component.




You can expand and display each control by clicking the title of the control or the plus sign next to the title of the control. You can collapse the entire accordion pane to allow more room to view the layout.


	The lower right region is the design area for building the layout.






About the Data Source Pane

The Data Source pane displays the structure of the data model and the data elements that are available to insert into the layout.

To insert a data element, select and drag it from the Data Source pane to the component in the layout.

The data type for each field is represented by an appropriate icon: number, date, or text.

The following figure shows the data source pane. The icon beside each element indicates the data type.

[image: Description of GUID-596855CD-FE4F-4FB4-84A7-D681EB2CEC1B-default.gif follows]



The JOB_TITLE element is shown as text, the SALARY element is shown as a number, and the HIRE_DATE element is shown as a date data type.

Note:
When you enter dates in the Layout Editor (such as a data comparison for a filter or for conditional formatting), use one of the following XSL date or time formats: YYYY-MM-DD or YYYY-MM-DDTHH:MM:SS.







About the Components Pane

The Components pane contains the layout components that you can insert into a report. These components include charts, pivot tables, and images. To insert a component, simply drag and drop it to the layout.

You can also use the Insert menu to add components to the layout.

[image: Description of GUID-2A8EAE76-2EC5-4CE8-B9D2-16ED21A10FA9-default.gif follows]







About the Properties Pane

The Properties pane displays the properties for the selected component. The properties displayed are determined by the selected component. Some of the properties available in the Properties pane are also editable in the dynamic tab for the component.

Click a property value to edit it. The change is applied to the component when you move the cursor out of the field. Collapse or expand a property group by clicking the plus or minus signs beside the group name.

The properties available for each component are discussed in detail in the corresponding section for that component in this chapter. If a property field is blank, then the default is used.

The following figure shows a sample Properties pane for a table column header.

[image: Description of GUID-58C8E216-1337-4B4E-A90B-9FCEA3735D8B-default.gif follows]







About the Tabbed Toolbar

The section defines the tabs and their functions in the Tabbed toolbar.

The Tabbed toolbar contains the following tabs:

	The Insert tab provides the components and page elements that can be placed on a layout. See Inserting Layout Components.


	The Page Layout tab provides common page-level tools and commands. See Page Layout Tab.


	The component-specific tab provides the most commonly used commands and properties for the component that is selected in the layout. For example, when you select a chart, the Chart tab displays. See the section on a specific component for details on the commands.

To set or control more properties for the selected component, open the Properties pane in the accordion pane, as described in About the Properties Pane.






Selecting and Deleting Layout Objects

You can select layout objects to set the focus or remove the object entirely

Each of the component-specific tabs include the Select region.

	The Select tool enables you to control precisely which component on the layout has focus. This ability is particularly helpful when working with a complex layout where components overlap. For example, to select a table, it is sometimes difficult to click the correct spot to select the table and not a column, or header cell. To avoid unnecessary clicking, use the Select tool to precisely select the Table component from the list. 

The following illustration shows the Select tool.

[image: Description of GUID-7F7163DA-5E73-4F33-818F-D156A19BB268-default.gif follows]




	The Delete tool provides a similar function to the Select tool to enable you to precisely select the component to delete.








About the Insert Tab

Use the Insert tab to insert report components and page elements.

[image: Description of GUID-1167D630-5B79-4EFC-8A3F-89622F0D8125-default.gif follows]



The Components group displays the report components that you can insert into the layout. To insert a component, select and drag the item to the desired location in the design area. For more information about each component, see its corresponding section in this chapter.

The Page Elements group contains page-level elements for the report. To insert a page break, the page number, or the total page number calculation, select and drag the component to the desired position in the layout.

Note:
Page Elements are intended for paginated output types, such as PDF and RTF. Using them in interactive or HTML output may have unexpected results.










Generating PDF/X output

PDF/X is a collection of ISO standards that defines methods for the exchange of digital graphic data using PDF to ensure predictable and consistent printing in a professional print environment.

A PDF/X document is a PDF file viewable by PDF readers such as Adobe Reader, but it follows an additional set of rules defined by the ISO specifications. These rules specify both required objects and features not supported for graphics exchange. The PDF/X standard follows strict rules in color management. BI Publisher supports the PDF/X-1a:2003 variation of the PDF/X standard.



Prerequisites

The generation of PDF/X output requires that you obtain the International Color Consortium (ICC) profile data file and place it under <bi publisher repository>/Admin/Configuration. 

The ICC profile is a binary file describing the color characteristics of the intended output device. For production environments, the color profile may be provided by your print vendor or by the printing company that prints the generated PDF/X file. An example of an ICC profile data file is: CoatedFOGRA27.icc.

Profile data is also available from Adobe (http://www.adobe.com/support) or colormanagement.org (http://www.colormanagement.org/).








Requirements and Limitations

PDF/X output has specified requirements and limitations.

The following lists limitations of and requirements for generating PDF/X output:

	Supported template types: The following template types support the generation of PDF/X: RTF, FO, XPT, and XSL. There are no additional template requirements to generate PDF/X. 


	Color requirements: The color data in the template (text color, images, and SVG) is stored as RGB data, but at the time the PDF/X file is generated, the color data is converted to CMYK using an ICC profile that you must provide to BI Publisher. Specify the ICC profile using the PDF/X ICC Profile Data property. See the following table. 


	PDF features not supported in PDF/X documents:

	Transparency (transparent colors render as opaque)


	Encryption





	Font requirements: By default, all fonts are replaced with Albany fonts. To use a different font in the output, specify the font mappings in the report configuration. If Albany fonts are not available in the JVM font directory and you have not specified a font mapping (that is, there is no embeddable font available), the output will not become a valid PDF/X file. In this case, Helvetica font is used.


	Reprocessing by BI Publisher utilities is not supported: Reprocessing of the PDF/X file using the BI Publisher utilities PDFBookBinder, PDFDocMerger, or PDFSignature is not supported. The reprocessed file becomes a regular PDF file and may lose conformance to the PDF/X standard.


	Required report configuration properties: The report run-time properties must be set as shown in the following table.


	Property	Required Setting
	pdf-version

	Must be no higher than 1.4.


	Enable PDF Security

(pdf-security)

	Must be set to false. 


	Encryption Level

(pdf-encryption-level)

	Must be set to 0.


	pdf-font-embedding

	Must be se to true.








Formatting properties specific to PDF/X output can be set in the Report Properties dialog. Of the formatting properties, the following two are required:


	Property	Description	Valid Values
	PDF/X ICC Profile Data

	The name of the ICC profile data file placed under <BI Publisher repository>/Admin/Configuration. 

	ICC profile data file name, for example: CoatedFOGRA27.icc 


	PDF/X output condition identifier

	The name of one of the standard printing conditions registered with ICC. The list of standard CMYK printing conditions to use with PDF/X-1a is provided on the following ICC website: http://www.color.org/chardata/drsection1.xalter.

	A valid "Reference name," for example: FOGRA43








For more information, see PDF/X Output Properties.











Additional Resources

For more information about the PDF/X standard, see these resources.

	Application Notes for PDF/X Standards


	ISO 15930-4:2003 Graphic technology -- Prepress digital data exchange using PDF -- Part 4: Complete exchange of CMYK and spot color printing data using PDF 1.4 (PDF/X-1a)












About Images

The image component enables you to include a graphic in the layout.

BI Publisher supports the following methods for including an image:




	Static image: Upload a static image that is saved in the report file. An uploaded image file must be in one of the following graphic file formats: GIF, JPEG, PNG, or BMP. The image file cannot be larger than 500 KB.


	Static URL: Specify a static link to a URL where an image is stored.


	Dynamic URL: Include the image URL in an element of the data. The value of the element is evaluated at runtime enabling dynamic insertion of images.







To insert an image:



	Drag and drop the image component to the layout.
	In the Insert an Image dialog, specify one of the following sources for the image:	Location: Click Browse to specify the file name and directory of the image on a local or mapped drive to upload the image.


	URL: Enter the URL where the image is stored.


	Field:

Image URL: Select the field from the data that contains a URL to an image.

Alternative Text: If the data includes a field that contains alternative text for the image, then select that field to display alternative text when the report is viewed as HTML.




The following figure shows the Insert an Image dialog set up to retrieve an image URL dynamically from the "Image" data element. The value of the "Name" element is used as alternative text.

[image: Description of GUID-CD40DC16-13E9-49EC-8D3C-20C5A0838B85-default.gif follows]





	Optionally resize the image in one of the following ways:	Drag the right bottom corner of the image. To preserve the aspect ratio when resizing an image, press and hold the Shift key before starting to drag the corner.


	Modify the width and height in the Properties pane.











Completed PDF Layout Example

The figure gives an illustration of a completed PDF layout.

[image: Description of GUID-26BBC7D1-D38B-4004-9BA8-2BE0B1888E37-default.gif follows]









RTF Output Properties

You can configure RTF output with a number of predetermined properties.

Set the properties described in Table 10-* to configure RTF output.





	Property Name	Description
	Enable change tracking

	Default: false

Description: Set to "true" to enable change tracking in the output RTF document.

Internal Name: rtf-track-changes


	Protect document for tracked changes

	Default: false

Description: Set to "true" to protect the document for tracked changes.

Internal Name: rtf-protect-document-for-tracked-changes


	Default font

	Default: Arial:12

Description: Use this property to define the font style and size in RTF output when no other font has been defined. This is particularly useful to control the sizing of empty table cells in generated reports. Enter the font name and size in the following format <FontName>:<size> for example: Arial:12. Note that the font you choose must be available to the BI Publisher processing engine at runtime. See Defining Font Mappings for information on installing fonts for the BI Publisher server and also for the list of fonts predefined for BI Publisher.

Internal Name: rtf-output-default-font











Using FO Elements and XSL Elements

This section describes how to use FO elements and XSL elements.





Using FO Elements

You can use the native FO syntax inside the Microsoft Word form fields.

For more information on XSL-FO see the W3C Website at http://www.w3.org/2002/08/XSLFOsummary.html

The full list of FO elements that BI Publisher supports is in Supported XSL-FO Elements.





Using XSL Elements

You can use any XSL element in the template by inserting the XSL syntax into a form field.

If you are using the basic RTF method, you cannot insert XSL syntax directly into the template. BI Publisher has extended the following XSL elements for use in RTF templates.

To use these in a basic-method RTF template, you must use the BI Publisher Tag form of the XSL element. If you are using form fields, use either option.



Applying a Template Rule

Use this element to apply a template rule to the current element's child nodes.

XSL Syntax: <xsl:apply-templates select="name">

BI Publisher Tag: <?apply:name?>

This function applies to <xsl:template-match="n">, where n is the element name.





Copying the Current Node

Use this element to create a copy of the current node.

XSL Syntax: <xsl:copy-of select="name">

BI Publisher Tag: <?copy-of:name?>





Calling a Named Template

Use this element to call a named template to be inserted into or applied to the current template.

For example, use this feature to render a table multiple times.

XSL Syntax: <xsl:call-template name="name">

BI Publisher Tag: <?call-template:name?>





Declaring a Template

Use this element to apply a set of rules when a specified node is matched.

XSL Syntax: <xsl:template name="name">

BI Publisher Tag: <?template:name?>





Declaring a Variable

Use this element to declare a local or global variable.

XSL Syntax: <xsl:variable name="name">

BI Publisher Tag: <?variable:name?>

Example:

<xsl:variable name="color" select="'red'"/> 


Assigns the value red to the color variable. The variable can then be referenced in the template.





Importing a Style Sheet

Use this element to import the contents of one style sheet into another.

Note:
An imported style sheet has lower precedence than the importing style sheet.



XSL Syntax: <xsl:import href="url">

BI Publisher Tag: <?import:url?>





Defining the Root Element of the Style Sheet

This and the <xsl:stylesheet> element are completely synonymous elements. Both are used to define the root element of the style sheet.

Note:
An included style sheet has the same precedence as the including style sheet.



XSL Syntax: <xsl:stylesheet xmlns:x="url">

BI Publisher Tag: <?namespace:x=url?>

Note:
The namespace must be declared in the template. See Declaring Namespaces.







Formatting Native XSL Numbers

The native XSL format-number function takes a basic format.

The basic format is:

format-number(number,format,[decimalformat])


The following list describes the parameters:

	number - Required. Specifies the number to be formatted.


	format - Required. Specifies the format pattern. Use the following characters to specify the pattern:

	# (Denotes a digit. Example: ####).


	0 (Denotes leading and following zeros. Example: 0000.00).


	. (The position of the decimal point Example: ###.##).


	, (The group separator for thousands. Example: ###,###.##).


	% (Displays the number as a percentage. Example: ##%).


	; (Pattern separator. The first pattern is used for positive numbers and the second for negative numbers).





	decimalformat - Optional. For more information on the decimal format, consult any basic XSLT manual.











XSL Equivalents

BI Publisher provides syntax equivalent with XSL.

The following table lists the BI Publisher simplified syntax with the XSL equivalents.





	Supported XSL Elements	Description	BI Publisher Syntax
	<xsl:value-of select= "name">

	Placeholder syntax

	<?name?>


	<xsl:apply-templates select="name">

	Applies a template rule to the current element's child nodes.

	<?apply:name?>


	<xsl:copy-of select="name">

	Creates a copy of the current node.

	<?copy-of:name?>


	<xsl:call-template name="name">

	Calls a named template to be inserted into/applied to the current template.

	<?call:name?>


	<xsl:sort select="name">

	Sorts a group of data based on an element in the dataset.

	<?sort:name?>


	<xsl:for-each select="name">

	Loops through the rows of data of a group, used to generate tabular output.

	<?for-each:name?>


	<xsl:choose>

	Used in conjunction with when and otherwise to express multiple conditional tests.

	<?choose?>


	<xsl:when test="exp">

	Used in conjunction with choose and otherwise to express multiple conditional tests

	<?when:expression?>


	<xsl:otherwise>

	Used in conjunction with choose and when to express multiple conditional tests

	<?otherwise?>


	<xsl:if test="exp">

	Used for conditional formatting.

	<?if:expression?>


	<xsl:template name="name">

	Template declaration

	<?template:name?>


	<xsl:variable name="name">

	Local or global variable declaration

	<?variable:name?>


	<xsl:import href="url">

	Import the contents of one stylesheet into another

	<?import:url?>


	<xsl:include href="url">

	Include one stylesheet in another

	<?include:url?>


	<xsl:stylesheet xmlns:x="url">

	Define the root element of a stylesheet

	<?namespace:x=url?>











Calling a Subtemplate from an External Source

This section describes how to call a subtemplate that resides outside the catalog.

Note:
These instructions are provided for backward compatibility only. It is recommended that you place subtemplates in the catalog.



Note that localization is not supported for subtemplates that are maintained outside the catalog.



Importing a Subtemplate Outside the Catalog over HTTP or FTP

Use a standard protocol, such as http or ftp and enter the import statement as shown here.

<?import:http//myhost:8080/subtemplate.rtf?>








Importing Subtemplates Outside the Catalog on the Same Server

If the subtemplate is located on the server, but not in the BI Publisher catalog, then enter this.

<?import:file://{template_path}?>

where

template_path is the path to the subtemplate file on the server

For example:

<?import:file://c:/Folder/mySubtemplate.rtf?>









Required Settings To Run Sub Templates Stored Outside the Catalog

To run sub templates outside the catalog you must configure the disable external references property.

Using sub templates requires the following FO processing configuration property setting for the report:

Disable external references: Must be set to False






17 Translating Catalog Objects, Data Models, and Templates

This chapter describes translating BI Publisher catalog objects, data models, and templates using the Export XLIFF function that is available at the catalog level.


This chapter includes the following sections:

	Overview


	What Can Be Translated?


	Exporting the XLIFF File


	Identifying and Updating the Object Tags


	Importing the XLIFF File







Considerations When Using the Customize Feature

When you click the Customize link, the report and the folder structure are copied to the Custom folder. The custom report still references the original data model. The data model is not copied. Because the data model referenced by the custom report is the original data model, an Oracle patch that updates the data model may impact the running of your custom report if the data structure is changed.

When an Oracle patch is applied that updates the original report, the custom report is not updated in any way.

When a custom version of a report exists, performing tasks on the original report will have the following results:


	Task Performed on the Original Report	Behavior When a Custom Report Is Present
	Open

	Opens the custom report.


	Schedule

	Creates a report job for the custom report.


	Edit

	Edits the custom report.


	Delete

	Deletes the original report (only).


	Copy

	Copies the original report.


	Cut/Paste

	Cuts and pastes the original report.


	Rename

	Renames the original report. The custom report name is not changed.


	Download

	Downloads the custom report.


	Customize

	Edits the custom report.








To apply further edits to a report in the Custom folder perform one of the following




	Select the Customize or Edit option for the original report; this action opens the existing customized report.


	 Navigate to the custom report in the Custom folder and select Edit.




If you manually create the identical folder path to a report under the Custom folder and create a report with the same name, BI Publisher treats the identically named report as a customized report and will run this report instead of the original report, as if you had used the Customize option to create it.

If you delete the original report, the custom report is not deleted. If you delete the custom report, the original report is not deleted. 







Overview

This chapter describes how to create and upload translated template files when you want to provide translations only for specific templates.

The following template types can be translated individually: 

	RTF layout files


	style templates


	subtemplates


	BI Publisher layouts (.xpt)




To translate the layouts within the broader scope of the catalog, see Translating Catalog Objects, Data Models, and Templates.




About Translations

BI Publisher provides the ability to create an XLIFF file from RTF templates. XLIFF is the XML Localization Interchange File Format. It is the standard format used by localization providers. Using BI Publisher's XLIFF generation tool you can generate the standard translation file of an RTF template.

You can then translate this file (or send to a translation provider). Once translated, the file can be uploaded to the report definition under the appropriate locale setting so that at runtime the translated report runs automatically for users who select the corresponding locale.

For more information, see Translation Support Overview and Concepts.




Adding Layouts to the Report Definition

You can add a layout to a report by any of the three options.

To add a new layout, from the report editor, click Add New Layout. The Add Layout page is shown in the following figure.

[image: Description of GUID-9A5C4B0E-FBA4-49C2-9471-F3E6A0012878-default.gif follows]



There are three options for adding a layout to a report:




	Create Layout - Select one of the basic or shared templates to launch the Layout Editor.


	Upload Layout - Upload a template file layout that you have designed in one of the supported file types.


	Generate Layout - Automatically generate a simple RTF layout.









Adding a Layout Using the Layout Editor

Follow these steps to add a layout using the Layout Editor.

To add a layout using the Layout Editor:



	Under the Create Layout region, click one of the basic or shared templates to launch the Layout Editor. The shared templates are preformatted layouts with common report components already inserted.
	Design the template. For information on using the Layout Editor, see Creating BI Publisher Layout Templates.
	When finished, click Save. In the Save Template dialog enter a name for this layout and select a locale. Click Save.
	Click Return to return to the Report Editor.
	Configure the settings for the layout. See Configuring Layouts Using the List View.






Adding a Layout by Uploading a Template File

Uploading a template file assumes that you have followed the instructions in this guide for creating a template file (RTF, PDF, Excel, Flash, or eText).

To add a layout by uploading a template file:



	Under the Upload or Generate Layout region, click the Upload icon.
	In the Upload dialog, perform the following:	Enter a Layout Name.


	Click Browse to locate the Template File in the local file system.


	Select the Template Type from the list.


	Select the Template Locale from the list.


	Click Upload.








If you are connected to BI Publisher through the Template Builder you can upload the layout file directly from the client tool. 

For more information, see Creating RTF Templates Using the Template Builder for Word.








Adding a Layout by Generating a Template File

Follow these steps to add a layout by generating a template file.

To add a layout by generating a template file:



	Under the Upload or Generate Layout region, click the Generate icon.
	In the Autogenerate Layout dialog, perform the following:	Enter a Template Name for the layout.


	Click Generate.








The autogenerate feature creates a simple table-based RTF layout that includes all the fields in the data model.

Note:
The autogenerate layout feature can only be used with data sets for which metadata is available. Therefore this feature cannot be used with data sets generated from stored XML files, HTTP feeds, Web services, or migrated data templates.











Requirements

To apply or edit form fields in a PDF document, you must have Adobe Acrobat Professional.

BI Publisher supports Adobe Acrobat 5.0 and later as a tool for updating the template. 

BI Publisher generates the output PDF version based on the input PDF version as follows: 

	PDF version 1.4 and earlier generates PDF 1.4


	PDF version 1.5 and later generates the same output version as the input version




Note:
BI Publisher supports the PDF 1.7 standard. For more information, see PDF Version Support.




Setting Properties for PDF Output

The Report Properties page includes a set of properties specific to rendering Flash templates.

These properties enable you to specify the size and placement of the Flash object when you select PDF as the output type.

Note:
To produce PDF output, you must specify the height and width of the template in the Flex Builder. See Creating the Layout.

To set properties for the PDF output:




	Navigate to the report in the catalog. Click Edit to launch the Report Editor.
	In the Report Editor, click Properties to open the Report Properties dialog.
	Click the Formatting tab and scroll down to the set of properties under the Flash heading.The following illustration shows the Flash heading in the Formatting tab.

[image: Description of GUID-B2E3628C-8C0D-44EA-A12E-DAC46D15FDBF-default.gif follows]





	Enter values for the properties. Note that no properties are required. If you do not enter any values, the default values assume an 11 inch by 8.5 inch document (standard landscape), with a quarter inch inset from the upper left corner of the page as the insertion point of the Flash object. The default area in the document is the size of the SWF object.	Page width of wrapper document - specify in points the width of the output PDF document. The default is 792, or 11 inches.


	Page height of wrapper document - specify in points the height of the output PDF document. The default is 612, or 8.5 inches.


	Start x position of Flash area in PDF - using the left edge of the document as the 0 axis point, specify in points the beginning horizontal position of the Flash object in the PDF document. The default is 18, or .25 inch.


	Start y position of Flash area in PDF - using the upper left corner of the document as the 0 axis point, specify in points the beginning vertical position of the Flash object in the PDF document. The default is 18, or .25 inch.


	Width of Flash area - enter in points the width of the area in the document for the Flash object to occupy. The default is the width of the SWF object.


	Height of Flash area - enter in points the height of the area in the document for the Flash object to occupy. The default is the height of the SWF object.











Part III Translating Reports and Catalog Objects

This part provides information about translating reports and catalog objects.

This part includes the following chapters:

	Translation Support Overview and Concepts


	Translating Individual Templates


	Translating Catalog Objects, Data Models, and Templates







Creating a Layout from a Predefined PDF Form

There are many PDF forms available online that you may want to use as layouts for the report data. For example, government forms that your company is required to submit. You can use these downloaded PDF files as the report layouts, supplying the XML data at runtime to fill in the report fields.

Some of these forms already have form fields defined, some do not. See Determining If a PDF Has Form Fields Defined if you are unsure. If the PDF form already has fields defined, then you can use one of the following methods to match the form field names to the data field names:




	Use Adobe Acrobat Professional to rename the fields in the document to match the names of the elements in the XML data file. See Using a Predefined PDF Form as a Layout by Renaming the Form Fields.


	Use BI Publisher's Data Model Editor to rename the XML element names in the data file to match the field names in the PDF form. For information, see Structuring Data in Data Modeling Guide for Oracle Business Intelligence Publisher.




If the form fields are not already defined in the downloaded PDF, then you must create them. See Adding Markup to the Template for instructions on inserting the form field placeholders.






Determining If a PDF Has Form Fields Defined

Follow these steps to determine if a PDF has form fields defined and to get a list of the field names.

To determine if the PDF form has form fields defined:


	Open the document in Adobe Acrobat Reader or Adobe Acrobat Professional.


	Click Highlight Fields. Form fields that exist in the document are highlighted.




document-repeat-elementname — The PDF form field, document-repeat-elementname, is added in the pdf template. The FormProcessor picks up this field at the beginning of its process and switches to the document repeat engine if document-repeat-elementname is set.




To get a list of the field names:


	Open the document in Adobe Acrobat Professional.
	From the Form menu, select Add or Edit Fields. The field names display in the document as well as in the Fields pane.






Using a Predefined PDF Form as a Layout by Renaming the Form Fields

You can use a PDF form as a template for another form.

To use a predefined PDF form as a layout:




	Download or import the PDF file to the local system.
	Open the file in Adobe Acrobat Professional.
	From the Form menu, select Add or Edit Fields. This highlights text fields that have already been defined.The following illustration shows a sample W-2 PDF form after selecting Add or Edit Fields to highlight the text fields.

[image: Description of GUID-7FE31CD0-D222-4511-9A2D-AC4E89D00842-default.gif follows]



To map the existing form fields to the data from the incoming XML file, rename the fields to match the element names in the XML file.



	Open the form field Text Field Properties dialog by either double-clicking the field, or by selecting the field then selecting Properties from the right-mouse menu.
	In the Name field, enter the element name from the input XML file.
	Repeat for all fields that you want populated by the data file.
	When all fields have been updated, click Close Form Editing.
	Save the layout.






Using the Comb of Characters Option

The comb of characters option for a PDF form field in Adobe Acrobat spreads the text evenly across the width of the text field.

Use this option when the form field requires the characters to be entered in specific positions, as the Routing number field shown in the following figure:


[image: Description of GUID-6C8FD3DC-832E-43EB-9E21-450E25775FEC-default.gif follows]





To use this feature, perform the following:




	In Adobe Acrobat Professional, add the form field as a text field. An example is shown in the following figure:
[image: Creating the routing form field]






	Open the Text Field Properties dialog and click the Options tab. Clear all check boxes and select the Comb of characters check box. Note:
The Comb of characters option is only enabled when all other options are cleared.

Enter the number of characters in the text field. For the routing number example, a value of 9 is entered in the Comb of field as shown in the following figure:[image: Description of GUID-ABCD3C23-1EF9-40AD-8CAD-8813E7C4CBA4-default.gif follows]





If your data may not contain the number of characters specified each time, you can set the Alignment option to specify whether the value will be aligned to the right, left, or center within the field.





When you run the report, the characters comprising the value for the routing field will be spread across the text field as shown in the following figure:

[image: Description of GUID-D1FA1744-1270-4A82-BF64-826677659953-default.gif follows]



The following figure shows how the data will display in the field when the data for the routing field does not contain the full nine characters and the Alignment option is set to left:

[image: Description of GUID-6D7A55EE-F9CF-4804-9B53-080120BFBD4C-default.gif follows]











Understanding Mappings Between the Template and the Data

When you design Excel templates use the Excel Template Builder for inserting fields and repeating groups to your template.

When the Template Builder inserts a field or repeating group it creates a mapping between the data and the spreadsheet and writes the mapping to a hidden sheet called the XDO_METADATA sheet. The Template Builder creates the hidden XDO_METADATA sheet the first time you insert a field or repeating group. 

To view or update the XDO_METADATA sheet unhide the sheet. To add calculations or more advanced functions, enter the XSL functions directly in the XDO_METADATA sheet using the named mappings created by the Template Builder. For more information about template-data mappings, see Understanding Excel Template Concepts.




9 Creating Flash Templates

BI Publisher's support for Flash templates enables you to develop Adobe Flex templates that can be applied to BI Publisher reports to generate interactive Flash output documents. This chapter describes how to create Flash templates.

This chapter includes the following sections:

	Overview


	Building a Flash Template


	Uploading the Flash Template to the Report Definition


	Setting Properties for PDF Output
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Reusing Static Content

This section describes how to reuse static, repeating content in a PDF report output to reduce the overall PDF file size.

This section contains the following topics:

	What Is Static Content Reuse?


	Limitations of this Feature


	Defining Reusable Content in an RTF Template


	Example






What Is Static Content Reuse?

If the report contains static content and the placement of that content in the report is also fixed (for example, a set of instructions on the back of a Federal W-2 form), then you can use this feature of BI Publisher to reduce the size of the generated PDF file.

Using the W-2 form as an example, the report has the expected output shown in the following illustration.

[image: Description of GUID-A54DABA1-5E20-40A8-BE1B-62512AACD606-default.gif follows]



For each employee, specific content is rendered, but the back (or second) page of each contains an identical set of instructions.

This set of instructions can be defined as reusable static content. When content is identified as reusable static content, BI Publisher includes the static content in the generated PDF document only once and references it in other places when needed, thereby reducing the overall output file size.





Limitations of this Feature

This feature has the following limitations.

	The static content to be reused in the generated report must fit onto one page of the generated PDF output.


	The contents of the report before the static content must have a fixed height. For example, the W-2 form has a fixed set of fields that occur before the static content is to be rendered. The reusable static contents are placed in the same position from the page origin for each occurrence.


	This feature can only be used with RTF templates generating PDF output.











Defining Reusable Content in an RTF Template

To define the static content to be reused, use these tags around the content in the template.

<?reusable-static-content:?>


… static content here …

<?end reusable-static-content?>


Inserting these tags around the static content signals BI Publisher to include this content only once in the generated file and then reference it in the same position for each occurrence.








Example

This example illustrates an implementation of this feature. The sample report generates one occurrence per employee. The generated report has employee-specific information on the front page of each occurrence, and static instructions that print on the back of each occurrence. A section break occurs after each employee to reset page numbering.

The following figure illustrates the template structure:


[image: Description of GUID-3E704F56-0DA9-44A8-BD87-482A163589C2-default.gif follows]










Assigning a Style Template to a Report Layout

Follow these steps to assign a style template to a report layout.

To assign a style template to a report layout:



	Navigate to the report in the catalog and click Edit to open the report editor.
	From the default thumbnail view, select View a List. In the Layout region, click the Choose icon to search for and select the style template from the BI Publisher catalog.
	For the layout templates that you want to use the style template, select the Apply Style Template box for the template. Note that the box is only enabled for RTF templates.


The following figure highlights the actions required to enable a style template in the Report Editor.


[image: Description of GUID-73AAA025-CDDC-4665-994F-F4E1DF50719F-default.gif follows]











Extended SQL and XSL Functions

BI Publisher has extended a set of SQL and XSL functions for use in RTF templates.

The syntax for these extended functions is

<?xdofx:expression?>

for extended SQL functions or

<?xdoxslt:expression?>

for extended XSL functions.

You cannot mix xdofx statements with XSL expressions in the same context. For example, assume that you had two elements, FIRST_NAME and LAST_NAME to concatenate into a 30-character field and right pad the field with the character "x". You could not use the following:

Incorrect:

<?xdofx:rpad(concat(FIRST_NAME,LAST_NAME),30, 'x')?>


because concat is an XSL expression. Instead, you could use the following:

Correct:

<?xdofx:rpad(FIRST_NAME||LAST_NAME),30,'x')?>


The supported functions are shown in the following table:





	SQL Statement or XSL Expression	Usage	Description
	2+3

	<?xdofx:2+3?>

	Addition


	2-3

	<?xdofx:2-3?>

	Subtraction


	2*3

	 <?xdofx:2*3?>

	Multiplication


	2 div 3

	<?xdofx:2 div 3?>

	Division


	2**3

	<?xdofx:2**3?>

	Exponential


	3||2

	<?xdofx:3||2?>

	Concatenation


	sdiv()

	<?xdoxslt:sdiv(num1,num2, string)?>

	Safe divide function returns a specified value if the result of the function is not a number (NaN). In the syntax shown, num1 is the dividend; num2 is the divisor and string is the value to be returned if NaN is returned. 

Examples: 

<?xdoxslt:sdiv(10,0, '0')?> would yield '0' 

<?xdoxslt:sdiv(10,0, 'None')?> would yield 'None'.


	lpad('aaa',10,'.')

	<?xdofx:lpad('aaa',10,'.')?>

	The lpad function pads the left side of a string with a specific set of characters. The syntax for the lpad function is: lpad(string1,padded_length,[pad_string])string1 is the string to pad characters to (the left-hand side).padded_length is the number of characters to return.pad_string is the string that is padded to the left-hand side of string1 .


	rpad('aaa',10,'.')

	<?xdofx:rpad('aaa',10,'.')?>

	The rpad function pads the right side of a string with a specific set of characters. The syntax for the rpad function is: rpad(string1,padded_length,[pad_string]).string1 is the string to pad characters to (the right-hand side).padded_length is the number of characters to return.pad_string is the string that is padded to the right-hand side of string1


	trim()

	<?xdoxslt:trim(' a ')?>

	Removes spaces in a string. Enter the text to be trimmed, the function returns the trimmed text.


	ltrim()

	<?xdoxslt:ltrim(' a ')?>

	Removes the leading white spaces in a string.


	rtrim()

	<?xdoxslt:rtrim(' a ')?>

	Removes the trailing white spaces in a string.


	truncate

	<?xdoxslt:truncate ( number [, integer ] )?>

	The truncate function returns number truncated to integer places right of the decimal point. If integer is omitted, then number is truncated to the whole integer value. integer can be negative to truncate values left of the decimal point. integer must be an integer. Example: <?xdoxslt:truncate(-2.3333)?> returns -2 Example: <?xdoxslt:truncate(2.7777, 2)?> returns 2.77 Example: <?xdoxslt:truncate(27.7777, -1)?> returns 20


	replicate

	<?xdoxslt:replicate('string', integer)?>

	The replicate function replicates the specified string the specified number of times. Example: <?xdoxslt:replicate('oracle', 3)?> returns oracleoracleoracle


	decode('xxx','bbb','ccc','xxx','ddd')

	<?xdofx:decode('xxx','bbb','ccc','xxx','ddd')?>

	The decode function has the functionality of an IF-THEN-ELSE statement. The syntax for the decode function is: decode(expression, search, result [,search, result]...[, default])expression is the value to compare.search is the value that is compared against expression.result is the value returned, if expression is equal to search.default is returned if no matches are found.


	Instr('abcabcabc','a',2)

	<?xdofx:Instr('abcabcabc','a',2)?>



	The instr function returns the location of a substring in a string. The syntax for the instr function is: instr(string1,string2,[start_position],[nth_appearance])string1 is the string to search.string2 is the substring to search for in string1.start_position is the position in string1 where the search starts. The first position in the string is 1. If the start_position is negative, the function counts back start_position number of characters from the end of string1 and then searches towards the beginning of string1.nth appearance is the nth appearance of string2.


	substr('abcdefg',2,3)

	<?xdofx:substr('abcdefg',2,3)?>

	The substr function allows you to extract a substring from a string. The syntax for the substr function is: substr(string, start_position, length)string is the source string.start_position is the position for extraction. The first position in the string is always 1.length is the number of characters to extract.


	left

	<?xdoxslt:left('abcdefg', 3)?>

	Enables you to extract the specified number of characters from a string, starting from the left. The syntax is left(string, Numchars) For example, <?xdoxslt:left('abcdefg', 3)?> returns abc


	right

	<?xdoxslt:right('abcdefg', 3)?>

	Enables you to extract the specified number of characters from a string, starting from the right. The syntax is right(string, Numchars) For example, <?xdoxslt:right('abcdefg', 3)?> returns efg


	replace(name,'John','Jon')

	<?xdofx:replace(name,'John','Jon')?>

	The replace function replaces a sequence of characters in a string with another set of characters. The syntax for the replace function is: replace(string1,string_to_replace,[replacement_string])string1 is the string to replace a sequence of characters with another set of characters.string_to_replace is the string that is searched for in string1.replacement_string is optional. All occurrences of string_to_replace are replaced with replacement_string in string1.


	to_number('12345')

	<?xdofx:to_number('12345')?>

	Function to_number converts char, a value of CHAR, VARCHAR2, NCHAR, or NVARCHAR2 datatype that contains a number in the format that is specified by the optional format model fmt, to a value of NUMBER datatype.


	format_number

	<?xdoxslt:format_number(12345, n, $_XDOLOCALE)?>

	Converts a number to a string and formats the number according to the locale specified in $_XDOLOCALE and to the number of decimal positions specified in n using Java's default symbols. For example: <?xdoxslt:format_number(-12345, 2, 'fr-FR')?> returns -12 345,00


	format_number

	<?xdoxslt:format_number(12345, n, s1, s2,$_XDOLOCALE)?>

	Converts a number to a string and uses the specified separators: s1 for the thousand separator and s2 for the decimal separator. For example: <?xdoxslt:format_number(12345, 2, 'g', 'd', $_XDOLOCALE)?> returns 12g345d00


	pat_format_number

	<?xdoxslt:pat_format_number(12345, '##,##0.00', $_XDOLOCALE)?>

	Returns a number formatted with the specified pattern. For example: <?xdoxslt:pat_format_number(12345, '##,##0.00', $_XDOLOCALE)?> returns 12,345.00


	to_char(12345)

	<?xdofx:to_char('12345')?>

	Use the TO_CHAR function to translate a value of NUMBER datatype to VARCHAR2 datatype.


	to_date

	<?xdofx:to_date ( char [, fmt [, 'nlsparam']] )

	TO_DATE converts char of CHAR, VARCHAR2, NCHAR, or NVARCHAR2 datatype to a value of DATE datatype. The fmt is a date format specifying the format of char. If you omit fmt, then char must be in the default date format. If fmt is 'J', for Julian, then char must be an integer.


	format_date()

	<?xdoxslt:format_date(./AnyDate,'yyyy-MM-dd','MM/dd/yyyy', $_XDOLOCALE, $_XDOTIMEZONE)?>

	Reads date in one format and creates in another format.


	sysdate()

	<?xdofx:sysdate()?>

	SYSDATE returns the current date and time in XML canonical date format (for example: 1997-07-16T19:20:30.45+01:00). The datatype of the returned value is DATE. The function requires no arguments. See Displaying the System Date (sysdate) in Reports for information on properly formatting the sysdate in report output.


	current_date()

	<?xdoxslt:current_date($_XDOLOCALE, $_XDOTIMEZONE)?> Example: <?xdoxslt:current_date('ja-JP', 'Asia/Tokyo')?>

	Returns the current date in yyyy-MM-dd format in the given locale and timezone. This function supports only the Gregorian calendar.


	current_time()

	<?xdoxslt:current_time($_XDOLOCALE, $_XDOTIMEZONE)?> Example: <?xdoxslt:current_time('ja-JP', 'Asia/Tokyo')?>

	Returns the current time in the given locale and timezone. This function supports only the Gregorian calendar.


	minimum

	<?xdoxslt:minimum(ELEMENT_NAME)?>

	Returns the minimum value of the element in the set.


	date_diff

	<?xdoxslt:date_diff('y', 'YYYY-MM-DD', 'YYYY-MM-DD', $_XDOLOCALE, $_XDOTIMEZONE)?>

	This function provides a method to get the difference between two dates in the given locale. The dates must be in "yyyy-MM-dd" format. This function supports only the Gregorian calendar. The syntax is as follows: <?xdoxslt:date_diff('format', 'YYYY-MM-DD', 'YYYY-MM-DD', $_XDOLOCALE, $_XDOTIMEZONE)?> where format is the time value for which the difference is to be calculated. Valid values are:

	y - for year


	m - for month


	w - for week


	d - for day


	h - for hour


	mi - for minute


	s - for seconds


	ms - for milliseconds




Example: <?xdoxslt:date_diff('y', '2000-04-08', '2001-05-01', $_XDOLOCALE, $_XDOTIMEZONE)?> 

returns 1

Example: <?xdoxslt:date_diff('m', '2001-04-08', '2000-02-01', $_XDOLOCALE, $_XDOTIMEZONE)?>

returns -14

Example: <?xdoxslt:date_diff('d', '2006-04-08', '2006-04-01', $_XDOLOCALE, 'America/Los_Angeles')?>

returns -7


	sec_diff

	<?xdoxslt:sec_diff('2000-04-08T20:00:00', '2000-04-08T21:00:00', $_XDOLOCALE, $_XDOTIMEZONE?>

	This function provides a method to get the difference between two dates in seconds in the given locale. The dates must be in "yyyy-MM-dd'T'HH:mm:ss". This function supports only Gregorian calendar. Example: <?xdoxslt:sec_diff('2000-04-08T20:00:00', '2000-04-08T21:00:00', $_XDOLOCALE, $_XDOTIMEZONE?> returns 3600


	get_day

	<?xdoxslt:get_day('2000-04-08', $_XDOLOCALE)?>

	This function provides a method to get the day value of a date in yyyy-MM-dd format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_day('2000-04-08', $_XDOLOCALE)?> returns 8


	get_month

	<?xdoxslt:get_month('2000-04-08', $_XDOLOCALE)?>

	This function provides a method to get the month value of a date in yyyy-MM-dd format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_month('2000-04-08', $_XDOLOCALE)?> returns 4


	get_year

	<?xdoxslt:get_year('2000-04-08', $_XDOLOCALE)?>

	This function provides a method to get the year value of a date in yyyy-MM-dd format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_year('2000-04-08', $_XDOLOCALE)?> returns 2000


	month_name

	<?xdoxslt:month_name(1, 0, $_XDOLOCALE)?>

	This function provides a method to get the name of the month in the given locale. This function supports only the Gregorian calendar. The syntax for this function is: <?xdoxslt:month_name(month, [abbreviate?], $_XDOLOCALE)?> where month is the numeric value of the month (Januany = 1) and [abbreviate?] is the value 0 for do not abbreviate or 1 for abbreviate. Example: <?xdoxslt:month_name(12, 1, 'fr-FR')?> returns dec. Example" <?xdoxslt:month_name(1, 0, $_XDOLOCALE)?> returns January


	maximum

	<?xdoxslt:maximum(ELEMENT_NAME)?>

	Returns the maximum value of the element in the set.


	abs

	<?xdoxslt:abs(-123.45)?>

	Returns the absolute value of the number entered. Example: <?xdoxslt:abs(-123.45)?> Returns: 123.45


	chr

	<?xdofx:chr(n)?>

	CHR returns the character having the binary equivalent to n in either the database character set or the national character set.


	ceil

	<?xdofx:ceil(n)?>

	CEIL returns smallest integer greater than or equal to n.


	floor

	<?xdofx:floor(n)?>

	FLOOR returns largest integer equal to or less than n.


	round (SQL function)

	<?xdofx:round ( number [, integer ] )?>

	ROUND returns number rounded to integer places right of the decimal point. If integer is omitted, then number is rounded to 0 places. integer can be negative to round off digits left of the decimal point. integer must be an integer. Example: <?xdofx:round (2.777)?> returns 3 Example: <?xdofx:round (2.777, 2)?> returns 2.78


	round (XSLT function)

	<?xdoxslt:round ( number [, integer ] )?>

	ROUND returns number rounded to integer places right of the decimal point. If integer is omitted, then number is rounded to 0 places. integer can be negative to round off digits left of the decimal point. integer must be an integer. Example: <?xdoxslt:round (2.777)?> returns 3 Example: <?xdoxslt:round (2.777, 2)?> returns 2.78


	lower

	<?xdofx:lower (char)?>

	LOWER returns char, with all letters lowercase. char can be any of the datatypes CHAR, VARCHAR2, NCHAR, NVARCHAR2, CLOB, or NCLOB. The return value is the same datatype as char.


	upper

	<?xdofx:upper(char)?>

	UPPER returns char, with all letters uppercase. char can be any of the datatypes CHAR, VARCHAR2, NCHAR, NVARCHAR2, CLOB, or NCLOB. The return value is the same datatype as char.


	length

	<?xdofx:length(char)?>

	The "length" function returns the length of char. LENGTH calculates length using characters as defined by the input character set.


	greatest

	<?xdofx:greatest ( expr [, expr]... )?>

	GREATEST returns the greatest of the list of exprs. All exprs after the first are implicitly converted to the datatype of the first expr before the comparison.


	least

	<?xdofx:least ( expr [, expr]... )?>

	LEAST returns the least of the list of exprs. All exprs after the first are implicitly converted to the datatype of the first expr before the comparison.


	next_element

	<?xdoxslt:next_element(current-group(),.,'<element-name>')?>

	Method to get the next element in the current group. Returns the element that occurs after the element named. For example: <?xdoxslt:next_element(current-group(),.,'employee')?> returns the element that occurs in the current group after "employee".


	prev_element

	<?xdoxslt:prev_element(current-group(),..,'<element-name')?>

	Method to get the previous element in the current group. Returns the element that occurs before the element named. For example: <?xdoxslt:prev_element(current-group(),.,'employee')?> returns the element that occurs in the current group before "employee".


	set_array

	<?xdoxslt:set_array($_XDOCTX, '<name of hash table>', n, '<value>')?>

	Sets a value in a hash table. Syntax is <?xdoxslt:set_array($_XDOCTX, '<name of hash table>', n, '<value>')?>where $_XDOCTX is required to set the context, <name of hash table> is the name that you supply for your table n is the index of the hash table <value> is the value to set in the hash table. For example: <?xdoxslt:set_array($_XDOCTX, 'Employee', 2, 'Jones')?> See get_array below.


	get_array

	<?xdoxslt:get_array($_XDOCTX, '<name of hash table>', n)?>

	Returns the value at the specified index of the hash table. Syntax is <?xdoxslt:get_array($_XDOCTX, '<name of hash table>', n)?> where $_XDOCTX is required to set the context, <name of hash table> is the name you supplied for your table in set_array n is the index value of the element you want returned. For example, used in conjunction with the set_array example above, <?xdoxslt:get_array($_XDOCTX, 'Employee', 2)?> returns Jones








The following table shows supported combination functions.





	SQL Statement	Usage
	(2+3/4-6*7)/8

	<?xdofx:(2+3/4-6*7)/8?>


	lpad(substr('1234567890',5,3),10,'^')

	<?xdofx:lpad(substr('1234567890',5,3),10,'^')?>


	decode('a','b','c','d','e','1')||instr('321',1,1)

	<?xdofx:decode('a','b','c','d','e','1')||instr('321',1,1)?>










Number-To-Word Conversion

This function enables the conversion of numbers to words for RTF template output.

This is a common requirement for check printing.

The new function is "to_check_number". The syntax of this function is

<?xdofx:to_check_number(amount, precisionOrCurrency, caseType, decimalStyle)?>


The following table describes the function attributes.





	Attribute	Description	Valid Value
	amount

	The number to be transformed.

	Any number


	precisionOrCurrency

	For this attribute you can specify either the precision, which is the number of digits after the decimal point; or the currency code, which governs the number of digits after the decimal point. The currency code does not generate a currency symbol in the output.

	An integer, such as 2; or a currency code, such as 'USD'.


	caseType

	The case type of the output.

	Valid values are: 'CASE_UPPER', 'CASE_LOWER', 'CASE_INIT_CAP'


	decimalStyle

	Output type of the decimal fraction area.

	Valid values are: 'DECIMAL_STYLE_FRACTION1', 'DECIMAL_STYLE_FRACTION2', 'DECIMAL_STYLE_WORD'








The following table displays the example function as entered in an RTF template and the returned output.





	RTF Template Entry	Returned Output
	<?xdofx:to_check_number(12345.67, 2)?>

	Twelve thousand three hundred forty-five and 67/100


	<?xdofx:to_check_number(12345.67, 'USD')?>

	Twelve thousand three hundred forty-five and 67/100


	<?xdofx:to_check_number(12345, 'JPY', 'CASE_UPPER')?>

	TWELVE THOUSAND THREE HUNDRED FORTY-FIVE


	<?xdofx:to_check_number(12345.67, 'EUR', 'CASE_LOWER', 'DECIMAL_STYLE_WORDS')?>

	twelve thousand three hundred forty-five and sixty-seven












Using XSLT Profiling in Template Viewer

XSL time logging commands are added to the XSL template to enable time measurements, which acts as a profiling tool. When the template is run, a log.csv file is generated which measures the time across  the XSL code.

To add XSLT profiling to template viewer:


The Inject Profiling into XSL check box must be enabled to use the XSL profiling feature.


	Select XML data file and RTF template file.
	Select Tools to turn the feature On.
	Select Generate XSL file from.
	Select Inject Profiling into XSL.The Generate XSL file from check box is enabled.

	Select RTF Template to generate XSL.The following text is printed in the Console panel: [120915_155214452][oracle.xdo.common.xml.XSLTProfiler][EVENT] XSLTProfiler in: BUPAY018-fix.xsl',  out: 'BUPAY018-fix-prf.xsl'

	Continue to select the XML data file on the left Data pane and the XSL template in the right Template pane.
	Click the Start Processing button.The PDF file is generated.Note:
The following text is printed in the console: [120915_160303478][][EVENT] Output of stopwatch_print is "C:\Users \hlie\cases\ER22309878\xdoxslt_nioDL8xUgG2597685428907396602_log.csv".
[image: Description of GUID-88D6547C-F909-490E-A4B1-33EE37E77421-default.gif follows]









	Open the file using MS Excel.Note the top three time consuming areas.








Inserting Images and Charts

BI Publisher supports several methods for including images in the published document.

The following sections describe these options:

	Directly Inserting Images


	Inserting Images with URL References


	Inserting Images with an Element Reference from an XML File


	Rendering an Image Retrieved from BLOB Data


	Adding Charts to Templates






Directly Inserting Images

Insert the jpg, gif, or png image directly in the template.





Inserting Images with URL References

Include an alternative text link for an image.

To insert images with URL references:




	Insert a dummy image in the template.
	In Microsoft Word's Format Picture dialog box select the Web tab. Enter the following syntax in the Alternative text region to reference the image URL:url:{'http://<image location>'}

For example, enter:

url:{'http://www.example.com/images/ora_log.gif'}









Inserting Images with an Element Reference from an XML File

Include a link to an XML file for an image.

To insert images with element references:




	Insert a dummy image in the template.
	In Microsoft Word's Format Picture dialog box select the Web tab. Enter the following syntax in the Alternative text region to reference the image URL:url:{IMAGE_LOCATION}

where IMAGE_LOCATION is an element from the XML file that holds the full URL to the image.

You can also build a URL based on multiple elements at runtime. Just use the concat function to build the URL string. For example:

url:{concat(SERVER,'/',IMAGE_DIR,'/',IMAGE_FILE)}

where SERVER, IMAGE_DIR, and IMAGE_FILE are element names from the XML file that hold the values to construct the URL.

This method can also be used with the OA_MEDIA reference as follows:

url:{concat('${OA_MEDIA}','/',IMAGE_FILE)}









Rendering an Image Retrieved from BLOB Data

You can include an image stored as a BLOB in a form.

If results XML contains image data that had been stored as a BLOB in the database, then use the following syntax in a form field inserted in the template where you want the image to render at runtime:

<fo:instream-foreign-object content-type="image/jpg">
<xsl:value-of select="IMAGE_ELEMENT"/>
</fo:instream-foreign-object>


where

image/jpg is the MIME type of the image (other options might be: image/gif and image/png)

and

IMAGE_ELEMENT is the element name of the BLOB in the XML data.

Note that you can specify height and width attributes for the image to set its size in the published report. BI Publisher scales the image to fit the box size that you define. For example, to set the size of the example above to three inches by four inches, enter the following:

<fo:instream-foreign-object content-type="image/jpg" height="3 in" width="4 in">
<xsl:value-of select="IMAGE_ELEMENT"/>
</fo:instream-foreign-object>


Specify in pixels as follows:

<fo:instream-foreign-object content-type="image/jpg" height="300 px" width="4 px">
...


or in centimeters:

<fo:instream-foreign-object content-type="image/jpg" height="3 cm" width="4 cm">
...


or as a percentage of the original dimensions:

<fo:instream-foreign-object content-type="image/jpg" height="300%" width="300%">
...






Adding Charts to Templates

Follow these steps to add a chart to the template.

The following list summarizes the steps to add a chart to the template. These steps are discussed in detail in this section with an example.




	Insert a dummy image in the template to define the size and position of the chart.
	Add the definition for the chart to the Alternative text box of the dummy image. The chart definition requires XSL commands.
	At runtime BI Publisher calls the charting engine to render the image that is then inserted into the final output document.


Note that RTF output is limited to raster images. PDF and HTML output support raster and vector images.

Note:
For more information, see Inserting a Chart.








Adding a Sample Chart

Follow this illustration to add a sample chart.

Following is a piece of XML data showing total sales by company division.

<sales year=2004>
 <division>
  <name>Groceries</name>
  <totalsales>3810</totalsales>
  <costofsales>2100</costofsales>
 </division>
 <division>
  <name>Toys</name>
  <totalsales>2432</totalsales>
  <costofsales>1200</costofsales>
 </division>
 <division>
  <name>Cars</name>
  <totalsales>6753</totalsales>
  <costofsales>4100</costofsales>
 </division>
 <division>
  <name>Hardware</name>
  <totalsales>2543</totalsales>
  <costofsales>1400</costofsales>
 </division>
 <division>
  <name>Electronics</name>
  <totalsales>5965</totalsales>
  <costofsales>3560</costofsales>
 </division>
</sales>


This example describes how to insert a chart into the template to display it as a vertical bar chart, as shown in the following bar chart.

[image: Description of GUID-FC1C8D1A-015C-4CFA-B6AE-74CC35026AF3-default.gif follows]



Note the following attributes of this chart:

	The style is a vertical bar chart.


	The chart displays a background grid.


	The components are colored.


	Sales totals are shown as Y-axis labels.


	Divisions are shown as X-axis labels.


	The chart is titled.


	The chart displays a legend.




Each of these properties can be customized to suit individual report requirements.





Inserting the Dummy Image

The first step is to add a dummy image to the template in the position you want the chart to appear.

The image size defines how large the chart image is in the final document.

Note:
You must insert the dummy image as a "Picture" and not any other kind of object.

The following illustration shows an example of a dummy image.

[image: Description of GUID-047696D8-10AA-4AF8-85B4-C82B2A12F348-default.gif follows]



The image can be embedded inside a for-each loop like any other form field if you want the chart to be repeated in the output based on the repeating data. In this example, the chart is defined within the sales year group so that a chart is generated for each year of data present in the XML file.

Right-click the image to open the Format Picture palette and select the Web tab. Use the Alternative text entry box to enter the code to define the chart characteristics and data definition for the chart.





Adding Code to the Alternative Text Box

An Alternative text box is a text field that contains code, the content of which is rendered as a chart in the final document.

The following figure shows an example of the BI Publisher code in the Format Picture Alternative text box.

[image: Description of GUID-84B7328C-B62B-4547-B0A2-625EE5FB30D3-default.gif follows]



The content of the Alternative text represents the chart that is rendered in the final document. For this chart, the text is as follows:

chart:
<Graph graphType = "BAR_VERT_CLUST">
 <Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <Y1Title text="Sales in Thousands" visible="true"/>
 <O1Title text="Division" visible="true"/>
 <LocalGridData colCount="{count(//division)}" rowCount="1">
  <RowLabels>
   <Label>Total Sales $1000s</Label>
  </RowLabels>
  <ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>
  <DataValues>
   <RowData>
    <xsl:for-each select="//division">
      <Cell>
       <xsl:value-of select="totalsales"/>
     </Cell>
    </xsl:for-each>
   </RowData>
  </DataValues>
 </LocalGridData>
</Graph>


The first element of the chart text must be the chart: element to inform the RTF parser that the following code describes a chart object.

Next is the opening <Graph> tag. Note that the whole of the code resides within the tags of the <Graph> element. This element has an attribute to define the chart type: graphType. If this attribute is not declared, the default chart is a vertical bar chart. BI Beans supports many different chart types. Several more types are presented in this section. For a complete listing, see the BI Beans graph DTD documentation.

The following code section defines the chart type and attributes:

<Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <Y1Title text="Sales in Thousands" visible="true"/>
 <O1Title text="Division" visible="true"/>


All of these values can be declared or you can substitute values from the XML data at runtime. For example, you can retrieve the chart title from an XML tag by using the following syntax:

<Title text="{CHARTTITLE}" visible="true" horizontalAlighment="CENTER"/>


where "CHARTTITLE" is the XML tag name that contains the chart title. Note that the tag name is enclosed in curly braces.

The next section defines the column and row labels:

<LocalGridData colCount="{count(//division)}" rowCount="1">
  <RowLabels>
   <Label>Total Sales $1000s</Label>
  </RowLabels>
  <ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>


The LocalGridData element has two attributes: colCount and rowCount. These define the number of columns and rows that are shown at runtime. In this example, a count function calculates the number of columns to render:

colCount="{count(//division)}"


The rowCount has been hard-coded to 1. This value defines the number of sets of data to be charted. In this case it is 1.

Next the code defines the row and column labels. These can be declared, or a value from the XML data can be substituted at runtime. The row label is used in the chart legend (that is, "Total Sales $1000s").

The column labels for this example are derived from the data: Groceries, Toys, Cars, and so on. This is done using a for-each loop:

<ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>


This code loops through the <division> group and inserts the value of the <name> element into the <Label> tag. At runtime, this code generates the following XML:

<ColLabels>
  <Label>Groceries</Label>
  <Label>Toys</Label>
  <Label>Cars</Label>
  <Label>Hardware</Label>
  <Label>Electronics</Label>
</ColLabels>


The next section defines the actual data values to chart:

<DataValues>
   <RowData>
    <xsl:for-each select="//division">
      <Cell>
       <xsl:value-of select="totalsales"/>
     </Cell>
    </xsl:for-each>
   </RowData>
  </DataValues>


Similar to the labels section, the code loops through the data to build the XML that is passed to the BI Beans rendering engine. This code generates the following XML:

<DataValues>
  <RowData>
    <Cell>3810</Cell>
    <Cell>2432</Cell>
    <Cell>6753</Cell>
    <Cell>2543</Cell>
    <Cell>5965</Cell>
  </RowData>
</DataValues>






Additional Chart Samples

Follow the sample pie chart to understand how you can display the data in a pie chart.

You can also display this data in a pie chart as shown in the following figure.

[image: Description of GUID-57996B35-5D32-4DF8-A285-2C4C51309CCA-default.gif follows]



The following is the code added to the template to render this chart at runtime:

chart:
<Graph graphType="PIE">
 <Title text="Company Sales 2004" visible="true"    
   horizontalAlignment="CENTER"/>
 <LocalGridData rowCount="{count(//division)}" colCount="1">
  <RowLabels>
  <xsl:for-each select="//division">     
  <Label>
   <xsl:value-of select="name"/>
  </Label>
  </xsl:for-each>
  </RowLabels>
  <DataValues>
   <xsl:for-each select="//division">
    <RowData>
      <Cell>
       <xsl:value-of select="totalsales"/>
      </Cell>
    </RowData>
   </xsl:for-each>
  </DataValues>
 </LocalGridData>
</Graph>






Horizontal Bar Chart Sample

This example shows total sales and cost of sales charted in a horizontal bar format. This also adds the data from the cost of sales element (<costofsales>) to the chart.

[image: Description of GUID-222B022F-4C90-4E5F-8DC0-B2B62B4385FA-default.gif follows]



The following code defines this chart in the template:

chart:
<Graph graphType = "BAR_HORIZ_CLUST">
 <Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <LocalGridData colCount="{count(//division)}" rowCount="2">
 <RowLabels>
  <Label>Total Sales ('000s)</Label>
  <Label>Cost of Sales ('000s)</Label>
 </RowLabels>
 <ColLabels>
  <xsl:for-each select="//division">
   <Label><xsl:value-of select="name"/></Label>
  </xsl:for-each>
 </ColLabels>
 <DataValues>
  <RowData>
   <xsl:for-each select="//division">
     <Cell><xsl:value-of select="totalsales"/></Cell>
   </xsl:for-each>
  </RowData>
  <RowData>
   <xsl:for-each select="//division">
    <Cell><xsl:value-of select="costofsales"/></Cell>
    </xsl:for-each>
  </RowData>
  </DataValues>
 </LocalGridData>
</Graph>


To accommodate the second set of data, the rowCount attribute for the LocalGridData element is set to 2. Also note the DataValues section defines two sets of data: one for Total Sales and one for Cost of Sales.





Changing the Appearance of the Chart

There are many attributes available from the BI Beans graph DTD that you can manipulate to change the look and feel of the chart.

For example, the previous chart can be changed to remove the grid, place a graduated background, and change the bar colors and fonts, as shown in the following figure:

[image: Description of GUID-1F304736-5EBA-43F6-99F0-67852C343725-default.gif follows]



The code to support this is as follows:

chart:
<Graph graphType = "BAR_HORIZ_CLUST">
<SeriesItems>
 <Series id="0" color="#ffcc00"/>
 <Series id="1" color="#ff6600"/>
</SeriesItems> 
<O1MajorTick visible="false"/>
<X1MajorTick visible="false"/>
<Y1MajorTick visible="false"/>
<Y2MajorTick visible="false"/>
<MarkerText visible="true" markerTextPlace="MTP_CENTER"/>
<PlotArea borderTransparent="true">
 <SFX fillType="FT_GRADIENT" gradientDirection="GD_LEFT" 
 gradientNumPins="300">
 <GradientPinStyle pinIndex="1" position="1" 
  gradientPinLeftColor="#999999" 
  gradientPinRightColor="#cc6600"/>
 </SFX>
</PlotArea>
<Title text="Company Sales 2004" visible="true">
 <GraphFont name="Tahoma" bold="false"/>
</Title>
. . . 
</Graph>


The colors for the bars are defined in the SeriesItems section. The colors are defined in hexadecimal format as follows:

<SeriesItems>  
  <Series id="0" color="#ffcc00"/>  
  <Series id="1" color="#ff6600"/> 
</SeriesItems>  


The following code hides the chart grid:

<O1MajorTick visible="false"/> 
  <X1MajorTick visible="false"/> 
  <Y1MajorTick visible="false"/> 
  <Y2MajorTick visible="false"/>


The MarkerText tag places the data values on the chart bars:

<MarkerText visible="true" markerTextPlace="MTP_CENTER"/> 


The PlotArea section defines the background. The SFX element establishes the gradient and the borderTransparent attribute hides the plot border:

<PlotArea borderTransparent="true">  
  <SFX fillType="FT_GRADIENT" gradientDirection="GD_LEFT"   
     gradientNumPins="300">  
     <GradientPinStyle pinIndex="1" position="1"    
       gradientPinLeftColor="#999999"    
       gradientPinRightColor="#cc6600"/>  
   </SFX> 
</PlotArea>


The Title text tag has also been updated to specify a new font type and size:

<Title text="Company Sales 2004" visible="true">  
  <GraphFont name="Tahoma" bold="false"/> 
</Title>












Uploading a Sub Template

You can upload one or more sub templates for use with BI Publisher.

To upload a subtemplate file:




	On the global header click New and then click Sub Template. This launches an untitled Sub Template page.
	In the Templates region, click Upload.
	In the Upload Template File dialog, select the subtemplate file for upload.	Type: Select rtf for RTF subtemplate files or xsl for XSL subtemplate files.


	Locale: Select the appropriate locale for the subtemplate file.






	Click Upload.The subtemplate file is displayed in the Templates region as the locale name that you selected (for example: English).



	Click Save. In the Save As dialog choose the catalog folder in which to save the Sub Template. Enter the Name and click Save. The following illustration shows a Sub Template named "My Subtemplate".[image: Description of GUID-E96873F2-F405-4ECB-BAB0-7A2C556DB983-default.gif follows]





	(RTF Sub Templates only) If you are uploading multiple localized files, then select the file that is to be used as the default. For more information on localization of template files, see Adding Translations to an RTF Subtemplate.Note:
You may upload only one RTF file per locale to a Sub Template definition. If you upload additional template files to this Sub Template, each file is automatically named as the locale regardless of the name that you give the file before upload.



Note:
Translations are not supported for XSL Sub Templates.







Note that the Sub Template object is saved with the extension ".xsb". You use the Name that you choose here with the .xsb extension when you import the Sub Template object (for example: MySubtemplate.xsb).







Expressions, Control Structures, and Functions

This section describes the rules and usage for expressions in the template. It also describes supported control structures and functions.



Expressions

Expressions can be used in the data column for data fields and some command parameters. An expression is a group of XML extract fields, literals, functions, and operators. Expressions can be nested. An expression can also include the "IF" control structure. When an expression is evaluated it always generates a result. Side effects are not allowed for the evaluation.

Based on the evaluation result, expressions are classified into the following three categories:

	Boolean Expression - an expression that returns a boolean value, either true or false. This kind of expression can be used only in the IF-THEN-ELSE control structure and the parameter of the display condition command.


	Numeric Expression - an expression that returns a number. This kind of expression can be used in numeric data fields. It can also be used in functions and commands that require numeric parameters.


	Character Expression - an expression that returns an alphanumeric string. This kind of expression can be used in string data fields (format type Alpha). They can also be used in functions and command that require string parameters.








Control Structures

The only supported control structure is IF-THEN-ELSE. It can be used in an expression.

The syntax is:

IF <boolean_expressionA> THEN
   <numeric or character expression1>
[ELSIF <boolean_expressionB THEN
   <numeric or character expression2>]
...
[ELSE
   <numeric or character expression3]
END IF


Generally the control structure must evaluate to a number or an alphanumeric string. The control structure is considered to a numeric or character expression. The ELSIF and ELSE clauses are optional, and there can be as many ELSIF clauses as necessary. The control structure can be nested.

The IN predicate is supported in the IF-THEN-ELSE control structure. For example:

IF PaymentAmount/Currency/Code IN ('USD', 'EUR', 'AON', 'AZM') THEN      
   PayeeAccount/FundsCaptureOrder/OrderAmount/Value * 100   
ELSIF PaymentAmount/Currency/Code IN ('BHD', 'IQD', 'KWD') THEN      
   PayeeAccount/FundsCaptureOrder/OrderAmount/Value * 1000   
ELSE      
   PayeeAccount/FundsCaptureOrder/OrderAmount/Value   
END IF; 






Functions

Here is the list of supported functions.

	SEQUENCE_NUMBER - is a record element index. It is used in conjunction with the Define Sequence command. It has one parameter, which is the sequence defined by the Define Sequence command. At runtime it increases its sequence value by one each time it is referenced in a record.


	COUNT - counts the child level extract instances or child level records of a specific type. Declare the COUNT function on a level above the entity to be counted. The function has one argument. If the argument is a level, then the function counts all the instances of the (child) level belonging to the current (parent) level instance.

For example, if the level to be counted is Payment and the current level is Batch, then the COUNT returns the total number of payments in the batch. However, if the current level is RequestHeader, the COUNT returns the total number of payments in the file across all batches. If the argument is a record type, the count function counts all the generated records of the (child level) record type belonging to the current level instance.


	INTEGER_PART, DECIMAL_PART - returns the integer or decimal portion of a numeric value. This is used in nested expressions and in commands (display condition and group by). For the final formatting of a numeric field in the data column, use the Integer/Decimal format.


	IS_NUMERIC - boolean test whether the argument is numeric. Used only with the "IF" control structure.


	TRUNCATE - truncate the first argument - a string to the length of the second argument. If the first argument is shorter than the length specified by the second argument, the first argument is returned unchanged. This is a user-friendly version for a subset of the SQL substr() functionality.


	SUM - sums all the child instance of the XML extract field argument. The field must be a numeric value. The field to be summed must always be at a lower level than the level on which the SUM function was declared.


	MIN, MAX - find the minimum or maximum of all the child instances of the XML extract field argument. The field must be a numeric value. The field to be operated on must always be at a lower level than the level on which the function was declared.


	FORMAT_DATE - Formats a date string to any desirable date format. For example:

FORMAT_DATE("1900-01-01T18:19:20", "YYYY/MM/DD HH24:MI:SS")

produces the following output:

1900/01/01 18:19:20


	FORMAT_NUMBER - Formats a number to display in desired format. For example:

FORMAT_NUMBER("1234567890.0987654321", "999,999.99")

produces the following output:

1,234,567,890.10


	MESSAGE_LENGTH - returns the length of the message in the EFT message.


	RECORD_LENGTH - returns the length of the record in the EFT message.


	INSTR - returns the numeric position of a named character within a text field.


	SYSDATE, DATE - gets Current Date and Time.


	POSITION - returns the position of a node in the XML document tree structure.


	REPLACE - replaces a string with another string.s


	CONVERT_CASE - converts a string or a character to UPPER or LOWER case.


	CHR - gets the character representation of an argument, which is an ASCII value.


	LPAD, RPAD - generates left or right padding for string values.


	AND, OR, NOT - operator functions on elements.


	DISTINCT_VALUES - equivalent to the XPATH function DISTINCT-VALUES. Returns a sequence in which all but one of a set of duplicate values, based on value equality, have been deleted. Usage: distinct_values(fieldname).


	INCREASE_DATE - increments a date by the number of days specified.

Usage:

increase_date(.//date, 2)

returns a date value two days after the value of .//date


	DECREASE_DATE - decreases a date by the number of days specified.

Usage:

decrease_date(.//date, 2)

returns a date value two before the value of .//date


	Other SQL functions include the following. Use the syntax corresponding to the SQL function.

	TO_DATE


	LOWER


	UPPER


	LENGTH


	GREATEST


	LEAST


	DECODE


	CEIL


	ABS


	FLOOR


	ROUND


	CHR


	TO_CHAR


	SUBSTR


	LTRIM


	RTRIM


	TRIM


	IN


	TRANSLATE












Creating a Filler Block

For FIXED_POSITION_BASED templates, you can use a filler block to define a specific block size for the eText output. When the actual data does not fill the specified block size, the remainder of the block is filled with a specified filler character.

For example, if you define a BLOCK SIZE of 9, and the eText output generated is only three lines of text, then the remaining six lines are filled with the specified FILLER CHARACTER.

The commands used are:

	<BEGIN FILLER BLOCK> - this signifies the beginning of the block. Enter a name for this block.


	<FILLER CHARACTER> - enter a character or string to use to "fill" the remainder of the block when the data does not fill it.

Example entries for <FILLER CHARACTER> are:

To fill the block with the ? character, enter the FILLER CHARACTER command as shown:

<FILLER CHARACTER> : ?

To fill the block with the string abc, enter the FILLER CHARACTER command as shown:

<FILLER CHARACTER> : abc

To fill the block with empty spaces, enter the FILLER CHARACTER command as shown:

<FILLER CHARACTER> :  


	<BLOCK SIZE> - enter an integer to specify the size of the block in lines of text.




These commands must be used before the template definition starts.

Enter the following command at the end of the block:

	<END FILLER BLOCK> - signifies the end of the block. Enter the name already specified for this block in the <BEGIN FILLER BLOCK> command.




The following figure shows an example of filler block usage:


[image: Description of GUID-7DD0A783-1E56-4612-ADF8-B035D20D45EB-default.gif follows]



[image: Description of GUID-7D177E8F-097B-4F30-AF64-9BD2C952B4EC-default.gif follows]



[image: Description of GUID-E1FEF66A-F0C8-47FC-8ED3-3AC951C7D22E-default.gif follows]





The following figure shows an example of output generated with FILLER BLOCK:


[image: Description of GUID-248D4BF9-3AA1-4E20-AACF-A81921A58FE8-default.gif follows]





The following figure shows an example of output generated if FILLER BLOCK is not used:


[image: Description of GUID-29B88353-B200-4EF9-93A3-8153D89052F6-default.gif follows]








Supported Utilities

Several utilities support PDF documents and templates.

The BI Publisher utilities that support PDF 1.7 are:

	FormProcessor ­– merges a PDF template with XML data to produce PDF document output.


	PDFDocMerger – provides optional processing of PDF files to merge documents, add page numbering, and set watermarks.


	PDFSignature  –  creates signed PDF documents by processing unsigned PDF documents with a signature field name and a password-protected Personal Information Exchange (PFX) file.










12 Understanding Subtemplates

A subtemplate is a piece of formatting functionality that can be defined once and used multiple times within a single layout template or across multiple layout template files. This chapter describes concepts for using subtemplates in BI Publisher.


This chapter includes the following sections:

	What is a Subtemplate?


	Supported Locations for Subtemplates


	Testing Subtemplates from the Desktop


	Uploading a Sub Template


	Calling a Subtemplate from an External Source




For information on designing an RTF subtemplate, see Designing RTF Subtemplates. For information on designing an XSL subtemplate, see Designing XSL Subtemplates.




Implementing PDF Splitting for an RTF Template

This section describes how to enable PDF splitting for reports generated from RTF templates.

This section includes the following topics:

	Entering the Commands in an RTF Template


	Example - split by each department






Entering the Commands in an RTF Template

When you design a template to use this feature, you must add commands to specify these queries.

	What element in the data is repeated (using the simple for-each command)


	How many occurrences of the element are included in each PDF file


	What information (data elements) to include in the index file




To achieve this, the following two commands must be entered in the template within the for-each loop of the element by which you want the document to split:

	<?catalog-index-info:name;element_name?>

where

name is the name that you choose that is used in the index file to identify the from and to records included in each document.

element_name is the XML tag name of the element that provides the value for name that you identify above.

The catalog-index-info command defines the construction of the index file that is created.


	<?if:position() mod n = 0?><?document-split:?><?end if?>

where

n is the number of records you want included per PDF file.

This command must be placed within the for-each loop of the element that is to be counted. This command instructs BI Publisher to split the document after the next page break when the number of records equals the value you have supplied for n.

Each time the document-split is performed, the name-value pairs defined in the catalog-index-info command are written to the index files.








Example - split by each department

This example is based on the XML data given here.

This example is based on the following XML data:

<DATA_DS>
 <G_EMP>
  <DEPARTMENT_NAME>Sales</DEPARTMENT_NAME> 
  <FIRST_NAME>Ellen</FIRST_NAME> 
  <LAST_NAME>Abel</LAST_NAME> 
  <HIRE_DATE>1996-05-11T00:00:00.000-07:00</HIRE_DATE> 
  <SALARY>11000</SALARY> 
 </G_EMP>
 <G_EMP>
  <DEPARTMENT_NAME>Sales</DEPARTMENT_NAME> 
  <FIRST_NAME>Sundar</FIRST_NAME> 
  <LAST_NAME>Ande</LAST_NAME> 
  <HIRE_DATE>2000-03-24T00:00:00.000-08:00</HIRE_DATE> 
  <SALARY>6400</SALARY> 
 </G_EMP>
 <G_EMP>
  <DEPARTMENT_NAME>Shipping</DEPARTMENT_NAME> 
  <FIRST_NAME>Mozhe</FIRST_NAME> 
  <LAST_NAME>Atkinson</LAST_NAME> 
  <HIRE_DATE>1997-10-30T00:00:00.000-08:00</HIRE_DATE> 
  <SALARY>2800</SALARY> 
 </G_EMP>
 <G_EMP>
  <DEPARTMENT_NAME>IT</DEPARTMENT_NAME> 
  <FIRST_NAME>David</FIRST_NAME> 
  <LAST_NAME>Austin</LAST_NAME> 
  <HIRE_DATE>1997-06-25T00:00:00.000-07:00</HIRE_DATE> 
  <SALARY>4800</SALARY> 
 </G_EMP>

...
</DATA_DS>

In this example, the output PDF report includes a document for each employee. You want a new PDF file generated for each department. You want the index to list the FIRST_NAME and LAST_NAME from each record that is included in the PDF file.

To achieve this output, enter the following in the template:

<?for-each-group:ROW;./DEPARTMENT_NAME?>
<?for-each:current-group()?>
<?catalog-index-info:'First Name';FIRST_NAME?>
<?catalog-index-info:'Last Name';LAST_NAME?>
...
<?end for-each?>
<?document-split:?>
<?end for-each-group?>










PDF Output Properties

See the table below which describes the properties available for PDF output.


	Property Name	Description
	Compress PDF output

	Default: true

Description: Specify "true" or "false" to control compression of the output PDF file.

Internal Name: pdf-compression


	Hide PDF viewer's menu bars

	Default: false

Description: Specify "true" to hide the viewer application's menu bar when the document is active. The menu bar option is only effective when using the Export button, which displays the output in a standalone Acrobat Reader application outside of the browser.

Internal Name: pdf-hide-menubar


	Hide PDF viewer's tool bars

	Default: false

Description: Specify "true" to hide the viewer application's toolbar when the document is active.

Internal Name: pdf-hide-toolbar


	Replace smart quotes

	Default: true

Description: Set to "false" if you do not want curly quotes replaced with straight quotes in the PDF output.

Internal Name: pdf-replace-smartquotes


	Use only one shared resources object for all pages

	Default: true

Description: The default mode of BI Publisher creates one shared resources object for all pages in a PDF file. This mode has the advantage of creating an overall smaller file size. However, the disadvantages are the following:

	Viewing may take longer for a large file with many SVG objects


	If you choose to break up the file by using Adobe Acrobat to extract or delete portions, then the edited PDF files are larger because the single shared resource object (that contains all of the SVG objects for the entire file) is included with each extracted portion.




Setting this property to "false" creates a resource object for each page. The file size is larger, but the PDF viewing is faster and the PDF can be broken up into smaller files more easily.

Internal Name: pdf-use-one-resources


	PDF Navigation Panel Initial View

	Default: Bookmarks Open

Description: Controls the navigation panel view that is presented when a user first opens a PDF report. The following options are supported:

	Panels Collapsed - displays the PDF document with the navigation panel collapsed.


	Bookmarks Open (default) - displays the bookmark links for easy navigation.


	Pages Open - displays a clickable thumbnail view of each page of the PDF.




Internal Name: pdf-pagemode











Template Features

Templates include several features that enhance their formatting and layout.

BI Publisher supports the template features that are described in the following sections:

	Inserting Page Breaks


	Inserting an Initial Page Number


	Specifying Last Page Only Content


	Ending on Even or Odd Pages


	Inserting Hyperlinks


	Including a Table of Contents


	Generating Bookmarks in PDF Output


	Inserting Check Boxes


	Inserting Drop-Down Lists


	Repeat Row Headers After Page Break






Inserting Page Breaks

You can create a page break in a few ways.

Note:
Page breaks are supported for PDF, RTF, and PPT output. Page breaks are not supported for HTML output.

To create a page break after the occurrence of a specific element use the "split-by-page-break" alias. This causes the report output to insert a hard page break between every instance of a specific element.

To insert a page break between each occurrence of a group, insert the "split-by-page-break" form field within the group immediately before the <?end for-each?> tag that closes the group. In the Help Text of this form field enter the syntax:

<?split-by-page-break:?>

For the following XML, assume you want to create a page break for each new supplier:

<SUPPLIER>
 <NAME>My Supplier</NAME>
 <INVOICES>
  <INVOICE>
   <INVNUM>10001-1</INVNUM>
   <INVDATE>1-Jan-2005</INVDATE>
   <INVAMT>100</INVOICEAMT>
  </INVOICE>
  <INVOICE>
   <INVNUM>10001-2</INVNUM>
   <INVDATE>10-Jan-2005</INVDATE>
   <INVAMT>200</INVOICEAMT>
  </INVOICE>
 </INVOICES>
</SUPPLIER>
<SUPPLIER>
 <NAME>My Second Supplier</NAME>
 <INVOICES>
  <INVOICE>
   <INVNUM>10001-1</INVNUM>
   <INVDATE>11-Jan-2005</INVDATE>
   <INVAMT>150</INVOICEAMT>
  </INVOICE>
…


In the template sample shown in the following illustration, the field called PageBreak contains the split-by-page-break syntax:

[image: Description of GUID-CAC89595-5349-4DAB-92A2-115DE989F7C6-default.gif follows]



Place the PageBreak field with the <?split-by-page-break:?> syntax immediately before the <?end for-each?> field. The PageBreak field sits inside the end of the SUPPLIER loop. This ensures that a page break is inserted before the occurrence of each new supplier. This method avoids the ejection of an extra page at the end of the group when using the native Microsoft Word page break after the group.





Inserting an Initial Page Number

Some reports require that the initial page number be set at a specified number. For example, monthly reports may be required to continue numbering from month to month. BI Publisher allows you to set the page number in the template to support this requirement.

Note:
Initial page number is supported for PDF and PPT output. It is not supported for HTML and RTF output.



Use the following syntax in the template to set the initial page number:

<?initial-page-number:pagenumber?>


where pagenumber is the XML element or parameter that holds the numeric value.

BI Publisher also supports continuing the page number from a previous section. The default behavior of a new section in a document is to reset the page numbering. However, if the report requires that the page numbering continue into the next section, use the following command:

<?initial-page-number:'auto'?>


This command allows the continuation of the page numbering from the previous section.

Example 1 - Set page number from XML data element

If the XML data contains an element to carry the initial page number, for example:

<REPORT>
  <PAGESTART>200<\PAGESTART>
  ....
</REPORT>

Enter the following in the template:

<?initial-page-number:PAGESTART?>

The initial page number is the value of the PAGESTART element, which in this case is 200.

Example 2 - Set page number by passing a parameter value

If you define a parameter called PAGESTART, then you can pass the initial value by calling the parameter.

Enter the following in the template:

<?initial-page-number:$PAGESTART?>

Note:
You must first declare the parameter in the template. See Setting Parameters.







Specifying Last Page Only Content

BI Publisher supports the Microsoft Word functionality to specify a different page layout for the first page, odd pages, and even pages.

Note:
This feature is supported for PDF and PPT output only.

To implement these options, simply select Page Setup from the File menu, then select the Layout tab. BI Publisher recognizes the settings that you make in this dialog.

However, Microsoft Word does not provide settings for a different last page only. This is useful for documents such as checks, invoices, or purchase orders on which you may want the content such as the check or the summary in a specific place only on the last page. BI Publisher provides this ability. 

To specify last page only content:




	Create a section break in the template to ensure the content of the final page is separated from the rest of the report.
	Insert the following syntax on the final page:<?start@last-page:body?>

<?end body?>





Any content on the page that occurs above or below these two tags is displayed only on the last page of the report. Also, note that because this command explicitly specifies the content of the final page, any desired headers or footers previously defined for the report must be reinserted on the last page.

This example uses the last page only feature for a report that generates an invoice listing with a summary to appear at the bottom of the last page.

Assume the following XML:

<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICELIST>
 <VENDOR>
  <VENDOR_NAME>Nuts and Bolts Limited</VENDOR_NAME>
  <ADDRESS>1 El Camino Real, Redwood City, CA 94065</ADDRESS>
  <INVOICE>
   <INV_TYPE>Standard</INV_TYPE>
   <INVOICE_NUM>981110</INVOICE_NUM>
   <INVOICE_DATE>10-NOV-04</INVOICE_DATE>
   <INVOICE_CURRENCY_CODE>EUR</INVOICE_CURRENCY_CODE>
   <ENT_AMT>122</ENT_AMT>
   <ACCTD_AMT>122</ACCTD_AMT>
   <VAT_CODE>VAT22%</VAT_CODE>
  </INVOICE>
  <INVOICE>
   <INV_TYPE>Standard</INV_TYPE>
   <INVOICE_NUM>100000</INVOICE_NUM>
   <INVOICE_DATE>28-MAY-04</INVOICE_DATE>
   <INVOICE_CURRENCY_CODE>FIM</INVOICE_CURRENCY_CODE>
   <ENT_AMT>122</ENT_AMT>
   <ACCTD_AMT>20.33</ACCTD_AMT>
   <VAT_CODE>VAT22%</VAT_CODE>
  </INVOICE>
 </VENDOR>
 <VENDOR>
  ...
<INVOICE>
 ...
  </INVOICE>
 </VENDOR>
 <SUMMARY>
  <SUM_ENT_AMT>61435</SUM_ENT_AMT>
  <SUM_ACCTD_AMT>58264.68</SUM_ACCTD_AMT>
  <TAX_CODE>EU22%</TAX_CODE>
 </SUMMARY>
</INVOICELIST>


The report should show each VENDOR and their INVOICE data with a SUMMARY section that appears only on the last page, placed at the bottom of the page. The template for this is shown in this figure.


[image: Description of GUID-B8B38734-7056-48D1-B709-9026C25A0487-default.gif follows]







Insert a Microsoft Word section break (type: next page) on the first page of the template. For the final page, insert new line characters to position the summary table at the bottom of the page. The summary table is shown in the following illustration.


[image: Description of GUID-6D7279C5-00F8-4A17-8833-C85D128D3017-default.gif follows]





In this example:

	The F and E components contain the for-each grouping statements.


	The grayed report fields are placeholders for the XML elements.


	The "Last Page Placeholder" field contains the syntax:

<?start@last-page:body?> <?end body?>

to declare the last page layout. Any content above or below this statement is displayed on the last page only. The content above the statement is regarded as the header and the content below the statement is regarded as the footer.




If the reports contains headers and footers that you want to carry over onto the last page, you must reinsert them on the last page. For more information, see Defining Headers and Footers.

You must insert a section break (type: next page) into the document to specify the last page layout. This example is available in the samples folder of the Oracle BI Publisher Template Builder for Word installation.

Because the default behavior of a new section in a document is to reset the page numbering the page number on the last page is reset. To continue the page numbering from the previous section, use the following command:

<?initial-page-number:'auto'?>


This command allows the continuation of the page numbering from the previous section.

It is important to note that if the report is only one page in length, the first page layout is used. If the report requires that a single page report should default to the last page layout (such as in a check printing implementation), then you can use the following alternate syntax for the "Last Page Placeholder" on the last page:

<?start@last-page-first:body?> <?end body?>

Substituting this syntax results in the last page layout for reports that are only one page long.








Ending on Even or Odd Pages

If the report has different odd and even page layouts, then you might want to force the report to end specifically on an odd or even page by following these steps.

Note:
This feature is supported for PDF and PDF output only. It is not supported for RTF and HTML output.



For example, you may include the terms and conditions of a purchase order in the footer of the report using the different odd/even footer functionality (see Defining Different First Page and Different Odd and Even Pages) and you want to ensure that the terms and conditions are printed on the final page.

Or, you may have binding requirements to have the report end on an even page, without specific layout.

To end on an even page with layout:

	Insert the following syntax in a form field in the template:

<?section:force-page-count;'end-on-even-layout'?>








To end on an odd page layout:


	Insert the following syntax in a form field in the template:<?section:force-page-count;'end-on-odd-layout'?>






If you do not have layout requirements for the final page, but would like a blank page ejected to force the page count to the preferred odd or even, then use the following syntax:

<?section:force-page-count;'end-on-even'?>


or

<?section:force-page-count;'end-on-odd'?>









Inserting Hyperlinks

BI Publisher supports several different types of hyperlinks. 

Note:
Hyperlinks are supported for PDF, RTF, HTML, PPT, and Excel output.

The hyperlinks can be fixed or dynamic and can link to either internal or external destinations. Hyperlinks can also be added to shapes.




	To insert static hyperlinks to either text or a shape, use the word processor's insert hyperlink feature.

To insert a static hyperlink to a text or a shape:

	Select the text or shape.


	Use the right-mouse menu to select Hyperlink; or, select Hyperlink from the Insert menu.


	Enter the URL using any of the methods provided on the Insert Hyperlink dialog box.




The following illustration shows the insertion of a static hyperlink using Microsoft Word's Insert Hyperlink dialog.

[image: Description of GUID-58383306-0AAB-4A20-9A86-72462411F329-default.gif follows]




	If the input XML data includes an element that contains a hyperlink or part of one, then you can create dynamic hyperlinks at runtime. In the Type the file or Web page name field of the Insert Hyperlink dialog, enter the following syntax:

{URL_LINK}

where URL_LINK is the incoming data element name.

If you have a fixed URL that you want to add elements from the XML data file to construct the URL, enter the following syntax:

http://www.example.com?product={PRODUCT_NAME}

where PRODUCT_NAME is the incoming data element name.

In both these cases, at runtime the dynamic URL is constructed.

The following illustration shows the insertion of a dynamic hyperlink using Microsoft Word's Insert Hyperlink dialog. The data element SUPPLIER_URL from the incoming XML file contains the hyperlink that is inserted into the report at runtime.

[image: Description of GUID-177D7509-8695-4647-B42B-562924273264-default.gif follows]




	You can also pass parameters at runtime to construct a dynamic URL.

Enter the parameter and element names surrounded by braces to build up the URL as follows:

{$SERVER_URL}{$REPORT}/cstid={CUSTOMER_ID}


where SERVER_URL and REPORT are parameters passed to the template at runtime (note the $ sign) and CUSTOMER_ID is an XML data element. This link may render as:

http://myserver.domain:8888/CustomerReport/cstid=1234




To add the target attribute to a URL, add the following to the URL string:

??target=_target_value


For example:

http://www.example.com??target=_top 


Values for the target attribute are:

	_top


	_blank


	_self


	_parent


	framename




You can pass in the value of target dynamically, using the following syntax:

http://www.example.com/index.html??target={$myTarget} 


where myTarget is the name of the parameter that holds the value.






Inserting Internal Links

Internal links point to a section within a document.

Insert internal links into the template using Microsoft Word's Bookmark feature. 

To insert internal links:




	Position the cursor in the desired destination in the document.
	From the Insert menu, select Bookmark.
	In the Bookmark dialog, enter a name for this bookmark, and select Add.
	Select the text or shape in the document that you want to link back to the Bookmark target.
	Use the right-mouse menu to select Hyperlink; or select Hyperlink from the Insert menu.
	On the Insert Hyperlink dialog, select Bookmark.
	Select the bookmark that you created from the list.


At runtime, the link is maintained in the generated report.










Including a Table of Contents

BI Publisher supports the table of contents generation feature of the RTF specification. Follow the word processor's procedures for inserting a table of contents.

Note:
Table of contents feature is supported for PDF and PPT output. RTF support is limited: After report generation, the user must press F9 to reset the page numbers.



BI Publisher also provides the ability to create dynamic section headings in the document from the XML data. You can then incorporate these into a table of contents.




To create dynamic headings:


	Enter a placeholder for the heading in the body of the document, and format it as a "Heading", using the word processor's style feature. You cannot use form fields for this functionality.For example, you want the report to display a heading for each company reported. The XML data element tag name is <COMPANY_NAME>. In the template, enter <?COMPANY_NAME?> where you want the heading to appear. Now format the text as a Heading.



	Create a table of contents using the word processor's table of contents feature.


At runtime, the TOC placeholders and heading text are substituted.








Generating Bookmarks in PDF Output

If you have defined a table of contents in the RTF template, then you can use the table of contents definition to generate links in the Bookmarks tab in the navigation pane of the output PDF.

The bookmarks can be either static or dynamically generated.

Note:
Bookmark support in RTF templates is limited to a single-point bookmark. This is to allow link (Goto) functionality within the document. Arrays in bookmarks are not supported.



For information on creating the table of contents, see Including a Table of Contents.




	To create links for a static table of contents:

Enter the syntax:

<?copy-to-bookmark:?>

directly above the table of contents and

<?end copy-to-bookmark:?>

directly below the table of contents.


	To create links for a dynamic table of contents:

Enter the syntax:

<?convert-to-bookmark:?>

directly above the table of contents and

<?end convert-to-bookmark:?>

directly below the table of contents.




To control the initial state of the bookmark when the PDF file is opened, use the following command:

<?collapse-bookmark:state;level?>


where

the state can have the following values:

	hide - Collapses the table of contents entries


	show - Expands the table of contents entries




and

level sets the table of contents collapse level. For example: "1" collapses the first level of entries in the table of contents; "2" collapses the first and second level entries.

Use this command with <?copy-to-bookmark:?> and <?convert-to-bookmark:?> as shown in the following examples:

	To create a static table of contents that hides level 1 and level 2 of the table of contents entries, enter the following:

<?copy-to-bookmark:?> 
<?collapse-bookmark:hide;2?>

directly above the table of contents and

<?end copy-to-bookmark:?>

directly below the table of contents.


	To create links for a dynamic table of contents that shows levels 1 and 2 of the table of contents expanded, enter the following:

<?convert-to-bookmark:>
<?collapse-bookmark:show;2?>

directly above the table of contents and

<?end convert-to-bookmark:?>

directly below the table of contents.











Inserting Check Boxes

You can include a check box in the template that you can define to display as checked or unchecked based on a value from the incoming data.

Note:
Check boxes are supported in PDF output only.






To define a check box in the template:


	Position the cursor in the template where you want the check box to display, and select the Check Box Form Field from the Forms tool bar, as shown in the following figure:[image: Description of GUID-D9B77DFA-B293-4013-82CE-67A1AA8D3454-default.gif follows]





	Right-click the field to open the Check Box Form Field Options dialog.
	Specify the Default value as either Checked or Not Checked.
	In the Form Field Help Text dialog, enter the criteria for how the box should behave. This must be a boolean expression (that is, one that returns a true or false result).For example, suppose the XML data contains an element called <population>. You want the check box to appear checked if the value of <population> is greater than 10,000. Enter the following in the help text field:

<?population>10000?>


The help text coding is shown in the following figure:

[image: Description of GUID-B7481CC6-9C8A-4CB3-B20A-C2FB301628C8-default.gif follows]



Note that you do not have to construct an "if" statement. The expression is treated as an "if" statement.

See Inserting Drop-Down Lists for a sample template using a check box.









Inserting Drop-Down Lists

BI Publisher allows you to use the drop-down form field to create a cross-reference in the template from the XML data to some other value that you define in the drop-down form field.

For example, suppose you have the following XML:

<countries>
 <country>
  <name>Chad</name>
  <population>7360000</population>
  <continentIndex>5</continentIndex>
 </country>
 <country>
  <name>China</name>
  <population>1265530000</population>
  <continentIndex>1</continentIndex>
 </country>
 <country>
  <name>Chile</name>
  <population>14677000</population>
  <continentIndex>3</continentIndex>
 </country>
. . . 
</countries>

Notice that each <country> entry has a <continentindex> entry, which is a numeric value to represent the continent. Using the drop-down form field, you can create an index in the template that cross-references the <continentindex> value to the actual continent name. You can then display the name in the published report. 




To create the index for the continent example:


	Position the cursor in the template where you want the value from the drop-down list to display, and select the Drop-Down Form Field from the Forms tool bar, as shown in the figure below:[image: Description of GUID-0F71958E-A762-444B-BA0C-3C4155E7FE7A-default.gif follows]





	Right-click the field to display the Drop-Down Form Field Options dialog.
	Add each value to the Drop-down item field and the click Add to add it to the Items in drop-down list group. The values are indexed starting from one for the first, and so on. For example, the list of continents is stored as shown in the following table:
	Index	Value
	1

	Asia


	2

	North America


	3

	South America


	4

	Europe


	5

	Africa


	6

	Australia










	Now use the Help Text box to enter the XML element name that holds the index for the drop-down field values.For this example, enter

<?continentIndex?>

The following figure shows the Drop-Down Form Field Options dialogs for this example:


[image: Description of GUID-F454FF2A-0844-426C-ABDC-B895965E56CB-default.gif follows]









Using the check box and drop-down list features, you can create a report to display population data with check boxes to demonstrate figures that reach a certain limit. An example illustrating a report of population data with check boxes is shown in the following figure:


[image: Description of GUID-11BB7DFA-8A41-4409-9E6A-A9429EBCB999-default.gif follows]





The template to create this report is shown in the below figure and the fields have the values shown in the table below.


[image: Description of GUID-47998B57-DC7E-45F0-94C2-69F5BCC3E51C-default.gif follows]






	Field	Form Field Entry	Description
	FE

	<?for-each:country?>

	Begins the country repeating group.


	China

	<?name?>

	Placeholder for the name element.


	1,000,000

	<?population?>

	Placeholder for the population element.


	(check box)

	<?population>1000000?>

	Establishes the condition for the check box. If the value for the population element is greater than 1,000,000, the check box is displayed as checked.


	Asia

	<?contintentIndex?>

	The drop-down form field for the continentIndex element. See the preceding description for its contents. At runtime, the value of the XML element is replaced with the value it is cross-referenced to in the drop-down form field.


	EFE

	<?end for-each?>

	Ends the country group.















Repeat Row Headers After Page Break

If your report includes a row header that spans multiple rows, for example in a group-left construction, you can specify that the content in the initial cell repeats on the next page.

See the example shown in the following table.


[image: Description of GUID-A9DF7BB7-2A37-4A07-8B0B-A956CED89D2A-default.gif follows]





In the preceding example, if the report breaks across the 04-Dec-12 group, you would most likely prefer that the cell contents "04-Dec-12" repeat on the next page. To specify that the cell contents repeat, insert the following code in a form field in the table data cell that is to repeat:

<?attribute@block:xdofo:rowspancell-repeat-nextpage;'true'?>


This feature is only useful when number-rows-spanned for the table-cell is greater than one.






C Designing Accessible Reports

This appendix describes techniques for designing reports to increase accessibility of report output for users with disabilities. Accessibility support is for HTML output only.

This appendix includes the following sections:

	Designing for Accessibility


	Designing Accessible Reports Using RTF Templates


	Designing Accessible Reports Using BI Publisher Layouts







Using Advanced BI Publisher Functions

BI Publisher provides a set of functions to achieve additional reporting functionality.

You define these functions in the Data Constraints region of the XDO_METADATA sheet.

The functions make use of Columns A, B, and C in the XDO_METADATA sheet as follows:

Use Column A to declare the function or to specify the defined name of the object to which to map the results of a calculation or XSL evaluation.

Use Column B to enter the special XDO-XSL syntax to describe how to control the data constraints for the XDO function, or the XSL syntax that describes the special constraint to apply to the XDO_ named elements.

Use Column C to specify additional instructions for a few functions.

The functions are described in the following sections:

	Reporting Functions


	Formatting Functions That Rely on Specific Data Attribute Values


	Grouping Functions






Reporting Functions

You can add functions to a template using the commands shown and a combination of BI Publisher syntax and XSL.

A summary list of the commands is shown in the following table. See the corresponding section for details on usage.





	Function	Commands
	Splitting the Report into Multiple Sheets

	XDO_SHEET_? with XDO_SHEET_NAME_?


	Declaring and Passing Parameters

	XDO_PARAM_?n?


	Defining a Link

	XDO_LINK_?link object name?


	Importing and Calling a Subtemplate

	XDO_SUBTEMPLATE_?n?


	Referencing Java Extension Libraries

	XDO_EXT_?n?










Splitting the Report into Multiple Sheets

Use this set of commands to define the logic to split the report data into multiple sheets.

Note:
Images are not supported across multiple sheets. If the template sheet includes images, when the data is split into multiple sheets, the images are displayed only on the first sheet.

The set of commands is described in the following list:




	Use XDO_SHEET_? to define the logic by which to split the data onto a new sheet.


	Use XDO_SHEET_NAME_? to specify the naming convention for each sheet. 




The following table describes the column entries.


	Column A Entry	Column B Entry	Column C Entry
	XDO_SHEET_?

	<?xsl_evaluation to split the data?> 

Example: 

<?.//DEPT?>

	n/a


	XDO_SHEET_NAME_?

	<?xsl_expression to name the sheet?> 

Example: 

<?concat(.//DEPARTMENT_NAME,'-',count(.//EMP_NAME))?>

	(Optional) 

<?original sheet name?> 

Example: 

<?Sheet3?>








XDO_SHEET_? must refer to an existing high-level node in the XML data. The example <?.//DEPT?> creates a new sheet for each occurrence of <DEPT> in the data.

If the data is flat, then you cannot use this command unless you first preprocess the data to create the desired hierarchy. To preprocess the data, define the transformation in an XSLT file, then specify this file in the Preprocess XSLT File field of the header section of the XDO _METADATA sheet. For more information, see Preprocessing the Data Using an XSL Transformation (XSLT) File.

Use XDO_SHEET_NAME_? to define the name to apply to the sheets. In Column B enter the XSL expression to derive the new sheet name. The expression can reference a value for an element or attribute in the XML data, or you can use the string operation on those elements to define the final sheet name. This example:

<?concat(.//DEPARTMENT_NAME,'-',count(.//EMP_NAME))?>


names each sheet using the value of DEPARTMENT_NAME concatenated with "-" and the count of employees in the DEPT group.

The original sheet name entry in Column C tells BI Publisher on which sheet to begin the specified sheet naming. If this parameter is not entered, BI Publisher applies the naming to the first sheet in the workbook that contains XDO_ names. You must enter this parameter if, for example, you have a report that contains summary data in the first two worksheets and the burst data should begin on Sheet3. In this case, you enter <?SHEET3?> in Column C.

Example: Splitting the data into multiple sheets

Using the employee data shown in the previous example. This example:

	Creates a new worksheet for each department


	Names each worksheet the name of the department with the number of employees in the department, for example: Sales-21.




To split the data into sheets:




	Enter the defined names for each cell of employee data and create the group for the repeating employee data, as shown in the following illustration.[image: Description of GUID-EA2F7219-BEB4-4A59-9A7A-A17A6DAD803A-default.gif follows]



Note:
Do not create the grouping around the department because the data is split by department.





	Enter the values that are described in the following table in the Data Constraints section of the XDO_METADATA sheet.
	Column A Entry	Column B Entry
	XDO_SHEET_?

	<?.//DEPT?>


	XDO_SHEET_NAME_?

	<?concat(.//DEPARTMENT_NAME,'-',count(.//EMP_NAME))?>












The entries are shown in the following illustration.

[image: Description of GUID-6838AB09-C173-47BD-96C0-D0E20A78BB1D-default.gif follows]



The following illustration shows the generated report. Each department data now displays on its own sheet, which shows the naming convention specified.

[image: Description of GUID-7690ADED-7EC0-4C98-BEB7-1FF0755D7075-default.gif follows]










Declaring and Passing Parameters

To define a parameter, use the XDO_PARAM_?n? function to declare the parameter, then use the $parameter_name syntax to pass a value to the parameter. A parameter must be defined in the data model.

To declare the parameter, use the command that is described in the following table:





	Column A Entry	Column B Entry
	XDO_PARAM_?n?

where n is the unique identifier for the parameter

	<?param@begin:parameter_name;parameter_value?>where parameter_name is the name of the parameter from the data model and parameter_value is the optional default value. 

For example:

<?param@begin:Country;US?>








To use the value of the parameter directly in a cell, refer to the parameter as $parameter_name in the definition for the XDO_ defined name, as described in the following table:





	Column A Entry	Column B Entry
	XDO_PARAM_?parameter_name?

For example:

XDO_PARAM_?Country?

	<?$parameter_name?>For example:

<?$Country?>








You can also refer to the parameter in other logic or calculations in the XDO_METADATA sheet using $parameter_name.

Example: Defining and passing a parameter

To declare and reference a parameter named Country:

	In the template sheet, mark the cell with a defined name. In the following figure, the cell has been marked with the defined name XDO_?Country?


[image: Description of GUID-6A91D3F9-3962-49D2-A98B-3E3720647E71-default.gif follows]






	In the hidden sheet assign that cell the parameter value, as shown in the following figure:


[image: Description of GUID-F0E7CF75-AAAC-4F3C-95C9-22FEBA605790-default.gif follows]















Defining a Link

Use the XDO_LINK_? command to define a hyperlink for any data cell, as described in this table.

Example: Defining a Link




	Column A Entry	Column B Entry
	XDO_LINK_?cell object name? 

For example:

XDO_LINK_?INVOICE_NO?

	<xsl statement to build the dynamic URL>For example:

<xsl:value-of select="concat('https://server.company.com/documents/invoice_print.show?c_rptno=',./INVOICE_NO)"/>








Assume your company generates customer invoices. The invoices are stored in a central location accessible by a Web server and can be identified by the invoice number (INVOICE_NO).

To generate a report that creates a dynamic link to each invoice:

	In the template sheet, assign the cell that is to display the INVOICE_NO the XDO defined name: XDO_?INVOICE_NO?, as shown in the following figure:


[image: Description of GUID-CA496ADB-E33F-41F2-A886-E12919298C4C-default.gif follows]






	In the XDO_METADATA sheet, enter the appropriate values, as described in the following table:


	Column A Entry	Column B Entry
	XDO_LINK_?INVOICE_NO?

	<xsl:value-of select="concat('https://server.company.com/documents/invoice_print.show?c_rptno=',./INVOICE_NO)"/>








The entries in the Excel are shown in the following figure:


[image: Description of GUID-2BAEB43F-696C-4A17-A5D8-6C2C36E85BCE-default.gif follows]








The report output is displayed as shown in the following figure. The logic that is defined in the XDO_METADATA sheet is applied to create a hyperlink for each INVOICE_NO entry.


[image: Description of GUID-0FB382B0-C8B0-4E56-A038-CA06F788704F-default.gif follows]












Importing and Calling a Subtemplate

Use these commands to declare XSL subtemplates that you can then call and reference in any of the XDO_ commands.

Note:
The Template Builder for Excel does not support preview for templates that import subtemplates.



To import the subtemplate, enter the command shown in the following table:





	Column A Entry	Column B Entry
	XDO_SUBTEMPLATE_?n? where n is a unique identifier. For example: XDO_SUBTEMPLATE_?1? 

	<xsl:import href="xdoxsl:///path to subtemplate.xsb?"/> For example: <xsl:import href="xdoxsl:///Shared Folders/Financial Reports/SubTemplates/MySubTemplate.xsb?"/>








To call the subtemplate, declare the cell name for which the results should be returned in Column A, then enter the call-template syntax with any other XSL processing to be performed. The commands are shown in the following table:





	Column A Entry	Column B Entry
	XDO_?cell object name?

	<xsl:call-template name="template_name"> </xsl:call-template>








For more information on XSL subtemplates and creating the subtemplate object in the catalog, see Designing XSL Subtemplates.

Example: Importing and Calling a Subtemplate

Assume you have the following subtemplate uploaded to the BI Publisher catalog as PaymentsSummary-SubTemplate.xsb. This subtemplate evaluates the value of a parameter named pPayType and based on the value, return a string that indicates the payment type:

<?xml version="1.0" encoding="utf-8"?>
<xsl:stylesheet version="2.0"
 xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:template match="/">
    </xsl:template>
      <xsl:template name="BRM_PAY_TYPES">
         <xsl:param name="pPayType" select="string('ALL')"/>
         <xsl:choose>
            <xsl:when test="$pPayType = '0'">UNDEFINED</xsl:when>
            <xsl:when test="$pPayType=string('10000')">PREPAID</xsl:when>
            <xsl:when test="$pPayType=string('10001')">INVOICE</xsl:when>
            <xsl:when test="$pPayType=string('10003')">CREDIT CARD</xsl:when>
            <xsl:when test="$pPayType=string('10005')">DIRECT DEBIT</xsl:when>
            <xsl:when test="$pPayType=string('10011')">CASH</xsl:when>
            <xsl:when test="$pPayType=string('10012')">CHECK</xsl:when>
            <xsl:when test="$pPayType=string('ALL')">ALL</xsl:when>
            </xsl:choose>
        </xsl:template>
</xsl:stylesheet>


In the Excel template, you have defined a field with the XDO Defined Name XDO_?TYPE?, which is populated based on the string returned from code performed in the subtemplate, as shown in the following figure:


[image: Description of GUID-ACEC222D-71F2-47CD-949D-4088C72F3F3F-default.gif follows]





Enter the commands shown in the following table in the Data Constraints region.





	Column A Entry	Column B Entry
	XDO_SUBTEMPLATE_?1?

	<xsl:import href="xdoxsl:///Shared Folders/Financial Reports/SubTemplates/PaymentsSummary-SubTemplate.xsb?"/>


	XDO_?TYPE?

	<xsl:call-template name="BRM_PAY_TYPES"> <xsl:with-param name="pPayType" select="string('10000')"/> </xsl:call-template>








The XDO_SUBTEMPLATE_?1? function imports the subtemplate from the BI Publisher catalog.

The XDO_?TYPE? cell entry maps the results of the subtemplate processing entered in Column B.








Referencing Java Extension Libraries

You can include the reference to a Java extension library in the template and then call methods from this library to perform processing in the template.

Use the command shown in the following table to reference the Java extension libraries.





	Column A Entry	Column B Entry
	XDO_EXT_?n? where n is a unique identifier. Example: XDO_EXT?1?

	<?namespace:xmlns:bipext="extension library"?> Example: <?namespace:xmlns:bipext="http://www.example.com/XSL/Transform/java/ example.com.xmlpublisher.reports.BIPExtension"?>








You can have multiple extension libraries defined in a single template file.

Example: Calling a Java Extension Library

Assume the extension library includes the following two methods that you want to call in the template:

	bipext:infTimeToStr()


	bipext:infStrToTimet()




After you have declared the library as shown above, specify the cell to which you want to apply the method by entering the XDO defined name in Column A and calling the function in Column B. The following table shows example commands.





	Column A Entry	Column B Entry
	XDO_?PARAM_START_DATE?

	<xsl:value-of select="bipext:infTimeToStr(bipext:infStrToTimet((.//PARAM_START_DATE)[1],2),3)"








The entries in the XDO_METADATA sheet to declare and call the Java extension libraries are shown in the following illustration.

[image: Description of GUID-9D713C06-B71C-4310-AD32-6D38A44AA06F-default.gif follows]












Formatting Functions That Rely on Specific Data Attribute Values

The commands in this table require that specific formatting attributes be present in the XML data file.

A summary list of the commands is shown in the following table. See the corresponding section for details on usage.





	Function	Command
	Defining Border and Underline Styles

	XDO_STYLE_n_?cell object name?


	Skipping a Row

	XDO_SKIPROW_?cell object name?










Defining Border and Underline Styles

While you can define a consistent style in the template using Excel formatting, the XDO_STYLE command enables you to define a different style for any data cell dynamically based on the XML data.

With the XDO_STYLE command you specify the cell to which to apply the style, the logic to determine when to apply the style, and the style type to apply. The style value must be present in the XML data. The following table provides examples.





	Column A Entry	Column B Entry	Column C Entry
	XDO_STYLE_n_?cell_object_name?

For example:

XDO_STYLE_1_?TOTAL_SALARY?

	<xsl evaluation that returns a supported value>

For example:

<xsl:value-of select=".//TOTAL_SALARY/@borderStyle"/>

	Style type

For example:

BottomBorderStyle








BI Publisher supports the normal Excel style types and values as shown in the following table:





	Style Type	Supported Values (Must be in returned by evaluation in Column B)	Supported Types (Enter in Column C)
	Normal

	BORDER_NONE

BORDER_THIN

BORDER_MEDIUM

BORDER_DASHED

BORDER_DOTTED

BORDER_THICK

BORDER_DOUBLE

BORDER_HAIR

BORDER_MEDIUM_DASHED

BORDER_DASH_DOT

BORDER_MEDIUM_DASH_DOT

BORDER_DASH_DOT_DOT

BORDER_MEDIUM_DASH_DOT_DOT

BORDER_SLANTED_DASH_DOT

	BottomBorderStyle

TopBorderStyle

LeftBorderStyle

RightBorderStyle

DiagonalLineStyle








You can also set a color using one of the types shown in the following table:





	Style Type	Supported Value (Must be in returned by evaluation in Column B)	Supported Types (Enter in Column C)
	Normal

	When you set Color Style, give the value in RRBBGG hex format, for example:

borderColor="0000FF"

	BottomBorderColor

TopBorderColor

LeftBorderColor

RightBorderColor

DiagonalLineColor








BI Publisher also supports the underline type with the values shown in the following table:





	Style Type	Supported Values (Must be in returned by evaluation in Column B)	Supported Type (Enter in Column C)
	Underline

	UNDERLINE_NONE

UNDERLINE_SINGLE

UNDERLINE_DOUBLE

UNDERLINE_SINGLE_ACCOUNTING

UNDERLINE_DOUBLE_ACCOUNTING

	UnderlineStyle








You can have multiple underline styles defined for a single cell.

Example: Defining Styles

To apply a style in a template, the style value must be present in the data. In this example, a border style and an underline style are applied to the DEPT_TOTAL_SALARY field shown in the Excel template.

For this example, the following data is used. Note that the DEPT_TOTAL_SALARY element in the data has these attributes defined:

	borderStyle


	underLineStyle


	borderColor




The value of each of these attributes is used to apply the defined style based on logic defined in the template.

<?xml version="1.0" encoding="UTF-8"?>

<EMPLOYEES>
  <G_DEPT>
    <DEPARTMENT_ID>10</DEPARTMENT_ID>
    <DEPARTMENT_NAME>Administration</DEPARTMENT_NAME>
    <LIST_G_EMP>
      <G_EMP>
        <EMPLOYEE_ID>200</EMPLOYEE_ID>
        <EMP_NAME>Jennifer Whalen</EMP_NAME>
        <EMAIL>JWHALEN</EMAIL>
        <PHONE_NUMBER>515.123.4444</PHONE_NUMBER>
        <HIRE_DATE>1987-09-17T00:00:00.000-06:00</HIRE_DATE>
        <SALARY>4400</SALARY>
      </G_EMP>
    </LIST_G_EMP>

    <DEPT_TOTAL_SALARY borderStyle="BORDER_DOUBLE" underLineStyle="UNDERLINE_DOUBLE_ACCOUNTING" borderColor="0000FF">4400</DEPT_TOTAL_SALARY>
  </G_DEPT>
  <G_DEPT>
    <DEPARTMENT_ID>20</DEPARTMENT_ID>
    <DEPARTMENT_NAME>Marketing</DEPARTMENT_NAME>
    <LIST_G_EMP>
      <G_EMP>
        <EMPLOYEE_ID>201</EMPLOYEE_ID>
        <EMP_NAME>Michael Hartstein</EMP_NAME>
        <EMAIL>MHARTSTE</EMAIL>
        <PHONE_NUMBER>515.123.5555</PHONE_NUMBER>
        <HIRE_DATE>1996-02-17T00:00:00.000-07:00</HIRE_DATE>
        <SALARY>13000</SALARY>
      </G_EMP>
      <G_EMP>
        <EMPLOYEE_ID>202</EMPLOYEE_ID>
        <EMP_NAME>Pat Fay</EMP_NAME>
        <EMAIL>PFAY</EMAIL>
        <PHONE_NUMBER>603.123.6666</PHONE_NUMBER>
        <HIRE_DATE>1997-08-17T00:00:00.000-06:00</HIRE_DATE>
        <SALARY>6000</SALARY>
        </G_EMP>
      </LIST_G_EMP>

      <DEPT_TOTAL_SALARY borderStyle="BORDER_DOUBLE" underLineStyle="UNDERLINE_DOUBLE_ACCOUNTING" borderColor="0000FF">19000</DEPT_TOTAL_SALARY>
  </G_DEPT>

...

</EMPLOYEES>


To define a style:

	In the Excel template, assign the defined name XDO_?DEPT_TOTAL_SALARY? to the field that is to display the DEPT_TOTAL_SALARY from the data, as shown in the following figure:


[image: Description of GUID-B0FD4BD5-4CFE-4F4F-9238-EC3F3CEAAF81-default.gif follows]






	In the XDO_METADATA sheet, enter the following:

	To define the top border style, use the entries shown in the following table:


	Column A Entry	Column B Entry	Column C Entry
	XDO_STYLE_1_?DEPT_TOTAL_SALARY?

	<xsl:value-of select=".//DEPT_TOTAL_SALARY/@borderStyle"/>

	TopBorderStyle








The entry in Column A maps this style command to the cell assigned the name XDO_?DEPT_TOTAL_SALARY?

The entry in Column B retrieves the style value from the attribute borderStyle of the DEPT_TOTAL_SALARY element. Note from the sample data that the value for borderStyle is "BORDER_DOUBLE".

The entry in Column C tells BI Publisher to apply a TopBorderStyle to the cell.


	To define the top border color, use the entries shown in the following table:


	Column A Entry	Column B Entry	Column C Entry
	XDO_STYLE_2_?DEPT_TOTAL_SALARY?

	<?.//DEPT_TOTAL_SALARY/@borderColor?>

	TopBorderColor








The entry in Column A maps this style command to the cell assigned the name XDO_?DEPT_TOTAL_SALARY?

The entry in Column B retrieves the style value from the attribute borderColor of the DEPT_TOTAL_SALARY element. Note from the sample data that the value for borderColor is 0000FF (blue).

The entry in Column C tells BI Publisher to apply a TopBorderColor to the cell.


	To define the underline style, use the entries shown in the following table:


	Column A Entry	Column B Entry	Column C Entry
	XDO_STYLE_3_?DEPT_TOTAL_SALARY?

	<?.//DEPT_TOTAL_SALARY/@underLineStyle?>

	UnderlineStyle








The entry in Column A maps this style command to the cell assigned the name XDO_?DEPT_TOTAL_SALARY?

The entry in Column B retrieves the style value from the attribute underLineStyle of the DEPT_TOTAL_SALARY element. Note from the sample data that the value for underLineStyle is UNDERLINE_DOUBLE_ACCOUNTING.

The entry in Column C tells BI Publisher to apply the UnderLineStyle to the cell.







The following figure shows the three entries in the Data Constraints region:


[image: Description of GUID-DE7587FF-3F88-469A-A2C9-A8975FC56F9C-default.gif follows]





When you run the report, the style commands are applied to the XDO_?DEPT_TOTAL_SALARY? cell, as shown in the following figure:


[image: Description of GUID-D8F537C9-9D6E-42D7-98C6-285D9F002507-default.gif follows]












Skipping a Row

Use the XDO_SKIPROW command to suppress the display of a row of data in a table when the results of an evaluation defined in Column B return the case insensitive string "True". 

Example entries are shown in the following table.





	Column A Entry	Column B Entry
	XDO_SKIPROW_?cell_object_name?

For example:

XDO_SKIPROW_?EMPLOYEE_ID?

	<xsl evaluation that returns the string "True"/>

For example:

<xsl:if test="string-length(./EMPLOYEE_ID/@MANAGER) != 0"> <xsl:value-of select="./EMPLOYEE_ID/@MANAGER"/> </xsl:if>








Example: Skipping a Row Based on Data Element Attribute

In this example, the Excel template suppresses the display of the row of employee data when the EMPLOYEE_ID element includes a "MANAGER" attribute with the value "True".

Assume data as shown below. Note that the EMPLOYEE_ID element for employee Michael Hartstein has the MANAGER attribute with the value "True". The other EMPLOYEE_ID elements in this set do not have the attribute.

<?xml version="1.0" encoding="UTF-8"?>

<EMPLOYEES>
  <G_DEPT>
    <DEPARTMENT_ID>20</DEPARTMENT_ID>
    <DEPARTMENT_NAME>Marketing</DEPARTMENT_NAME>
    <LIST_G_EMP>
      <G_EMP>
        <EMPLOYEE_ID MANAGER="TRUE">201</EMPLOYEE_ID>
        <EMP_NAME>Michael Hartstein</EMP_NAME>
        <EMAIL>MHARTSTE</EMAIL>
        <PHONE_NUMBER>515.123.5555</PHONE_NUMBER>
        <HIRE_DATE>1996-02-17T00:00:00.000-07:00</HIRE_DATE>
        <SALARY>13000</SALARY>
       </G_EMP>
       <G_EMP>
        <EMPLOYEE_ID>202</EMPLOYEE_ID>
        <EMP_NAME>Pat Fay</EMP_NAME>
        <EMAIL>PFAY</EMAIL>
        <PHONE_NUMBER>603.123.6666</PHONE_NUMBER>
        <HIRE_DATE>1997-08-17T00:00:00.000-06:00</HIRE_DATE>
        <SALARY>6000</SALARY>
       </G_EMP>
       <G_EMP>
        <EMPLOYEE_ID>652</EMPLOYEE_ID>
        <EMP_NAME>William Morgan</EMP_NAME>
        <EMAIL>WMORGAN</EMAIL>
        <PHONE_NUMBER>219.123.7776</PHONE_NUMBER>
        <HIRE_DATE>1994-10-17T00:00:00.000-06:00</HIRE_DATE>
        <SALARY>8000</SALARY>
       </G_EMP>
      </LIST_G_EMP>
  </G_DEPT>

...

</EMPLOYEES>


To suppress the display of the row of the employee data when the MANAGER attribute is set to "True", enter the entries shown in the following table in the Data Constraints section.





	Column A Entry	Column B Entry
	XDO_SKIPROW_?EMPLOYEE_ID?

	<xsl:if test="string-length(./EMPLOYEE_ID/@MANAGER) != 0"> <xsl:value-of select="./EMPLOYEE_ID/@MANAGER"/> </xsl:if>








The output from this template is shown in the following illustration. Note that the employee Michael Hartstein is not included in the report.

[image: Description of GUID-2BCEDD93-FE0B-4DAF-8E40-EBC4A5266117-default.gif follows]












Grouping Functions

Use the functions shown in this table to create groupings of data in the template.


	Function	Command
	Grouping the Data

	XDO_GROUP_?group element?


	Regrouping the Data

	XDO_REGROUP_?










Grouping the Data

Use the XDO_GROUP command to group flat data when the layout requires a specific data grouping, for example, to split the data across multiple sheets.

Example entries are shown in the following table:





	Column A Entry	Column B Entry	Column C Entry
	XDO_GROUP_?group element?

For example:

XDO_GROUP_?STATE_GROUP?

	<xsl beginning groupng logic/>

For example:

<xsl:for-each-group select="current-group()" group-by="./STATE"> <xsl:for-each-group select="current-group()" group-by="./RESOURCE_NAME"> <xsl:for-each select="current-group()">

	<xsl ending groupng tags/>

For example:

</xsl:for-each> <xsl:for-each-group> <xsl:for-each-group>








Define the XSL statements to be placed at the beginning and ending of the section of the group definition marked up by XDO_?cell object name?. You can mark multiple groups nested in the template, giving each the definition appropriate to the corresponding group.








Handling the Generated XDO Define Names in Nested Groups

When XDO_GROUP_? is used in a nested group, the ranges of XDO define names in the final report become meaningless. In this case, do not refer to the define names in formulas in the final report. You can disable the XDO markup activity in the final report using the command XDO_MARKUP_?.

The following table shows the usage of XDO_MARKUP_? in the XDO_METADATA sheet:


	Column A Entry	Column B Entry
	XDO_MARKUP_?

	"false" or "FALSE"

(The cell must be formatted as Text in the Excel Format Cells dialog.)








In addition, if your template includes a large number of defined names and these are used in multiple levels of nested groups, Excel may not be able to handle the number of generated defined names. In this case, use the XDO_MARKUP_? command to disable markup for the generated report.

When set to false, BI Publisher does not produce any defined names for any result produced by XDO_GROUP_?





Regrouping the Data

The XDO_REGROUP regroups the data by declaring the structure using the defined names. 

The XDO_REGROUP logic is a shortened form of the XDO_GROUP logic and does not require the XSLTcoding requirements in the XDO_METADATA sheet. The definition must therefore be directly on XDO_REGROUP_? define names, or on any other definition on the XDO_METADATA sheet. Entries are shown in the following table.





	Column A Entry	Column B Entry
	XDO_REGROUP_?

	XDO_REGROUP_?UniqueGroupID?levelName?groupByName?sortByName?sortByName?sortByName?

where

	UniqueGroupID is the ID of the group. It can be the same as the levelName or you can assign it unique name.


	levelName is the XML level tag name in the XML data file or XDO_CURRGRP_ that represents the current-group() in the context of nested grouping. XDO_CURRGRP_ should be used for all inner groups when more than one nesting group exists in your template.


	groupByName is the field name that you want to use for the GroupBy operation for the current group. This name can be empty if the XDO_REGROUP_? command is used for the most inner group.


	sortByName is the field name that you want to sort the group by. You can have multiple sortBy fields. If no sortByName is declared, then the data from the XML file is not sorted.











The next three tables show an example of how to create three nested groupings.





	Column A Entry	Column B Entry
	XDO_REGROUP_?

	XDO_REGROUP_?PAYMENTSUMMARY_Q1?PAYMENTSUMMARY_Q1?PAY_TYPE_NAME?








In the definition shown in the previous table, the most outer group is defined as PAYMENTSUMMARY_Q1, and it is grouped by PAY_TYPE_NAME





	Column A Entry	Column B Entry
	XDO_REGROUP_?

	XDO_REGROUP_?COUNTRYGRP?XDO_CURRGRP_?COUNTRY?








The definition shown in the previous table creates a second outer group. The group is assigned the name COUNTRY_GRP and it is grouped by the element COUNTRY.





	Column A Entry	Column B Entry
	XDO_REGROUP_?

	XDO_REGROUP_?STATEGRP?XDO_CURRGRP_?STATE?








The definition shown in the previous table creates the inner group STATEGRP and it includes a sortByName parameter: STATE.











Preface

Oracle Business Intelligence Publisher (BI Publisher) is a reporting and publishing application that enables you to extract data from multiple data sources, create layouts for report data, and publish the report to numerous output formats. BI Publisher also enables you to schedule reports and deliver the reports to multiple delivery destinations required by your business.



Audience

This document is intended for report designers and developers using Oracle Business Intelligence Publisher to create reports, configure reports, add translations, and use other BI Publisher report design features.

This guide describes how to create report layouts and use BI Publisher's report editor to assemble the components of a report. See the guides that are listed in the following table for more information about using the product for other business roles.


	Role	Sample Tasks	Guide
	Administrator

	Configuring Security

Configuring System Settings

Diagnosing and Monitoring System Processes

	Administrator's Guide for Oracle Business Intelligence Publisher


	Application developer or integrator

	Integrating BI Publisher into existing applications using the application programming interfaces

	Developer's Guide for Oracle Business Intelligence Publisher


	Report consumer

	Viewing reports

Scheduling report jobs

Managing report jobs

	User's Guide for Oracle Business Intelligence Publisher


	Data Model developer

	Fetching and structuring the data to use in reports

	Data Modeling Guide for Oracle Business Intelligence Publisher












Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.








System Requirements and Certification

Refer to the system requirements and certification documentation for information about hardware and software requirements, platforms, databases, and other information. Both of these documents are available on Oracle Technology Network (OTN).

The system requirements document covers information such as hardware and software requirements, minimum disk space and memory requirements, and required system libraries, packages, or patches:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusion-requirements-100147.html

The certification document covers supported installation types, platforms, operating systems, databases, JDKs, and third-party products:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusion-certification-100350.html





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface

	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.


	italic

	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.


	monospace

	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.













Adding Markup to the Template

After you have converted a document to PDF, you define form fields that display the data from the XML input file. These form fields are placeholders for the data. The process of associating the XML data to the PDF template is the same as the process for the RTF template.

See Associating the XML Data to the Template Layout.

When you draw the form fields in Adobe Acrobat, you are drawing them on top of the template that you designed. There is not a relationship between the design elements on the template and the form fields. You therefore must place the fields exactly where you want the data to display on the template.




G Using the Customize Feature

This appendix describes how to use the Customize feature available for reports when BI Publisher is integrated with Oracle BI Enterprise Edition.


This appendix includes the following sections:

	About Customizing Reports


	Prerequisites and Limitations of the Customization Feature


	Using the Customize Feature


	Considerations When Using the Customize Feature







Example Uses of XSL Subtemplates

These are examples of formatting that can be achieved in a report by using XSL subtemplates.

	Handling XML Data with HTML Formatting


	Dynamically Applying Formatting to a Portion of Data






Handling XML Data with HTML Formatting

If you have XML data that already contains HTML formatting and you want to preserve that formatting in the report, then you can preserve that formatting by using an XSL subtemplate to map the HTML formatting commands to XSL equivalents that can be handled by BI Publisher.

Note that the HTML must be in XHTML format. This means that all HTML tags must have start and end tags in the data. For example, if the data uses a simple <BR> for a break, then you must add the closing </BR> before you can use this solution.

Following is some sample data with HTML formatting:

<DATA>
  <ROW>
    <PROJECT_NAME>Project Management</PROJECT_NAME>
    <PROJECT_SCOPE>
      <p>Develop an application to produce <i>executive-level summaries</i> and detailed project reports. The application will allow users to: </p>
       <p>Import existing MS Project files </p>
       <p>Allow the user to map file-specific resources to a central database entities (i.e., people) and projects; </p>
       <p>Provide structured output that can be viewed by staff and executives. </p>
   </PROJECT_SCOPE>
   <PROJECT_DEFINITION><b>Information about current projects is not readily available to executives.</b> Providing this information creates a reporting burden for IT staff, who may already maintain this information in Microsoft Project files. </PROJECT_DEFINITION>
  </ROW>
</DATA>


Note in this sample the following HTML tags:




	<p> - paragraph tag


	<i> - italics tag


	<b> - bold tag




Assume a report requirement to display this to retain the formatting supplied by these tags as shown in the following figure:


[image: Description of GUID-722F09DB-4F37-401B-BF5F-8062FEB12C7A-default.gif follows]





The following subtemplate uses XSL syntax to match the three HTML tags in the XML data. The template then replaces the matched HTML string with its XSLFO equivalent.

<xsl:template match="P|p">
 <fo:block white-space-collapse="false" padding-bottom="3pt" linefeed-treatment="preserve">
  <xsl:apply-templates select="text()|*|@*"/> 
 </fo:block>
</xsl:template>

<xsl:template match="STRONG|B|b">
        <fo:inline font-weight="bold">
                <xsl:apply-templates/>
        </fo:inline>
</xsl:template>

<xsl:template match="EM|I|i">
        <fo:inline font-style="italic">
                <xsl:apply-templates/>
        </fo:inline>
</xsl:template>





To use this XSL syntax:


	Upload this XSL subtemplate file to the BI Publisher catalog location: Shared Folders/Projects. Save this subtemplate file as htmlmarkup.xsb.
	In the main template enter the following to import the subtemplate file:<?import:xdoxsl:///Projects/htmlmarkup.xsb?>




	For each field that has HTML markup, call the xsl apply-template command. In this example, there are two fields:<xsl:apply-templates select="PROJECT_SCOPE"/>
<xsl:apply-templates select="PROJECT_DEFINITION"/>

The following figure shows the field definitions in the template:


[image: Description of GUID-AE6840AB-757E-4F9B-BDA9-108C88005408-default.gif follows]





The command tells the processor to apply all templates to the value of the element PROJECT_SCOPE and PROJECT_DEFINITION. It then cycles through the subtemplate functions looking for a match.









Dynamically Applying Formatting to a Portion of Data

This application of subtemplates is useful for documents that require chemical formulae, mathematical calculations, or superscripts and subscripts.

For example, in the sample XML data below CO2 is expected to display as CO2 and H2O is expected to display as H2O.

<ROWSET> 
  <ROW> 
    <FORMULA>CO2</FORMULA> 
  </ROW> 
  <ROW> 
   <FORMULA>H2O</FORMULA> 
  </ROW>
</ROWSET>


This can be achieved by using an XSL subtemplate. Using XSL syntax you can define a template with any name, for example, "chemical_formatter" that accepts the FORMULA field as a parameter, and then read one character at a time. It compares the character with 0 - 9 digits, and if there is a match, then that character is subscripted using the following XSL FO syntax:

<fo:inline baseline-shift="sub" font-size="75%">


Here is sample code for the XSL template statement:

<xsl:template name="chemical_formatter"> 
<! -  accepts a parameter e.g. H2O  - > 
<xsl:param name="formula"/> 
<! -  Takes the first character of the string and tests it to see if it is a number between 0-9 - > <xsl:variable name="each_char" 
select="substring($formula,1,1)"/> 
<xsl:choose> 
   <xsl:when test="$each_char='1' or $each_char='2' 
   or $each_char='3' or $each_char='4' or $each_char='5' 
   or $each_char='6' or $each_char='7' or $each_char='8' 
   or $each_char='9' or $each_char='0'"> 
   <! -  if it is numeric it sets the FO subscripting properties  - > 
     <fo:inline baseline-shift="sub" font-size="75%"> 
        <xsl:value-of select="$each_char"/> 
     </fo:inline> 
   </xsl:when> 
   <xsl:otherwise> 
   <! -  otherwise the charater is left as is  - > 
       <fo:inline baseline-shift="normal"> 
         <xsl:value-of select="$each_char"/> 
       </fo:inline> 
   </xsl:otherwise> 
 </xsl:choose> 
 <! -  test if there are other chars in the string, if so the recall the template  - >
   <xsl:if test="substring-after($formula,$each_char) !=''"> 
      <xsl:call-template name="chemical_formater"> 
        <xsl:with-param name="formula"> 
           <xsl:value-of select="substring-after($formula,$each_char)"/> 
        </xsl:with-param> 
     </xsl:call-template> 
   </xsl:if> 
</xsl:template>





To use this XSL template statement:


	Save this file as chemical.xsl.
	Follow the instructions in Uploading a Sub Template. Assume that you name the Sub Template "Chemical" (it is saved as Chemical.xsb) and place it in the following location: Shared Folders/Subtemplates.
	In the main RTF template enter the import syntax:<?import:xdoxsl:///Subtemplates/Chemical.xsb?>




	To render the XSL code in the report, create a loop over the data and in the VALUE field use:<xsl:call-template name="chemical_formatter">
<xsl:with-param name="formula" select="VALUE"/> </xsl:call-template>






This calls the formatting template with the FORMULA value that is, H2O. Once rendered, the formulae are shown as expected: H2O.









Updating a Style Template

You can alter a style template after it has been saved.

To update or edit a saved style template:




	Navigate to the file in the catalog.
	Click Edit to open the Style Template properties page.
	Delete the existing file.
	Upload the edited file, choosing the same locale.





Creating Reports Using a Direct Connection to a Subject Area

Subject area reports contain queries that are issued directly to the Oracle BI Server, therefore the report does not use a BI Publisher data model.



When you run a report that uses a subject area as a data source, the Oracle BI Server optimizes and determines how many queries are actually issued to the database based on the columns selected for the report.

Keep the following points in mind when creating a subject area report:

	You must use the Create Report guide to create subject area reports.


	No data model is created for a subject area report. BI Publisher executes the subject area queries as defined in Oracle BI Enterprise Edition to retrieve the report data.


	In the Create Report guide, you can only select one subject area for a report. To create a report that uses multiple subject areas, first create a report against a single subject area using the Create Report guide and then edit the report in the report editor to add subject areas. See Creating a Report Against Multiple Subject Areas

 for more information.
	For reports that use a subject area, BI Publisher calculates subtotals and totals based on the data received from the BI Server, which is already summarized. As BI Publisher is not performing the summary calculations, certain functions that require access to the original column data, such as count distinct and average, may deliver different results in BI Publisher.


	Hierarchical columns that are available in Oracle BI Enterprise Edition are not available for use in subject area reports in BI Publisher.


	Be aware that if you link multiple fields from unrelated subject areas in a single report component such as a graph, table, or pivot table, the rendering of the component may fail because the data cannot be correlated correctly.






Creating Subject Area Reports

You can create a subject area report by launching the create report guide.

To create a subject area report:



	Launch the Create Report guide.
	Select a subject area. Only one subject area can be selected.To report against multiple subject areas, after selecting the first subject area, select the Use Report Editor option, and click Finish to save the report. Then, use the report editor to add the additional subject areas. For more information, see Creating a Report Against Multiple Subject Areas.



	Follow the prompts to create your report layout as described in Choosing Columns for Report Layouts.






Adding Parameters to Subject Area Reports

Parameters are usually defined in the data model for BI Publisher reports. Reports that run directly against a subject area do not use a data model, therefore, you must use the report editor to set up parameter definitions for subject area reports.

If you intend to use a subject area report in an Oracle BI Enterprise Edition dashboard and you need to use pass parameters, see 'Using Prompts with Parameterized Reports’ in User's Guide for Oracle Business Intelligence Enterprise Edition for more information.




To add parameters to subject area reports:



	Create and save the report as described in Creating Subject Area Reports.
	In report editor, click Parameters to launch the Edit Parameters dialog as shown in the following figure.[image: Description of GUID-9B8345DF-FCE4-473D-892A-C35775B99D78-default.gif follows]





	Click Add to launch the Select a Column to Define Parameter dialog as shown in the following figure.[image: Description of GUID-78094C9A-79BE-4ED1-839D-276E1B193A54-default.gif follows]





	Select a parameter column and click OK to launch the Edit Parameter dialog as shown in the following figure.The options displayed for selection in the Edit Parameter dialog are driven by the parameter column data type.

[image: Description of GUID-62E5AEAC-EB9B-4202-9C07-1D20CE230EC5-default.gif follows]





	Enter the parameter label to be displayed in the report.
	Select a parameter display option:	Calendar - Provides users with a field into which they can enter a specific date, as well as a calendar pop-up to select a date. This display option is only available for selection if the parameter has a date column type.


	Choice List - Provides users with a collapsed list of all prompt values. This display option is useful for a long list of values where you want to provide the user with the ability to search for a specific value.


	Checkboxes - Provides users with a visible list of all prompt values where a small, selectable box displays before each value item. This display option is suitable for a prompt that contains a smaller set of data.


	Radio Buttons - Provides users with a visible list of all prompt values where a radio button is displayed before each prompt value. This display option is useful for short lists of values where the user is to select only one prompt value.


	Text - Provides users with a field into which they can enter a specific prompt value. This display option cannot be used for multiple prompt values. Only the field and the field label are displayed for this option.






	Select the parameter operator. The default value is set to is equal to/is in.
	Click OK.






Creating a Report Against Multiple Subject Areas

You can use the report editor to link a report to multiple subject areas.

To add multiple subject areas to a report:



	Use the report editor to open the report. The upper left corner displays the subjects areas already linked to the report as shown in the following figure:[image: Description of GUID-450500A0-8A34-4A21-A66A-74C6C5D5637E-default.gif follows]





	Click Edit Subject Areas to launch the Select Subject Areas dialog as shown in the following figure:[image: Description of GUID-2CD460BB-772D-4B73-8818-990A69B9AA84-default.gif follows]





	From the Available pane, select one or more subject areas.
	Click Add to move the subject area(s) to the Selected pane.
	Click Finish.







Inserting Layout Components

The layout editor supports components that are typically used in reports and other business documents.

The followings components are described in these sections:

	Inserting Layout Grids


	About Repeating Sections


	About Data Tables


	About Charts


	About Gauge Charts


	About Pivot Tables


	About Text Items


	About Images


	About Lists







15 Translation Support Overview and Concepts

This chapter provides an overview of concepts related to report and catalog translation in BI Publisher.


It includes the following sections:

	Translation Support Overview


	Working with Translation Files


	Locale Selection Logic







FO Processing Properties

The properties described in this table can be set to govern FO processing.


	Property Name	Description
	Use BI Publisher's XSLT processor

	Default: true

Description: Controls BI Publisher's parser usage. If set to false, then XSLT is not parsed.

Internal Name: xslt-xdoparser


	Enable scalable feature of XSLT processor

	Default: false

Description: Controls the scalable feature of the XDO parser. The property "Use BI Publisher's XSLT processor" must be set to true for this property to be effective.

Internal Name: xslt-scalable


	Enable XSLT runtime optimization

	Default: true

Description: When set to true, the overall performance of the FO processor is increased and the size of the temporary FO files generated in the temp directory is significantly decreased. Note that for small reports (for example 1-2 pages) the increase in performance is not as marked. To further enhance performance when you set this property to true, it is recommended that you set the property Extract attribute sets to false. See RTF Template Properties.

Internal Name: xslt-runtime-optimization


	Enable XPath Optimization

	Default: false

Description: When set to true, the XML data file is analyzed for element frequency. The information is then used to optimize XPath in XSL.

Internal Name: xslt-xpath-optimization


	Pages cached during processing

	Default: 50

Description: This property is enabled only when you have specified a Temporary Directory (under General properties). During table of contents generation, the FO Processor caches the pages until the number of pages exceeds the value specified for this property. It then writes the pages to a file in the Temporary Directory.

Internal Name: system-cache-page-size


	Bidi language digit substitution type

	Default: National

Description: Valid values are None and National. When set to None, Eastern European numbers are used. When set to National, Hindi format (Arabic-Indic digits) is used. This setting is effective only when the locale is Arabic, otherwise it is ignored.

Internal Name: digit-substitution


	Disable variable header support

	Default: false

Description: If true, prevents variable header support. Variable header support automatically extends the size of the header to accommodate the contents.

Internal Name: fo-prevent-variable-header


	Add prefix to IDs when merging FO

	Default: false

Description: When merging multiple XSL-FO inputs, the FO Processor automatically adds random prefixes to resolve conflicting IDs. Setting this property to true disables this feature.

Internal Name: fo-merge-conflict-resolution


	Enable multithreading

	Default: false

Description: If you have a multiprocessor machine or a machine with a dual-core single processor, you may be able to achieve faster document generation by setting this option to True.

Internal Name: fo-multi-threads


	Disable external references

	Default: true

Description: A true setting (default) disallows the importing of secondary files such as subtemplates or other XML documents during XSL processing and XML parsing. This increases the security of the system. Set this to false if the report or template calls external files.

Internal Name: xdk-secure-io-mode


	FO Parsing Buffer Size

	Default: 1000000

Description: Sets the size of the buffer for the FO Processor. When the buffer is full, the elements from the buffer are rendered in the report. Reports with large tables or pivot tables that require complex formatting and calculations may require a larger buffer to properly render those objects in the report. Increase the size of the buffer at the report level for these reports. Note that increasing this value affects the memory consumption of the system.

Internal Name: fo-chunk-size


	Enable XSLT runtime optimization for sub-template

	Default: true

Note:
 The default is true on the BI Publisher server. If you call the FOProcessor directly, the default is false.

Description: Provides an option to perform XSL import in FOProcessor before passing only one XSL to XDK for further processing. This allows xslt-optimization to be applied to the entire main XSL template which already includes all its subtemplates.

Internal Name: xslt-do-import


	Enable PPTX native chart support

	Default: false

Description: This property applies to PowerPoint 2007 output. When set to true, charts in PowerPoint 2007 output are rendered as native PowerPoint (PPTX) charts. When set to false, the chart is rendered as an embedded PNG image.

Internal Name: pptx-native-chart


	Report Timezone

	Default: User

Description: Valid values: User or JVM.  

When set to User, BI Publisher uses the User-level Report Time Zone setting for reports. The User Report Time Zone is set in the user's Account Settings. 

When set to JVM, BI Publisher uses the server JVM timezone setting for all users' reports. All reports therefore display the same time regardless of individual user settings. This setting can be overridden at the report level.

Internal Name: fo-report-timezone
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2 Creating and Editing Reports

This chapter describes how to create and edit BI Publisher reports.

The chapter includes the following topics:

	About Report Components


	Creating Reports: Process Overview


	Creating Reports


	Creating Reports Using a Direct Connection to a Subject Area


	Editing Reports


	Adding Layouts to the Report Definition


	Configuring Layouts Using the List View


	Configuring Parameter Settings for the Report


	Configuring Report Properties


	Accessing Reports via a URL







Understanding XSL Subtemplates

An XSL subtemplate is an XSL file that consists of one or more <xsl:template> definitions, each containing a block of formatting or processing commands. 

When uploaded to BI Publisher as a Sub Template object in the Catalog, this XSL file can be called from other RTF templates to execute the formatting or processing commands.

XSL subtemplates can handle complex data and layout requirements. Use XSL subtemplates to transform the data structure for a section of a report (for example, for a chart) or to create a style sheet to manage a complex layout.



Where to Put XSL Code in the RTF Main Template

When you call the XSL subtemplate within a main RTF subtemplate, you use XSL commands.

You must put this code inside a BI Publisher field (or Microsoft Word form field). You cannot enter XSL code directly in the body of the RTF template.

For more information on inserting form fields in an RTF template see Inserting a Field.






Setting Predefined or Custom Formulas

You can set custom formulas using the Define Custom Formula icon.

The following illustration shows the Define Custom Formula icon.

[image: Description of GUID-69CE889E-2867-4A6B-B60B-CC759AE5200A-default.gif follows]



The Formula group of commands is available from the following tabs:

	Column tab


	Total Cell tab


	Chart Measure Field tab


	Pivot Table Data tab




Note that not all options are applicable to each component type.



About the Predefined Formulas

The table provides definitions of predefined formulas.

The menu provides the predefined formulas that are described in the following table.





	Formula	Description
	No Formula

	Removes any mathematical formula from a numeric column.


	Blank Text

	Removes all data and inserts blank text.


	Count

	Returns the count of the number of occurrences of the element in the current group.


	Count Distinct

	Returns a count of the distinct values of an element in the current group.


	Summation

	Sums the values of the element in the current group.


	Average

	Displays the average of the values in the current group.


	Maximum

	Displays the highest value of all occurrences in the current group.


	Minimum

	Displays the lowest value of all occurrences in the current group.








For non-numeric data, only the following formula options are supported:

	Blank Text


	Count


	Count Distinct











Applying a Custom Formula

Click Define Custom Formula to define your own formula for a component. The Function dialog enables you to define Basic Math, Context, and Statistical functions in the layout.

The following figure shows the Function dialog:


[image: Description of GUID-B03DD6CB-EAEE-4DFE-AF7B-E608420BD312-default.gif follows]










About the Basic Math Functions

When you click one of the basic math functions, you are prompted to define the appropriate parameters for the function. You can enter a constant value, select a field from the data, or create a nested function to supply the value.

In the Function dialog, clicking the Multiplication function displays prompts to enter the multiplicand and the multiplier. The example shows that the multiplicand is the value of the Amount Sold field. The multiplier is the constant value.


[image: Description of GUID-CF535189-37EA-41F2-B70B-9510B81AAB2C-default.gif follows]









About the Statistical Math Functions

When you click one of the statistical math functions you are prompted to define the appropriate parameter for the function. You can select a field from the data, or create a nested function to supply the values.

In the following figure, clicking the Average function displays prompts for you to specify the source of the values for which to calculate the average.


[image: Description of GUID-32A35313-733C-469A-B350-F16E13B4C725-default.gif follows]











Applying a Custom Formula: Examples

Follow these examples to understand custom formula.

Example 1: Subtraction
The following figure shows data for Revenue and Cost for each Office:

[image: Description of GUID-97A32D4E-6FC8-4D6A-960A-A8E46D7483B1-default.gif follows]



Using a custom formula, you can add a column to this table to calculate Profit (Revenue - Cost).

	Add another numeric data column to the table. For example, drag another instance of Revenue to the table, as shown in the following figure:

[image: Description of GUID-BDCB51C2-EA83-4BBA-820B-C4BF62AE158B-default.gif follows]




	With the table column selected, click Define Custom Formula.


	In the Function dialog select Subtraction from the list, as shown in the following figure. Because the source data for the column is Revenue, by default the Minuend and the Subtrahend both show the Revenue element.


[image: Description of GUID-C651A19F-5962-448B-878D-11CFDA66A7A5-default.gif follows]






	Select Subtrahend, then in the Parameter region, select Field and choose the Cost element, as shown in the following figure:


[image: Description of GUID-90563532-0240-43E4-A163-34AF6DFED18E-default.gif follows]





The dialog is updated to show that the formula is now Revenue minus Cost, as shown in the following figure:


[image: Description of GUID-E0B3D6FE-1C10-484B-A323-10FC2D421311-default.gif follows]






	Click OK to close the dialog.


	The table column displays the custom formula. Edit the table column header title, and now the table has a Profit column, as shown in the following figure:

[image: Description of GUID-3FDE97F1-5EB3-4844-AD72-D612888C4A09-default.gif follows]






Example 2: Nested Function

This example uses a nested function to create a column that shows Revenue less taxes.




	Add another numeric data column to the table. For example, drag another instance of Revenue to the table, as shown in the following figure:[image: Description of GUID-A32C027D-FD22-4F70-BD97-EA2DC3A8BE3B-default.gif follows]





	With the table column selected, click Define Custom Formula.
	In the Function dialog select Subtraction from the list. Because the source data for the column is Revenue, by default the Minuend and the Subtrahend both show the Revenue element, as shown in the following figure:
[image: Description of GUID-C651A19F-5962-448B-878D-11CFDA66A7A5-default.gif follows]







	Select Subtrahend, then in the Parameter region, select Nested Function and click Edit, as shown in the following figure.
[image: Description of GUID-E52A8DED-B882-4FBA-82D0-B5ACF67A6DF4-default.gif follows]





A second Function dialog is displayed to enable you to define the nested function. In this case the nested function is Revenue times a constant value (tax rate of .23), as shown in the following figure:


[image: Description of GUID-311B0F48-B9F1-4CEA-810B-AEDC85CF06C9-default.gif follows]







	Click OK to close the dialog. The primary Function dialog now shows the nested function as the source of the subtrahend, as shown in the following figure:
[image: Description of GUID-E664F1B4-C17B-492F-90C3-230F94A1F6B1-default.gif follows]







	Click OK to close the Function dialog. The table column displays the custom formula. Edit the table column header label, and now the table displays the custom function, as shown in the following figure:[image: Description of GUID-59F9A5ED-606B-4669-8AC9-2D69C752EE35-default.gif follows]












Exporting the XLIFF File

Follow these steps to export an XLIFF file for a catalog folder.

	Select the folder in the catalog.
	Click the Translation toolbar button and then click Export XLIFF, as shown in the following figure:
[image: Description of GUID-A1DA2124-C536-4CCE-99DE-215B6FFC59CE-default.gif follows]





BI Publisher extracts the translatable strings from the template and exports them to an XLIFF (.xlf file).



	Save the XLIFF file to a local directory.





Associating the XML Data to the Template Layout

The figure in this section shows a sample layout for a Payables Invoice Register.


[image: Description of GUID-1F12F16C-28AC-4DC5-B574-234C2F0012C2-default.gif follows]





Note the following:

	The data fields that are defined on the template.

For example: Supplier, Invoice Number, and Invoice Date


	The elements of the template that are repeated when the report is run.

For example, all the fields on the template are repeated for each Supplier that is reported. Each row of the invoice table is repeated for each invoice that is reported.






Using an XML Input File

Following is the XML file that is used as input to the Payables Invoice Register report template.

To simplify the example, the XML output shown has been modified from the actual output from the Payables report.

<?xml version="1.0" encoding="WINDOWS-1252" ?>
 - <VENDOR_REPORT>
  - <LIST_G_VENDOR_NAME>
   - <G_VENDOR_NAME>
     <VENDOR_NAME>COMPANY A</VENDOR_NAME>
   -  <LIST_G_INVOICE_NUM>
    -  <G_INVOICE_NUM>
       <SET_OF_BOOKS_ID>124</SET_OF_BOOKS_ID>
       <GL_DATE>10-NOV-03</GL_DATE>
       <INV_TYPE>Standard</INV_TYPE>
       <INVOICE_NUM>031110</INVOICE_NUM>
       <INVOICE_DATE>10-NOV-03</INVOICE_DATE>
       <INVOICE_CURRENCY_CODE>EUR</INVOICE_CURRENCY_CODE>
       <ENT_AMT>122</ENT_AMT>
       <ACCTD_AMT>122</ACCTD_AMT>
       <VAT_CODE>VAT22%</VAT_CODE>
      </G_INVOICE_NUM>
     </LIST_G_INVOICE_NUM>
     <ENT_SUM_VENDOR>1000.00</ENT_SUM_VENDOR>
     <ACCTD_SUM_VENDOR>1000.00</ACCTD_SUM_VENDOR>  
    </G_VENDOR_NAME>
   </LIST_G_VENDOR_NAME>
  <ACCTD_SUM_REP>108763.68</ACCTD_SUM_REP>
  <ENT_SUM_REP>122039</ENT_SUM_REP>
 </VENDOR_REPORT> 


XML files are composed of elements. Each tag set is an element. For example <INVOICE_DATE> </INVOICE_DATE> is the invoice date element. "INVOICE_DATE" is the tag name. The data between the tags is the value of the element. For example, the value of INVOICE_DATE is "10-NOV-03".

The elements of the XML file have a hierarchical structure. Another way of saying this is that the elements have parent-child relationships. In the XML sample, some elements are contained within the tags of another element. The containing element is the parent and the included elements are its children.

Every XML file has only one root element that contains all the other elements. In this example, VENDOR_REPORT is the root element. The elements LIST_G_VENDOR_NAME, ACCTD_SUM_REP, and ENT_SUM_REP are contained between the VENDOR_REPORT tags and are children of VENDOR_REPORT. Each child element can have child elements of its own.





Identifying Placeholders and Groups

The template content and layout must correspond to the content and hierarchy of the input XML file. Each data field in the template must map to an element in the XML file. Each group of repeating elements in the template must correspond to a parent-child relationship in the XML file.

To map the data fields you define placeholders. To designate the repeating elements, you define groups.

Note:
BI Publisher supports regrouping of data if the report requires grouping that does not follow the hierarchy of the incoming XML data. For information on using this feature, see Regrouping the XML Data.







Using Placeholders

Each data field in the report template must correspond to an element in the XML file.

When you mark up the template design, you define placeholders for the XML elements. The placeholder maps the template report field to the XML element. At runtime the placeholder is replaced by the value of the element of the same name in the XML data file.

For example, the "Supplier" field from the sample report layout corresponds to the XML element VENDOR_NAME. When you mark up the template, you create a placeholder for VENDOR_NAME in the position of the Supplier field. At runtime, this placeholder is replaced by the value of the element from the XML file (the value in the sample file is COMPANY A).





Identifying the Groups of Repeating Elements

The sample report lists suppliers and their invoices. There are fields that repeat for each supplier. One of these fields is the supplier's invoices. There are fields that repeat for each invoice.

The report therefore consists of two groups of repeating fields:

	Fields that repeat for each supplier


	Fields that repeat for each invoice




The invoices group is nested inside the suppliers group. This can be represented as follows:

Suppliers

	Supplier Name


	Invoices

	Invoice Num


	Invoice Date


	GL Date


	Currency


	Entered Amount


	Accounted Amount





	Total Entered Amount


	Total Accounted Amount




Compare this structure to the hierarchy of the XML input file. The fields that belong to the Suppliers group shown above are children of the element G_VENDOR_NAME. The fields that belong to the Invoices group are children of the element G_INVOICE_NUM.

By defining a group, you are notifying BI Publisher that for each occurrence of an element (parent), you want the included fields (children) displayed. At runtime, BI Publisher loops through the occurrences of the element and displays the fields each time.






Uploading a Template to the BI Publisher Server

If you used the Open Template dialog to connect to BI Publisher, and load the data to the Template Builder, or if you downloaded an existing template from the BI Publisher catalog, then you can upload the new or updated layout back to the report definition on the server.

See Working in Connected Mode.

If you downloaded an existing template and want to upload the modifications to the template, then select Upload Template from the Oracle BI Publisher menu.

If this is a new template for the report definition, then use the Upload Template As option to upload the layout to the report definition on the server. Also use this option to upload modifications to an existing template under a different name.




E Generating PDF/A and PDF/X Output

This appendix describes how to generate PDF/A and PDF/X output from BI Publisher.

This chapter includes the following topics:

	Generating PDF/A Output


	Generating PDF/X output







10 Setting Report Processing and Output Document Properties

This chapter describes how to configure report processing and output document properties in BI Publisher.


This chapter includes the following sections:

	Overview


	PDF Output Properties


	PDF Security Properties


	PDF Digital Signature Properties


	PDF/A Output Properties


	PDF/X Output Properties


	RTF Output Properties


	HTML Output Properties


	FO Processing Properties


	DOCX Output


	RTF Template Properties


	PDF Template Properties


	Flash Template Properties


	CSV Output Properties


	Excel 2007 Output Properties


	All Outputs


	Defining Font Mappings







Calling an XSL Subtemplate from the Main Template

To implement the subtemplate in the main template, make two entries in the main template.

First, import the subtemplate file to the main template. The import syntax tells the BI Publisher engine where to find the Sub Template in the catalog.

Second, enter a call command to render the contents of the subtemplate at the position desired.






Importing the Subtemplate

Enter the import command anywhere in the main template prior to the call template command as shown here.

<?import:xdoxsl:///{path to subtemplate.xsb}?>

where

path to subtemplate.xsb is the path to the subtemplate .xsb object in the catalog.

For example:

<?import:xdoxsl:///Executive/Financial Reports/mySubtemplate.xsb?>








Calling the Subtemplate

The template statements that you defined within the XSL subtemplate file are applied to data elements. There are two ways you can call a template defined in the imported XSL subtemplate.

	By matching the data content with the match criteria:

<xsl:apply-templates select="data_element"/>


This method applies all the templates that are defined in the XSL subtemplate to the data_element specified. Based on the data content of data_element, appropriate functions in those templates are applied. See the following use case for a detailed example: Handling XML Data with HTML Formatting.


	By calling a template by name:

<xsl:call-template name="templateName"/>


This method calls the template by name and the template executes, similar to a function call. Here also parameters can be passed to the template call, similarly to an RTF subtemplate. See Passing Parameters to an XSL Subtemplate.

See the following use case for a detailed example: Dynamically Applying Formatting to a Portion of Data.








Passing Parameters to an XSL Subtemplate

Declare the parameter in the <xsl:template> definition.

To pass parameters to the XSL subtemplate:




	Declare the parameter in the <xsl:template> definition, as follows:<xsl:template name="templateName" match="/">
   <xsl:param name="name" />
</xsl:template>




	Then call this template using the following syntax:<xsl:call-template name="templateName">
  <xsl:with-param name="name" select="expression">
    <?--- Content:template -->
  </xsl:with-param>
</xsl:call-template>











Declaring Namespaces

If the XML data contains namespaces, you must declare them in the template prior to referencing the namespace in a placeholder. Declare the namespace in the template using either the basic RTF method or in a form field.

Enter the following syntax:

<?namespace:namespace name= namespace url?>

For example:

<?namespace:fsg=http://www.example.com/fsg/2002-30-20/?>

Once declared, you can use the namespace in the placeholder markup, for example: <?fsg:ReportName?>




Types of Translations

You can add different types of translations to templates.

There are two options for adding translations for templates:

	Create a separate RTF template that is translated (a localized template). This option is available for RTF templates only.


	Generate an XLIFF from the original template. At runtime the original template is applied for the layout and the XLIFF is applied for the translation.




Use the first option if the translated template requires a different layout from the original template

If you require only translation of the text strings of the template layout, then use the XLIFF option.

The diagrams in the following graphic illustrate the translation concepts.

[image: Description of GUID-F821BC8D-DF3D-4B87-B555-BA28DB4DEA4D-default.gif follows]






Setting Up a Configuration File

The Template Builder can be used with a BI Publisher configuration file.

The configuration file must be named xdoconfig.xml and must be stored in the config directory (example path: C:\Program Files\Oracle\BI Publisher Desktop\Template Builder for Word\config) under the BI Publisher directory.

Alternatively, you can use the file name xdo.cfg, which is used by the BI Publisher server. The configuration file allows you to:

	Define additional fonts such as Windings to test the templates


	Use security settings for PDF files




See the appendix Configuration File Reference in Administrator's Guide for Oracle Business Intelligence Publisher for the syntax of the configuration file.




13 Designing RTF Subtemplates

This chapter describes how to use RTF subtemplates to create and reuse functionality across multiple BI Publisher reports.

This chapter includes the following sections:

	Understanding RTF Subtemplates


	Process Overview for Creating and Implementing RTF Sub Templates


	Creating an RTF Subtemplate File


	Calling a Subtemplate from a Main Template


	When to Use RTF Subtemplates


	Adding Translations to an RTF Subtemplate







Controlling the Placement of Instructions Using the Context Commands

The BI Publisher syntax is simplified XSL instructions. This syntax, along with any native XSL commands you may use in the template, is converted to XSL-FO at runtime. The placement of these instructions within the converted stylesheet determines the behavior of the template.

BI Publisher's RTF processor places these instructions within the XSL-FO stylesheet according to the most common context. However, sometimes you must define the context of the instructions differently to create a specific behavior. To support this requirement, BI Publisher provides a set of context commands that allow you to define the context (or placement) of the processing instructions. For example, using context commands, you can:

	Specify an if statement in a table to refer to a cell, a row, a column or the whole table.


	Specify a for-each loop to repeat either the current data or the complete section (to create new headers and footers and restart the page numbering)


	Define a variable in the current loop or at the beginning of the document.




You can specify a context for both processing commands using the BI Publisher syntax and those using native XSL.

	To specify a context for a processing command using the simplified BI Publisher syntax, simply add @context to the syntax instruction. For example:

	<?for-each@section:INVOICE?> - Specifies that the group INVOICE should begin a new section for each occurrence. By adding the section context, you can reset the header and footer and page numbering.

If you do not want to restart the page numbering, then add the command: <?initial-page-number:'auto'?> after the @section command to continue the page numbering across sections.


	<?if@column:VAT?> - Specifies that the if statement should apply to the VAT column only.





	To specify a context for an XSL command, add the xdofo:ctx="context" attribute to the tags to specify the context for the insertion of the instructions. The value of the context determines where the code is placed.

For example:

<xsl:for-each xdofo:ctx="section" select ="INVOICE">

<xsl:attribute xdofo:ctx="inblock" name="background-color">red</xsl:attribute>




BI Publisher supports the context types that are described in the following table:





	Context	Description
	section

	The statement affects the whole section including the header and footer. For example, a for-each@section context command creates a new section for each occurrence - with restarted page numbering and header and footer. Note that you can retain continuous page numbering across sections by using the <?initial-page-number:'auto'?> command. See Creating Batch Reports for an example of this usage.


	column

	The statement affects the whole column of a table. This context is typically used to show and hide table columns depending on the data. See Formatting Columns for an example.


	cell

	The statement affects the cell of a table. This is often used together with @column in pivot tables to create a dynamic number of columns. See Inserting Pivot Tables for an example.


	block

	The statement affects multiple complete fo:blocks (RTF paragraphs). This context is typically used for if and for-each statements. It can also be used to apply formatting to a paragraph or a table cell. See Highlighting Cells for an example.


	inline

	The context becomes the single statement inside an fo:inline block. This context is used for variables.


	incontext

	The statement is inserted immediately after the surrounding statement. This is the default for <?sort?> statements that must follow the surrounding for-each as the first element.


	inblock

	The statement becomes a single statement inside an fo:block (RTF paragraph). This is typically not useful for control statements (such as if and for-each) but is useful for statements that generate text, such as call-template.


	inlines

	The statement affects multiple complete inline sections. An inline section is text that uses the same formatting, such as a group of words rendered as bold. See Using If Statements in Boilerplate Text.

If you use @inlines with if syntax, any other if syntax inside the statement must use the context command @inline. If you use @inlines with FOR-EACH syntax any other if or FOR-EACH syntax inside the statement must use the context command @inline.


	begin

	The statement is placed at the beginning of the XSL stylesheet. This is required for global variables. See Setting Parameters.


	end

	The statement is placed at the end of the XSL stylesheet.








The following table shows the default context for the BI Publisher commands:





	Command	Context
	apply-template

	inline


	attribute

	inline


	call-template

	inblock


	choose

	block


	for-each

	block


	if

	block


	import

	begin


	param

	begin


	sort

	incontext


	template

	end


	value-of

	inline


	variable

	end











Using the Template Builder for Excel

The Excel Template Builder facilitates template design by automating the insertion of simple mappings, providing preview functionality, and enabling direct connection to the BI Publisher server from your Excel session. 

The BI Publisher tab that displays when you install the Template Builder is shown in the following illustration.

[image: Description of GUID-F6392F44-3471-4CC9-AABB-7A5920D0D80B-default.gif follows]



You can use the Template Builder in connected mode or disconnected mode. In connected mode, log in to the BI Publisher server from Excel. The connection enables you to browse the BI Publisher catalog and load sample data from an existing report or data model. When your template is complete, you can upload it directly to the report definition in the BI Publisher catalog. In disconnected mode, you must download a sample data file from the data model to your local client.

This section includes the following topics about using the Template Builder for Excel: 

	Working in Connected Mode


	Working in Disconnected Mode


	Inserting Fields


	Inserting Repeating Groups


	Using the Field Browser to View, Edit, and Delete Fields


	Previewing Templates


	Importing Excel Analyzer Templates






Working in Connected Mode

In connected mode you can interact directly with the BI Publisher server.

The process flow for creating or editing a template in connected mode is:




	Open Excel with the BI Publisher Template Builder for Excel Add-in installed.
	Log on to the BI Publisher server.
	Select the report or data model for which you want to create a new layout; or, select an existing layout to modify.
	Design your template in Excel.
	Preview your template using the View Report or Preview command.
	Use one of the upload template commands to upload your completed template to the BI Publisher catalog.


The following sections provide more detail on the Template Builder features when working in connected mode:

	Logging In Through the Template Builder


	Online Features of the Template Builder


	Uploading Templates from the Template Builder









Logging In Through the Template Builder

The Excel Template Builder enables a direct connection to the BI Publisher server from your desktop Excel session.

By logging in directly to BI Publisher you can browse the catalog to choose the report to which to add the Excel template; or, if no report has been created, you can select the data model and create the report in the catalog from your Excel session. 

To log on to the BI Publisher server:




	In Excel, on the BI Publisher tab in the Online group, click Log On. 
	In the Login dialog, enter your BI Publisher username and password and the URL to the BI Publisher server. The URL to the BI Publisher server takes the form http:// www.<host>:<port>/xmlpserver. The Login dialog is shown in the following illustration.Note:
Log in is supported only for connections directly to the BI Publisher server. For example: http://www.example.com:7001/xmlpserver. The Template Builder does not support logging in through the Oracle BI Enterprise Edition analytics server. 

[image: Description of GUID-60CB1FD9-A7E8-4F3F-AD8C-83AD9F37B586-default.gif follows]











Online Features of the Template Builder

After logging in, the following commands in the Online group become enabled.

[image: Description of GUID-63D538EC-7945-429D-9239-E02E987DF75B-default.gif follows]



	Log Off - ends the connection to the BI Publisher server.


	Open - enables interaction with the BI Publisher catalog. See Accessing the BI Publisher Catalog from the Template Builder.


	View Report - executes the data model on the server and returns live results to view in your template. If the data model includes parameters, you are prompted to enter values.


	Upload Template/Upload Template As - uploads the template to the BI Publisher catalog. See Uploading Templates from the Template Builder.






Accessing the BI Publisher Catalog from the Template Builder

The Open online command enables interaction with the BI Publisher catalog.

The Open command launches the Open Template dialog to enable access to the BI Publisher catalog.


[image: Description of GUID-37B1504B-A8B4-4293-A4EE-1988A4B30D0B-default.gif follows]





Navigate the catalog folders to locate the report, data model, or existing layout template. From this dialog you can initiate one of the following actions:




	Modify an existing Excel template.

When you select a report in the Reports region, any existing Excel templates or Excel Analyzer templates (deprecated) are displayed in the lower Layout Templates region. To modify an existing template, select the template name and click Open Layout Template. The Template Builder loads the sample data from the report's data model and opens the existing template in Excel. 


	Create a new template for an existing report. 

Select the report name in the Reports region and click Open Report. The Template Builder loads the sample data for this report's data model.


	Select a data model to create a new report.

When you select a data model from the catalog, the Create Report button is enabled. Click Create Report and you are prompted to enter a report name and select the location in the catalog to save the new report.













Uploading Templates from the Template Builder

A link to upload templates is provided if you are online with the server.

If you have maintained the connection during the design process, click one of the following to upload your completed template to the BI Publisher server:




	Upload Template uploads your edited template and replaces the existing template in the catalog. Upload Template is enabled only when you have opened an existing template from the Open Template dialog using the Open Layout Template button. 


	Upload Template As prompts you to assign a Template Name and Locale to the template then uploads the file to the report in the BI Publisher catalog.













Working in Disconnected Mode

When direct connection to the BI Publisher server is not possible or not desirable, you can use the Template Builder to design and preview templates in disconnected mode.

In disconnected mode the commands in the Online group are not enabled. The process flow for working in disconnected mode is:




	Log in to the BI Publisher server and download sample data from the data model for which you want to design a template. 
	Open Excel with the BI Publisher Template Builder for Excel Add-in installed.
	Load the sample data to the Template Builder.
	Design your template in Excel.
	Preview your template using the Preview command.
	Log in to the BI Publisher server and use the report editor to upload your template.


The following sections provide more detail on the Template Builder features when working in disconnected mode:

	Obtaining Sample Data


	Loading Sample Data in Disconnected Mode


	Uploading Templates to the Report









Obtaining Sample Data

The Template Builder requires sample data to insert the data field mappings to your template.

For information on saving sample data from the report data model, see Testing Data Models and Generating Sample Data in Data Modeling Guide for Oracle Business Intelligence Publisher.

If you do not have access to the report data model, but you can access the report, then you can alternatively save sample data from the report viewer. 

To save data from the report viewer:




	In the BI Publisher catalog, navigate to the report.
	Click Open to run the report in the report viewer.
	Click the Actions menu, then click Export, then click Data. You are prompted to save the XML file.
	Save the file to a local directory.






Loading Sample Data in Disconnected Mode

You can load sample data into a local directory while offline.

Once you have saved the sample data from the report data model to a local directory, load it to the Template Builder.




	Open Excel with the BI Publisher Template Builder for Excel Add-in installed.
	On the BI Publisher tab, in the Load Data group, click Sample XML. You are prompted to locate and select the data from its saved location. A confirmation message confirms the data is loaded.






Uploading Templates to the Report

You can upload report templates while offline.

When working in disconnected mode, upload the template to the report editor following the instructions in Adding a Layout by Uploading a Template File.










Inserting Fields

The Field command in the Insert group maps data elements from the loaded sample data to the desired location in the spreadsheet. 



To insert a field:




	In Excel, select the cell to which to map the data element.
	On the BI Publisher tab, in the Insert group, click Field. The Field dialog launches, displaying the data elements from your sample data.
	On the Field dialog select the element to insert to the cell. Notice that as you select items in the data structure, sample data is displayed in the Example region as shown in the following illustration.
[image: Description of GUID-67966513-D744-4CDC-B41F-DCCF36281A24-default.gif follows]







	Click Insert to insert the data element to the cell in the spreadsheet. Sample data is inserted to the cell.


When you insert a field, the Template Builder creates a mapping between the data and the cell by assigning a unique Excel defined name to the cell and mapping the data element to that defined name. The mapping is written to the XDO_METADATA sheet as shown in the following illustration.


[image: Description of GUID-D72AD5B7-63B5-4C25-AC06-94D8D5A11A42-default.gif follows]





Note that the XDO_METADATA sheet is hidden by default.






More Features of the Field Dialog

The Field dialog provides the following features.

Find



For an XML document with a large and complicated structure, use the find functionality to find a specific field. Enter all or part of the field name into the Find field and click Find Next. 




Business View or XML Tag Name View



When working in connected mode, you can choose whether to view the data structure using the Business View names or the XML Tag Names as defined in the data model. Business View names are user-friendly names defined for the data elements in the data model editor. This option is not available when sample data has been loaded from a locally stored file or when the data model does not include Business View names.










Inserting Repeating Groups

You can insert repeating groups of cell elements.

To insert a repeating group:




	Select the cells in the spreadsheet that contain the elements you want repeated.
	On the BI Publisher menu, in the Insert group, click Repeating Group.
	Enter the appropriate fields in the BI Publisher Properties dialog, as shown in the following illustration.[image: Description of GUID-87A23782-1FD1-4538-9091-951A8E2B6847-default.gif follows]



For Each

Select the element that for each occurrence, you want the loop to repeat. When you select the For Each data field you are telling BI Publisher that for each occurrence of the selected field in the data you want the elements and processing instructions contained within the loop to be repeated.

For example, assume that the data contains invoice data for customers and you want to create a table with each customer's invoices. In this case, for each customer number you want the table to repeat. You would therefore select the customer number in the For Each field to create a new loop (or group) for each customer.

Note the following about creating repeating groups:

	For loops and groupings not inside another group (that is, outer groups) you must select the repeating data element to be used. For example if the data set is flat, the only repeatable element is /DATA/ROWSET/ROW. In cases with multiple data sources or hierarchical XML you can choose the data set.


	If you are creating nested groups (inserting a loop or group inside of another loop in the template), the On Grouping checkbox is selected and the For Each field is not editable because it is already defined by the preexisting outer loop. The For Each field is displayed as "Group Item" to inform you that an outer group is already defined.




Absolute Path

Select this check box to use the Absolute Path to the element in the XML structure. This is important if the data contains the same element name grouped under different parent elements.

Group By

Select a field from the list by which you want to group the data. To create a simple loop, do not select a group by element. Selecting a group by element regroups the data into a new hierarchy based on the group by element.

On Grouping

When creating a nested for-each loop, select On Grouping to repeat the for-each loop only when the element appears within the parent loop. Deselect On Grouping to repeat global data (outside the parent loop) within the nested loop. 



	When you have completed the dialog options, click OK to insert the BI Publisher code to define the groupings. An Excel defined name is assigned to the cell range using the BI Publisher syntax XDO_GROUP_?name? and the code is written to the XDO_METADATA sheet as shown in the following illustration.[image: Description of GUID-51B5F55F-9F36-4F00-9BD5-41E739B9AA73-default.gif follows]











Using the Field Browser to View, Edit, and Delete Fields

The Field Browser enables you to view and edit the code inserted by the Template Builder and the code you inserted manually into the XDO_METADATA sheet.

When you select a line of code in the Field Browser, the corresponding cells in the template are highlighted, so you know which field you are editing, deleting, or viewing.

To edit or delete a field using the Field Browser:




	On the BI Publisher menu, in the Tools group, click Field Browser.
	The Field Browser displays the BI Publisher commands that are present in the template. Select the field or command to view. The code for the selected command displays in the lower Edit region. Notice that if the code has opening and ending tags (such as the opening and ending tags of a repeating group) the opening tag display in the upper code box and the closing tag displays in the lower code box.When you select a command, the area of the template that corresponds to the code is highlighted. In the following illustration the repeating group is selected in the Field Browser and the corresponding fields are highlighted in the template.

[image: Description of GUID-EDD5D6BF-6F18-4B4E-A1C1-787C09D4156D-default.gif follows]





	To delete the code, click Delete. To edit the code, update the code displayed in the Edit and click Update.
	When finished, click Close to close the Field Browser.






Previewing Templates

Use the preview feature of the Template Builder to test your template before uploading it to the BI Publisher server.

To preview a template with the loaded sample data:




	On the BI Publisher tab in the Preview group, click Excel.

The sample data is applied to the template and the output document is opened in a new workbook. 




If you are working in connected mode, you have the option of testing your template with live data from the report data model using View Report. 

To view your template using live data: 

	On the BI Publisher tab in the Online group, click View Report.

The Template Builder sends a request to execute the data model on the BI Publisher server and returns the data to apply to the template. If the data model requires parameters, you are prompted to enter values. The output document is opened in a new Excel workbook. 











Importing Excel Analyzer Templates

The Excel Analyzer feature of BI Publisher has been deprecated, but if you have Excel Analyzer templates from previous BI Publisher releases, you can use the Import command of the Excel Template Builder to import an Excel Analyzer template and convert it to an Excel template. The Import command supports only Excel Analyzer templates created using the Offline Mode.

To import an Excel Analyzer template:


	Open the Excel Analyzer template. If you are working in connected mode, navigate to the report that contains the template you wish to convert. When you select the report in the Open Template dialog, the Excel Analyzer template displays in the Layout Templates region as type "excel". Click Open Layout Template to open the Excel Analyzer template in Excel.
	Click Import. A message notifies you: This feature will overwrite your template.
	Click OK.


The Template Builder converts the Excel Analyzer template to an Excel template.









Performing Calculations

Adobe Acrobat provides a calculation function in the Field Properties dialog box. 

To create a field to display a calculated total on a report:




	Create a text field to display the calculated total. Give the field any Name you choose.
	In the Field Properties dialog box, select the Format tab.
	Select Number from the Category list.
	Select the Calculate tab.
	Select the radio button next to "Value is the <List of operations> of the following fields:"
	Select sum (+) from the list.
	Click the Pick... button and select the fields to be totaled.





Overview

This chapter describes how to use the Export XLIFF function that is available at the catalog level.

When you select a folder and choose this option, a single XLIFF file is generated that contains the translatable strings from the catalog objects contained in the folder; and the RTF and XPT templates contained in the folder. See the following section for the detailed list of what is translatable.

The target strings in the generated XLIFF file can be translated into the desired language. The XLIFF can then be uploaded back to the BI Publisher repository and assigned the appropriate locale. The translated strings from the XLIFF are displayed when a user selects the target language as their UI language (for catalog object strings) or selects the target language as their Report Locale (for report template strings).

If BI Publisher is integrated with Oracle Business Intelligence Enterprise Edition, then BI Publisher catalog object string translation (folder and report, data model, style template and sub template names) is ignored. The Oracle BI Enterprise Edition catalog translation mechanism is applied instead. See "Localizing Oracle Business Intelligence" in System Administrator's Guide for Oracle Business Intelligence Enterprise Edition for information on components that can be translated in an integrated catalog.




DOCX Output

The properties described in this table can be set to configure Microsoft Word output.


	Property Name	Description
	Enable change tracking

	Default: False

Description: Set this property to True to enable change tracking in the Microsoft Word document that is generated by BI Publisher.


	Protect document for tracked changes

	Default: False

Description: Set this property to True protect the document from any changes besides tracked changes. All edits are tracked and no other user can accept tracked changes to alter the original document.


	Default font

	Default: Arial:12

Description: When the font used in the template is available in Microsoft Word, the template font is used. If the font used in the template is unavailable in Microsoft Word, the default font specified here is used. Enter the default font as follows:

fontname:fontsize

Example: Courier:10











Getting Started

This section describes how to get started with creating RTF templates using the Template Builder for Word.

It contains the following topics:

	Features of the Oracle BI Publisher Template Builder for Word


	Building and Uploading a Template


	Working in Connected Mode






Features of the Oracle BI Publisher Template Builder for Word

When you open Microsoft Word after installing the Template Builder, you see the Oracle BI Publisher menu. Using this you can perform different tasks.

For versions of Microsoft Word prior to 2007, the menu and toolbar are displayed as shown in the following figure:


[image: Description of GUID-4525C470-511E-4407-A6D4-07BA9D00A32A-default.gif follows]





For Microsoft Word 2007 users, the BI Publisher commands are displayed in the ribbon format, as shown in the following figure:


[image: Description of GUID-F89213F7-2363-4794-A4B6-DA7B26B4C30A-default.gif follows]





Use the menu (or toolbar) to perform the following:

	Insert data fields into age RTF templates


	Insert tables, forms, charts, and pivot tables


	Preview the template in multiple outputs


	Browse and update the content of form fields


	Validate the template


	Perform calculations on fields within the template


	Connect to the Oracle BI Publisher catalog to retrieve data to build the template


	Upload the template to the Oracle BI Publisher server


	Extract boilerplate text into an XLIFF translation file and test translations








Building and Uploading a Template

You can build and upload the template using a direct connection with the BI Publisher server, or you can build and upload the template in disconnected mode.



Working in Connected Mode

Connected mode allows you to make changes directly on the BI Publisher server.

To work in connected mode:




	Open Microsoft Word.
	From the Oracle BI Publisher menu, select Log On.
	Enter your BI Publisher credentials and the URL for the BI Publisher server, for example: http://www.example.com:7001/xmlpserver. (Contact your system administrator if you do not know the URL.)
	The Open Template dialog presents the same folder structure as the BI Publisher catalog. Select the report or data model for which you want to build a template.
	If you selected a data model:Click Create Report to create a report for this data model in the BI Publisher catalog. This is the report that you upload the template to.

Enter a Report Name and select the folder in which to save it.

Click Save.

The sample data from the data model is loaded to the Template Builder.

If you selected a report:

Click Open Report to load the data to the Template Builder; or double-click Newin the Layout Templates pane, as shown in the following illustration.

Any existing templates are listed in the Layout Templates pane.

[image: Description of GUID-227C44C4-BF7E-4263-B4D3-32C6E4D95510-default.gif follows]





	Follow the guidelines in this chapter to insert data fields and design the template using features such as tables, charts, and graphics. Use Microsoft Word to apply formatting to fonts and other objects in the template.For more advanced template options, use the guidelines in Creating RTF Templates.



	To upload the template file to the BI Publisher server and add it to the report definition, select Upload Template As from the Oracle BI Publisher menu.If you have not saved the template, then you are prompted to save it in Rich Text Format.



	Enter a name and select a locale in the Upload as New dialog. This is the name that is displayed under Layouts in the Report Editor. This is also the layout name that is displayed when a user runs this report.
	Configure properties for this layout. Navigate to the BI Publisher report editor to configure properties for this layout, such as output formats. See Configuring the Layout Settings Using the List View for more information.









Working in Disconnected Mode

To work in disconnected mode, you must have a sample data file available in the local work environment.

To work in disconnected mode:




	Save a sample data file to your local computer. See Accessing Data for Building Templates.
	Open Microsoft Word with the Template Builder installed.
	On the Oracle BI Publisher menu in the Load Data group select Sample XML. Locate the sample data file in the local directory and click Open.Note:
The Template Builder also supports using XML Schema to design an RTF template. However, because the schema contains no data, the preview of the report also contains no data.



	Follow the guidelines in this chapter to insert data fields and design the template using features such as tables, charts, graphics, and other layout components. Use Microsoft Word to apply formatting to fonts and other objects in the template.For more advanced template options, use the guidelines in Creating RTF Templates.



	Upload the layout template file.In the BI Publisher catalog, open the report in the Report Editor. Click Add New Layout.

Complete the fields in the dialog and then select Upload. The template now appears as a layout for the report.



	Configure properties for this layout. See Configuring Layouts Using the List View for more information.












Accessing Data for Building Templates

The data model defines the XML format that is merged with the RTF template. The Template Builder requires sample data to build the template. You must load sample data to use most of the template builder functionality.

If you are not connected to BI Publisher, then use the procedure in Loading XML Data from a Local File. If you are connected, then use the procedure in Loading Data from the BI Publisher Catalog.



Loading XML Data from a Local File

One method of loading data to the Template Builder is to save a sample of the report data to a local directory.



For information on saving sample data from a report data model, see the Testing Data Models and Generating Sample Data section in Data Modeling Guide for Oracle Business Intelligence Publisher.

If you do not have access to the report data model, but you can access the report, then you can alternatively save sample data from the report viewer. 

To save data from the report viewer:




	In the BI Publisher catalog, navigate to the report.
	Click Open to run the report in the report viewer.
	Click the Actions icon, then click Export, then click Data. You are prompted to save the XML file.
	Save the file to a local directory.
	Use the Load Sample XML feature below to load the saved XML file to the Template Builder.


The Load Data group from the Oracle BI Publisher menu enables you to select and load the saved XML file to the Template Builder.

	Sample XML - Enables you to load a sample XML file that contains all fields that you want to insert into the template as a data source. If you are not connected to the BI Publisher server, then use this method to load the data.


	XML Schema - Enables you to load an XML Schema file (.xsd) that contains the fields available in the report XML data. The XML schema has the advantage of being complete (a sample XML file might not contain all the fields from the data source). For the preview, the Template Builder can generate dummy sample data for an XML Schema. However, the preview works better if you also upload real sample data.











Loading Data from the BI Publisher Catalog

You can connect directly to the BI Publisher Server to load the BI Publisher report data to the Template Builder to use as sample data for designing layouts.

You can also download an existing template to modify it.

To connect to BI Publisher and load a data source:




	Log on to the BI Publisher Server: From the Oracle BI Publisher menu, select Log On. For more information on logging in to the BI Publisher server, see Working in Connected Mode.
	After you area logged on, you can select Open. The Open Template dialog launches.
	Navigate to the folder that contains the report or data model for which you want to create a template.When you select a report, you can either select from the Layout Templates to open an existing template, select Open Report to load just the XML sample data to create a new layout, or double-click <New> to load the data to the Template Builder to build a new layout.

When you select a data model, you are prompted to create a report in the catalog.










Inserting Layout Grids

The layout grid provides a way to divide a layout into sections.

It functions similarly to a table in HTML or Word documents to create forms or to provide sophisticated layouts. Use a layout grid to control the exact placement of all other components in the layout.

To insert a layout grid:




	Select and drag the Layout Grid component to the design area.


The following illustration shows the Create a Layout Grid dialog.

[image: Description of GUID-D7D316D9-D1BD-4BC5-A364-6DB9732138A7-default.gif follows]



In the dialog, enter the number of rows and columns for the grid and click OK to insert the grid to the design area, as shown in the following illustration.

[image: Description of GUID-2D4AE9BA-D60B-4FEB-BC55-B6B98EE02F15-default.gif follows]



Note the following about a layout grid:

	The grid is created with equidistant columns, and the row size defaults to a minimum of one row of text.


	Although Font properties are not enabled for a layout grid cell (set font properties using the individual component properties), the background color and border properties are enabled.


	When you insert a component to a grid cell, it automatically resizes to accommodate the component.


	Adjust the column width and height by either positioning the mouse pointer over the border and dragging the blue bar, or by changing the grid column properties in the Properties pane.


	The grid supports merging of cells.


	You can insert a grid inside a grid.


	Similar to Microsoft Word, the grid uses a flow layout that is very convenient for designing business documents. Components that do not occupy a full paragraph or block are positioned top-down and left to right.









Adding a Border or Background Color

By default, the gridlines are displayed in the design area only and are not shown during runtime. If you want to display the gridlines in the finished report, then select the grid cell and click the Set Border command button to launch the Border dialog.

To add a background color to a cell:



	Click the Background Color command button to launch the Color Picker.






About the Insert Options

When you have inserted a layout grid, you can add additional rows or columns.

Select the layout grid cell that is the focal point, then click the appropriate command button:

	Add a Row above


	Add a Column to the right


	Add a Row below


	Add a Column to the left








About the Join and Unjoin Options

Follow these steps to know how to join cells and to unjoin cells that have been joined.

To join cells horizontally or vertically:
	Select multiple adjacent cells by holding down the Ctrl key and clicking each grid cell.


	Click the Join command button.







To unjoin cells that have been joined:



	Select the joined cell and click the Unjoin button.






Adding an Expand and Collapse Option

When viewing a report in interactive mode, you can expand and collapse a layout grid to toggle the display of the grid's contents. Expand and Collapse are supported at the grid level, (not the cell-level) therefore ensure to insert grids appropriately. For example, if the report contains a chart in the top portion of the layout and a table in the bottom and you want to collapse the chart display, you must insert one layout grid to contain the chart and a second layout grid beneath the first to contain the table. Do not insert one grid with two rows.

To enable the expand and collapse option:



	Select the layout grid.
	Open the Properties pane.
	Set the Interactive: Expand/Collapse property to True. The following figure shows this option on the Properties pane.[image: Description of GUID-F614C981-FADB-4A8D-B4B5-D2A067476C2D-default.gif follows]












Editing Reports

Navigate to the report editor through the Create Report process flow or by clicking a report's Edit link in the catalog.

The report editor is shown in the following figure:

[image: Description of GUID-75150805-456E-4A46-AA6F-D159FEF59967-default.gif follows]



Use the report editor to:

	Add layouts


	Configure layouts


	Configure the parameters for this report


	Configure the report properties


	Update the data model associated with the report




This procedure addresses these options in the order listed.




Formatting Dates

Excel cannot recognize canonical date format. If the date format in the XML data is in canonical format, that is, YYYY-MM-DDThh:mm:ss+HH:MM, you must apply a function to display it properly.

One option to display a date is to use the Excel REPLACE and SUBSTITUTE functions. This option retains the full date and timestamp. If you only require the date portion in the data (YYY-MM-DD), then another option is to use the DATEVALUE function. The following example shows how to use both options.

Example: Formatting a Canonical Date in Excel

Using the Employee by Department template and data from the first example, this procedure adds the HIRE_DATE element to the layout and displays the date as shown in Column E of the following figure:


[image: Description of GUID-C4EB9216-C863-45F3-A088-1EE9A4F7FE58-default.gif follows]








To format the date:


	Add a column to the table in your layout for HIRE_DATE.
	In the table row where the data is to display, use the Template Builder to insert the HIRE_DATE field.Note:
If you are not using the Template Builder, copy and paste a sample value for HIRE_DATE from the XML data into the cell that is to display the HIRE_DATE field. For example:

Copy and paste

1996-02-03T00:00:00.000-07:00

into the E8 cell.

Assign the cell the defined name XDO_?HIRE_DATE? to map it to the HIRE_DATE element in the data.



The inserted field is shown in the following figure:


[image: Description of GUID-17695836-A615-48DD-A8C4-6E56A6B080C5-default.gif follows]





If you do nothing else, the HIRE_DATE value is displayed as shown. To format the date as "3-Feb-96", you must apply a function to that field and display the results in a new field.



	Insert a new Hire Date column. This is now column F, as shown in the following figure:
[image: Description of GUID-F22A49BF-E2F4-4252-8110-13820D4A6F6C-default.gif follows]







	In the new Hire Date cell (F8), enter one of the following Excel functions:	To retain the full date and timestamp, enter:

=--REPLACE(SUBSTITUTE(E8,"T"," "),LEN(E8)-6,6,"")



	To retain only the date portion (YYY-MM-DD), enter:

=DATEVALUE(LEFT(E8,10))





Notice that in both functions, "E8" refers to the cell that contains the value to convert.

After you enter the function, it populates the F8 cell as shown in the following figure:


[image: Description of GUID-3326B63C-AA9D-408F-ADC1-321F2CAD5844-default.gif follows]







	Apply formatting to the cell.Right-click the F8 cell. From the menu, select Format Cells. In the Format Cells dialog, select Date and the desired format, as shown in the following figure.


[image: Description of GUID-1BC18AA2-D9E6-455B-863B-E6BE22B1D48E-default.gif follows]





The sample data in the F8 cell now displays as 3-Feb-96.



	Hide the E column, so that report consumers do not see the canonical date that is converted.The following figure shows the template with column E hidden:


[image: Description of GUID-A685B286-2CF2-4EA6-8998-7FBD1AF3EC72-default.gif follows]












Adding Translations to an RTF Subtemplate

RTF subtemplates offer the same support for translations as RTF template files.

You can upload multiple translated RTF files under a single Subtemplate definition and assign the appropriate locale. These are displayed in the Templates region, as shown in the following figure.

Or you can generate an XLIFF (.xlf) file of the translatable strings, translate the strings, and upload the translated file. These are displayed in the Translations region, as shown in the following figure:


[image: Description of GUID-94321423-5926-46A7-A38B-D9BD35F79162-default.gif follows]





At runtime, the appropriate subtemplate localization is applied based on the user's account Preference setting for Report Locale for reports viewed online; or, for scheduled reports, based on the user's selection for Report Locale for the scheduled report.

The XLIFF files for subtemplates can be generated individually, then translated, and uploaded individually. Or, if you perform a catalog translation that includes the Sub Template folders, the strings from the subtemplate files are extracted and included in the larger catalog translation file. When the catalog translation file is uploaded toBI Publisher, the appropriate translations from the catalog file are displayed in the Translations region of the Sub Template definition.

For more information on translations, see Translation Support Overview and Concepts.




Saving a Layout

You can save a report layout.

To save the layout to the report definition:




	Click the Save or Save As toolbar button
	Enter a unique name for this layout.
	Select a Locale.Note:
When you have saved the layout, the Locale cannot be updated.








About Repeating Sections

Repeating sections repeat the components within the section of the layout based on the occurrence of an element in the data. Repeating sections are used to create classic banded reports, as well as repeating pages or sections for different data elements (such as Group Above/Outline).

To create a repeating section:



	Drag and drop the repeating section component to the layout.
	In the Repeating Section dialog, select one of the following:	Element - Specify the element for which the section repeats. For example, if the dataset contains sales information for several countries. If you select COUNTRY as the repeat-by element, then the section of the layout repeats for each unique country occurring in the dataset.


	Group Detail - If you have nested sections, then select this option. To continue the previous example, assuming there are unique data rows for each city and grouping by country, then this option creates a section that repeats for each city.








The following figure shows a layout that has a repeating section defined for the element Department. Within the repeating section are a chart that shows salaries by manager and a table that shows all employee salaries. So for each occurrence of department in the dataset, the chart and table are repeated.

[image: Description of GUID-B1FA7C59-C992-4B2E-8196-36E14ACC4031-default.gif follows]








Setting Page Break Options for a Repeating Section

By default, for paginated output types, the page breaks automatically according to the amount of content that fits on a page.

It is frequently desirable to have the report break after each occurrence of the repeated content.

Using the preceding example, it is desirable for the PDF output of this report to break after each department. 

To create a break in the report after each occurrence of the repeating section:




	Select the repeating section component.
	Open the Properties pane.
	Set the Page Break property to Page.The following illustration shows the Properties for a repeating section.

[image: Description of GUID-EFC0E348-AE00-47D8-B046-F4B0D58444FA-default.gif follows]











How Repeating Sections Display in Interactive Mode

In interactive mode, the values for the repeat by element are displayed as a list of values. This enables the report consumer to dynamically select and view the results.

The following figure shows the repeat by element Department displayed in a list of values:

[image: Description of GUID-A6CCBC45-3956-40EA-B965-656088FD7E06-default.gif follows]



By contrast, the below figure shows the same layout displayed in PDF. In this example the page break option is set so that each new department begins the repeating section on a new page.

[image: Description of GUID-7561CB69-013B-45B6-A789-B1267F04C665-default.gif follows]







Showing All Values in a Repeating Section

In interactive mode, the values for the repeat by element are displayed as a list of values. By default, this list includes only the values present for the element in the data. Therefore, a report consumer can view results for only one item at a time.

To enable a report consumer to view the results in the repeating section for all values of the element, the Repeating Section component provides the property: Show All. When this property is set to true, the value "All" is added to the list to enable the display of results for all values.

To enable Show All:




	Select the repeating section component.
	Open the Properties pane.
	Set the Show All property to True.The following illustration shows the Show All setting in the Properties pane.

[image: Description of GUID-CC4853A3-18E7-427B-A32B-7B02F756B1B2-default.gif follows]







When you view the report, the option All is added to the menu of values, as shown in the following illustration.

[image: Description of GUID-168408FE-3CBF-40A0-B730-8A6AE66766A0-default.gif follows]











Embedding PCL Commands for Check Printing

PCL (Printer Command Language) is a page description language. Like Postscript, it is widely supported in office printers. To support PCL printers, BI Publisher provides a PDF to PCL converter. In addition to translating the PDF document into a sequence of PCL commands, specific PCL commands can be embedded in an RTF template, so that when the report output is generated in PDF and then converted to PCL the commands are maintained in the PCL file. When the PCL printer receives the PCL file, it invokes the embedded commands.

BI Publisher supports PCL commands to enable font selection commands for secure check printing; for example, to invoke the MICR font used for the machine-readable account codes and the custom font used for the check signer's signature. The MICR font and the custom signature font are stored in hardware cartridges on the printer and are invoked using PCL escape sequences embedded in the PCL-formatted file.

To embed the PCL commands in the file that is printed, use the BI Publisher commands described in this section in your RTF template in the specific position on the page where you want the PCL commands to render.

To use this feature, an administrator must also define the PCL printer in the BI Publisher printer setup page to use the PDF to PCL filter.

Note:
This feature is provided to support commands for font selection as described in the chapter, PCL Font Selection of the PCL5 Printer Language Technical Reference Manual. If you include other PCL commands (such as tray switching) in the template, the report output may produce the results desired, although these commands are not strictly supported.





Procedure Overview

This overview discusses how to embed PCL commands in a template

To embed PCL commands in a template to be invoked by your PCL printer, perform the following: 




	Define the PCL printer in the BI Publisher Administration Delivery options. See Adding a Printer or Fax Server in Administrator's Guide for Oracle Business Intelligence Publisher.
	Include the commands in the RTF template as described in Embedding PCL Commands in RTF Templates.
	To generate the output, schedule or run the report selecting PDF as the output type. Select the PCL printer defined in step 1 as the destination. 






Embedding PCL Commands in RTF Templates

BI Publisher supports custom PCL command embedding, which means that in addition to translating PDF documents into a sequence of PCL commands, BI Publisher supports specifying exact PCL commands to be included at a specific position on a PCL page.

To use this feature, include the following syntax in a template or data at the position where you want to print out the text.

<pcl><control><esc/>(pcl command)</control>(text or data field)<sp/>(text or data field)</pcl>


where

<pcl></pcl>: indicates the start and end of the custom PCL command sequence and the text to print using the custom command. If any text data appears before <pcl> or after </pcl>, it is printed as regular text using the font and font size in effect.

<control></control>: indicates the start and end of the PCL sequence. The data inserted after </control> is considered text data. The PCL command included between <control> and </control> is applied to it. Inserting any data between <pcl> and <control> is invalid and the data is ignored.

<esc/>: include <esc/> between <control> and </control> to escape character (ASCII 0x1b) in the output.

<sp/>: inserts a space. Include <sp/> in the text section (after </control> and before </pcl>) to insert a space character in the output.

The entire command and text sequence between <pcl></pcl> must be entered as a single line of text rendered by a single text-showing (Tj) operator in PDF. To insert a space, you must use <sp/> because the inclusion of an actual space in the text or data would separate the sequence into multiple text sequences in the PDF.

The following figure shows a sample check template with the command sequence:


[image: Description of GUID-16F77633-72E0-4BCF-9CD4-5A3ECBC72844-default.gif follows]





The PCL command sequence in the example is

<pcl><control><esc/>(70X</control>ROUTING<sp/>ACCOUNT</pcl>


Note that (70X is the font to substitute; ROUTING and ACCOUNT are form fields mapped to the input XML data and the <sp/> command is used to insert the space between the routing and account numbers.

This RTF template is merged with data and converted to PDF as shown in the following figure. The PCL command sequence is displayed as regular text.

Note:
You can make the font size smaller to make the line less visible, but you cannot hide it.


[image: Description of GUID-DA93DC07-0724-4BA7-941A-12A9FB859995-default.gif follows]





When this PDF is converted to PCL, <esc/> is converted to the escape character 0x1b; the PCL command is included from the PDF ((70X); <sp/> is converted to a space character and the text is generated with the PCL absolute cursor positioning command (&a#v#h#P). The following figure shows the PCL output displayed using a text editor.


[image: Description of GUID-EDD89DA0-C6FD-4B50-8FDD-4839044B8F36-default.gif follows]





When this PCL file is sent to a printer where the MICR font with font ID 70 is installed, the printer produces the final printed output as shown in the following figure:


[image: Description of GUID-2D0A8BA9-5192-436C-8932-77682214F4F5-default.gif follows]









Specifications and Restrictions

BI Publisher's PDF to PCL converter supports input of PDF files up to version 1.7 and output of PCL 5 (including HP/GL2 and PJL) and PCL 5c.

The converter supports basic text and vector/raster graphic features in PDF that are required for most business reporting and office printing. 

Note the following limitations for documents processed by the PDF to PCL converter:

	SVG graphics, such as graphs, are not supported. 


	Embedded objects (such as Flash objects) and file attachments are not supported.


	Use of Adobe core dingbats and symbol font is not supported. Use TrueType fonts to print dingbats and symbols and embed the font when generating PDF. 


	BI Publisher supports printing of the generated output on any printer that supports PCL 5/PCL 5c standard. However, the display of the generated output using PCL viewer applications or any software that re-processes PCL for other than direct printing purposes is not supported. 


	The PDF to PCL converter supports, with limitations, the conversion of PDF documents generated by BI Publisher's FO processor. Other PDFs, such as PDF files processed with FormProcessor or PDF documents generated by external applications may produce the printed results desired, but are not strictly supported. 


	The PDF to PCL converter supports the conversion of PDF documents generated by the PDFBookBinder and PDFDocMerger utilities so far as all the PDF documents used for generating the output are originally generated by BI Publisher's FOProcessor and the documents do not include restricted features.









PDF/A Output Properties

Set properties to configure PDF/A output.

PDF/A output properties are described in the table below. For more information on PDF/A output see Generating PDF/A Output.





	Property Name	Description
	PDF/A ICC Profile Data

	Default: Default profile data provided by JVM

Description: The name of the ICC profile data file, for example: CoatedFOGRA27.icc

The ICC (International Color Consortium) profile is a binary file describing the color characteristics of the environment where this PDF/A file is intended to be displayed. (For more information, see the article at http://en.wikipedia.org/wiki/ICC_profile).  

The ICC profile that you select must have a major version below 4. 

To use a specific profile data file other than the default settings in the JVM, obtain the file and place it under <bi publisher repository>/Admin/Configuration. When you set this property, you must also set a value for PDF/A ICC Profile Info (pdfa-icc-profile-info).

Internal Name: pdfa-icc-profile-data


	PDF/A ICC Profile Info

	Default: sRGB IEC61966-2.1 

Description: 	ICC profile information (required when pdfa-icc-profile-data is specified) 

Internal Name: pdfa-icc-profile-info


	PDF/A file identifier

	Default: Automatically generated file identifier

Description: 	One or more valid file identifiers set in the xmpMM:Identifier field of the metadata dictionary. To specify more than one identifier, separate values with a comma (,).

Internal Name: pdfa-file-identifier 


	PDF/A document ID

	Default: None

Description: Valid document ID. The value is set in the xmpMM:DocumentID field of the metadata dictionary.  

Internal Name: pdfa-document-id 


	PDF/A version ID

	Default: None

Description: Valid version ID. The value is set in the xmpMM:VersionID field of the metadata dictionary.

Internal Name: pdfa-version-id 


	PDF/A rendition class

	Default: None

Description: Valid rendition class. The value is set in the xmpMM:RenditionClass field of the metadata dictionary.

Internal Name: pdfa-rendition-class











About Data Tables

The data table is a standard table that is shown in many layouts. It contains a header, data columns, and a total row. The table supports "group left" functionality (outlines) that merges fields with the same values as well as subtotals, grand totals, custom calculations, and running totals.

Once inserted, you can edit the table properties using the dynamic tabs or the Properties pane. The following dynamic tabs are available for the table components:

	Table


	Table Column Header


	Column


	Total Cell




This section contains the following topics about working with tables:

	Inserting a Data Table


	Setting Alternating Row Colors


	About the Table Tab


	About the Table Column Header Tab


	About the Column Tab


	About the Total Cell Tab


	Inserting Dynamic Hyperlinks






Inserting a Data Table

Follow these steps to insert a data table and to add data columns to the table.

To insert a data table:


	From the Insert tab, select and drag the Data Table component to the design area.The following figure shows an example of an inserted, empty data table. Notice that the Table tab is now displayed.


[image: Description of GUID-667F01DB-A900-4BCA-A5C8-9CAB0E7F9A99-default.gif follows]







	To add data columns to the table, select an element from the Data Source pane and drag it to the table in the layout.Note:
You cannot include elements from multiple data models in report components unless the data models are linked. For more information, see Creating Element Level Links in Data Modeling Guide for Oracle
Business Intelligence Publisher.



The following figure shows the columns being added to the table. Notice that when you drop a column on the table the sample data is immediately displayed.


[image: Description of GUID-4B6D127D-5429-40EF-BE44-FA0D82C2C481-default.gif follows]







	Continue to drag the elements from the Data Source pane to form the columns of the table. If you must reposition a column that you have already added, then select it and drag it to the correct position.The following figure shows a completed data table:


[image: Description of GUID-0E9E9C15-1A69-438C-82D8-DC2677ECD98F-default.gif follows]





Notice the following default behavior:

	A total row is automatically inserted. By default it calculates the sum of the items in the column. You can remove this row or edit the display and calculation applied. See About the Total Cell Tab.


	Default date formatting is applied. To change the default formatting, see About the Column Tab.


	Default number formatting and alignment is applied. To change the default formatting, see About the Column Tab.












Setting Alternating Row Colors

Some data tables are easier to read when the rows display alternating colors.

An example of alternating colors is shown in the following illustration.

[image: Description of GUID-66E19E34-B769-418B-BC12-40431014BBA3-default.gif follows]



To set an alternating row color:




	Select the table.
	Open the Properties pane.
	Click the value shown for Alternate Row Color to launch the color picker. The following illustration shows the Alternate Row Color option.[image: Description of GUID-3D381367-395E-4E61-BC22-1978477CAC42-default.gif follows]





	Choose a color and click OK.






About the Table Tab

The Table tab defines the functions that you can perform to display a table in a customized manner.

The Table tab enables you to perform the following:

	Set the number of rows displayed


	Define filters for the data displayed in the table


	Define conditions and formats to apply to rows that meet the conditions


	Show or hide the total row for the table




The following figure shows the Table tab.


[image: Description of GUID-F8248ECD-2223-4436-9D52-A042CFE3C749-default.gif follows]










Setting the Rows to Display Option

The Rows to Display property controls the number of rows of data displayed

The property is set as follows:

	When designing the layout, this property sets the number of rows that are displayed for the table within the layout editor.


	When viewing this layout in the report viewer in interactive mode, this property sets the size of the scrollable region for the table.




The default is 10 rows of data. You can select 10, 20, 30, 40, or All rows of data to be displayed. To set a custom value, open the Properties pane and enter the custom value for the Rows to Display property.

Note:
Displaying more rows of data can impact the performance of the Layout Editor.





About Filters

A filter refines the displayed items by a condition. This is a powerful feature that enables you to display only desired elements in the table without having to perform additional coding.

For example, you could add a filter to meet some of the following report conditions:

	Display only the top 10 salaries


	Display only the bottom 25 store sales


	Display only employees in the IT department


	Display only sales that are between $10,000 and $20,000 and in the Southern region




You can add multiple filters and manage the order in which they are applied to the table data.





Setting Filters for a Table

You can use a filter to narrow table results.

To set a filter:




	Click the Filter toolbar button.
	Enter the fields to define a filter, as described in the following table.
	Field	Description
	Data Field

	Select the data field to filter the table data by. All elements are available regardless of whether they are included as table columns.


	Operator

	Select from the following operators: is equal to is not equal to is less than is greater than is less than or equal to is greater than or equal to is between is in top is in bottom


	Value

	Enter the value or values appropriate for the operator selected. The value can be either a text entry, or an element from the data.
















Managing Filters

After you have added filters, use the Manage Filters feature to edit, delete, or change the order that the filters are applied.

To manage filters:




	Click the Manage Filters toolbar button to launch the Manage Filters dialog, as shown in the following illustration.[image: Description of GUID-DBA7ED22-7D96-4EA7-BDA4-34C9515476AF-default.gif follows]





	Hover the cursor over the filter to display the actions toolbar. Use the toolbar buttons to edit the filter, move the filter up or down in the order of application, delete, or add another filter.






About Conditional Formats

A conditional format changes the formatting of an element in the table based on a condition.

This feature is extremely useful for highlighting target ranges of values in the table. For example, you could create a set of conditional formats for the table that display rows in different colors depending on threshold values.





Applying Conditional Formats to a Table

This table describes the different fields in the Highlight dialog.

To apply a conditional format:



	Click the Highlight button. This launches the Highlight dialog, as shown in the following figure.
[image: Description of GUID-50256A70-C2A9-4EFD-BAAA-81AED1B28EB9-default.gif follows]







	Enter the fields to define a condition and format to apply, as described in the following table.
	Field	Description
	Data Field

	Select the data field to apply the condition to. All elements are available regardless of whether they are included as table columns. For example, you may want to highlight in red all employees with salaries greater than $10,000, but not actually include the salary element in the table.


	Operator

	Select from the following operators: is equal to is not equal to is less than is greater than is less than or equal to is greater than or equal to is between


	Value

	Enter the value or values appropriate for the operator selected. The value can be either a text entry, or an element from the data.

Note:
If entering a date value, use on of the following XSL date or time formats: YYYY-MM-DD or YYYY-MM-DDTHH:MM:SS.


	Font Family

	Select the font to apply to the row of data that meets the condition. You can also apply bold, italic, or underline emphasis.


	Size

	Select the size of the font to apply to the row of data that meets the condition.


	Color

	Click the color box to open the Color Picker. Choose one of the predefined colors or click Custom Color to define a color to apply to the font.


	Background Color

	Click the color box to open the Color Picker. Choose one of the predefined colors or click Custom Color to define the background color to apply to the row.








The following figure shows the table in the layout with the condition applied.


[image: Description of GUID-D1D5A6AA-9856-4B68-8A90-35F8A7B5445E-default.gif follows]













Managing Formats

After you have added conditional formats, use the Manage Formats command to edit or delete a format.

To manage formats:




	Click the Manage Formats button to launch the Manage Conditional Formats dialog, as shown in the following illustration.[image: Description of GUID-DBD05084-C5E8-4301-A960-AE026F98C1C1-default.gif follows]





	Hover the cursor over an item to display the actions toolbar. Use the toolbar buttons to edit the format, move the format up or down in the order of application, delete, or add another format. The order of the conditions is important because only the first condition that is met is applied.






Controlling the Display of the Total Row

By default, the layout editor inserts a total row in a table that sums numeric columns. To remove the total row, click the Show menu and select the table view without the highlighted total row.

The following figure shows the Show menu options:

[image: Description of GUID-55553487-43CA-43C9-AD25-6C398E91FF44-default.gif follows]



The total row can be further customized using the Total Cell tab and the Properties pane. For more information see About the Total Cell Tab.










About the Table Column Header Tab

The Table Column Header tab defines the functions that you can perform.

The following figure shows the Table Column Header tab.


[image: Description of GUID-149F5BEC-DBFD-45F0-90CD-426C8A3433D1-default.gif follows]





The Table Column Header tab enables you to perform the following:

	Edit the font properties of the table header column


	Edit the cell properties of the table header including border weight, style, and color and background fill color


	Set the vertical and horizontal alignment of the table header


	Apply grouping






About Grouping

"Grouping" groups together elements in the data of the same value. In a table, applying grouping can make the table easier to read.

The Grouping option enables you to choose between "Group Left" or "Group Above". Group left maintains the "group by" element within the table. The following figure shows a table that has been grouped by Manager using Group Left.


[image: Description of GUID-46C3A183-2262-4E4E-94E3-45B90D6C2F12-default.gif follows]





Group above inserts a Repeating Section component, and extracts the grouping element from the table. The grouping element is instead displayed above the table and a separate table is displayed for each occurrence of the grouping element. The following figure shows a table that has been grouped by Manager using Group Above.

[image: Description of GUID-AFA40237-7BE6-4477-B7DD-8680616D3F3F-default.gif follows]







Example: Group Left

The illustration here shows an example where the table data has been grouped by the elements of the first two columns, Manager and Title.

Notice that there is only one entry per manager name and one entry for each job title under that manager name. This organizes the data rows more cleanly in the table.

[image: Description of GUID-37809E37-4110-4BF5-854B-32A951A89593-default.gif follows]







Applying Subtotals

To further enhance a table, you can add a subtotal row to display for each grouped occurrence of the element.





Example: Group Above

The illustration here shows an example where the table data has been grouped by Manager. 

Notice that in the design pane, the Data Table component has been replaced with a Repeating Element component that contains the data table. The Manager element is inserted above the table with a label.


[image: Description of GUID-5C2DCD35-7F87-4FFB-961C-2788B1292079-default.gif follows]





The label is a text item. Edit the text by double-clicking the item to select it, then single-clicking to edit.

When you run the report, a separate table is created for each occurrence of the grouping element. In Interactive output mode, the grouping element displayed at the top of the table is displayed as a filter. Select the value that you want to view from the list, as shown in the below figure:


[image: Description of GUID-325AA6ED-D4A2-49F1-94FF-A427BE59B1C9-default.gif follows]














About the Column Tab

The Column tab is enabled when you select a specific column in a table. You can edit font and cell properties and apply them.


[image: Description of GUID-DEF256ED-6CB6-4B32-9C33-F4EF0D42F63A-default.gif follows]





The Column tab allows you to perform the following actions:

	Edit the font properties of the column including style, size, and color


	Edit the cell properties of the column including border weight, style, and color and background fill color


	Set the vertical and horizontal alignment of the column contents


	Apply formatting to the column data (options depend on the data type)


	Apply grouping


	Apply a running total (or other formula) to the data


	Apply sorting and sort precedence


	Apply conditional formatting to the column






About the Data Formatting Options for Columns

The options available from the Data Formatting region of the tab depend on the data type of the column selected. The tab provides common options to choose from.

If an option is not listed, you can enter a custom Oracle or Microsoft formatting mask in the Properties pane. You can also set a formatting mask dynamically by including the mask as an element in your data. These features are described in the following sections:

	Applying Formatting to Numeric Data Columns


	Applying Formatting to Date Type Data Columns


	Custom and Dynamic Formatting Masks








Applying Formatting to Numeric Data Columns

Follow these formatting options if the column contains numeric data.

	Format - Select one of the common number formats from the list. The format is applied immediately to the table column. The formats are categorized by Number, Percent, and Currency, as shown in the following figure:

[image: Description of GUID-0276B1CC-1687-4173-8149-9DFFE4A0D705-default.gif follows]



To apply a format not available from this list, see Applying Custom Data Formatting.


	Decimal position - Click the Move Left or Move Right to increase or decrease the decimal positions displayed.


	Show/Hide Grouping Separator - Click this button to hide the grouping separator (for example, 1,234.00 displays as 1234.00). To show the grouping separator, click the button again.











Applying Formatting to Date Type Data Columns

Use these formatting options if the column contains dates.

	Format - Select one of the common date formats from the list. The format is applied immediately to the table column. The formats are categorized by Date and Time, as shown in the following figure:

[image: Description of GUID-246B164D-B44C-48AD-B7AB-A5F6A7B4248C-default.gif follows]













Custom and Dynamic Formatting Masks

You can apply any Microsoft or Oracle (recommended) format mask to a report data field. You can manually enter the mask in the Formatting Mask property on the Properties pane. 

To enter a custom data formatting mask:



	Select the data column or field in the layout.
	On the  Properties pane, under the Data Formatting group select the Formatting Style. Supported styles are Oracle and Microsoft.
	In the Formatting Mask field, manually enter the format mask to apply.


For more information on Microsoft and Oracle format masks, see Formatting Numbers, Dates, and Currencies.

Formatting masks can also be applied dynamically by either including the mask in a data element of your report data, or as a parameter to the report. The mask is passed to the layout editor based on the value of the data element. 

To enter a dynamic formatting mask, in the Formatting Mask field, choose the data element that defines the formatting mask. The following figure shows an example of setting a dynamic number format mask. For this example, a parameter called NumberFormat prompts the user to define a format mask when the report is submitted. The value is passed to the Formatting Mask property and applied to the data field in the layout.

[image: Description of GUID-084F9F54-76DE-4C40-8230-8605233A9CE2-default.gif follows]



If you use a parameter to pass the format mask ensure that you select the Include Parameter Tags option on the data model Properties page.








About the Formula Option

The options available from the Formula region of the Column tab depend on the data type of the column.

For more information about applying formulas, see Setting Predefined or Custom Formulas.





About the Sort Option

To sort the data in a column, select the column, then under the Sort group click Ascending Order or Descending Order.

To sort by more than one column, select the column, the sort order, and then assign a Priority to each column. The priority list is a list of values beneath the sort order commands.

For example, in the employee salary table shown in the following figure, assume you want to sort ascending first by Title then sort descending by Annual Salary:


[image: Description of GUID-26851D84-8262-49BC-B049-0E299767A8C5-default.gif follows]








To apply the sort order to this table:



	Select the Title column.
	On the Column tab, under Sort, click the Ascending Order button.
	From the Priority list, select 1. The following figure shows the Priority list.

[image: Description of GUID-14F860BB-49D0-4ECE-A139-F4EE3A60630E-default.gif follows]





	Next select the Annual Salary column.
	On the Column tab, under Sort, click the Descending Order button.
	From the Priority list, select 2.






Removing a Sort Order

You can remove the sorting applied to a column.

To remove a sort order applied to a column:




	Select the column.
	From the Sort region on the Column tab, click the appropriate button of the sort order that has been applied. For example, to deselect the ascending order, click the Ascending Order button to undo the sort.








About the Total Cell Tab

The Layout Editor automatically inserts a grand total row when you insert a data table to the layout. As shown in the section on grouping, you can also insert subtotal rows within the table based on a grouping element.

To edit the attributes of the cells in a grand total or subtotal row, select the cell and use the options in the Total Cell tab shown in the following figure.


[image: Description of GUID-B7D59762-DA9C-4CC1-9587-658904C9A925-default.gif follows]





The Total Cell tab enables you to perform the following:

	Edit the font properties of the total cell


	Edit the cell properties of the total cell including border weight, style, and color and background fill color


	Set the vertical and horizontal alignment of the table header


	Apply formatting to the cell data


	Apply a formula to the cell


	Apply conditional formatting to the cell






Applying Data Formatting to a Total Cell

The section talks about applying data formatting to a total cell.

See About the Data Formatting Options for Columns.








Applying a Formula

By default, the formula applied to a Total Cell within a numeric column is a sum of the column items. The Formula option enables you to apply a different formula.

Not all options available from the Formula region of the column tab are applicable to a Total Cell.

For more information about applying formulas, see Setting Predefined or Custom Formulas.










Inserting Dynamic Hyperlinks

The layout editor supports dynamic hyperlinks in tables.

To insert a dynamic hyperlink:




	Select the table column.
	Click Properties. The column properties include an option for URL, as shown in the following illustration.[image: Description of GUID-9CA5F2DD-A568-45CA-B823-8B2AB593EB20-default.gif follows]





	In the URL field, enter the static portion of the URL and embed the absolute path to the element that provides the dynamic portion of the URL within curly braces {}. For example:http://example.com/show_page?id={/DATA/GROUP1/ELEMENT_NAME}

where http://example.com/show_page?id= is the static portion of the URL and {/DATA/GROUP1/ELEMENT_NAME} is the absolute path to the element in the data that supplies the dynamic portion.





For example, in the employee salary report, suppose each employee name should render as a hyperlink to the employee's person record. Assume the static portion of the URL to each person record is

 https://people.hrserver.com/records/show_page?id=

The dynamic portion comes from the data element EMPLOYEE_ID. For this example, append the full path to the EMPLOYEE_ID element within curly braces and enter this in the URL field as follows:

https://people.hrserver.com/records/show_page?id={/ROWSET/ROW/EMPLOYEE_ID}








Applying Custom Data Formatting

BI Publisher supports the use of the Oracle and Microsoft format masks for custom data formatting. The results of the output depends on the selected locale.

For more information on Microsoft format masks, see Using the Microsoft Number Format Mask.

For more information on Oracle format masks, see Using the Oracle Format Mask.




To apply custom data formatting:



	Select a data field or column.
	Click Properties. The Data Formatting options are displayed as shown in the following figure:
[image: Description of GUID-5ADCAFF4-EB19-4A1A-9D00-74D1455EB67E-default.gif follows]







	From the Formatting Style drop-down list, select the Oracle or Microsoft formatting style. The Oracle formatting style is recommended.
	In the Formatting Mask field, enter a formatting mask. For example, for a column that contains product totals, you can use the Oracle formatting style, and the 9G999D99 formatting mask to display total values with two zeros to the right of the decimal place.







All Outputs

The table lists properties applicable to all outputs.

The properties in the following table apply to all outputs:





	Property Name	Description
	Hide version number in output

	Default: false

Description: Some report output documents display Oracle BI Publisher in the document properties. For example, PDF documents identify Oracle BI Publisher as the PDF Producer in the properties for the document. If you do not want to include the version of BI Publisher that generated the document (for example, Oracle BI Publisher 11.1.1.4.0), then set this property to true.


	Use 11.1.1.5 compatibility mode

	Reserved. Do not update unless instructed by Oracle.











Locale Selection Logic

BI Publisher applies a translation based on the user's selected Report Locale.

BI Publisher first tries to match an RTF template named for the locale, then an XLIFF file named for the locale. If an exact match on language-territory is not found, then BI Publisher tries to match on language only.

For example, if you have a report for which the base template is called EmployeeTemplate.rtf and the locale selected is French (France), then BI Publisher selects the translation to apply according to the following hierarchy:

EmployeeTemplate.rtf (fr_FR)

EmployeeTemplate.xlf (fr_FR)

EmployeeTemplate.rtf (fr)

EmployeeTemplate.xlf (fr)

EmployeeTemplate.rtf (default)

With the same set of translations, if the locale selected is French (Switzerland), then the EmployeeTemplate.rtf (fr) is applied. Now if the available translations are limited to the following set:

EmployeeTemplate.rtf (fr_FR)

EmployeeTemplate.xlf (fr_FR)

EmployeeTemplate.rtf (default)

and the locale selected is French (Switzerland), then the EmployeeTemplate.rtf (default) is applied. Even though there is a language match, BI Publisher does not match the different locales.

Therefore, to ensure that a French language translation is used when French is the selected language, regardless of the selected locale, you must include either an rtf or xlf file named for the language only (that is, EmployeeTemplate_fr.rtf or EmployeeTemplate_fr.xlf).




What Can Be Translated?

Specific strings can be translated into different languages.

The following table shows what strings can be translated.





	Object	What Can Be Translated	Preference That Determines Translation Displayed
	Folder

	Name Description

	UI Language (applies to all)


	Data Model

	Name Description Data Display Name

	UI Language (applies to all)


	Report

	Name Description Layout Names Data Model Reference Parameter Name

	UI Language (applies to all)


	Style Template

	Name Static text in the template

	UI Language Report Locale


	Sub Template

	Name Static text in the template

	UI Language Report Locale


	BI Publisher Layouts (.xpt)

	Static text in the layout

	Report Locale


	RTF Layouts

	Static text in the layout

	Report Locale










About Source Language Limitations

Translation of BI Publisher catalog objects using the Export XLIFF function is available at the catalog level.

For catalog translation, the source language is limited to "en". You must create catalog and data model objects in English locale to be able to translate them.






11 Creating and Implementing Style Templates

A style template is an RTF template that contains style information that can be applied to other RTF layouts to achieve a consistent look and feel across your enterprise reports.

This chapter describes how to create and implement style templates. It includes the following sections:

	Understanding Style Templates


	Creating a Style Template RTF File


	Uploading a Style Template File to the Catalog


	Assigning a Style Template to a Report Layout


	Updating a Style Template


	Adding Translations to a Style Template Definition







F PDF Version Support

This chapter describes BI Publisher's support for PDF specification 1.7 in its processing utilities.


It contains the following sections:

	About PDF Version Support


	Supported Utilities


	Limitations







About Pivot Tables

The pivot table provides views of multidimensional data in tabular form. It supports multiple measures and dimensions and subtotals at all levels.

The following figure shows a pivot table:

[image: Description of GUID-5B465B61-FF8F-45A1-8EF8-D6081B35004A-default.gif follows]





Inserting a Pivot Table

To insert a pivot table:


	From the Insert tab, select and drag the Pivot Table component to the layout. The following figure shows the empty pivot table structure.
[image: Description of GUID-89D8A33C-DE9C-4342-9DC9-DF2290453E26-default.gif follows]







	Drag and drop data fields from the Data Source pane to the row, column, and data positions.Drag multiple fields to the pivot table and place them precisely to structure the pivot table, as shown in the following figure:


[image: Description of GUID-18D203AC-EC9E-42FA-BF45-B16AEE69DC97-default.gif follows]







	By default the pivot table is inserted with no data formatting applied. To apply a format to the data, click the first column of data to enable the Pivot Table Data toolbar. On the Data Formatting group, select the appropriate format as shown in the following figure:
[image: Description of GUID-F7190A34-09D6-4C7D-A45A-DB8F76B45E51-default.gif follows]







	Optionally resize the pivot table by clicking and dragging the handler in the lower right corner of the pivot table.






Customizing a Pivot Table Menu

After you insert a pivot table customize the appearance and layout using these dynamic tabs.

	Pivot Table tab


	Pivot Table Header tab


	Pivot Table Data tab








About the Pivot Table Tab

You can customize the appearance of a pivot table using the Pivot Table tab.

The following figure shows the Pivot Table tab.


[image: Description of GUID-5133BB35-EC94-4FDD-8F0D-9C121B504469-default.gif follows]










Applying Filters

This section describes filters and manage filters features.

See About Filters for a description of the Filter and Manage Filters features.








Customizing the Display of Totals

The Pivot Table tab enables you to quickly customize the display of grand total and subtotal rows.

By default, the layout editor inserts the pivot table with the total and subtotal displays as shown in the tab:

	Row Grand Total - Inserted at the bottom of table


	Row Subtotal - Inserted at the top of each subgroup, with no row header


	Column Grand Total - Inserted at the far right


	Column Subtotal - Inserted to the left of each column subgroup, with no header




Change the positioning and display of totals and subtotals by clicking the appropriate group in the tab and selecting the desired layout pattern from the menu.








Converting a Pivot Table to a Chart

The Convert Pivot Table to a Chart command converts the pivot table to a default vertical bar chart.

After conversion, customize the table as described in About Charts.

The following figure shows the pivot table created in the preceding step converted to a vertical bar chart.


[image: Description of GUID-FF815463-0208-43DD-8D11-3DDCA2DF17D2-default.gif follows]












Switching Rows and Columns

Use the Switch Rows and Columns command to see a different view of the same data.

The following illustration shows the pivot table created in the previous step with rows and columns switched.

[image: Description of GUID-36EC2882-6758-4BE3-BF23-2B0384A6DF16-default.gif follows]












Customizing the Pivot Table Headers

Use the Pivot Table Header tab to customize the fonts, colors, etc.

The Pivot Table Header tab is shown in the following figure:


[image: Description of GUID-2292229C-7989-4866-837A-F50989FDA9F8-default.gif follows]





Select the column or row header of the pivot table and use the Pivot Table Header tab to perform the following:

	Customize the fonts, colors, alignment and other display features of the header.


	Apply a sort order (for more information see About the Sort Option).


	Apply data formatting (if the data type is number or date).











Customizing the Pivot Table Data

Select the data area of the pivot table and use the Pivot Table Data tab to perform these actions. The commands in the Pivot Table Data tab are the same as the corresponding commands in the table Column tab.

The Pivot Table Data tab is shown in the following figure:


[image: Description of GUID-AD00FF3F-9191-4E6D-9A51-703D9939E4C6-default.gif follows]





See the references for more information on their use.

	Customize the fonts, colors, alignment and other display features of the data.


	Apply conditional formatting to the data for more information (see About Conditional Formats).


	Apply data formatting (see About the Data Formatting Options for Columns).


	Apply a formula (see Applying a Formula).












Excel 2007 Output Properties

Use the properties described in this table to control Excel 2007 output.


	Property Name	Description
	Show grid lines

	Default: false

Description: Set to true to show the Excel table grid lines in the report output.


	Page break as a new sheet

	Default: true

Description: When set to True a page break that is specified in the report template generates a new sheet in the Excel workbook.


	Minimum column width

	Default: 3 (in points, 0.04 inch)

Description: When the column width is less than the specified minimum and it contains no data, the column is merged with the preceding column. The value must be set in points. The valid range for this property is  0.5 to 20 points.


	Minimum row height

	Default: 1 (in points, 0.01 inch)

Description: When the row height is less than the specified minimum and it contains no data, the row is removed. The value must be set in points. The valid range for this property is  .001 to 5 points.


	Keep values in same column

	Default: False

Description: Set this property to True to minimize column merging. Column width is set based on column contents using the values supplied in the Table Auto Layout property. Output may not appear as neatly laid out as when using the original layout algorithm.


	Table Auto Layout

	Default: N/A

Valid Values: Specify a conversion ratio in points and a maximum length in points, for example 6.5,150. See example.

Description: For this property to take effect, the property "Keep values in same column" must be set to True. 

This property expands the table column width to fit the contents. The column width is expanded based on the character count and conversion ratio up to the maximum specification. 

Example: Assume a report with two columns of Excel data -- Column 1 contains a text string that is 18 characters and Column 2 is 30 characters long. When the value of this property is set to 6.5,150, the following calculations are performed:

Column 1 is 18 characters:

Apply the calculation: 18 * 6.5pts = 117 pts

The column in the Excel output will be 117 pts wide.

Column 2 is 30 characters:

Apply the calculation: 30 * 6.5 pts = 195 pts

Because 195 pts is greater than the specified maximum of 150, Column 2 will be 150 pts wide in the Excel output.


	Maximum allowable nested table row count

	Default: 20,000

Description: Specify the maximum allowable row count for a nested table. Allowed values are 15000 to 999,999.

During report processing, nested inner table rows cannot be flushed to the XLSX writer, therefore they stay in-memory, increasing memory consumption. Set this limit to avoid out-of-memory exceptions. When this limit is reached for the size of the inner table, generation is terminated. The incomplete XLSX output file is returned. 











About Text Items

The text item component allows you to enter free-form text in the layout.

To create a text item component:



	Drag and drop the text item component to the layout.
	Double-click the text to enter text editor mode. Select parts of the text to apply different formatting to different parts.




Displaying a Data Field Side-by-Side with a Text Item

By default, the text item always spawns a complete paragraph. Inserting a data field next to the text field places the data field beneath the text field.

The data field beneath a text item is shown in the following figure:

[image: Description of GUID-320DB850-83EF-4B20-9BD7-EC980F93D0A4-default.gif follows]






To display the data field inline with the text item:


	Set the Display property to Inline in the Properties pane.
[image: Description of GUID-30576EE5-2A11-4897-BE9E-3F8C5436B8B8-default.gif follows]





This setting enables the positioning of text items and data fields into a single line as shown in the following figure:


[image: Description of GUID-4B4C0433-9849-4AF2-BADE-680F51EE0814-default.gif follows]













About the Text Toolbar

The Text tab defines all the functions that you can do with respect to font and alignment of text in a report.

The Text tab is shown in the following figure.


[image: Description of GUID-E3ED74DA-8668-4881-BCF6-1535BFC596E0-default.gif follows]





The Text tab enables you to perform the following:

	Set the font properties


	Set alignment of the text in the grid cell


	Insert predefined text items: page number, date, and time


	Insert a hyperlink









Editing Font Properties

Use the Font group of commands to set the style, size, emphasis, and color.

	Select a font style


	Select a font size


	Apply emphasis (bold, italic, or underline)


	Insert a border around the text item


	Apply a background color


	Apply a font color











Inserting Page Numbers

Drag and drop the page number component to the design area.

The following illustration shows the Page # of N construction.

[image: Description of GUID-6AC0EB9F-F904-45AB-85C2-41985DB075EB-default.gif follows]



To create the Page # of N construction:




	From the Insert tab drag and drop a Text Item to the design area where you want the page numbers to display.
	Double-click the inserted text to select the text item for editing. Type "Page ".
	From the Text dynamic tab, drag and drop the Page Number component.
	Enter a space, and type "of ".
	From the Text dynamic tab, drag and drop the Page Total component.






Inserting the Date and Time

You can insert time and date variables in a report design.

To insert the date and time in a report:




	From the tab drag and drop a Text Item to the design area where you want the date and time to display.
	Double-click the inserted text to select the text item for editing.
	Click the Date icon to insert the date icon in the text item. Click the Time icon to insert the time icon in the text item.Note:
To display the items side-by-side, set the Text Item property to "Inline".

The following illustration shows the insertion of the date and time icons.

[image: Description of GUID-BC5D8C17-1A27-4680-8AC1-EB5F46C6F0DF-default.gif follows]







When this report is viewed, the date and time are displayed according to the server time zone if viewed online, or for scheduled reports, the time zone selected for the schedule job. The following illustration shows the date and time displayed in a report.

[image: Description of GUID-E1A955FA-299F-4EBC-BE87-22B9BBF1FF67-default.gif follows]










Inserting a Hyperlink

Follow these steps to insert a hyperlink.

To insert a hyperlink in a report:


	From the Insert tab drag and drop a Text Item to the design area where you want the date and time to display.
	Double-click the inserted text to select the text item for editing. Enter the text which you want to convert to a link.
	Select the text, then click the Link button.
	In the dialog enter the URL.









Inserting Page-Level Calculations

Learn more about the supported page-level calculations for PDFs and PPTs.

BI Publisher supports the page-level calculations that are described in the following sections for PDF and PPT outputs only:

	Displaying Page Totals


	Inserting Brought Forward and Carried Forward Totals


	Inserting Running Totals






Displaying Page Totals

BI Publisher allows you to display calculated page totals in the report. Because the page is not created until publishing time, the totaling function must be executed by the formatting engine.

Note:
Page totaling is performed in the PDF-formatting layer. Therefore this feature is not available for other outputs types: HTML, RTF, Excel. This page totaling function works only if the source XML co6de has raw numeric values. The numbers must not be preformatted.



Because the page total field does not exist in the XML input data, you must define a variable to hold the value. When you define the variable, you associate it with the element from the XML file that is to be totaled for the page. Once you define total fields, you can also perform additional functions on the data in those fields.

To declare the variable that is to hold the page total, insert the following syntax immediately following the placeholder for the element that is to be totaled:

<?add-page-total:TotalFieldName;'element'?>


where

TotalFieldName is the name you assign to the total (to reference later) and

'element' is the XML element field to be totaled.

You can add this syntax to as many fields as you want to total.

Then when you want to display the total field, enter the following syntax:

<?show-page-total:TotalFieldName;'Oracle-number-format' number-separators="{$_XDONFSEPARATORS}"?>


where

TotalFieldName is the name you assigned to give the page total field above and

Oracle-number-format is the format you want to use to for the display, using the Oracle format mask (for example: 'C9G999D00'). For the list of Oracle format mask symbols, see Oracle Abstract Format Masks.

number-separators="{$_XDONFSEPARATORS}" is a required attribute to apply the grouping separator and decimal separator for the format mask you defined.

The following example shows how to set up page total fields in a template to display total credits and debits that have displayed on the page, and then calculate the net of the two fields.

This example uses the following XML code:

<balance_sheet>
 <transaction>
  <debit>100</debit>
  <credit>90</credit>
 </transaction>
 <transaction>
  <debit>110</debit>
  <credit>80</credit>
 </transaction>
…
<\balance_sheet>


The following figure shows the table to insert in the template to hold the values:


[image: Description of GUID-822F565C-CFB6-4F1B-8BB7-CD7C88B7AF29-default.gif follows]





The following table shows the form field entries made in the template whose table is shown in the previous figure:


	Default Text Entry	Form Field Help Text Entry	Description
	FE

	<?for-each:transaction?>	This field defines the opening "for-each" loop for the transaction group.


	100.00

	<?debit?><?add-page-total:dt;'debit'?>	This field is the placeholder for the debit element from the XML file. To total this field by page, the page total declaration syntax is added. The variable defined to hold the total for the debit element is dt.


	90.00

	<?credit?> <?add-page-total:ct;'credit'?>	This field is the placeholder for the credit element from the XML file. To total this field by page, the page total declaration syntax is added. The variable defined to hold the total for the credit element is ct.


	Net

	<add-page-total:net;'debit - credit'?>	Creates a net page total by subtracting the credit values from the debit values.


	EFE

	<?end for-each?>	Closes the for-each loop.








Note that on the variable defined as "net" you perform a calculation on the values of the credit and debit elements.

Now that you have declared the page total fields, you can insert a field in the template where you want the page totals to appear. Reference the calculated variables using the names you supplied (in the example, ct and dt). The syntax to display the page totals is as follows:

For example, to display the debit page total, enter the following:

<?show-page-total:dt;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Therefore to complete the example, place the following at the bottom of the template page, or in the footer:

Page Total Debit: <?show-page-total:dt;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Page Total Credit: <?show-page-total:ct;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Page Total Balance: <?show-page-total:net;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

The output for this report is shown in the following figure:


[image: Description of GUID-C34CC61F-EE34-4228-9573-FB771B24D324-default.gif follows]









Inserting Brought Forward and Carried Forward Totals

Many reports require that a page total be maintained throughout the report output and be displayed at the beginning and end of each page. These totals are known as "brought forward and carried forward" totals.

Note:
The totaling for the brought forward and carried forward fields is performed in the PDF-formatting layer. Therefore this feature is not available for other outputs types such as HTML, RTF, and Excel.



An example of a report with forward totals is displayed in the following figure:


[image: Description of GUID-7351323A-53E5-477C-9AEE-243BCA3689B2-default.gif follows]





At the end of the first page, the page total for the Amount element is displayed as the Carried Forward total. At the top of the second page, this value is displayed as the Brought Forward total from the previous page. At the bottom of the second page, the brought forward value plus the total for that page is calculated and displayed as the new Carried Forward value, and this continues throughout the report.

This functionality is an extension of the Displaying Page Totals feature. The following example walks through the syntax and setup required to display the brought forward and carried forward totals in the published report.

Assume that you have the following XML code:

<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICES>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>1-Jan-2005</INVDATE>
  <INVAMT>100</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-2</INVNUM>
  <INVDATE>10-Jan-2005</INVDATE>
  <INVAMT>200</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>11-Jan-2005</INVDATE>
  <INVAMT>150</INVOICEAMT>
 </INVOICE>
. . .
</INVOICES>


The sample template that is shown in the following figure creates the invoice table and declares a placeholder that holds the page total.


[image: Description of GUID-4362EE8C-65FA-48A9-A167-A6DEC545C9C0-default.gif follows]





The following table shows the fields in the template that is shown in the above figure.


	Field	Form Field Help Text Entry	Description
	Init PTs

	<?init-page-total: InvAmt?>

	Declares InvAmt as the placeholder that holds the page total.


	FE

	<?for-each:INVOICE?>

	Begins the INVOICE group.


	10001-1

	<?INVNUM?>

	Placeholder for the Invoice Number tag.


	1-Jan-2005

	<?INVDATE?>

	Placeholder for the Invoice Date tag.


	100.00

	<?INVAMT?>

	Placeholder for the Invoice Amount tag.


	InvAmt

	<?add-page-total:InvAmt;INVAMT?>

	Assigns the "InvAmt" page total object to the INVAMT element in the data.


	EFE

	<?end for-each?>

	Closes the INVOICE group.


	End PTs

	<?end-page-total:InvAmt?>

	Closes the "InvAmt" page total.








To display the brought forward total at the top of each page (except the first), use the following syntax:

<xdofo:inline-total
  display-condition="exceptfirst"
  name="InvAmt">
   Brought Forward:
<xdofo:show-brought-forward
  name="InvAmt"
  format="99G999G999D00" number-separators="{$_XDONFSEPARATORS}"/>/>
</xdofo:inline-total>


The following list describes the elements that comprise the brought forward syntax:

	inline-total - This element has two properties:

	name - Specifies the name of the variable you declared for the field.


	display-condition - Sets the display condition. This is an optional property that takes one of the following values:

	first - Contents are displayed only on the first page.


	last - Contents are displayed only on the last page.


	exceptfirst - Contents are displayed on all pages except first.


	exceptlast - Contents are displayed on all pages except last.


	everytime - (Default) Contents are displayed on every page.




In this example, display-condition is set to "exceptfirst" to prevent the value from appearing on the first page where the value would be zero.





	Brought Forward: - This string is optional and is displayed as the field name on the report.


	show-brought-forward - Shows the value on the page. It has the following properties:

	name - The name of the field to show. In this case, InvAmt. This property is mandatory.


	format - The Oracle number format to apply to the value at runtime. This property is optional, but if you want to supply a format mask, you must use the Oracle format mask. For more information, see Oracle Abstract Format Masks.


	number-separators="{$_XDONFSEPARATORS}" - This attribute is required to apply the grouping separator and number separator for the format mask you defined.







Insert the brought forward object at the top of the template where you want the brought forward total to display. If you place it in the body of the template, then you can insert the syntax in a form field.

If you want the brought forward total to display in the header, you must insert the full code string into the header because Microsoft Word does not support form fields in the header or footer regions. However, you can alternatively use the start body/end body syntax, which allows you to define what the body area of the report is. BI Publisher recognizes any content above the defined body area as header content, and any content below as the footer. This allows you to use form fields. See Creating Multiple or Complex Headers and Footers for details.

Place the carried forward object at the bottom of the template where you want the total to display. The carried forward object for our example is as follows:

<xdofo:inline-total
  display-condition="exceptlast"
  name="InvAmt">
   Carried Forward:
<xdofo:show-carry-forward
  name="InvAmt"
  format="99G999G999D00" number-separators="{$_XDONFSEPARATORS}"/>
</xdofo:inline-total>


Note the following differences with the brought-forward object:

	The display-condition is set to exceptlast so that the carried forward total is displayed on every page except the last page.


	The display string is "Carried Forward".


	The show-carry-forward element is used to show the carried forward value. It has the same properties as brought-carried-forward, described above.




You are not limited to a single value in the template, you can create multiple brought forward/carried forward objects in the template pointing to various numeric elements in the data.

Note:
Ensure that you do not include the commands <?init-page-total:invAmnt?> and <?end-page-total:InvAmt?> as shown in the preceding example. The display-condition logic computation depends on these commands to function correctly.







Inserting Running Totals

The variable functionality can be used to add a running total to the invoice listing report.

See Setting Variables for more information. This example assumes the following XML structure:

<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICES>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>1-Jan-2005</INVDATE>
  <INVAMT>100</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-2</INVNUM>
  <INVDATE>10-Jan-2005</INVDATE>
  <INVAMT>200</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>11-Jan-2005</INVDATE>
  <INVAMT>150</INVOICEAMT>
 </INVOICE>
</INVOICES>


You can use this XML code to create a report that contains running totals as shown in the following illustration.

[image: Description of GUID-038AAFB6-EFB3-4FA0-BFD8-81A79DFF5DCB-default.gif follows]



To create the Running Total field, define a variable to track the total and initialize it to 0. The template is shown in the following illustration.

[image: Description of GUID-0B5C1607-9F34-43D0-9CBB-59F205784C90-default.gif follows]



The values for the form fields in the template that is shown in the previous illustration are described in the next table.


	Form Field	Syntax	Description
	RtotalVar

	<?xdoxslt:set_variable($_XDOCTX, 'RTotalVar', 0)?>

	Declares the "RTotalVar" variable and initializes it to 0.


	FE

	<?for-each:INVOICE?>

	Starts the Invoice group.


	10001-1

	<?INVNUM?>

	Invoice Number tag


	1-Jan-2005

	<?INVDATE?>

	Invoice Date tag


	100.00

	<?xdoxslt:set_variable($_XDOCTX, 'RTotalVar', xdoxslt:get_variable($_XDOCTX, 'RTotalVar') + INVAMT)?> <?xdoxslt:get_variable($_XDOCTX, 'RTotalVar')?>

	Sets the value of RTotalVar to the current value plus the new Invoice Amount. Retrieves the RTotalVar value for display.


	EFE

	<?end for-each?>

	Ends the INVOICE group.













Supported Formatting Features of Microsoft Word

Microsoft Word can simplify formatting output.

In addition to the features already listed, BI Publisher supports the features of Microsoft Word that are described in the following sections:

	General Features of Microsoft Word


	Aligning Objects


	Inserting Tables


	Inserting Date Fields


	Inserting Multiple Columns on Pages


	Inserting Backgrounds and Watermarks


	Microsoft Word Features That Are Not Supported






General Features of Microsoft Word

The general features of Microsoft Word are large blocks of text, page breaks, page numbering, and hidden text.

	Large blocks of text


	Page breaks

(Not supported for HTML output) To insert a page break, press Ctrl+Enter right before the closing tag of a group. For example if you want the template to start a new page for every Supplier in the Payables Invoice Register:

	Place the cursor just before the Supplier group's closing <?end for-each?> tag.


	Press Ctrl+Enter to insert a page break.




At runtime each Supplier starts on a new page.

Using this Microsoft Word native feature causes a single blank page to print at the end of the report output. To avoid this single blank page, use BI Publisher's page break alias. See Inserting Page Breaks.


	Page numbering

Insert page numbers into the final report by using the page numbering methods of the word processor. For example, if you are using Microsoft Word:

	From the Insert menu, select Page Numbers...


	Select the Position, Alignment, and Format as desired.




At runtime the page numbers are displayed as selected.

Note that page numbering is not supported for HTML output and has limited support in RTF output. After the RTF report is generated, press F9 to reset the page numbers.


	Hidden text

You can format text as hidden in Microsoft Word and the hidden text is maintained in RTF output reports.











Aligning Objects

Use the word processor's alignment features to align text, graphics, objects, and tables. Bidirectional languages are handled automatically using the word processor's left/right alignment controls.

Note that BI Publisher output documents do not support right and left justification for symbol-based languages such as Chinese, Japanese, and Korean.





Inserting Tables

Microsoft Word tables are can be used to enhance your reports.

The following Microsoft Word features are supported in BI Publisher:




	Nested Tables


	Cell Alignment

You can align any object in the template using the word processor's alignment tools. This alignment is reflected in the final report output.


	Row spanning and column spanning

To span both columns and rows in the template:

	Select the cells that you want to merge.


	From the Table menu, select Merge Cells.


	Align the data within the merged cell as you would normally.




At runtime the cells appear merged.


	Table Autoformatting

BI Publisher recognizes the table autoformats available in Microsoft Word.

To autoformat tables:

	Select the table that you want to format.


	From the Table menu, select Autoformat.


	Select the desired table format.




At runtime, the table is formatted using your selection.


	Cell patterns and colors

To highlight cells or rows of a table with a pattern or color:

	Select the cell(s) or table.


	From the Table menu, select Table Properties.


	From the Table tab, select the Borders and Shading... button.


	Add borders and shading as desired.





	Repeating table headers

Note:
This feature is not supported for RTF output.

If the data is displayed in a table and you expect the table to extend across multiple pages, then you can define the header rows that you want to repeat at the start of each page.

To repeat header rows:

	Select the row(s) that you want to repeat on each page.


	From the Table menu, select Heading Rows Repeat.





	Prevent rows from breaking across pages. 

If you want to ensure that data within a row of a table is kept together on a page, you can set this as an option using Microsoft Word's Table Properties.

To keep a row's contents together on one page:

	Select the row(s) that you want to ensure do not break across a page.


	From the Table menu, select Table Properties.


	From the Row tab, deselect the check box Allow row to break across pages.





	Fixed-width columns

To set the widths of table columns:

	Select a column and then select Table > Table Properties.


	In the Table Properties dialog, select the Column tab.


	Enable the Preferred width checkbox and then enter the width as a Percent or in Inches.


	Select the Next Column button to set the width of the next column.




Note that the total width of the columns must add up to the total width of the table.


	Text truncation

By default, if the text within a table cell does not fit within the cell, then the text is wrapped. To truncate the text instead, use the table properties dialog.

Note that table text truncation is supported for PDF and PPT outputs only.

To truncate the text within a table cell:

	Place the cursor in the cell in which you want the text truncated.


	Right-click and select Table Properties... from the menu, or navigate to Table > Table Properties...


	From the Table Properties dialog, select the Cell tab, then select Options...


	Deselect the Wrap Text check box.







An example of truncation is shown in the following figure.

[image: Description of GUID-E8E9E94A-7E40-4D02-8153-A28214B5E092-default.gif follows]



Note:
When using multibyte characters (for example, simplified Chinese) in tables, ensure that the column widths are large enough to contain the width of the largest character plus the cell's left and right margins to avoid unexpected character display in your final output.








Inserting Date Fields

Insert dates using the date feature of the word processor. Note that this date corresponds to the publishing date, not to the request run date.





Inserting Multiple Columns on Pages

BI Publisher supports Microsoft Word's Columns function to enable you to publish the output in multiple columns on a page. (Note that this is not supported for HTML output.)

Select Format, then Columns to display the Columns dialog to define the number of columns for the template.

To generate address labels in a two-column format:




	Divide the page into two columns using the Columns command.
	Define the repeatable group in the first column. Note that you define the repeatable group only in the first column, as shown in the following illustration.


[image: Description of GUID-E887A0A8-AE5D-4024-A208-ADF64C80CAAC-default.gif follows]



Tip:
To prevent the address block from breaking across pages or columns, embed the label block inside a single-celled table. Then specify in the Table Properties that the row should not break across pages. See Inserting Tables.

This template produces the multicolumn output that is shown in the following illustration.

[image: Description of GUID-BCB7026E-D127-4151-B22F-52D99B72C561-default.gif follows]










Inserting Backgrounds and Watermarks

BI Publisher supports the Background feature in Microsoft Word. You can specify a single, graduated color or an image background for the template to be displayed in the PDF output.

Note:
This feature is supported for PDF output and PPT output only.

To add a background to the template, use the Format > Background menu option.



Adding a Background Using Microsoft Word 2000

With the Background support feature in Microsoft Word you can select a color background and fill effects.

From the Background pop up menu, you can:




	Select a single color background from the color palette.


	Select Fill Effects to open the Fill Effects dialog.

From this dialog, select one of the following supported options:

	Gradient: This can be either one or two colors.


	Texture: Select one of the textures provided, or load your own.


	Pattern: Select a pattern and background/foreground colors.


	Picture: Load a picture to use as a background image.














Adding a Text or Image Watermark Using Microsoft Word 2002 or later

These versions of Microsoft Word allow you to add either a text or image watermark. Note that the steps you take to add a watermark depend on which version of Microsoft Word you are using.

You can add the following types of watermarks to documents:

	Picture Watermark - Load an image and define how it should be scaled on the document.


	Text Watermark - Use the predefined text options or enter your own, then specify the font, size and how the text should be rendered.

The following figure shows an example of the Printed Watermark dialog completed to display a text watermark in Microsoft Word 2010:




[image: Description of GUID-6D000EAF-3C56-41E9-B297-11F4AF219FEA-default.gif follows]









Microsoft Word Features That Are Not Supported

Do not use soft returns in your RTF template to achieve specific text placement. Instead use hard carriage returns.

A soft return may have unexpected results in your generated output.






Preprocessing the Data Using an XSL Transformation (XSLT) File

For the best performance, design the data model to perform as much of the data processing as possible. When it is not possible to get the required output from the data engine, you can preprocess the data using an XSLT file that contains the instructions to transform the data.

Some sample use cases include:




	To create groups to establish the necessary hierarchy to support the desired layout


	To add style attributes to data elements


	To perform complex data processing logic that may be impossible in the Excel Template or undesirable for performance reasons




Note:
The Template Builder for Excel does not support preview for templates that require XSLT preprocessing.



To use an XSLT preprocess file:

	Create the file and save as .xsl.


	Upload the file to the report definition in the BI Publisher catalog, as you would a template:

	Navigate to the report in the catalog.


	Click Edit.


	Click Add New Layout.


	Click Upload.


	Complete the fields in the Upload dialog and select "XSL Stylesheet (HTML/XML/Text)" as the template Type.


	After upload, click View a List. Deselect Active, so that users do not see this template as an option when they view the report.

Note:
For testing purposes, you might want to maintain the XSL template as active to enable you to view the intermediate data when the template is applied to the data. After testing is complete, set the template to inactive.




	Save the report definition.





	In the Excel template, on the XDO_METADATA sheet, in the Header section, enter the file name for the Preprocess XSLT File parameter. For example: splitByBrand.xsl









XSLT Preprocessing Examples: Splitting Flat Data into Multiple Sheets

This topic presents two examples of using an XSLT preprocess file to group flat data so that it can be split into multiple sheets in Excel.

The examples are:

	Splitting the Data by a Specific Field


	Splitting the Data by Count of Rows

Splitting the data by row count is an option when your report data exceeds the sheet row size of Excel 2003 (65,536 rows per sheet).




Both examples use the following XML data:

 <ROWSET>
    <ROW>
    <Products.Type>COATINGS</Products.Type> 
    <Products.Brand>Enterprise</Products.Brand>
    <Markets.Region>CENTRAL REGION</Markets.Region> 
    <Markets.District>CHICAGO DISTRICT</Markets.District> 
    <Periods.Year>2000</Periods.Year> 
    <Measures.Dollars>1555548.0</Measures.Dollars> 
   </ROW>
   <ROW>
    <Products.Type>COATINGS</Products.Type> 
    <Products.Brand>Enterprise</Products.Brand> 
    <Markets.Region>EASTERN REGION</Markets.Region> 
    <Markets.District>NEW YORK DISTRICT</Markets.District>
    <Periods.Year>2000</Periods.Year> 
    <Measures.Dollars>1409228.0</Measures.Dollars> 
   </ROW>
...
</ROWSET>



Splitting the Data by a Specific Field

This example demonstrates how to use an XSLT preprocess file to create a grouping in the data that will enable the splitting of the data across multiple Excel sheets based on the grouping.

This example groups the sample data by the Products.Brand field.




	Create an XSLT file to group the data. The following sample XSLT file groups the data according to <Products.Brand> and creates a high level element <BrandGroup> for each of those groups. 

<?xml version="1.0" encoding="utf-8" ?> 
  <xsl:stylesheet version="2.0"   xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:template match="/">
    <ROWSET>
      <xsl:for-each-group select="/ROWSET/ROW" group-by="./Products.Brand">
        <xsl:variable name="var_brand" select="current-grouping-key()" /> 
        <BrandGroup>
          <xsl:attribute name="name">
             <xsl:value-of select="$var_brand" /> 
          </xsl:attribute>
          <xsl:copy-of select="current-group()" /> 
       </BrandGroup>
     </xsl:for-each-group>
    </ROWSET>
  </xsl:template></xsl:stylesheet>


When applied to the data sample, this XSLT file generates intermediate data as follows:

 <ROWSET> 
   <BrandGroup name="Enterprise"> 
     <ROW> 
       <Products.Type>COATINGS</Products.Type>
       <Products.Brand>Enterprise</Products.Brand>
       <Markets.Region>CENTRAL REGION</Markets.Region>
       <Markets.District>CHICAGO DISTRICT</Markets.District>
       <Periods.Year>2000</Periods.Year> 
       <Measures.Dollars>1555548.0</Measures.Dollars>
     </ROW> 
     ... 
   </BrandGroup> 
   ...  <ROWSET> 



	Save the XSLT file as splitByBrand.xsl and upload the file to the report definition in the BI Publisher catalog. Select "XSL Stylesheet (HTML/XML/Text)" as the template Type.
	In the Excel template file, in the XDO_METADATA sheet, enter the following:	For the Preprocess XSLT File parameter, enter "splitByBrand.xsl"


	In the Data Constraints region, make the entries shown in the table to split the data into multiple sheets based on the <BrandGroup> element created by the results of the XSLT preprocessing.


	Column A Entry	Column B Entry
	XDO_SHEET_? 

	<?//BrandGroup?>


	XDO_SHEET_NAME_?

	<?./@name?>








The sample entries in the XDO_METADATA sheet are shown in this figure.


[image: Description of GUID-63A10786-E6B7-4527-90D0-CAE9CB1C946C-default.gif follows]










	Hide the XDO_METADATA sheet if you do not want your users to see it. Upload the Excel template file to the report definition in the BI Publisher catalog.






Splitting the Data by Count of Rows

This example demonstrates how to use an XSLT preprocess file to group the sample XML data.

The sample XML data is grouped by the count of occurrences of /ROWSET/ROW and then configure the Excel template to create a new sheet for each occurrence of the newly created group




	Create an XSLT file to create groups in the data according to a size specified in a variable. The following sample XSLT file groups the occurrences of /ROWSET/ROW according to the value of $var_size and creates a high level element <CountGroup> for each of those groups. 

  <?xml version="1.0" encoding="utf-8" ?>   <xsl:stylesheet version="2.0"
 xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
    <xsl:template match="/">
      <ROWSET>
       <xsl:variable name="var_size" select="3" />
       <xsl:for-each select="/ROWSET/ROW">
        <xsl:variable name="var_pos" select="position()" />
        <xsl:variable name="var_mod" select="$var_pos mod($var_size)" />
         <xsl:if test="$var_mod = 1">
         <xsl:variable name="var_groupNum" select="($var_pos - $var_mod) div number($var_size) + 1" />
         <xsl:element name="CountGroup">
          <xsl:attribute name="name">
           <xsl:value-of select="concat('Group', $var_groupNum)" />
      </xsl:attribute>
      <xsl:for-each select="/ROWSET/ROW[position() > ($var_pos -1) and position() < ($var_pos + $var_size)]">
        <xsl:copy-of select="." /> 
       </xsl:for-each>
      </xsl:element>
     </xsl:if>
   </xsl:for-each>
  </ROWSET>
 </xsl:template>
</xsl:stylesheet>

When applied to the data sample, this XSLT file generates intermediate data as follows:

 <ROWSET> 
   <CountGroup name="Group1">
      <ROW> 
       <Products.Type>COATINGS</Products.Type>
        <Products.Brand>Enterprise</Products.Brand>
        <Markets.Region>CENTRAL REGION</Markets.Region>
        <Markets.District>CHICAGO DISTRICT</Markets.District>
        <Periods.Year>2000</Periods.Year>
        <Measures.Dollars>1555548.0</Measures.Dollars>
      </ROW> 
     ... 
   </CountGroup> 
   ... 
 <ROWSET> 



	Save the XSLT file as splitByCount.xsl and upload the file to the report definition in the BI Publisher catalog. Select "XSL Stylesheet (HTML/XML/Text)" as the template Type.
	In the Excel template file, in the XDO_METADATA sheet, enter the following:	For the Preprocess XSLT File parameter, enter "splitByCount.xsl"


	In the Data Constraints region, make the entries shown in the following table .


	Column A Entry	Column B Entry
	XDO_SHEET_? 

	<?//CountGroup?>


	XDO_SHEET_NAME_?

	<?./@name?>













	Hide the XDO_METADATA sheet so that it does not display to report consumers.
	Upload the Excel template file to the report definition in the BI Publisher catalog.









PDF Security Properties

Use the properties described in the table below to control the security settings for the output PDF documents.


	Property Name	Description
	Enable PDF Security

	Default: false

Description: If you specify "true," then the output PDF file is encrypted. You can then also specify the following properties:

	Open document password


	Modify permissions password


	Encryption Level




Internal Name: pdf-security


	Open document password

	Default: N/A

Description: This password is required for opening the document. It enables users to open the document only. This property is enabled only when "Enable PDF Security" is set to "true". Note that BI Publisher follows Adobe's password restrictions. The password must contain only Latin 1 characters and must be no more than 32 bytes long.

Internal Name: pdf-open-password


	Modify permissions password

	Default: N/A

Description: This password enables users to override the security setting. This property is effective only when "Enable PDF Security" is set to "true". Note that BI Publisher follows the Adobe's password restrictions. The password must contain only Latin 1 characters and must be no more than 32 bytes long.

Internal Name: pdf-permissions-password


	Encryption level

	Default: 2 - high

Description: Specify the encryption level for the output PDF file. The possible values are:

	0: Low (40-bit RC4, Acrobat 3.0 or later)


	1: Medium (128-bit RC4, Acrobat 5.0 or later)


	2: High (128-bit AES, Acrobat 7.0 or later)




This property is effective only when "Enable PDF Security" is set to "true". When Encryption level is set to 0, you can also set the following properties:

	Disable printing


	Disable document modification


	Disable context copying, extraction, and accessibility


	Disable adding or changing comments and form fields




When Encryption level is set to 1 or higher, the following properties are available:

	Enable text access for screen readers


	Enable copying of text, images, and other content


	Allowed change level


	Allowed printing level




Internal Name: pdf-encryption-level


	Disable document modification

	Default: false

Description: Permission available when "Encryption level" is set to 0. When set to "true", the PDF file cannot be edited.

Internal Name: pdf-no-changing-the-document


	Disable printing

	Default: false

Description: Permission available when "Encryption level" is set to 0. When set to "true", printing is disabled for the PDF file.

Internal Name: pdf-no-printing


	Disable adding or changing comments and form fields

	Default: false

Description: Permission available when "Encryption level" is set to 0. When set to "true", the ability to add or change comments and form fields is disabled.

Internal Name: pdf-no-accff


	Disable context copying, extraction, and accessibility

	Default: false

Description: Permission available when "Encryption level" is set to 0. When set to "true", the context copying, extraction, and accessibility features are disabled.

Internal Name: pdf-no-cceda


	Enable text access for screen readers

	Default: true

Description: Permission available when "Encryption level" is set to 1 or higher. When set to "true", text access for screen reader devices is enabled.

Internal Name: pdf-enable-accessibility


	Enable copying of text, images, and other content

	Default: false

Description: Permission available when "Encryption level" is set to 1 or higher. When set to "true", copying of text, images, and other content is enabled.

Internal Name: pdf-enable-copying


	Allowed change level

	Default: 0

Description: Permission available when "Encryption level" is set to 1 or higher. Valid Values are:

	0: none


	1: Allows inserting, deleting, and rotating pages


	2: Allows filling in form fields and signing


	3: Allows commenting, filling in form fields, and signing


	4: Allows all changes except extracting pages




Internal Name: pdf-changes-allowed


	Allowed printing level

	Default: 0

Description: Permission available when "Encryption level" is set to 1 or higher. Valid values are:

	0: None


	1: Low resolution (150 dpi)


	2: High resolution




Internal Name: pdf-printing-allowed











3 Creating BI Publisher Layout Templates

This chapter describes creating BI Publisher layout templates using the layout editor.

The chapter includes the following topics:

	Overview of BI Publisher Layouts


	Launching the Layout Editor


	About the Layout Editor Interface


	Page Layout Tab


	Inserting Layout Components


	Inserting Layout Grids


	About Repeating Sections


	About Data Tables


	About Charts


	About Gauge Charts


	About Pivot Tables


	About Text Items


	About Images


	About Lists


	Setting Predefined or Custom Formulas


	Saving a Layout







